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Purpose

Cisco Unified Communications Manager Security Guide helps system and phone administrators perform the
following tasks:

* Configure authentication.

* Configure encryption.

* Configure digest authentication.

* Install server authentication certificate that is associated with HTTPS
* Configure the Cisco CTL Client.

* Configure security profiles.

* Configure Certificate Authority Proxy Function (CAPF) to install, upgrade, or delete locally significant
certificates on supported Cisco Unified IP Phone models.

* Configure phone hardening.
* Configure Survivable Remote Site Telephony (SRST) references for security.
* Configure gateways and trunks for security.

* Configure FIPS (Federal Information Processing Standard) 140-2 mode.
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This guide provides a reference and procedural guide for system and phone administrators who plan to
configure call security features for Cisco Unified Communications Manager.

Organization

The following table lists the major sections of this guide:

Table 1: Guide Overview

Chapter

Description

Security Basics

Security Overview

Provides an overview of security terminology, system requirements, interactions
and restrictions, installation requirements, and a configuration checklist; describes
the different types of authentication and encryption.

Hypertext Transfer
Protocol Over Secure
Sockets Layer (HTTPS)

Provides an overview of HTTPS and describes how to install the server
authentication certificate in the trusted folder.

Default Security Setup

Provides information about the Security by Default feature, which provides
automatic security features for Cisco Unified IP Phones.

Cisco CTL Client Setup | Describes how to configure authentication by installing and configuring the
CiscoCTL Client.

TLS Setup

Certificates

Certificate Overview

Security for Phonesand

Voice Mail Ports

Phone Security

Describes how Unified Communications Manager and the phone use security;
provides a list of tasks that you perform to configure security for the phone.

Phone Security Profile
Setup

Describes how to configure the security profile and apply it to the phones in
Unified Communications Manager.

Secure and Nonsecure
indication Tone Setup

Describes how to configure a phone to play a secure-indication tone.

Configuration File Setup

Encryption to Analog Describes how to configure a secure SCCP connection to analog endpoints.
Endpoint Setup
Encrypted Phone Describes how to configure encrypted phone configuration files in Unified

Communications Manager.
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Chapter

Description

Digest Authentication for
SIP phones Setup

Describes how to configure digest authentication on the phone that is running
SIP in Unified Communications Manager Administration.

Phone Hardening

Describes how to tighten the security on the phone by using Unified
Communications Manager Administration.

Secure Conference
Resources Setup

Describes how to configure media encryption for secure conferences.

Voice-Messaging Ports
Security Setup

Describes how to configure security for voice mail ports in Unified
Communications Manager Administration.

Secure Call Monitoring
and Recording Setup

Describes how to configure secure call monitoring and recording.

Virtual Private Networks for Ciscol PPhones

Security for CTI, JTAPI

,and TAPI

Authentication and
Encryption Setup for CTI,
JTAPI and TAPI

Describes how to configure the Application User CAPF Profile and End User
CAPF Profiles in Unified Communications Manager.

Security for SRST Refer

ences, Gateways, Trunks, and Cisco Unified Mobility Advantage Servers

Secure Survivable Remote
Site Telephony (SRST)
Reference

Describes how to configure the SRST reference for security in Unified
Communications Manager Administration.

Encryption Setup for
Gateways and Trunks

Describes how Unified Communications Manager communicates with a secure
gateway or trunk; describes IPSec recommendations and considerations.

SIP Trunk Security
Profile Setup

Describes how to configure and apply the SIP trunk security profile in Unified
Communications Manager Administration.

Digest Authentication Describes how to configure digest authentication for the SIP trunk in Unified
setup for SIP Trunks Communications Manager Administration.
Cisco Unified Mobility | Describes how to configure a Cisco Unified Mobility Advantage server security

Advantage Server security
Profile Setup

profile in Unified Communications Manager Administration.

FIPS 140-2 Mode Setup

Describes how to configure FIPS (Federal Information Processing Standard)
140-2 mode in Unified Communications Manager Administration.

Cisco V.150 Minimum
Essential Requirements
(MER)

Describes how to configure the V.150 feature, which allows you to make secure
calls in a modem over IP network.
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. Related Documentation

Related Documentation

Each chapter contains a list of related documentation for the chapter topic.

Refer to the following documents for further information about related CiscolP telephony applications and
products:

« Cisco Unified IP Phone Administration Guide for Cisco Unified Communications Manager

» Media and Signaling Authentication and Encryption Feature for Cisco I0S MGCP Gateways
« Cisco Unified Communications Manager Integration Guide for Cisco Unity

» Cisco Unified Communications Manager Integration Guide for Cisco Unity Connection

* Cisco Unified Survivable Remote Site Telephony (SRST) administration documentation that supports
the SRST-enabled gateway

« Cisco IP Phone Administration Guide for your phone model

Conventions

Notes use the following conventions:

)

Note Means reader take note. Notes contain helpful suggestions or references to material not covered in the
publication.

Tips use the following conventions:

Je

Tip Means the following are useful tips.

Cautions use the following conventions:

A

Caution Means reader be careful. In this situation, you might do something that could result in equipment damage or
loss of data.

Obtain Documentation, Support, and Security Guidelines

For information on obtaining documentation, obtaining support, providing documentation feedback, security
guidelines, and also recommended aliases and general Ciscodocuments, see the monthly What'sNew in
CiscoProduct Documentation, which also lists all new and revised Ciscotechnical documentation, at
http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html
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Cisco Product Security Overview

This product contains cryptographic features and is subject to United States and local country laws governing
import, export, transfer and use. Delivery of Cisco cryptographic products does not imply third-party authority
to import, export, distribute or use encryption. Importers, exporters, distributors and users are responsible for
compliance with U.S. and local country laws. By using this product you agree to comply with applicable laws
and regulations. If you are unable to comply with U.S. and local laws, return this product immediately.

Further information regarding U.S. export regulations may be found at http://www.access.gpo.gov/bis/ear/
ear_data.html.
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CHAPTER 1

Security Overview

Implementing security mechanisms in the Unified Communications Manager system prevents identity theft
of the phones and the Unified Communications Manager server, data tampering, and call-signaling/media-stream
tampering.

The CiscolP telephony network establishes and maintains authenticated communication streams, digitally
signs files before transferring the file to the phone, and encrypts media streams and call signaling between
Cisco Unified IP Phones.

* Terms and Acronyms, on page |

* System Requirements, on page 6

* Features List, on page 6

* Security Icons, on page 7

* Interactions and Restrictions, on page 8

* Best Practices, on page 13

* CTL Client, SSL, CAPF, and Security Token Installation, on page 15
* TLS and IPSec, on page 15

* Certificates, on page 16

* Authentication, Integrity, and Authorization, on page 20
* Encryption, on page 24

* NMAP Scan Operation, on page 32

* Set Up Authentication and Encryption, on page 32

* Where to Find More Information, on page 35

Terms and Acronyms

The definitions in the following table apply when you configure authentication, encryption, and other security
features for your CiscolPtelephony network:

Table 2: Terminology

Term Definition

Access Control List (ACL) List that defines rights and permissions to access
system functions and resources. See Method List.

Security Guide for Cisco Unified Communications Manager, Release 11.5(1)SU10 .
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Term Definition

Authentication Process that verifies the identity of the communicating
entity.

Authorization Process that specifies whether an authenticated user,

service, or application has the necessary permissions
to perform a requested action; in Unified
Communications Manager, the security process that
restricts certain trunk-side SIP requests to authorized
users.

Authorization Header

A SIP user agent response to a challenge.

Certificate

A message that contains the certificate holder name,
the public key, and the digital signature of the
certificate authority that is issuing the certificate.

Certificate Authority (CA)

Trusted entity that issues certificates: Cisco or a
third-party entity.

Certificate Authority Proxy Function (CAPF)

Process by which supported devices can request
locally significant certificates by using Unified
Communications Manager Administration.

Certificate Trust List (CTL)

A file, which is created either with the CLI command
set utils cli or with the CTL Client and signed by the
Cisco Site Administrator Security Token (security
token), that contains a list of certificates for servers
that the phone is to trust.

Challenge

In digest authentication, a request to a SIP user agent
to authenticate its identity.

Cisco Site Administrator Security Token (security
token; etoken)

A portable hardware security module that contains a
private key and an X.509v3 certificate that the Cisco
Certificate Authority signs; used for file
authentication, it may be used to sign the CTL file.

Hardware security tokens are required for only the
CTL Client. The CLI command set utils ctl does not
require hardware security tokens.

Device Authentication

Process that validates the identity of the device and
ensures that the entity is what it claims to be before a
connection is made.

Digest Authentication A form of device authentication where an MD5 hash
of a shared password (among other things) gets used
to establish the identity of a SIP user agent.

Digest User User name that is included in an authorization request

that phones that are running SIP or SIP trunks send.
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Term

Definition

Digital Signature

Value that is generated by hashing the message and
then encrypting the message with the private key of
the signer; the recipient decrypts the message and the
hash with the signer public key, produces another hash
with the same hash function, then compares the two
hashes to ensure that the messages match and the
content is intact.

DSP Digital signaling processor.

DSP Farm A network resource for IP telephony conferencing
that is provided by DSPs on a H.323 or MGCP
gateway.

Encryption Process of translating data into ciphertext, which

ensures the confidentiality of the information and that
only the intended recipient can read the data. Requires
an encryption algorithm and encryption key.

File Authentication

Process that validates digitally signed files that the
phone downloads. The phone validates the signature
to make sure that file tampering did not occur after
the file creation.

H.323 An internet standard that defines a common set of
codecs, call setup and negotiating procedures, and
basic data transport methods.

hash A number, usually in hexadecimal, that is generated

from a string of text by using a hash function, which
creates a small digital “fingerprint” for the data.

Hypertext Transfer Protocol over Secure Sockets
Layer (HTTPS)

An IETF-defined protocol that ensures (at a minimum)
the identity of the HTTPS server; by using encryption,
ensures the confidentiality of the information that is
exchanged between the Tomcat server and the browser
client.

Image Authentication

Process whereby a phone validates the integrity and
source of a binary image prior to loading it on the
phone.

Integrity Process that ensures that data tampering did not occur
between entities.
IPSec Transport that provides secure H.225, H.245, and RAS

signaling channels for end-to-end security.

Locally Significant Certificate (LSC)

A digital X.509v3 certificate that CAPF issues;
installed on the phone or JTAPI/TAPI/CTI
application.
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Term

Definition

Manufacture Installed Certificate (MIC)

A digital X.509v3 certificate that is signed by the
Cisco Certificate Authority and installed in supported
phones by Cisco Manufacturing; used as the
authentication mechanism to CAPF when LSCs are
installed in phones.

Man-in-the-Middle Attacks

Process that allows an attacker to observe and modify
the information flow between Unified
Communications Manager and the phone.

Multipoint Control Unit (MCU)

A flexible system to connect multiple H.323 endpoints
and allow multiple users to participate in [P-based
video conferences.

MD5

A hash function that is used with encryption.

Media Encryption

Process whereby the confidentiality of the media is
protected with cryptographic procedures. Media
encryption uses Secure Real-Time Protocol (SRTP)
as defined in IETFRFC3711.

Message/Data Tampering

Event when an attacker attempts to alter messages in
transit, including ending a call prematurely.

Method List

Tool to restrict certain categories of messages that can
come in on a SIP trunk during the authorization
process; defines which SIP nonINVITE methods are
allowed for a trunk-side application or device. Also
method ACL.

Mixed Mode

Unified Communications Manager security mode that
you configure to allow devices with secure/nonsecure
profiles and RTP/ SRTP media to connect to Unified
Communications Manager.

Nonce

A unique, random number that the server generates
for each digest authentication request; used to generate
an MDS5 hash.

Nonsecure Mode

Unified Communications Manager security mode that
you configure to allow devices with nonsecure profiles
and RTP media to connect to Unified Communications
Manager.

Nonsecure Call

Call in which at least one device is not authenticated
or encrypted.

Nonsecure Device

Device that uses UDP or TCP signaling and nonsecure
media.
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Term

Definition

PKI

Public key infrastructure, which comprises the set of
elements that is needed for public key encryption,
including secure public key distribution, certificates,
and certificate authorities.

Public / Private key

Keys that are used in encryption. Public keys are
widely available, but private keys are held by their
respective owners. Asymmetrical encryption combines
both types.

Replay Attack

Event when an attacker captures information that
identifies a phone or proxy server and replays
information while pretending to be the actual device;
for example, by impersonating the proxy server private
key.

RTP

Real-Time Transport Protocol

Simple Certificate Enrollment Protocol (SCEP)

A protocol that is used to communicate with a
certificate authority that issues X.509 certificates.

Secure Call

Call in which all devices are authenticated, signaling
is encrypted, and the media (voice stream) is
encrypted.

Signaling Authentication

TLS process that validates that no tampering occurred
to signaling packets during transmission.

Signaling Encryption

Process that uses cryptographic methods to protect
the confidentiality of all signaling messages that are
sent between the device and the Unified
Communications Manager server.

SIP Realm

A string (name) that Unified Communications
Manager uses to respond to a challenge.

SRTP

Secure Real-Time Transport Protocol that secures
voice conversation in the network and provides
protection against replay attacks.

SSL

A cryptographic protocol that secures data
communications such as e-mail on the Internet;
equivalent to TLS, its successor.

Transport Layer Security (TLS)

A cryptographic protocol that secures data
communications such as e-mail on the Internet;
functionally equivalent to SSL.

Trust List

Certificate list without digital signatures.
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Trust Store A repository of X.509 certificates that an application,
such as Unified Communications Manager, explicitly
trusts.

X.509 An ITU-T cryptographic standard for importing PKI
certificates, which includes certificate formats.

System Requirements

The following system requirements exist for authentication or encryption:

* The Administrator password can differ on every server in a cluster.

* The username and password that are used at the Cisco CTL client (to log in to the Unified Communications
Manager server) must match the Unified Communications Manager Administration username and
password (the username and password that are used to log in to Unified Communications Manager

Administration).

* Before you configure voicemail ports for security, verify that you installed a version of Cisco Unity or
Cisco Unity Connection system that supports this Unified Communications Manager release.

Features List

Unified Communications Manager system uses a multilayered approach to call security, from the transport

layer to the application layer.

Transport layer security includes TLS and IPSec for signaling authentication and encryption to control and
prevent access to the voice domain. SRTP adds media authentication and encryption to secure privacy and
confidentiality for voice conversation and other media.

The following table provides a summary of the authentication and encryption features that Unified
Communications Manager can implement during an SCCP call session, depending on the features that are

supported and configured.

Table 3: SCCP Call Security Features

Security Feature

Line Side

Trunk Side

Transport/Connection/Integrity

Secure TLS port

IPSec associations

Device Authentication

TLS certificate exchange w/Unified
Communications Manager and/or
CAPF

IPSec certificate exchange or
preshared key

Signaling
Authentication/Encryption

TLS Mode: authenticated or
encrypted

IPSec [authentication header,
encryption (ESP), or both]

Media Encryption

SRTP

SRTP
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Security Feature Line Side Trunk Side
Authorization Presence requests Presence requests
Note Supported features on a device vary by device type.

The following table provides a summary of the authentication and encryption features that Unified
Communications Manager can implement during a SIP call session, depending on the features that are supported
and configured.

Table 4: SIP Call Security Features

Security Feature Line Side Trunk Side
Transport/Connection/Integrity Secure TLS port Secure TLS port
Device Authentication TLS certificate exchange w/Unified | I[PSec certificate exchange or
Communications Manager and/or |preshared key
CAPF
Digest Authentication Each SIP device uses unique digest | SIP trunk user agents use unique
user credentials. digest credentials.
Signaling TLS Mode: authenticated or TLS Mode: authenticated or
Authentication/Encryption encrypted (except Cisco Unified IP | encrypted mode
Phones 7942/7962).
Media Encryption SRTP SRTP
Authorization Presence requests Presence requests
Method list
Note Supported features on a device vary by device type.

Security Icons

Unified Communications Manager provides security status for a call, according to security levels that are
configured for the Unified Communications Manager server(s) and devices that are participating in the call.

Phones that support security icons display the call security level.

* The phone displays a shield icon for calls with a signaling security level of authenticated. A shield
identifies a secured connection between CiscolP devices, which means that the devices have authenticated
or encrypted signaling.

* The phone displays a lock icon for calls with encrypted media, which means that the devices are using
encrypted signaling and encrypted media.
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Note Some phone models display only the lock icon.

The security status of a call can change for point-to-point, intracluster, intercluster, and multihop calls. SCCP
line, SIP line, and H.323 signaling support notification of call security status changes to participating endpoints.
Refer to topics related to security icons and encryption for restrictions that are associated with security icons.

The audio and video portions of the call provide basis for the call security status. Consider the call secure
only if both the audio and video portions are secure. The following table describes the rules that determine
whether a security icon displays, and which icon appears.

Table 5: Security Icon Display Rules

Media and Device Types In the Call | Phones That Display Both Shield |Phones That Display Only the Lock
and Lock Icons Icon

Secure audio only Lock Lock

Secure audio with unsecure video | Shield None

Secure audio with secure video Lock Lock

Authenticated device with Shield None

nonsecure audio only

Authenticated device with Shield None

nonsecure audio and video

Unauthenticated device with None None

nonsecure audio only

Unauthenticated device with None None

nonsecure audio and video

)

Note The “Override BFCP Application Encryption Status When Designating Call Security Status” service parameter
displays the lock icon when parameter value is True and audio is secure. This condition ignores the security
statuses of all other media channels. The default parameter value is False.

For conference and barge calls, the security icon displays the security status for the conference.

Interactions and Restrictions

This section contains interaction and restriction information.

See the related topics for information about interactions and restrictions that are associated with the secure
conference feature.

. Security Guide for Cisco Unified Communications Manager, Release 11.5(1)SU10



| Security Basics

Interactions

Restrictions

Interactions .

This section provides information on the Interaction of Cisco Security features with Unified Communications
Manager applications.

Presence

Configure presence groups to restrict presence requests sent to authorized users. You can add presence group
authorization for phones and trunks that are running SIP.

Refer to Feature Configuration Guide for Cisco Unified Communications Manager for more information
about configuring presence groups.

Configure Unified Communications Manager to allow and accept presence requests on SIP trunk. If required,
Configure Unified Communications Manager to accept and authenticate incoming presence requests from
remote devices or applications.

SIP Trunk

Configure SIP Trunk Security Profile to accept incoming, out of dialog, REFER requests to use SIP-initiated
transfer features and other advanced transfer features on SIP trunks. For Example, Web Transfer and Click
to Dial.

Configure SIP Trunk Security Profile to accept Unsolicited Notification SIP requests to report events (MWI
support) and to reduce per-call MTP allocations (from a voice-messaging server).

Configure SIP Trunk Security Profile to accept SIP requests which replaces header in REFERS and INVITES.
The Unified Communications Manager can now transfer an external call for a SIP trunk to an external device
or party.

Extension Mobility

For Extension Mobility, SIP digest credentials change when a user logs in and out as different end users have
different credentials.

Computer Telephony Integration (CTI)

Cisco Unified Communications Manager Assistant supports a secure connection to CTI (transport layer
security connection) when you configure a CAPF profile (one for each Cisco Unified Communications Manager
Assistant node).

CTI TLS support requires you to configure a unique InstancelD (IID) for every application instance, when
multiple instances of a CTI/JTAPI/TAPI application are running. The IID secures the signaling and media
communication streams between CTI Manager and JTAPI/TSP/CTI applications.

When the device security mode equals authenticated or encrypted, the Cisco Unity-CM TSP connects to
Unified Communications Manager through the Unified Communications Manager TLS port. When the security
mode equals nonsecure, the Cisco Unity TSP connects to Unified Communications Manager through the CTI
Manager port.

This section describes restrictions that apply to Cisco security features.
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Authentication and Encryption
Consider the following restrictions before you install and configure authentication and encryption features:

* You cannot implement signaling or media encryption without device authentication. To install device
authentication, enable the Cisco CTL Provider service and install and configure the Cisco CTL client.

* Cisco does not support Network Address Translation (NAT) with Unified Communications Manager if
you configure mixed mode.

You can enable UDP in the firewall to allow media stream firewall traversal. Enabling UDP allows the
media source on the trusted side of the firewall to open a bidirectional media flow through the firewall
by sending the media packet through the firewall.

2

Tip Hardware DSP resources cannot initiate this type of connection and, therefore, must exist outside the firewall.

Signaling encryption does not support NAT traversal. Instead of using NAT, consider using LAN extension
VPNEs.

Barge and Encryption

The following restrictions apply to barge and encryption:

* Due to bandwidth requirements, Cisco IP Phones 7942 and 7962 do not support barge from an encrypted
device on an active encrypted call. The barge attempt will fail. A tone plays on the initiator phone to
indicate that the barge failed.

* Encrypted Cisco IP Phones that are running release 8.2 or earlier can only barge an active call as
authenticated or nonsecure participants.

» If a caller barges a secure SCCP call, the system uses an internal tone-playing mechanism at the target
device, and the status remains secure.

» If a caller barges a secure SIP call, the system provides tone-on-hold, and Unified Communications
Manager classifies the call as nonsecure during the tone.

\}

Note Nonsecure or authenticated Cisco IP Phones that are running release 8.3 or later can barge encrypted calls.
The security icon indicates the security status for the conference.

Wideband Codecs and Encryption

The following information applies for Cisco Unified IP Phones 7962 or 7942 that are configured for encryption
and associated with a wideband codec region. This only applies to Cisco Unified IP Phones 7962 or 7942 that
are configured for TLS/SRTP.

To establish an encrypted call, Unified Communications Manager ignores the wideband codec and chooses
another supported codec from the codec list that the phone presents. If the other devices in the call are not
configured for encryption, Unified Communications Manager may establish the authenticated/nonsecure call
by using the wideband codec.
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Media Resources and Encryption

Unified Communications Manager supports authenticated and encrypted calls between secure Cisco Unified
IP Phones (SCCP or SIP), secure CTI devices/route points, secure Cisco MGCP I0S gateways, secure SIP
trunks, secure H.323 gateways, secure conference bridges, and secure H.323/H.245/H.225 trunks where no
media resources are used. Unified Communications Manager does not provide media encryption in the
following cases:

« Calls that involve transcoders

* Call that involve media termination points

\}

Note MTP encryption is not supported only with the non-passthrough MTP.

Phone Support and Encryption

The following Cisco Unified IP Phones that are running SCCP support encryption: 6901, 6911, 6921, 6941,
6945, 6961,7906G, 7911G, 7921G, 7925G, 7925G-EX, 7926G, 7931G, 7941G, 7941G-GE, 7942G, 7945G,
7961G, 7961G-GE, 7962G, 7965G, 7970G, 7971G, 7975G, 8941, 8945, and 9961.

The following Cisco Unified IP Phones that are running SIP support encryption: 6901, 6911, 6921, 6941,
6945, 6961, 7811, 7821, 7841, 7861, 7832, 7906G, 7911G, 7941G, 7941G-GE, 7942G, 7961G,
7961G-GE,7962G, 7965G, 7970G, 7971G, 7975G, 8811, 8821, 8821-EX, 8832, 8841, 8845, 8851, 8851NR,
8865, 8865NR, 8941, 8945, 8961, 9971, and 9971.

For more information, see the System Configuration Guide for Cisco Unified Communications Manager that
support encryption and this version of Unified Communications Manager.

A

Warning  To obtain the full benefit of security features, Cisco recommends that you upgrade Cisco IP Phones to firmware
release 8.3 or later, which supports the encryption features in this Unified Communications Manager release.
Encrypted phones that run earlier releases do not fully support these new features. These phones can participate
in secure conference and barge calls only as authenticated or nonsecure participants.

Cisco IP Phones that are running on firmware release 8.3 with an earlier release of Unified Communications
Manager will display their connection security status, not the conference security status, during a conference
or barge call, and do not support secure conference features like conference list.

Phone Support and Encrypted Setup Files

Not all phones support encrypted configuration files. Some phones support encrypted configuration files but
do not validate file signatures. All phones that support encrypted configuration files require firmware that is
compatible with Unified Communications Manager Release 5.0 or later to receive full encrypted configuration
files.

Security Icons and Encryption

The following restrictions apply to security icons and encryption:
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* The encryption lock icon may not display on the phone when you perform tasks such as transferring or
putting a call on hold; the status changes from encrypted to nonsecure if the media streams that are
associated with these tasks, such as MOH, are not encrypted.

* Unified Communications Manager does not display the shield icon for calls that are transiting H.323
trunks.

* For calls that involve the PSTN, the security icon shows the security status for only the IP domain portion
of the call.

* A SIP trunk will report encrypted or not-authenticated security status when using the TLS transport type.
When SRTP is negotiated, the security status will get encrypted; otherwise it will remain not-authenticated.
This will allow Unified Communications Manager call control to determine the overall security level of
a call that involves a SIP trunk.

A SIP trunk will report authenticated status over the trunk if a party is authenticated during events such
as a meet-me conference or a cbarge. (The SIP trunk will still be using TLS/SRTP.)

* For Secure Monitoring and Recording, a SIP trunk will utilize the existing Call Info header mechanism
for transmitting the security icon status over the SIP trunk, as currently used by the SIP line. This enables
the SIP trunk peer to monitor the overall security status of a call.

» Some phone models display only the lock icon, not the shield icon.

Cluster and Device Security Modes

\}

Note Device security mode configures the security capability for a Cisco IP Phone or SIP trunk. Cluster security
mode configures the security capability for your standalone server or a cluster.

When the cluster security mode equals nonsecure, the device security mode equals nonsecure in the phone
configuration file. In these circumstances, the phone makes nonsecure connections with the SRST-enabled
gateway and Unified Communications Manager, even if the device security mode specifies authenticated or
encrypted. Security-related settings other than device security mode, such as the SRST Allowed check box,
also get ignored. The security configuration does not get deleted in Unified Communications Manager
Administration, but security does not get provided.

The phone attempts a secure connection to the SRST-enabled gateway only when the cluster security mode
equals mixed, the device security mode in the phone configuration file is set to authenticated or encrypted,
the SRST Allowed? check box is checked in the Trunk Configuration window, and a valid SRST certificate
exists in the phone configuration file.

Digest Authentication and Encryption

Unified Communications Manager defines a SIP call as having two or more separate call legs. For a standard,
two-party call between two SIP devices, two separate call legs exist: one leg between the originating SIP user
agent and Unified Communications Manager (the originating call leg) and the other leg between Unified
Communications Manager and destination SIP user agent (the terminating call leg). Each call leg represents
a separate dialog. Because digest authentication is a point-to-point process, digest authentication on each call
leg stays independent of the other call legs. SRTP capabilities can change for each call leg, depending on the
capabilities that are negotiated between the user agents.
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Packet Capturing and Encryption

When SRTP encryption is implemented, third-party sniffing tools do not work. Authorized administrators
with appropriate authentication can initiate packet capturing with a configuration change in Unified
Communications Manager Administration (for devices that support packet capturing). See the Troubleshooting
Guide for Cisco Unified Communications Manager that supports this release for information about configuring
packet capturing in Unified Communications Manager.

Best Practices

We recommend the following best practices while configuring security for Unified Communications Manager:

* Always install and configure security in a secure lab environment before you deploy to a wide-scale
network.

* Use IPSec for gateways and other application servers at remote locations.

A

Warning  If you fail to use IPSec, the session encryption keys get transmitted in cleartext.

* To prevent toll fraud, configure conference enhancements. For more information, see System Configuration
Guide for Cisco Unified Communications Manager.

To restrict external call transfers, perform configuration tasks. For more information, see Feature
Configuration Guide for Cisco Unified Communications Manager.

Device Resets, Server and Cluster Reboots, and Service Restarts

This section describes when you need to reset the devices, to reboot the server/cluster, or to restart services
in Cisco Unified Serviceability.

Consider the following guidelines:

* Reset a single device after you apply a different security profile in Cisco Unified Communications
Manager Administration.

* Reset the devices if you perform phone-hardening tasks.

* Reset the devices after you change the cluster security mode from mixed to nonsecure mode (or vice
versa).

* Restart all devices after you configure the Cisco CTL client or update the CTL file.

* Reset the devices after you update CAPF enterprise parameters.

* Restart the Cisco CTL Provider service after you update ports for the TLS connection.

* Restart the Cisco CallManager service after you change the cluster security mode from mixed to nonsecure
mode (or vice versa).

* Restart the Cisco Certificate Authority Proxy Function service after you update associated CAPF service
parameters.

* Restart all Cisco CallManager and Cisco TETP services in Cisco Unified Serviceability after you configure
the Cisco CTL Client or update the CTL file. Perform this task on all servers that run these services in
the cluster.

* Restart all Cisco CallManager and Cisco TFTP services after you start or stop the CTL Provider service.
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* Reset dependent devices after you configure secure SRST references.

* If you set the Smart Card service to Started and Automatic, reboot the PC where you installed the
Cisco CTL client.

* Restart the Cisco IP Manager Assistant service, Cisco Web Dialer Web Service, and the Cisco Extended
Functions service after you configure the security-related service parameters that are associated with the
Application User CAPF Profile.

To restart the Cisco CallManager service, refer to Cisco Unified Serviceability Administration Guide.

To reset a single device after you update the phone configuration, see topics related to applying the phone
security profile.

Reset Devices, Servers, Clusters, and Services

This section provides information on when to reset devices, servers, clusters, and services in Cisco Unified
Serviceability.

To reset all devices in a cluster, perform the following procedure:

Procedure

Step 1 From Unified Communications Manager, choose System > CiscoUnifiedCM.
Step 2 Click Find.

A list of configured Unified Communications Manager servers appears.

Step 3 Choose the Unified Communications Manager on which you want to reset devices.
Step 4 Click Reset.
Step 5 Perform Step 2 and Step 4 for each server in the cluster.

Media Encryption with Barge Setup

Configure barge for Cisco Unified IP Phones 7962 and 7942 for encryption and perform the following tasks
in Cisco Unified Communications Manager Administration.

+ Update the Cluster Security Mode parameter in the CTL client.

* Update the Builtin Bridge Enable parameter in the Service Parameter window.

On completion of the tasks, the following message appears.

L 4]

Attention  If you configure encryption for Cisco Unified IP Phone models 7962 and 7942, the encrypted devices can't
accept a barge request when they are participating in an encrypted call. The barge attempt fails when the call
is encrypted.

Cisco Unified IP Phones 7962 and 7942 configured with an encrypted security profile doesn't display the
message in the Phone Configuration window. You choose Default for the Built In Bridge setting or the
default setting equals Default. The same restriction applies for either selection.
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Tip Reset the dependent CiscolP devices for changes to take effect.

CTL Client, SSL, CAPF, and Security Token Installation

To obtain authentication support, you can use one of the following options:

1. Install the Cisco CTL client, from Unified Communications Manager Administration. For the Cisco CTL
client option, you must obtain at least two security tokens.

2. Use the CLI command set utils ctl, which does not require security tokens. For more information about
this option, see the Command Line Interface Guide for Cisco Unified Communications Solutions.

Media and signaling encryption capabilities automatically install when you install Unified Communications
Manager.

Unified Communications Manager automatically installs Secure Sockets Layer (SSL) for Unified
Communications Manager virtual directories.

Cisco Certificate Authority Proxy Function (CAPF) installs automatically as a part of Unified Communications
Manager Administration.

TLS and IPSec

Transport security handles the coding, packing, and sending of data. Unified Communications Manager
provides the following secure transport protocols:

» Transport Layer Security (TLS) provides secure and reliable data transfer between two systems or devices,
by using secure ports and certificate exchange. TLS secures and controls connections among Unified
Communications Manager-controlled systems, devices, and processes to prevent access to the voice
domain. Unified Communications Manager uses TLS to secure SCCP calls to phones that are running
SCCP and SIP calls to phones or trunks that are running SIP.

* [P Security (IPSec) provides secure and reliable data transfer between Unified Communications Manager
and gateways. [PSec implements signaling authentication and encryption to CiscolOS MGCP and H.323
gateways.

You can add secure RTP (SRTP) to TLS and IPSec transport services for the next level of security on devices
that support SRTP. SRTP authenticates and encrypts the media stream (voice packets) to ensure that voice
conversations that originate at or terminate to CiscoUnified[PPhones and either TDM or analog voice gateway
ports are protected from eavesdroppers who may have gained access to the voice domain. SRTP adds protection
against replay attacks.

Cisco Unified Communications Manager 9.0 and later provides TLS/SRTP support for dual-mode smart
phones. TLS establishes the same secure and reliable data transfer mode for mobile phones as for IP phones,
and SRTP encrypts voice conversations.
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Certificates

Certificates secure client and server identities. After root certificates are installed, certificates get added to
the root trust stores to secure connections between users and hosts, including devices and application users.

Administrators can view the fingerprint of server certificates, regenerate self-signed certificates, and delete
trust certificates at the Cisco Unified Communications Operating System GUI.

Administrators can also regenerate and view self-signed certificates at the command line interface (CLI).

For information on updating the CallManager trust store and managing certificates, refer to the Administration
Guide for Cisco Unified Communications Manager that supports this Unified Communications Manager
release.

)

Note

\)

¢ Unified Communications Manager supports only PEM (.pem) and DER (.der) formatted certificates.

* The maximum supported size of certificate for DER or PEM is 4096 bits.

Note

When you upload two certificates, ensure that they have same common name and same validity period but
different serial numbers and signature algorithms.

For example, root CA with 27:20:41:0c:50b:08:69:80:42:62:4f:13:bd:16:06: 6aserial number and SHA 1
algorithm exists in Cisco Unified Communications Manager tomcat-trust. When you attempt to upload the
certificate with 70:35:33:71:0b:7c:08:b2:47:b3:aa:£9:5c:0d:ca:e4 serial number and SHA256 algorithm,
the certificate management happens in the following way:

1. The validity of incoming certificate is verified.
2. The certificate with same common name is searched in the Tomcat trust folder.

3. The serial numbers of the certificate existing in the Tomcat trust folder and the incoming certificate that
you are uploading is checked. If the serial numbers are different, the validity start date of both the certificates
is verified. If the validity start time stamp of incoming certificate is later than the validity start time stamp
of the existing certificate, the existing certificate replaces the newer incoming certificate in the Tomcat
trust folder. Else, the new incoming certificate is not uploaded.

Both SHA1 and SHA256 algorithms have same subject name or common name, which implies that they
belong to the same entity. The Unified Communications Manager framework does not support both these
algorithms on the Unified Communications Manager server simultaneously. Only one certificate that belongs
to any entity is supported in a particular trust folder, irrespective of the signature algorithm.

Phone Certificate Types

A phone certificate is a unique identifier which authenticates phones. It's crucial for security against IP attacks.

Phone Certificates are as follows:
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Table 6:

Phone Certificates Description

Manufacture Installed MICs are signed by Cisco Manufacturing CA and we automatically install this
Certificate (MIC) certificate in supported Cisco Unified IP Phone.

MICs authenticate with CiscoCertificate Authority Proxy Function (CAPF) for
Locally Significant Certificates (LSC) installation or download an encrypted
configuration file. Cannot use after expiry, as administrators can’t modify, delete,
or revoke the certificates.

Locally Significant Cisco Unified IP Phones require an LSC to operate in secure mode and is used
Certificates (LSC) for authentication and encryption. They are signed by CAPF, Online or Offline
CA and takes precedence over MIC.

After you perform the necessary tasks that are associated with CAPF, this
certificate gets installed on supported phones. The LSC secures the connection
between Unified Communications Manager and the phone after you configure
the device security mode for authentication or encryption.

2

Tip We recommend that you use only MICs for LSC installation. We support LSCs to authenticate the TLS
connection with Unified Communications Manager. When phone configurations use MICs for TLS
authentication or for any other purpose, we assume no liability as MIC root certificates get easily compromised.

Upgrade Cisco Unified IP Phones 6900, 7900, 8900, and 9900 series to use LSCs for a TLS connection to
Unified Communications Manager. Remove MIC root certificates from the Unified Communications Manager
trust store to avoid possible future compatibility issues.

)

Note Phone models that use MICs for TLS connection to Unified Communications Manager may not be able to
register.

Administrators should remove the following MIC root certificates from the Unified Communications Manager
trust store:

* CAP-RTP-001

» CAP-RTP-002

* Cisco_Manufacturing CA

* Cisco_Root CA 2048

* Cisco_Manufacturing CA SHA2
* Cisco Root CA M2

*+ ACT2 _SUDI_CA

MIC root certificates that stay in the CAPF trust store get used for certificate upgrades. For information on
updating the Unified Communications Manager trust store and managing certificates, see Administration
Guide for Cisco Unified Communications Manager.
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\)

Note The Secure Onboarding feature doesn’t work if you remove the Cisco Manufacturing certificates from the
CallManger-trust store, because it can’t validate the Manufacture Installed Certificates (MICs) from phones.

Server Certificate Types

Server Certificates are basically to identify a server. The server certificates serve the rationale of encrypting
and decrypting the content.

Self-signed (own) certificate types in Unified Communications Manager servers are as follows:

Unified Communications Manager imports the following certificate types to the Unified Communications
Manager trust store:

Table 7: Certificate Type and Description

Certificate Type Description

Cisco Unity server or | Cisco Unity and Cisco Unity Connection use this self-signed root certificate to
Cisco Unity Connection |sign the Cisco Unity SCCP and Cisco Unity Connection SCCP device certificates.
certificate For Cisco Unity, the Cisco Unity Telephony Integration Manager (UTIM) manages
this certificate. For Cisco Unity Connection, Cisco Unity Connection
Administration manages this certificate.

Cisco Unity and Cisco | Cisco Unity and Cisco Unity Connection SCCP devices use this signed certificate
Unity Connection SCCP to establish a TLS connection with Unified Communications Manager.
device certificates

SIP Proxy server A SIP user agent that connects via a SIP trunk authenticates to Unified
certificate Communications Manager if the CallManager trust store contains the SIP user
agent certificate and if the SIP user agent contains the Unified Communications
Manager certificate in its trust store.

\}

Note The certificate name represents a hash of the certificate subject name, which is based on the voice-mail server
name. Every device (or port) gets issued a certificate that is rooted at the root certificate.

The following additional trust store exists:

» Common trust store for Tomcat and web applications
* [PSec-trust

* CAPF-trust

* Userlicensing-trust

» TVS-trust

* Phone-SAST-trust

* Phone-CTL-trust
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For more information about CA trust certificates for Cisco Unity Connection, see the Administration Guide
for Cisco Unified Communications Manager. These trust-certificates secure connections to Exchange or
Meeting Place Express for fetching e-mails, calendar information, or contacts.

Support for Certificates from External CAs

Unified Communications Manager supports integration with third-party certificate authorities (CAs) by using
a PKCS#10 certificate signing request (CSR) mechanism, which is accessible at the Unified Communications
Manager GUIL

Customers who currently use third-party CAs should use the CSR mechanism to issue certificates for:

* Unified Communications Manager
* CAPF

* [PSec

* Tomcat

* TVS

\}

Note Multiserver (SAN) CA-signed certificates only applies to nodes in the cluster when the certificate gets uploaded
to the Publisher. Generate a new multiserver certificate. Upload it to the cluster every time you add a new
node or build it again.

If you run your system in mixed mode, some endpoints may not accept CA certificates with a key size of
4096 or longer. To use CA certificates in mixed mode, choose one of the following options:

* Use certificates with a certificate key size less than 4096.

* Use self-signed certificates.

)

Note This release of Unified Communications Manager doesn't provide SCEP interface support.

\}

Note Be sure to run the CTL client after you upload a third-party, CA-signed certificate to the platform to update
the CTL file.

Restart the appropriate services for the update after running the CTL client.
For example:

* Restart TFTP services and Unified Communications Manager services when you update the Unified
Communications Manager certificate.

* Restart CAPF when you update the CAPF certificate.
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After uploading the Unified Communications Manager or CAPF certificates, you might observe the phones
reset automatically to update their ITL File.

For information on generating Certificate Signing Requests (CSRs) at the platform, see Administration Guide
for Cisco Unified Communications Manager.

Authentication, Integrity, and Authorization

Integrity and authentication protect against the following threats:

» TFTP file manipulation (integrity)

* Modification of call-processing signaling between the phone and Unified Communications Manager
(authentication)

* Man-in-the-middle attacks (authentication), as defined in Acronyms section.
* Phone and server identity theft (authentication)

* Replay attack (digest authentication)

Authorization specifies what an authenticated user, service, or application can do. You can implement multiple
authentication and authorization methods in a single session.

Image Authentication

This process prevents tampering with the binary image, the firmware load, prior to loading it on the phone.
Tampering with the image causes the phone to fail the authentication process and reject the image. Image
authentication occurs through signed binary files that automatically install when you install Unified
Communications Manager. Likewise, firmware updates that you download from the web also provide signed
binary images.

Device Authentication

This process validates the identity of the communicating device and ensures that the entity is who it claims
to be.

Device authentication occurs between the Unified Communications Manager server and supported Cisco
Unified IP Phones, SIP trunks, or JTAPI/TAPI/CTI applications (when supported). An authenticated connection
occurs between these entities only when each entity accepts the certificate of the other entity. Mutual
authentication describes this process of mutual certificate exchange.

Device authentication relies on the creation of the CiscoCTL file (for authenticating Unified Communications
Manager server node and applications), and the Certificate Authority Proxy Function (for authenticating
phones and JTAPI/TAPI/CTI applications).

Je

Tip

A SIP user agent that connects via a SIP trunk authenticates to Unified Communications Manager if the
CallManager trust store contains the SIP user agent certificate and if the SIP user agent contains the Unified
Communications Manager certificate in its trust store. For information on updating the CallManager trust
store, refer to the Administration Guide for Cisco Unified Communications Manager that supports this Unified
Communications Manager release.
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File Authentication

This process validates digitally signed files that the phone downloads; for example, the configuration, ring
list, locale, and CTL files. The phone validates the signature to verify that file tampering did not occur after
the file creation. For a list of devices that are supported, see “Phone Model Support”.

If you configure the cluster for mixed mode, the TETP server signs static files, such as ring list, localized,
default.cnf.xml, and ring list wav files, in.sgn format. The TFTP server signs files in <device name>.cnf.xml
format every time that the TFTP server verifies that a data change occurred for the file.

The TFTP server writes the signed files to disk if caching is disabled. If the TFTP server verifies that a saved
file has changed, the TFTP server re-signs the file. The new file on the disk overwrites the saved file that gets
deleted. Before the phone can download the new file, the administrator must restart affected devices in Unified
Communications Manager.

After the phone receives the files from the TFTP server, the phone verifies the integrity of the files by validating
the signature on the file. For the phone to establish an authenticated connection, ensure that the following
criteria are met:

* A certificate must exist in the phone.

* The CTL file must exist on the phone, and the Unified Communications Manager entry and certificate
must exist in the file.

* You configured the device for authentication or encryption.

Signaling Authentication

This process, also known as signaling integrity, uses the TLS protocol to validate that no tampering occurred
to signaling packets during transmission.

Signaling authentication relies on the creation of the Certificate Trust List (CTL)file.

Digest Authentication

This process for SIP trunks and phones allows Unified Communications Manager to challenge the identity
of'a device that is connecting to Unified Communications Manager. When challenged, the device presents its
digest credentials, similar to a username and password, to Unified Communications Manager for verification.
If the credentials that are presented match those that are configured in the database for that device, digest
authentication succeeds, and Unified Communications Manager processes the SIP request.

\)

Note Be aware that the cluster security mode has no effect on digest authentication.

)

Note If you enable digest authentication for a device, the device requires a unique digest user ID and password to
register.

You configure SIP digest credentials in the Unified Communications Manager database for a phone user or
application user.
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* For applications, you specify digest credentials in the Application User Configuration window.

* For phones that are running SIP, you specify the digest authentication credentials in the End User window.
To associate the credentials with the phone after you configure the user, you choose a Digest User, the
end user, in the Phone Configuration window. After you reset the phone, the credentials exist in the
phone configuration file that the TFTPserver offers to the phone. See topics related to encrypted phone
configuration file setup to ensure digest credentials do not get sent in the clear in TFTP downloads.

* For challenges received on SIP trunks, you configure a SIP realm, which specifies the realm username
(device or application user) and digest credentials.

When you enable digest authentication for an external phone or trunk that is running SIP and configure digest
credentials, Unified Communications Manager calculates a credentials checksum that includes a hash of the
username, password, and the realm. The system uses a nonce value, which is a random number, to calculate
the MD5 hash. Unified Communications Manager encrypts the values and stores the username and the
checksum in the database.

To initiate a challenge, Unified Communications Manager uses a SIP 401 (Unauthorized) message, which
includes the nonce and the realm in the header. You configure the nonce validity time in the SIP device security
profile for the phone or trunk. The nonce validity time specifies the number of minutes that a nonce value
stays valid. When the time interval expires, Unified Communications Manager rejects the external device and
generates a new number.

)

Note

P
Tip

Unified Communications Manager acts as a user agent server (UAS) for SIP calls that are originated by
line-side phones or devices that are reached through the SIP trunk, as a user agent client (UAC) for SIP calls
that it originates to the SIP trunk, or a back-to-back user agent (B2BUA) for line-to-line or trunk-to-trunk
connections. In most environments, Unified Communications Manager acts primarily as B2BUA connecting
SCCP and SIP endpoints. (A SIP user agent represents a device or application that originates a SIP message.)

Digest authentication does not provide integrity or confidentiality. To ensure integrity and confidentiality for
the device, configure the TLS protocol for the device, if the device supports TLS. If the device supports
encryption, configure the device security mode as encrypted. If the device supports encrypted phone
configuration files, configure encryption for the files.

Digest Authentication for Phones

When you enable digest authentication for a phone, Unified Communications Manager challenges all requests
for phones that are running SIP except keepalive messages. Unified Communications Manager does not
respond to challenges from line-side phones.

After receiving a response, Unified Communications Manager validates the checksum for the username that
is stored in the database against the credentials in the response header.

Phones that are running SIP exist in the Unified Communications Manager realm, which is defined in Unified
Communications Manager Administration at installation. You configure the SIP Realm for challenges to
phones with the service parameter SIP Station Realm. Each digest user can have one set of digest credentials
per realm.
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Tip If you enable digest authentication for an end user but do not configure the digest credentials, the phone will
fail registration. If the cluster mode is nonsecure and you enable digest authentication and configure digest
credentials, the digest credentials get sent to the phone, and Unified Communications Manager still initiates
challenges.

Digest Authentication for Trunks

When you enable digest authentication for a trunk, Unified Communications Manager challenges SIP trunk
requests from SIP devices and applications that connect through a SIP trunk. The system uses the Cluster ID
enterprise parameter in the challenge message. SIP user agents that connect through the SIP trunk respond
with the unique digest credentials that you configured for the device or application in Unified Communications
Manager.

When Unified Communications Manager initiates a SIP trunk request, a SIP user agent that connects through
the SIP trunk can challenge the identity of Unified Communications Manager. For these incoming challenges,
you configure a SIP Realm to provide the requested credentials for the user. When Unified Communications
Manager receives a SIP 401(Unauthorized) or SIP 407 (Proxy Authentication Required) message, Unified
Communications Manager looks up the encrypted password for the realm that connects though the trunk and
for the username that the challenge message specifies. Unified Communications Manager decrypts the password,
calculates the digest, and presents it in the response message.

Je

Tip  The realm represents the domain that connects through the SIP trunk, such as xyz.com, which helps to identify
the source of the request.

To configure the SIP Realm, see topics related to digest authentication for SIP trunks. You must configure a
SIP Realm and username and password in Unified Communications Manager for each SIP trunk user agent

that can challenge Unified Communications Manager. Each user agent can have one set of digest credentials
per realm.

Authorization

Unified Communications Manager uses the authorization process to restrict certain categories of messages
from phones that are running SIP, from SIP trunks, and from SIP application requests on SIP trunks.

* For SIP INVITE messages and in-dialog messages, and for phones that are running SIP, Unified
Communications Manager provides authorization through calling search spaces and partitions.

* For SIP SUBSCRIBE requests from phones, Unified Communications Manager provides authorization
for user access to presence groups.

* For SIP trunks, Unified Communications Manager provides authorization of presence subscriptions and
certain non-INVITE SIP messages; for example, out-of-dial REFER, unsolicited notification, and any
SIP request with the replaces header. You specify authorization in the SIP Trunk Security Profile
Configuration window when you check the allowed SIP requests in the window.

To enable authorization for SIP trunk applications, check the Enable Application Level Authorization and the

Digest Authentication check box in the SIP Trunk Security Profile window; then, check the allowed SIP
request check boxes in the Application User Configuration window.
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Tip  Encryption capability installs automatically when you install Unified Communications Manager on a server.
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If you enable both SIP trunk authorization and application level authorization, authorization occurs for the
SIP trunk first and then for the SIP application user. For the trunk, Unified Communications Manager downloads
the trunk Access Control List (ACL) information and caches it. The ACL information gets applied to the
incoming SIP request. If the ACL does not allow the SIP request, the call fails with a 403 Forbidden message.

If the ACL allows the SIP request, Unified Communications Manager checks whether digest authentication
is enabled in the SIP Trunk Security Profile. If digest authentication is not enabled and application-level
authorization is not enabled, Unified Communications Manager processes the request. If digest authentication
is enabled, Unified Communications Manager verifies that the authentication header exists in the incoming
request and then uses digest authentication to identify the source application. If the header does not exist,
Unified Communications Manager challenges the device with a 401 message.

Before an application-level ACL gets applied, Unified Communications Manager authenticates the SIP trunk
user agent through digest authentication. Therefore, you must enable digest authentication in the SIP Trunk
Security Profile before application-level authorization can occur.

This section describes the types of encryption that Unified Communications Manager supports:

Secure End Users Login Credentials

From Unified Communications Manager Release 12.5(1), all end users login credentials are hashed with
SHAZ2 to provide enhanced security. Earlier than Unified Communications Manager Release 12.5(1), all end
users login credentials were hashed with SHA1 only. Unified Communications Manager Release 12.5(1) also
includes the “UCM Users with the Out-Of-Date Credential Algorithm” report. This report is available in the
Cisco Unified Reporting page. This report helps the administrator to list all the end users whose passwords
or PINs are hashed with SHAI.

All end users passwords or PINs that are hashed with SHA1 are migrated to SHA2 automatically upon their
first successful login. The end users with SHA1 hashed (out of date) credentials can update their PINs or
passwords using one of the following ways:

» Update the PIN by logging into Extension Mobility or Directory access on the phone.

+ Update the password by logging into Cisco Jabber, Cisco Unified Communications Self Care Portal, or
Cisco Unified CM Administration.

For more information on how to generate the report, see the Cisco Unified CM Administration Online Help.

Signaling Encryption

Signaling encryption ensures that all SIP and SCCP signaling messages that are sent between the device and
the Unified Communications Manager server are encrypted.
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Signaling encryption ensures that the information that pertains to the parties, DTMF digits that are entered
by the parties, call status, media encryption keys, and so on, are protected against unintended or unauthorized
access.

Cisco does not support Network Address Translation (NAT) with Unified Communications Manager if you
configure the cluster for mixed mode; NAT does not work with signaling encryption.

You can enable UDP ALG in the firewall to allow media stream firewall traversal. Enabling the UDP ALG
allows the media source on the trusted side of the firewall to open a bidirectional media flow through the
firewall by sending the media packet through the firewall.

Je

Tip Hardware DSP resources cannot initiate this type of connection and, therefore, must exist outside the firewall.

Signaling encryption does not support NAT traversal. Instead of using NAT, consider using LAN extension
VPNs.

Media Encryption

Media encryption, which uses Secure Real-Time Protocol (SRTP), ensures that only the intended recipient
can interpret the media streams between supported devices. Media encryption includes creating a media master
key pair for the devices, delivering the keys to the devices, and securing the delivery of the keys while the
keys are in transport. Unified Communications Manager supports SRTP primarily for IOS gateways and
Unified Communications Manager H.323 trunks on gatekeeper-controlled and non-gatekeeper-controlled
trunks as well as on SIP trunks.

\}

Note

Cisco Unified Communications Manager handles media encryption keys differently for different devices and
protocols. All phones that are running SCCP get their media encryption keys from Unified Communications
Manager, which secures the media encryption key downloads to phones with TLS encrypted signaling channels.
Phones that are running SIP generate and store their own media encryption keys. Media encryption keys that
are derived by Unified Communications Manager system securely get sent via encrypted signaling paths to
gateways over [PSec-protected links for H.323 and MGCP or encrypted TLS links for SCCP and SIP.

Devices must state upon negotiation if it can use SRTP. CUCM does not support SRTP if the device uses
cached previous negotiations SDP with different devices within the same call.

If the devices support SRTP, the system uses a SRTP connection. If at least one device does not support SRTP,
the system uses an RTP connection. SRTP-to-RTP fallback may occur for transfers from a secure device to
a non-secure device, transcoding, music on hold, and so on.

For most security-supported devices, authentication and signaling encryption serve as the minimum requirements
for media encryption; that is, if the devices do not support signaling encryption and authentication, media
encryption cannot occur. CiscolOS gateways and trunks support media encryption without authentication.
For CiscolOS gateways and trunks, you must configure IPSec when you enable the SRTP capability (media
encryption).
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A

Warning

Before you configure SRTP or signaling encryption for gateways and trunks, Ciscostrongly recommends that
you configure IPSec because CiscolOS MGCP gateways, H.323 gateways, and H.323/H.245/H.225 trunks

rely on IPSec configuration to ensure that security-related information does not get sent in the clear. Unified
Communications Manager does not verify that you configured IPSec correctly. If you do not configure IPSec

correctly, security-related information may get exposed.

SIP trunks rely on TLS to ensure that security-related information does not get sent in the clear.

The following example demonstrates media encryption for SCCP and MGCP calls.

1. Device A and Device B, which support media encryption and authentication, register with Unified
Communications Manager.

2. When Device A places a call to Device B, Unified Communications Manager requests two sets of media
session master values from the key manager function.

3. Both devices receive the two sets: one set for the media stream, Device A—Device B, and the other set
for the media stream, Device B—Device A.

4. Using the first set of master values, Device A derives the keys that encrypt and authenticate the media
stream, Device A—Device B.

5. Using the second set of master values, Device A derives the keys that authenticate and decrypt the media
stream, Device B—Device A.

6. Device B uses these sets in the inverse operational sequence.

7. After the devices receive the keys, the devices perform the required key derivation, and SRTP packet
processing occurs.

\}

Note Phones that are running SIP and H.323 trunks/gateways generate their own cryptographic parameters and
send them to Unified Communications Manager.

For media encryption with conference calls, refer to topics related to secure conference resources.

AES 256 Encryption Support for TLS and SIP SRTP

Cisco Collaboration Solutions use Transport Layer Security (TLS) and Secure Real-time Transport Protocol
(SRTP) for signaling and media encryption. Currently, Advanced Encryption Standard (AES) with a 128-bit
encryption key is used as the encryption cipher. AES also uses Hash-based Message Authentication Code
Secure Hash Algorithm-1 (HMAC-SHA-1) as the authentication method. These algorithms cannot effectively
scale to meet the required changing security and performance needs. To meet escalating security and
performance requirements, the algorithms and protocols for encryption, authentication, digital signatures, and
key exchange in Next-Generation Encryption (NGE) are developed. Also, AES 256 encryption support is
provided instead of AES 128 for TLS and Session Initiation Protocol (SIP) SRTP that supports NGE.

The AES 256 encryption support for TLS and SIP SRTP is enhanced to focus on AES 256 cipher support in
signaling and media encryption. This feature is useful for the applications that run on Unified Communications
Manager to initiate and support TLS 1.2 connections with the AES-256 based ciphers that conform to SHA-2
(Secure Hash Algorithm) standards and is Federal Information Processing Standards (FIPS) compliant.
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This feature has the following requirements:

 The connection that the SIP trunk and SIP line initiates.

* The ciphers that Unified Communications Manager supports for SRTP calls over SIP line and SIP trunk.

N

Note  With this release, TLS 1.2 is supported on some interfaces like SIP, but is not supported on all interfaces. It
is recommended that you leave TLS 1.0 and 1.1 enabled in your Collaboration deployment.

AES 256 and SHA-2 Support in TLS

The Transport Layer Security (TLS) protocol provides authentication, data integrity, and confidentiality for
communications between two applications. TLS 1.2 is based on Secure Sockets Layer (SSL) protocol version
3.0, although the two protocols are not compatible with each other. TLS operates in a client/server mode
where one side acts as a server and the other side acts as a client. SSL is positioned as a protocol layer between
the Transmission Control Protocol (TCP) layer and the application to form a secure connection between clients
and servers so that they can communicate securely over a network. To operate, TLS requires TCP as the
reliable transport layer protocol.

In Unified Communications Manager, AES 256 and SHA-2 (Secure Hash Algorithm-2) support in TLS 1.2
is an enhancement to handle the connection that is initiated by the SIP Trunk and the SIP line. The supported
ciphers, which are AES 256 and SHA-2 compliant, are listed as follows:

* TLS ECDH_RSA WITH AES 128 GCM_SHA256—The cipher string is
ECDH-RSA-AES128-GCM-SHA256.

« TLS ECDH_RSA WITH_AES 256 GCM_SHA384—The cipher string is
ECDH-RSA-AES256-GCM-SHA384.

where:

* TLS is Transport Layer Security

» ECDH is Elliptic curve Diffie-Hellman, which is an algorithm
* RSA is Rivest Shamir Adleman, which is an algorithm

» AES is Advanced Encryption Standards

* GCM is Galois/Counter Mode

In addition to the newly-supported ciphers, Unified Communications Manager continues to support
TLS RSA WITH_AES 128 CBC_SHA. The cipher string of this cipher is AES128-SHA.

)

Note * The Unified Communications Manager certificates are based on RSA.

* In Unified Communications Manager, Cisco Endpoints (phones) do not support the above mentioned
new ciphers for TLS 1.2.

» With AES 256 and SHA-2 (Secure Hash Algorithm-2) support in TLS 1.2 enhancement in Unified
Communications Manager, the default key size for Certificate Authority Proxy Function (CAPF) is
increased to 2048 bits.
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AES 256 Support in SRTP SIP Call Signaling

Secure Real-time Transport Protocol (SRTP) defines the methods of providing confidentiality and data integrity
for both Real-time Transport Protocol (RTP) voice and video media and their corresponding Real-time
Transport Control Protocol (RTCP) streams. SRTP implements this method through the use of encryption
and message authentication headers. In SRTP, encryption applies to the payload of the RTP packet only, and
not to the RTP header. However, message authentication applies to both the RTP header and the RTP payload.
Also, SRTP indirectly provides protection against replay attacks because message authentication applies to
the RTP sequence number within the header. SRTP uses Advanced Encryption Standards (AES) with a 128-bit
encryption key as the encryption cipher. It also uses Hash-based Message Authentication Code Secure Hash
Algorithm-1 (HMAC-SHA-1) as the authentication method.

Unified Communications Manager supports crypto ciphers for the SRTP calls over SIP line and SIP trunk.
These crypto ciphers are AEAD AES 256 GCM and AEAD AES 128 GCM, where AEAD is
Authenticated-Encryption with Associated-Data, and GCM is Galois/Counter Mode. These ciphers are based
on GCM. If these ciphers are present in the Session Description Protocol (SDP), they are treated with higher
priority as compared to the AES 128 and SHA-1 based ciphers. Cisco Endpoints (phones) do not support
these new ciphers that you add for Unified Communications Manager for SRTP.

In addition to the newly supported ciphers, Unified Communications Manager continues to support the
following ciphers:

« AES_CM_128 HMAC_SHAI 80
« AES_CM_128 HMAC_SHAI 32
- F8 128 HMAC SHAI 80

AES 256 encryption is supported in the following calls:
* SIP line to SIP line call signaling
* SIP line to SIP trunk signaling
* SIP trunk to SIP trunk signaling

Cisco Unified Communications Manager Requirements
* Support for TLS Version 1.2 on the SIP trunk and SIP line connections is available.

* Cipher support—TLS ECDHE RSA WITH AES 256 GCM_SHA384 (cipher string
ECDHE-RSA-AES256-GCM-SHA384) and TLS ECDHE RSA WITH AES 128 GCM_SHA256
(cipher string ECDHE-RSA-AES128-GCM-SHA256)—is available when the TLS 1.2 connection is
made. These ciphers are based on GCM and conform to SHA-2 category.

* Unified Communications Manager initiates TLS1.2 with the
TLS ECDHE RSA WITH AES 256 GCM SHA384 and
TLS ECDHE RSA WITH _AES 128 GCM_SHA256 ciphers. If the peer does not support TLS1.2,
then Unified Communications Manager will fall back to TLS 1.0 with the existing AES128-SHA cipher.

* The SRTP calls over SIP line and SIP trunk support the GCM-based AEAD AES 256 GCM and
AEAD AES 128 GCM ciphers.
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Interactions and Restrictions

* Unified Communications Manager requirements apply to SIP line and SIP trunk, and basic SIP to SIP
calls only.

* The device types that are based on non-SIP protocols will continue to support the existing behavior with
the TLS versions with the supported ciphers. Skinny Call Control Protocol (SCCP) also supports TLS
1.2 with the earlier supported ciphers.

* SIP to non-SIP calls will continue to use AES 128 and SHA-1 based ciphers.

AES 80-Bit Authentication Support

Unified Communications Manager supports Advanced Encryption Standard (AES) with a 128-bit encryption
key and an 80-bit authentication tag used as the encryption cipher on Music On Hold (MOH), Interactive
Voice Response (IVR), and Annunciator. By default, the phones that support the 80-bit authentication tag
play the MOH, IVR, and Annunciator using the AES CM 128 HMAC SHA1 80 crypto ciphers.

When a phone securely connects with IP Voice Media Streaming (IPVMS), precedence is given to the

AES CM 128 HMAC SHA1 80 crypto cipher. If the phone does not support 80-bit authentication, it reverts
to the AES CM_128 HMAC SHA1 32 cipher. If a phone does not support 80-bit or 32-bit authentication
tag, the negotiation occurs over Real-Time Transport Protocol (RTP).

\}

Note The SCCP phone supports only 32-bit authentication tag. Hence, negotiation between the phone and IPVMS
happens only over the AES CM_128 HMAC SHA1 32 cipher.

If Phone A supports AES CM_ 128 HMAC SHA1 80 and Phone B supports the

AES CM 128 HMAC SHAT1 32 crypto cipher, and when User A (Phone A) dials User B (Phone B) and
the call is placed on hold by User B, then Phone A connects to MOH. The negotiation between Phone A and
MOH occurs through AES CM_128 HMAC SHA1 80 cipher because Phone A supports only the 80-bit
authentication tag.

If User B (Phone B) dials User A (Phone A) and the call is placed on hold by User A, the negotiation between
Phone B and MOH occurs through the AES CM_128 HMAC SHAI1 32 cipher because Phone B supports
only the 32-bit authentication tag.

If a phone supports 80-bit authentication tag, the negotiation between a phone and an IVR or Annunciator
occurs through AES CM 128 HMAC SHA1 80.

The following table shows the supported crypto ciphers on the phones and their negotiation cipher.

Table 8: Phones Capabilities vs. Negotiated Cipher

Phones Capabilities Negotiated Cipher
AES_CM 128 HMAC SHA1 32 and AES_CM 128 HMAC_SHA1 80
AES_CM 128 HMAC_SHA1 80

AES CM 128 HMAC SHAI1 32 AES CM 128 HMAC SHAI1 32
AES CM 128 HMAC _SHA1 80 AES CM 128 HMAC _SHA1 80
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Phones Capabilities Negotiated Cipher

Other than AES CM 128 HMAC SHAI1 32 and |Revertto RTP.
AES CM_128 HMAC SHAL 80

Self-encrypting Drive

Unified Communications Manager supports self-encrypting drives (SED). This is also called Full Disk
Encryption (FDE). FDE is a cryptographic method that is used to encrypt all the data that is available on the
hard drive. The data includes files, operating system, and software programs. The hardware available on the
disk encrypts all the incoming data and decrypts all the outgoing data.

When the drive is locked, an encryption key is created and stored internally. All data that is stored on this
derive is encrypted using that key and stored in the encrypted form. The FDE comprises a key ID and a security
key.

For more information, see Cisco UCS C-Series Servers Integrated Management Controller GUI Configuration
Guide.

Configuration File Encryption

Unified Communications Manager pushes confidential data such as digest credentials and administrator
passwords to phones in configuration file downloads from the TFTP server.

Unified Communications Manager uses reversible encryption to secure these credentials in the database. To
secure this data during the download process, Cisco recommends that you configure encrypted configuration
files for all Cisco IP Phones that support this option. When this option is enabled, only the device configuration
file gets encrypted for download.

\}

Note In some circumstances, you may choose to download confidential data to phones in the clear; for example,
to troubleshoot the phone.

Unified Communications Manager encodes and stores encryption keys in the database. The TFTP server
encrypts and decrypts configuration files by using symmetric encryption keys:

« If the phone has PKI capabilities, Unified Communications Manager can use the phone public key to
encrypt the phone configuration file.

» If the phone does not have PKI capabilities, you must configure a unique symmetric key in Unified
Communications Manager and in the phone.

You enable encrypted configuration file settings in the Phone Security Profile window in Unified

Communications Manager Administration, which you then apply to a phone in the Phone Configuration
window.

Encrypted iX Channel

Unified Communications Manager supports an encrypted iX channel. The iX channel provides a reliable
channel for multiplexing application media between SIP phones in a video conference. Encrypted iX Channel
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uses DTLS to add security to your deployment and ensures that the application media is sent over the iX
Channel is private and cannot be viewed by intermediate parties who attempt to intercept media.

I0S MTP and RSVP agents in pass through mode also support encrypted iX Channel.

Configuration
To enable an encrypted iX Channel on Unified Communications Manager, you must:

* Check the Allow iX Application Media check box in the SIP Profile Configuration that is used by any
intermediate SIP trunks. This setting turns on the iX channel negotiation.

» Configure the Secure Call | con Display Policy service parameter to enable a secure lock icon. By
default, the setting is All media except BFCP and iX transports must be encrypted.

Encryption Modes

There are two types of Session Description Protocol (SDP) offers thatUnified Communications Manager
supports for iX Channel encryption for encrypted phones. This encryption type is driven by what the endpoints
support and is not a configurable item in the Unified Communications Manager.

« Best Effort Encryption—The SDP offer is for an encrypted iX Channel, but falls back to a non-encrypted
iX Channel if the SIP peers do not support it. This approach can be used if encryption is not mandatory
in the solution.

For example, encryption is mandatory within the cloud, and not in a single enterprise.
Best-Effort iX Encryption

m=application 12345 UDP/UDT/IX *

a=setup:actpass

a=fingerprint: SHA-1 <key>

* Forced Encryption—The SDP offer is for an encrypted iX Channel only. This offer is rejected if the
SIP peers do not support iX Channel encryption. This approach can be used in deployments where
encryption is mandatory between endpoints.

For example, encryption is mandatory between the two SIP devices.
Forced iX Encryption
m=application 12345 UDP/DTLS/UDT/IX *
a=setup:actpass
a=fingerprint: SHA-1 <key>
By default, all Cisco IP Phones are set to offer Best Effort iX Encryption. However, you can reset this to

Forced Encryption by setting the Encryption M odeto On within the Product-Specific Configuration of Cisco
TelePresence endpoints, or by reconfiguring settings on the Cisco Meeting Server.

Non-Encrypted Modes

Unified Communications Managerenables negotiation of secure active control messages in media path from
endpoints in a meeting when the endpoint may not be deployed in a fully secure mode. For example, if the
endpoint is Off-Net and is registered with Unified CM in Mobile and Remote Access mode.
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Prerequisite
Before you start using this feature, make sure that:
* System adheres to the export compliance requirement

* SIP trunk to the conference bridge is secure

Unified CM can negotiate the DTLS information in secure active control messages for non-secure endpoints
or softphones and receive messages in the following ways:

* Best Effort Encryption iX to On-Premise registered endpoints or softphones

* Forced iX Encryption to Off-Premise registered endpoints or softphones

n Operation

You can run a Network Mapper (NMAP) scan program on any Windows or Linux platform to perform
vulnerability scans. NMAP represents a free and open source utility for network exploration or security
auditing.

)

Note NMAP DP scan can take up to 18 hours to complete.

Syntax
nmap -n -vww -sU -p <port range> <ccm_ip_address>
where:

-n: No DNS resolution. Tells NMAP to never do reverse DNS resolution on the active IP addresses that it
finds. Because DNS can be slow even with the NMAP built-in parallel stub resolver, this option can slash
scanning times.

-v: Increases the verbosity level, which causes NMAP to print more information about the scan in progress.
The system shows open ports as they are found and provides completion time estimates when NMAP estimates
that a scan will take more than a few minutes. Use this option twice or more for even greater verbosity.

-sU: Specifies a UDP port scan.

-p: Specifies which ports to scan and overrides the default. Be aware that individual port numbers are acceptable,
as are ranges that are separated by a hyphen (for example 1-1023).

ccm_ip_address: IP address of Cisco Unified Communications Manager

Set Up Authentication and Encryption

| A

Important

This procedure applies to the CTL Client encryption option. You may also set up encryption by using the

utilsctl CLI command set. For more information about this option, see the Command Line Interface Guide

for Cisco Unified Communications Solutions.
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Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Step 7

Set Up Authentication and Encryption .

The following procedure provides all the tasks that you must perform to implement authentication and
encryption. See the related topics for chapter references which contain tasks that you must perform for the
specified security feature.

* To implement authentication and encryption for a new install, refer to the following table.

« To add a node to a secure cluster, see Installing Cisco Unified Communications Manager, which describes
how to add a node and how to configure security for the new node.

Procedure

Activate the Cisco CTL Provider service in Cisco Unified Serviceability

Be sure to activate the Cisco CTL Provider service on each Unified Communications Manager server in the
cluster.

Tip If you activated this service prior to a Unified Communications Manager upgrade, you do not need
to activate the service again. The service automatically activates after the upgrade.

Activate the Cisco Certificate Authority Proxy service in Cisco Unified Serviceability to install, upgrade,
troubleshoot, or delete locally significant certificates.

Activate the Cisco Certificate Authority Proxy service on the first node only.

Timesaver Performing this task before you install and configure the Cisco CTL client ensures that you do not
have to update the CTL file to use CAPF.

If you do not want to use the default port settings, configure ports for the TLS connection.

Tip If you configured these settings prior to a Unified Communications Manager upgrade, the settings
migrate automatically during the upgrade.

Ifusing the Cisco CTL client for encryption, obtain at least two security tokens and the passwords, hostnames/IP
addresses, and port numbers for the servers that you will configure for the Cisco CTL client.

Note You do not need hardware security tokens for the utils ctl CLI option.

Install the Cisco CTL client.

Tip To update the Cisco CTL file after an upgrade to this Unified Communications Manager release,
you must install the plug-in that is available in this Cisco Unified Communications Manager
Administration release.

Configure the Cisco CTL client.

Tip If you created the Cisco CTL file prior to a Unified Communications Manager upgrade, the Cisco
CTL file migrates automatically during the upgrade. To update the Cisco CTL file after an upgrade
to this Unified Communications Manager release, you must install and configure the latest version
of the Cisco CTL client.

Note Cisco's CTL client is no longer supported from Release 14. We recommend you use the CLI command
to switch the Unified Communications Manager server to Mixed Mode instead of the Cisco CTL
plugin.

Configure the phone security profiles.
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Step 8

Step 9

Step 10
Step 11

Step 12
Step 13

Step 14

Step 15

Step 16

Step 17

Perform the following tasks when you configure the profiles:
a) Configure the device security mode.

Tip The device security mode migrates automatically during the Unified Communications Manager
upgrade. If you want to configure encryption for devices that only supported authentication in
a prior release, you must choose a security profile for encryption in the Phone Configuration
window.

b) Configure CAPF settings (for some phones that are running SCCP and SIP).
Additional CAPF settings display in the Phone Configuration window.

¢) Ifyou plan to use digest authentication for phones that are running SIP, check the Enable Digest
Authentication check box.

d) To enable encrypted configuration files (for some phones that are running SCCP and SIP), check the
Encrypted Confide check box.

e) To exclude digest credentials in configuration file downloads, check the Exclude Digest Credential in
Configuration File check box.

Apply the phone security profiles to the phones.
Thefollowing steps are optional:

(Optional) Verify that the locally significant certificates are installed on supported Cisco Unified IP Phones

(Optional) Configure digest authentication for phones that are running SIP.

(Optional) Perform phone-hardening tasks.

Tip If you configured phone-hardening settings prior to a Unified Communications Manager upgrade,
the device configuration settings migrate automatically during the upgrade.

(Optional) Configure conference bridge resources for security.
(Optional) Configure voice mail ports for security.

For more information, see the applicable Cisco Unity or Cisco Unity Connection integration guide for this
Unified Communications Manager release.

(Optional) Configure security settings for SRST references.

Tip If you configured secure SRST references in a previous Unified Communications Manager release,
the configuration automatically migrates during the Unified Communications Manager upgrade.

(Optional) Configure IPSec.

For more information, see the Administration Guide for Cisco Unified Communications Manager .

(Optional) Configure the SIP trunk security profile.
If you plan to use digest authentication, check the Enable Digest Authentication check box in the profile.
For trunk-level authorization, check the authorization check boxes for the allowed SIP requests.

If you want application-level authorization to occur after trunk-level authorization, check the Enable Application
Level Authorization check box.

You cannot check application-level authorization unless digest authentication is checked.

(Optional) Apply the SIP trunk security profile to the trunk.
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Step 18
Step 19

Step 20
Step 21

Where to Find More Information .

(Optional) Configure digest authentication for the trunk.

(Optional) If you checked the Enable Application Level Authorization check box in the SIP trunk security
profile, configure the allowed SIP requests by checking the authorization check boxes in the Application User
Configuration window.

(Optional) Reset all phones.
(Optional) Reboot all servers.

Where to Find More Information

Related Cisco Documentation

Refer to the following documents for further information about related CiscolP telephony applications and
products:

« System Configuration Guide for Cisco Unified Communications Manager

» Administration Guide for Cisco Unified Communications Manager

 Media and Signaling Authentication and Encryption Feature for Cisco I0S MGCP Gateways
» Cisco Unified Communications Manager Integration Guide for Cisco Unity

« Cisco Unified Communications Manager Integration Guide for Cisco Unity Connection

» Cisco Unified Survivable Remote Site Telephony (SRST) Administration Guide that supports the
SRST-enabled gateway.

« Administration Guide for Cisco Unified Communications Manager
« Cisco Unified Communications Manager Bulk Administration Guide
» Troubleshooting Guide for Cisco Unified Communications Manager

« Cisco IP Phone Administration Guide that support your phone model
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CHAPTER 2

Hypertext Transfer Protocol Over Secure Sockets
Layer (HTTPS)

This chapter provides information about Hypertext Transfer Protocol over Secure Sockets Layer.

* HTTPS, on page 37

* HTTPS for Cisco Unified IP Phone Services, on page 39

» Save Certificate to Trusted Folder Using Internet Explorer 8, on page 42
* First-Time Authentication for Firefox with HTTPS, on page 44

* First-Time Authentication for Safari with HTTPS, on page 46

* Where to Find More Information About HTTPS Setup, on page 48

HTTPS, or Hypertext Transfer Protocol over Secure Sockets Layer (SSL), secures communication between
a browser and a web server for Microsoft Windows users. HTTPS uses certificates to ensure server identities
and to secure the browser connection. HTTPS uses a public key to encrypt the data, including the user login
and password, during transport over the Internet.

Unified Communications Manager supports SSL and Transport Layer Security (TLS) for HTTPS connections.
Cisco recommends using TLS for improved security if your web browser version supports TLS. Disable SSL
on your web browser to use TLS for secure HTTPS communications.

To enable HTTPS, you must download a certificate that identifies the server during the connection process.
You can accept the server certificate for the current session only, or you can download the certificate to a trust
folder (file) to secure the current session and future sessions with that server. The trust folder stores the
certificates for all your trusted sites.

Cisco supports these browsers for connection to the Cisco Tomcat web server application in Unified
Communications Manager:

* Microsoft Internet Explorer (IE) 7 when running on Microsoft Windows XP SP3
* Microsoft Internet Explorer (IE) 8 when running on Microsoft Windows XP SP3 or Microsoft Vista SP2
* Firefox 3.x when running on Microsoft Windows XP SP3, Microsoft Vista SP2 or Apple MAC OS X

* Safari 4.x when running on Apple MAC OS X

Security Guide for Cisco Unified Communications Manager, Release 11.5(1)SU10 .



Security Basics |

[l ures

\)

Note When you install/upgrade Unified Communications Manager, an HTTPS self-signed certificate (Tomcat) is
generated. The self-signed certificate migrates automatically during upgrades to Unified Communications
Manager. A copy of this certificate is created in.DER and.PEM formats.

You can regenerate the self-signed certificate by using the Cisco Unified Communications Operating System
GUI. Refer to the Administration Guide for Cisco Unified Communications Manager for more information.

The following table shows the applications that use HTTPS with Cisco Tomcat in Unified Communications

Manager.

Table 9: Unified Communications Manager HTTPS Applications

Unified Communications Manager HTTPS Application | Web Application
ccmadmin Unified Communications Manager Administration
ccmservice Cisco Unified Serviceability
cmplatform Operating System administration pages
cmuser Cisco Personal Assistant
ast Real Time Monitoring Tool
RTMTReports Real Time Monitoring Tool reports archive
PktCap TAC troubleshooting tools that are used for packet
capturing
art Unified Communications Manager CDR Analysis and
Reporting
taps Unified Communications Manager Auto-Register
Phone Tool
dna Dialed Number Analyzer
drf Disaster Recovery System
SOAP Simple Object Access Protocol API for reading from
and writing to the Unified Communications Manager
database
Note For security, all Web applications that are
using SOAP require HTTPS. Cisco does
not support HTTP for SOAP applications.
Existing applications that use HTTP will
fail; they cannot be converted to HTTPS
by changing directories.
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HTTPS for Cisco Unified IP Phone Services

For Unified Communications Manager, Cisco IP Phones and Cisco Unified IP Phone Services support HTTPS,
encryption, and secure identification of the server using port 8443.

TVS (Trust verification service) does not verify certificate chains. For TVS to verify the certificate, the same
certificate that is presented to TVS by the phone must be in the Tomcat-trust certificate store.

TVS does verify root or intermediate certificates. Only the identity certificate is verified if it is not in the
database. Even if the root and intermediate certificates are present,. verification fails.

Cisco Unified IP Phones that Support HTTPS
The following Cisco IP Phones support HTTPS:
* 6901, 6911, 6921, 6941, 6945, 6961
« 7811, 7821, 7832, 7841, 7861

* 7906, 7911, 7925, 7925-EX, 7926, 7931, 7941, 7941G-GE, 7942, 7945, 7961, 7962, 7961G-GE, 7965,
7970, 7971, 7975

- 8811, 8821, 8831, 8832, 8841, 8845, 8851, 885INR, 8861, 8865, 8865NR
- 8941, 8945, 8961
« 9951, 9971

\)

Note The 69xx phones in this list can act as HTTPS clients, but cannot act as an HTTPS server. The remaining
phones in this list can act as an HTTPS client or an HTTPS server.

Features That Support HTTPS

The following features support HTTPS:
* Cisco Extension Mobility (EM)
* Cisco Extension Mobility Cross Cluster (EMCC)
* Cisco Unified Communications Manager Manager Assistant (IPMA)
* Cisco Unified IP Phone Services
* Personal Directory

* Change Credentials
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Cisco Unified IP Phone Services Settings

To support HTTPS in Unified Communications Manager Release 8.0(1) and later, the Phone Configuration
Settings include the secure URL parameters shown in the following table.

To configure the secure URL parameters, choose Device > Device Settings > Phone Services from Unified
Communications Manager Administration. For more information, see the System Configuration Guide for
Cisco Unified Communications Manager

)

Note When you delete the Secured Phone URL Parameters in the Enterprise Parameter section of Cisco Unified
Communications Manager Administration and then reboot, the URL Parameters are re-populated by default.
After you reboot go to the Secured Phone URL Parameters section and make the correct modifications to the
URL and reboot the phones.

Table 10: Phone Configuration Settings for Secure URLs

Field Description

Secure Authentication URL Enter the secure URL that the phone uses to validate
requests that are made to the phone web server.

Note If you do not provide a Secure
Authentication URL, the device uses the
nonsecure URL. If you provide both a
secure URL and a nonsecure URL, the
device chooses the appropriate URL, based
on its capabilities.

By default, this URL accesses a Cisco Unified
Communications Self Care Portal window that was
configured during installation.

Leave this field blank to accept the default setting.

Maximum length: 255

Secure Directory URL Enter the secure URL for the server from which the
phone obtains directory information. This parameter
specifies the URL that secured Cisco IP Phones use
when you press the Directory button.

Note If you do not provide a Secure Directory
URL, the device uses the nonsecure URL.
If you provide both a secure URL and a
nonsecure URL, the device chooses the
appropriate URL, based on its capabilities.

Leave this field blank to accept the default setting.

Maximum length: 255
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Field

Description

Secure Idle URL

Enter the secure URL for the information that displays
on the Cisco IP Phone display when the phone is idle,
as specified in Idle Timer field. For example, you can
display a logo on the LCD when the phone has not
been used for 5 minutes.

Note If you do not provide a Secure Idle URL,
the device uses the nonsecure URL. If you
provide both a secure URL and a nonsecure
URL, the device chooses the appropriate
URL, based on its capabilities.

To accept the default setting, leave this field blank.

Maximum length: 255

Secure Information URL

Enter the secure URL for the server location where
the Cisco IP Phone can find help text information.
This information displays when the user presses the
information (i) button or the question mark (?) button.

Note If you do not provide a Secure Information
URL, the device uses the nonsecure URL.
If you provide both a secure URL and a
nonsecure URL, the device chooses the
appropriate URL, based on its capabilities.

To accept the default setting, leave this field blank.

Maximum length: 255

Secure Messages URL

Enter the secure URL for the messages server. The
Cisco IP Phone contacts this URL when the user
presses the Messages button.

Note If you do not provide a Secure Messages
URL, the device uses the nonsecure URL.
If you provide both a secure URL and a
nonsecure URL, the device chooses the
appropriate URL, based on its capabilities.

To accept the default setting, leave this field blank.
Maximum length: 255
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Field Description

Secure Services URL Enter the secure URL for Cisco Unified IP Phone
services. The is the location that the secure Cisco
Unified IP Phone contacts when the user presses the
Services button.

Note If you do not provide a Secure Services
URL, the device uses the nonsecure URL.
If you provide both a secure URL and a
nonsecure URL, the device chooses the
appropriate URL, based on its capabilities.

To accept the default setting, leave this field blank.

Maximum length: 255

Enterprise Parameter Settings for HTTPS Support

To support HTTPS, Unified Communications Manager Release 8.0(1) and later supports the following new
Enterprise Parameters:

* Secured Authentication URL
* Secured Directory URL

* Secured Idle URL

* Secured Information URL

* Secured Messaged URL

* Secured Services URL

Save Certificate to Trusted Folder Using Internet Explorer 8

Be sure to import the Unified Communications Manager certificate to Internet Explorer 8 to secure access
without having to reload the certificate every time that you restart the browser. If you continue to a website
that has a certificate warning and the certificate is not in the trust store, Internet Explorer 8 remembers the
certificate for the current session only.

After you download the server certificate, Internet Explorer 8 continues to display certificate errors for the
website. You can ignore the security warnings when the Trusted Root Certificate Authority trust store for the
browser contains the imported certificate.

The following procedure describes how to import the Unified Communications Manager certificate to the
root certificate trust store for Internet Explorer 8.
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Step 7

Step 8

Step 9

Step 10

Step 11

Copy Internet Explorer 8 Certificate to File .

Procedure

Browse to application on the Tomcat server (for example, enter the hostname, localhost, or IP address for
Unified Communications Manager Administration in the browser).

The browser displays a Certificate Error: Navigation Blocked message to indicate that this website is untrusted.

To access the server, click Continueto this website (not recommended).

The Unified Communications Manager Administration window displays, and the browser displays the address
bar and Certificate Error status in red.

To import the server certificate, click the Certificate Error status box to display the status report. Click the
View Certificates link in the report.

Verify the certificate details.
Select the General tab in the Certificate window and click I nstall Certificate.

The Certificate Import Wizard launches.

To start the Wizard, click Next.

The Certificate Store window displays.

Verify that the Automatic option, which allows the wizard to select the certificate store for this certificate
type, is selected and click Next.

Verify the setting and click Finish.

A security warning displays for the import operation.

To install the certificate, click Yes.

The Import Wizard displays “The import was successful.”

Click OK. The next time that you click the View certificateslink, the Certification Path tab in the Certificate
window displays “This certificate is OK.”

To verify that the trust store contains the imported certificate, click Tools> I nternet Optionsin the Internet
Explorer toolbar and select the Content tab. Click Certificates and select the Trusted Root Certifications
Authoritiestab. Scroll to find the imported certificate in the list.

After importing the certificate, the browser continues to display the address bar and a Certificate Error status
in red. The status persists even if you reenter the hostname, localhost, or IP address or refresh or relaunch the
browser.

Copy Internet Explorer 8 Certificate to File

Copying the certificate to a file and storing it locally allows you to restore the certificate whenever necessary.

Performing the following procedure copies the certificate by using a standard certificate storage format. To
copy the certificate contents to file, perform the following procedure:
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Step 1
Step 2
Step 3
Step 4
Step 5
Step 6

Step 7
Step 8
Step 9
Step 10

Procedure

Click the Certificate Error status box.

Click View Certificates.

Click the Details tab.

Click the Copy to File button.

The Certificate Export Wizard displays. Click Next.

The following list defines the file formats from which you can choose. Choose the file format that you want
to use for the exported file; click Next.

a) DER encoded binary X.509 (.CER)—Uses DER to transfer information between entities.

b) Base-64 encoded X.509 (.CER)—Sends secure binary attachments over the internet; uses ASCII text
format to prevent corruption of file.

¢) Cryptographic Message Syntax Standard-PKCS #7 Certificates (.P7B)—Exports the certificate and all
certificates in the certification path to the chosen PC.

Browse to the location to which you want to export the file copy and name the file. Click Save.

The file name and path display in the Certificate Export Wizard pane. Click Next.

Your file and settings display. Click Finish.

When the successful export dialog box displays, click OK.

First-Time Authentication for Firefox with HTTPS

The first time that you (or a user) accesses Unified Communications Manager Administration or other Unified
Communications Manager SSL-enabled virtual directories (after the Unified Communications Manager
installation/upgrade) from a browser client, a Security Alert dialog box asks whether you trust the server.

When the dialog box displays, you must perform one of the following tasks:

* By clicking | Understand The Risks, you choose to trust the certificate for the current web session only.
If you trust the certificate for the current session only, the Security Alert dialog box displays each time
that you access the application; that is, until you install the certificate in the trusted folder.

* By clicking Get Me Out Of Here, you cancel the action. No authentication occurs, and you cannot
access the web application. To access the web application, you must click | Understand The Risks.

Save Certificate to Trusted Folder Using Firefox 3.x

Step 1

Step 2
Step 3

Perform the following procedure to save the HTTPS certificate in the trusted folder in the browser client.

Procedure

Access the Tomcat server (for example, enter the hostname, localhost, or IP address for Cisco Unified
Communications Manager Administration in the browser).

When the Security Alert dialog box displays, click | Understand The Risks.
Click Add Exception.
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Step 6
Step 7
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The Add Exception dialog box displays.

Click Get Certificate.

Check the Permanently storethis exception check box.

Click Confirm Security Exception.

To view the details of the certificate by performing the following steps:
a) From the Firefox browser, click Tools> Options.

The Options dialog box displays

b) Click Advanced.
¢) Click View Certificates.

The Certificate Manager dialog box displays.
d) Highlight the certificate that you want to view and click View.
The Certificate Viewer dialog box displays.

e) Click the Details tab.
f) In the Certificate Fields field, highlight the field that you want to view.

Details display in the Field Values field.

g) From the Certificate Viewer dialog box, click Close.
h) From the Certificate Manager dialog box, click OK.

Copy Firefox 3.x Certificate to File

Step 1

Step 2
Step 3

Step 4
Step 5

Step 6
Step 7

Copying the certificate to a file and storing it locally allows you to restore the certificate whenever necessary.

Performing the following procedure copies the certificate by using a standard certificate storage format. To
copy the certificate contents to file, perform the following procedure:

Procedure

From the Firefox browser, click Tools> Options.

The Options dialog box displays.

If it is not already selected, click Advanced.

Click the Encryption tab and click View Certificates.

The Certificate Manager dialog box displays.

Click the Serverstab.

Highlight the certificate you want to copy and click Export.
The Save Certificate to File dialog box displays.

Browse to the location to which you want to copy the file.

From the Save astype drop-down list, choose the file type from the following options:

Security Guide for Cisco Unified Communications Manager, Release 11.5(1)SU10 .



Security Basics |
. First-Time Authentication for Safari with HTTPS

a) X.509 Certificate (PEM)—Uses PEM to transfer information between entities.

b) X.509 Certificate with chain (PEM)—Uses Privacy Enhanced Mail to verify the certificate chain and
transfer information between entities.

* X.509 Certificate (DER)—Uses DER to transfer information between entities.

* X.509 Certificate (PKCS#7)—PKCS#7 is a standard for signing or encrypting data. Since the
certificate is needed to verify signed data, it is possible to include it in the SignedData structure.
A.P7C-file is just a degenerated SignedData structure, without any data to sign.

* X.509 Certificate with chain (PKCS#7)—Uses PKCS#7 to verify the certificate chain and transfer
information between entities.

Step 8 Click Save.
Step 9 Click OK.

First-Time Authentication for Safari with HTTPS

The first time that you (or a user) accesses Unified Communications Manager Administration or other Unified
Communications Manager SSL-enabled virtual directories (after the Unified Communications Manager
installation/upgrade) from a browser client, a Security Alert dialog box asks whether you trust the server.

When the dialog box displays, you must perform one of the following tasks:

* By clicking Yes, you choose to trust the certificate for the current web session only. If you trust the
certificate for the current session only, the Security Alert dialog box displays each time that you access
the application; that is, until you install the certificate in the trusted folder.

* By clicking Show Certificate > Install Certificate, you intend to perform certificate installation tasks,
so you always trust the certificate. If you install the certificate in the trusted folder, the Security Alert
dialog box does not display each time that you access the web application.

* By clicking No, you cancel the action. No authentication occurs, and you cannot access the web
application. To access the web application, you must click Yes or install the certificate via the Show
Certificate> Install Certificate options.

N

Note The address that you use to access Unified Communications Manager must match
the name on the certificate, or a message will display by default. If you access
the web application by using the localhost or IP address after you install the
certificate in the trusted folder, a security alert indicates that the name of the
security certificate does not match the name of the site that you are accessing.

Save Certificate to Trusted Folder Using Safari 4.x

Perform the following procedure to save the HTTPS certificate in the trusted folder in the browser client.
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Step 1

Step 2

Step 3
Step 4
Step 5
Step 6
Step 7
Step 8

Step 9

Step 10
Step 11

Copy Safari 4.x Certificate to File .

Procedure

Access the Tomcat server (for example, enter the hostname, localhost, or IP address for Cisco Unified
Communications Manager Administration in the browser).

When the Security Alert dialog box displays, click Show Certificate.

You can click the Details tab to view the details of the certificate if you choose to verify the certificate data.
To display a subset of settings, if available, choose one of the following options:

a) All—All options display in the Details pane.
b) Version 1 Fields Only—Version, Serial Number, Signature Algorithm, Issuer, Valid From, Valid To,
Subject, and the Public Key options display.

c) Extensions Only—Subject Key Identifier, Key Usage, and the Enhanced Key Usage options display.
d) Critical Extensions Only—Ceritical Extensions, if any, display

e) Properties Only—Thumbprint algorithm and the thumbprint options display.

In the Certificate pane, click I nstall Certificate.

When the Certificate Import Wizard displays, click Next.

Click the Place all certificatesin the following store radio button; click Browse.

Browse to Trusted Root Certification Authorities; select it and click OK.

Click Next.

Click Finish.

A Security Warning Box displays the certificate thumbprint for you.

To install the certificate, click Yes.

A message states that the import was successful. Click OK.

In the lower, right corner of the dialog box, click OK.

To trust the certificate, so you do not receive the dialog box again, click Yes.

Tip You can verify the certificate was installed successfully by clicking the Certification Path tab in
the Certificate pane.

Copy Safari 4.x Certificate to File

Step 1

Copying the certificate to a file and storing it locally allows you to restore the certificate whenever necessary.

Performing the following procedure copies the certificate by using a standard certificate storage format. To
copy the certificate contents to file, perform the following procedure:

Procedure

In the Security Alert dialog box, click Show Certificate.

Tip In Safari, click the Certificate Error status box to display the Show Certificate option.
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Step 2 Click the Details tab.
Step 3 Click the Copy to File button.
Step 4 The Certificate Export Wizard displays. Click Next.

Step 5 The following list defines the file formats from which you can choose. Choose the file format that you want
to use for the exported file; click Next.

a) DER encoded binary X.509 (.CER)—Uses DER to transfer information between entities.

b) Base-64 encoded X.509 (.CER)—Sends secure binary attachments over the internet; uses ASCII text
format to prevent corruption of file.

¢) Cryptographic Message Syntax Standard-PKCS #7 Certificates (.P7B)—Exports the certificate and all
certificates in the certification path to the chosen PC.

Step 6 Browse to the location to which you want to export the file copy and name the file. Click Save.
Step 7 The file name and path display in the Certificate Export Wizard pane. Click Next.

Step 8 Your file and settings display. Click Finish.

Step 9 When the successful export dialog box displays, click OK.

Where to Find More Information About HTTPS Setup

Related Cisco Documentation

« Cisco Unified Serviceability Administration Guide
« Administration Guide for Cisco Unified Communications Manager

» Microsoft documentation that is available on HTTPS
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Default Security Setup

This section provides information about the default security setup.

* Default Security Features, on page 49

* Trust Verification Service, on page 50

* Initial Trust List, on page 50

* Update ITL File for Cisco Unified IP Phones, on page 53

* Autoregistration, on page 53

* Obtain Cisco Unified IP Phone Support List, on page 53

* ECDSA Support for Common Criteria for Certified Solutions, on page 54

* Certificate Regeneration, on page 57

» Tomcat Certificate Regeneration, on page 58

* System Back-Up Procedure After TFTP Certificate Regeneration, on page 59

* Refresh Upgrade From Cisco Unified Communications Manager Release 7.x to Release 8.6 Or Later,
on page 59

* Roll Back Cluster to a Pre-8.0 Release, on page 60

* Migrate IP Phones Between Clusters with Cisco Unified Communications Manager and ITL Files, on
page 62

* Perform Bulk Reset of ITL File, on page 69

» Reset CTL Localkey, on page 69

* View the Validity Period of ITLRecovery Certificate, on page 70

* Contact Search Authentication Task Flow, on page 70

Default Security Features

Security by Default provides the following automatic security features for Cisco Unified IP Phones:

» Signing of the phone configuration files.
* Support for phone configuration file encryption.

* https with Tomcat and other Web services (Midlets)

For Unified Communications Manager Release 8.0 later, these security features are provided by default without
running the CTL Client.
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Trust Verification Service

There are large number of phones in a network and Cisco Unified IP Phone have limited memory. Hence,
Unified Communications Manager acts as a remote trust store through TVS and so that a certificate trust store
doesn’t have to be placed on each phone. The Cisco Unified IP Phones contact TVS server for verification,
because it cannot verify a signature or certificate through CTL or ITL files. Thus, having a central trust store
is easier to manage than having the trust store on all the Cisco Unified IP Phones.

TVS enables Cisco Unified IP Phone to authenticate application servers, such as EM services, directory, and
MIDlet, during HTTPS establishment.

TVS provides the following features:

* Scalability—Cisco Unified IP Phone resources are not impacted by the number of certificates to trust.
* Flexibility—Addition or removal of trust certificates are automatically reflected in the system.

* Security by Default—Non-media and signaling security features are part of the default installation and
don't require user intervention.

)

Note When you enable secure signaling and media, create a CTL file and then set the cluster to mixed mode. To
create a CTL file and set the cluster to mixed mode, use the CLI command utilsctl set-cluster mixed-mode.

The following are the basic concepts that describe TVS:

* TVS runs on the Unified Communications Manager server and authenticates certificates on behalf of the
Cisco IP Phone.

* Cisco Unified IP Phone only needs to trust TVS, instead of downloading all the trusted certificates.

* The ITL file is generated automatically without user intervention. The ITL file is downloaded by Cisco
Unified IP Phone and trust flows from there.

TVS Description

The following are the basic concepts that describe TVS:

* TVS runs on the Unified Communications Manager server and authenticates certificates on behalf of the
Cisco IP Phone.

* Cisco IP Phone only needs to trust TVS, instead of downloading all the trusted certificates.

* The ITL file is generated automatically without user intervention. The ITL file is downloaded by Cisco
IP Phone and trust flows from there.

Initial Trust List

The Initial Trust List (ITL) file has the same format as the CTL file. However, it is a smaller and leaner version.
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The following attributes apply to the ITL file:

* The system builds the ITL file automatically when the TFTP service is activated and you install the
cluster. The ITL file is updated automatically if the content is modified.

* The ITL file does not require eTokens. It uses a soft eToken (the private key associated with TFTP
server's CallManager certificate).

* The Cisco Unified IP Phone download the ITL file during a reset, restart, or after downloading the CTL
file.

The ITL file contains the following certificates:
* ITLRecovery Certificate—This certificate signs the ITL File.

* The CallManager certificate of the TFTP server—This certificate allows you to authenticate the ITL file
signature and the phone configuration file signature.

+ All the TVS certificates available on the cluster—These certificates allow the phone to communicate to
TVS securely and to request certificates authentication.

» The CAPF certificate—These certificates support configuration file encryption. The CAPF certificate
isn't required in the ITL File (TVS can authenticate it), however, it simplifies the connection to CAPF.

The ITL file contains a record for each certificate. Each record contains:

* A certificate
* Pre-extracted certificate fields for easy lookup by the Cisco IP Phone
* Certificate role (TFTP, CUCM, TFTP+CCM, CAPF, TVS, SAST)

The TFTP server's CallManager certificate is present in two ITL records with two different roles:

* TFTP or the TFTP and CCM role—To authenticate configuration file signature.

* SAST role—To authenticate the ITL file signature.

Initial Trust List Files

The Initial Trust List (ITL) file has the same format as the CTL file. However, it is a smaller and leaner version.
The following attributes apply to the ITL file:

* The system builds the ITL file automatically when you install the cluster. The ITL file is updated
automatically if the content is modified.

*» The ITL file does not require eTokens. It uses a soft eToken (the private key associated with TFTP
server's CallManager certificate).

* The Cisco Unified IP Phone download the ITL file during a reset, restart, or after downloading the CTL
file.

ITL File Contents

The ITL file contains the following certificates:
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* The CallManager certificate of the TFTP server—This certificate allows you to authenticate the ITL file
signature and the phone configuration file signature.

+ All the TVS certificates available on the cluster—These certificates allow the phone to communicate to
TVS securely and to request certificates authentication.

» The CAPF certificate—These certificates support configuration file encryption. The CAPF certificate
isn't required in the ITL File (TVS can authenticate it), however, it simplifies the connection to CAPF.
The ITL file contains a record for each certificate. Each record contains:
* A certificate
* Pre-extracted certificate fields for easy lookup by the Cisco IP Phone

* Certificate role (TFTP, CUCM, TFTP+CCM, CAPEF, TVS, SAST)

The TFTP server's CallManager certificate is present in two ITL records with two different roles:

* TFTP or the TFTP and CCM role—To authenticate configuration file signature.

* SAST role—To authenticate the ITL file signature.

ITL and CTL File Interaction

The Cisco IP Phone relies on the CTL file to know about the cluster security mode (non-secure or mixed
mode). The CTL File tracks the cluster security mode by including the Unified Communications Manager
certificate in the Unified Communications Manager record.

The ITL File also contains the cluster security mode indication.

Certificate Management Changes for ITLRecovery Certificate

* The validity of ITLRecovery has been extended from 5 years to 20 years to ensure that the ITLRecovery
certificate remains same for a longer period.

N

Note The validity of ITLRecovery certificates continues to be 5 years if you upgrade
Unified Communications Manager. While upgrading Unified Communications
Manager, the certificates get copied to the later release. However, when you
regenerate an ITLRecovery certificate or when you do a fresh install of Unified
Communications Manager, the validity of ITLRecovery gets extended to 20 years.

* Before you regenerate an ITLRecovery certificate, a warning message appears on both the CLI and the
GUL This warning message displays that if you use a tokenless CTL and if you regenerate the CallManager
certificate, ensure that the CTL file has the updated CallManager certificate and that certificate is updated
to endpoints.
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Interactions and Restrictions

If a Unified Communications Manager cluster has more than 39 certificates, then the ITL file size on Cisco
IP Phone exceeds 64 kilobytes. Increase in the ITL file size affects the ITL to load properly on the phone
causing the phone registration to fail with Unified Communications Manager.

Update ITL File for Cisco Unified IP Phones

Step 1
Step 2
Step 3
Step 4

A centralized TFTP with Unified Communication Manager using Security By Default with ITL files installed
on the phones does not validate TFTP configuration files.

Perform the following procedure before any phones from the remote clusters are added to the centralized
TFTP deployment.

Procedure

On the Central TFTP server, enable the Enterprise Parameter Prepare cluster for pre CM-8.0 rollback.
Restart TVS and TFTP.

Reset all phones to verify that they download the new ITL file that disables ITL signature verification.
Configure Enterprise Parameter Secure https URLs to use HTTP instead of HTTPS.

Note Unified Communications Manager Release 10.5 and later automatically resets phones after you
enable the Prepare cluster for pre CM-8.0 rollback Enterprise Parameter. For Central TFTP
server's Unified Communications Manager version and how to enable this parameter, see "Roll
Back Cluster to a Pre-8.0 Release" section in the Security Guide for Cisco Unified Communications
Manager.

Autoregistration

The system supports autoregistration in both mixed mode and nonsecure mode. The default configuration file
will also be signed. Cisco IP Phones that do not support Security by Default will be served a nonsigned default
configuration file.

Obtain Cisco Unified IP Phone Support List

Step 1
Step 2
Step 3

Use the Cisco Unified Reporting tool to generate a list of Cisco endpoints that support Security By Default.

Procedure

From Cisco Unified Reporting, choose System Reports.
From the System Reportslist, choose Unified CM Phone Feature List.
From the Product drop-down list, choose Security By Default.
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Step 4 Click Submit.
A report is generated with the list of supported features for the particular phone.

ECDSA Support for Common Criteria for Certified Solutions

Unified Communications Manager supports Elliptic Curve Digital Signature Algorithm (ECDSA) certificates.
These certificates are stronger than the RSA-based certificates and are required for products that have Common
Criteria (CC) certifications. The US government Commercial Solutions for Classified Systems (CSfC) program
requires the CC certification and so, it is included in Unified Communications Manager.

The ECDSA certificates are available along with the existing RSA certificates in the following
areas—Certificate Manager, SIP, Certificate Authority Proxy Function (CAPF), Transport Layer Security
(TLS) Tracing, Entropy, HTTP, and computer telephony integration (CTI) Manager.

)

Note ECDSA is supported only for Unified Communications Manager and Tomcat.

Certificate Manager ECDSA Support

In Unified Communications Manager Release 11.0, the certificate manager supports both generation of
self-signed ECDSA certificates and the ECDSA certificate signing request (CSR). Earlier releases of Unified
Communications Manager supported RSA certificate only. However, Unified Communications Manager
Release 11.0 onwards, CallM anager-ECDSA certificate has been added along with the existing RSA
certificate.

Both the CallManager and CallM anager-ECDSA certificates share the common certificate trust
store—CallManager-Trust. Unified Communications Manager uploads these certificates to this trust store.

The certificate manager supports generation of ECDSA certificates having different values of key length.

When you update or install Unified Communications Manager, the self-signed certificate is generated. Unified
Communications Manager Release 11.0 always has an ECDSA certificate and uses that certificate in its SIP
interface. The secure Computer Telephony Integration (CTI) Manager interface also supports ECDSA
certificates. As both the CTI Manager and SIP server use the same server certificate, both the interfaces work
in synchronization.

SIP ECDSA Support

Unified Communications Manager Release 11.0 includes ECDSA support for SIP lines and SIP trunk interfaces.
The connection between Unified Communications Manager and an endpoint phone or video device is a SIP
line connection whereas the connection between two Unified Communications Managers is a SIP trunk
connection. All SIP connections support the ECDSA ciphers and use ECDSA certificates.

Following are the scenarios when SIP makes (Transport Layer Security) TLS connections:

* When SIP acts as a TLS server—When the SIP trunk interface of Unified Communications Manager
acts as a TLS server for incoming secure SIP connection, the SIP trunk interface determines if the
CallManager-ECDSA certificate exists on disk. If the certificate exists on the disk, the SIP trunk interface
uses the CallManager-ECDSA certificate if the selected cipher suite is
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TLS ECDHE_ECDSA_WITH_AES 128 GCM_SHA?256 or

TLS ECDHE_ECDSA_WITH_AES 256 GCM_SHA384. The SIP trunk interface continues to
support RSA TLS cipher suites for connections from clients that do not support ECDSA cipher suites.
The TL S Ciphers drop-down list contains options that permit configuration of the supported cipher
suites when Unified Communications Manager acts as a TLS server.

* When SIP acts as a TLS client—When the SIP trunk interface acts as a TLS client, the SIP trunk interface
sends a list of requested cipher suites to the server based on the TL S Ciphersfield (which also includes
the ECDSA cipher s option) in the Enter prise Parameter s window of Cisco Unified Communications
Manager. The TLS Ciphers. This configuration determines the TLS client cipher suite list and the
supported cipher suites in order of preference.

A\

Note If you establish a TLS connection with an earlier release of the Unified
Communications Manager that does not support ECDSA client certificate, the
connection uses an RSA cipher suite. The client certificate sent in the TLS
connection is not bound to the TLS Cipher you that you choose. Earlier releases
of Unified Communications Manager also support that TLS servers receive and
handle ECDSA client certificates.

Devices that use an ECDSA cipher to make a connection to Unified Communications Manager must have the
CallManager-ECDSA certificate in their Identity Trust List (ITL) file. Then, the devices must incorporate the
CallManager-ECDSA certificate into their local certificate store to trust the connection that is secured by the
CallManager-ECDSA certificate.

CAPF ECDSA Support

Certificate Authority Proxy Function (CAPF) is a Cisco proprietary method for exchanging certificates between
Cisco endpoints and Unified Communications Manager. Only Cisco endpoints use CAPF. To accomplish
common criteria requirements, CAPF is updated to CAPF version 3 so that a client can be provided with
ECDSA Locally Significant Certificate (LSC). A customer creates LSC locally. An LSC is an alternative to
manufacturer installed certificate (MIC) that the manufacturer creates.

Use CAPF version 3 to allow Unified Communications Manager server to direct phone, CTI applications,
and Jabber clients to generate EC keys to be used in their LSCs. After the EC Keys are generated, Unified
Communications Manager either generates an ECDSA LSC and sends it to the Cisco endpoint or generates
an ECDSA CSR.

In case the endpoint does not have CAPF version 3 support, you can configure the required EC key size and
RSA key size and choose EC Key Preferred, RSA Backup option in Phone Configuration window from
Cisco Unified CM Administration as a backup. This backup option is useful when CAPF server tries to send
arequest to EC key pair and the phone communicates to the server that it does not support EC key, the server
sends the request to generate an RSA key pair instead of the EC key pair.

)

Note The Endpoint Advanced Encryption Algorithms Support parameter indicates that phones download the
TFTP configuration files using advanced TLS ciphers. By default, EC ciphers have the highest priority. This

solution is only supported for an on-premises deployment without MRA.
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To have strong encryption, a robust source of entropy is required. Entropy is a measure of randomness of data
and helps in determining the minimum threshold for common criteria requirements. Data conversion techniques,
such as cryptography and encryption, rely on a good source of entropy for their effectiveness. If a strong
encryption algorithm, such as ECDSA, uses a weak source of entropy, the encryption can be easily broken.

In Unified Communications Manager Release 11.0, the entropy source for Unified Communications Manager
is improved. Entropy Monitoring Daemon is a built-in feature that does not require configuration. However,
you can turn it off through the Unified Communications Manager CLI.

Use the following CLI commands to control the Entropy Monitoring Daemon service:

CLI Command Description

utils service start Entropy Monitoring Daemon Starts the Entropy Monitoring Daemon
service.

utils service stop Entropy Monitoring Daemon Stops the Entropy Monitoring Daemon
service.

utils service active Entropy Monitoring Daemon Activatesthe Entropy Monitoring Daemon

service, which further loads the kernel module.

utils service deactive Entropy Monitoring Daemon | Deactivates the Entropy Monitoring
Daemon service, which further unloads the kernel
module.

HTTPS Support for Configuration Download

For secure configuration download, Unified Communications Manager Release 11.0 is enhanced to support
HTTPS in addition to the HTTP and TFTP interfaces that were used in the earlier releases. Both client and
server use mutual authentication, if required. Clients that are enrolled with ECDSA LSCs and Encrypted TFTP
configurations are required to present their LSC.

The HTTPS interface uses both the CallManager and the CallManager-ECDSA certificates as the server
certificates.

)

Note When you update CallManager, CallManager ECDSA, or Tomcat certificates, you must deactivate and
reactivate the TFTP service. Port 6971 is used for authentication of the CallManager and CallManager-ECDSA

certificates whereas port 6972 is used for the authentication of the Tomcat certificates.

CTI Manager Support

The computer telephony integration (CTI) interface is enhanced to support four new ciphers. The ciphers
suites are TLS ECDHE_RSA_WITH_AES 128 GCM_SHA?256,

TLS ECDHE_RSA_WITH_AES 256 GCM_SHA384,

TLS ECDHE_ECDSA_WITH_AES 128 GCM_SHA?256 and

TLS ECDHE_ECDSA_WITH_AES 256_GCM_SHA384. By supporting these cipher suites, the CTI
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Manager interface needs to have the CallM anager-ECDSA certificate, if it exists in Unified Communications
Manager. Similar to the SIP interface, the Enterprise Parameter TL S Cipher soption in Unified Communications
Manager is used to configure the TLS ciphers that are supported on the CTI Manager secure interface.

Certificate Regeneration

If you regenerate one of the Unified Communications Manager certificates, you must perform the steps in
this section.

A

Caution Regenerating a certificate can affect your system operations. Regenerating a certificate overwrites the existing
certificate including a third party signed certificate if one was uploaded. For more information, see the
Administration Guide for Cisco Unified Communications Manager .

Regenerate CAPF Certificate

To regenerate the CAPF certificate, perform the following steps:

N

Note If the CAPF certificate is on the publisher, you might observe the phones restarting automatically to update
their ITL file. This is applicable when the Phone interaction on Certificate Update parameter is automatically
reset.

Procedure

Step 1 Regenerate the CAPF certificate.
Step 2 If you have a CTL file then you must update the CTL file.

For more information see Regenerate Certificate, section in the Cisco Unified Communications Manager
Security Guide.

Step 3 CAPF service is automatically restarted when CAPF certificate is regenerated.

See the “Activating the Certificate Authority Proxy Function Service” section, in the Cisco Unified
Communications Manager Security Guide.

Regenerate TVS Certificate
Y

Note Ifyou plan to regenerate both TVS and TFTP certificates, regenerate the TVS certificate, wait for the possible
phone restarts to complete, and then regenerate the TFTP certificate. This is applicable when the Phone
interaction on Certificate Update parameter is automatically reset.
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Procedure

Step 1 Regenerate the TVS certificate.
Step 2 If you have a CTL file then you must update the CTL file.

For more information see Regenerate Certificate, section in the Cisco Unified Communications Manager
Security Guide.

Step 3 TVS service is automatically restarted when TVS certificate is regenerated.

Regenerate TFTP Certificate

To regenerate a TFTP certificate, follow these steps:

\}

Note If you plan to regenerate multiples certificates you must regenerate the TFTP certificate last. Wait for the
possible phone restarts to complete before you regenerate the TFTP certificate. You might need to manually
delete the ITL File from all Cisco IP Phones, if you do not follow this procedure. This is applicable when the
Phone interaction on Certificate Update parameter is automatically reset.

Procedure

Step 1 Regenerate the TFTP certificate.

For more information see Administration Guide for Cisco Unified Communications Manager .

Step 2 If the TFTP service was activated, wait until all the phones have automatically restarted.
Step 3 If your cluster is in mixed mode, update the CTL file.
Step 4 If the cluster is part of an EMCC deployment, repeat the steps for bulk certificate provisioning.

For more information see Administration Guide for Cisco Unified Communications Manager .

Tomcat Certificate Regeneration

To regenerate the Tomcat certificate, perform the following steps:

Procedure

Step 1 Regenerate the Tomcat certificate.

For more information see Administration Guide for Cisco Unified Communications Manager .

Step 2 Restart the Tomcat Service.
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Step 3

System Back-Up Procedure After TFTP Certificate Regeneration .

For more information see Administration Guide for Cisco Unified Communications.

If the cluster is part of an EMCC deployment, repeat the steps for bulk certificate provisioning.

For more information see Administration Guide for Cisco Unified Communications Manager .

SystemBack-UpProcedure After TFTP Certificate Regeneration

The trust anchor for the ITL File is a software entity: the TFTP private key. If the server crashes, the key gets
lost, and phones will not be able to validate new ITL File.

In Unified Communications Manager Release 10.0, the TFTP certificate and private key both get backed up
by the Disaster Recovery System. The system encrypts the backup package to keep the private key secret. If
the server crashes, the previous certificates and keys will be restored.

Whenever the TFTP certificate gets regenerated, you must create a new system backup. For backup procedures,
see the Administration Guide for Cisco Unified Communications Manager .

Refresh Upgrade From Cisco Unified Communications Manager
Release 7.x to Release 8.6 Or Later

Step 1

Step 2

To upgrade your cluster from Release 7.x to Release 8.6 or later, follow this procedure:

Procedure

Follow the normal procedure for upgrading a cluster. For more information, see Administration Guide for
Cisco Unified Communications Manager .

Tip After you finish upgrading all nodes in the cluster to Unified Communications Manager Release
8.6 or later, you must also follow all the steps in this procedure to ensure that your Cisco Unified
IP Phones register with the system.
If you are running one of the following releases in mixed mode, you must run the CTL client:
* Unified Communications Manager Release 7.1(2)

* All regular releases of 7.1(2)
* All ES releases of 712 prior to 007.001(002.32016.001)

* Unified Communications Manager Release 7.1(3)
* All regular releases of 713 prior to 007.001(003.21900.003) = 7.1(3a)sula
 All ES releases of 713 prior to 007.001(003.21005.001)

Note For more information about running the CTL client, see Chapter 4, “Configuring the CTL
Client,”.

Security Guide for Cisco Unified Communications Manager, Release 11.5(1)SU10 .



Security Basics |

. Roll Back Cluster to a Pre-8.0 Release

Step 3

Step 4

Wait ten minutes for the Cisco IP Phones to automatically restart and register with Unified Communications
Manager.

Caution  You must back up your cluster using the Disaster Recovery System (DRS) to be able to recover the
cluster.

Back Up Your Cluster.

To backup your cluster using DRS, see the Administration Guide for Cisco Unified Communications Manager

What to do next

Once the publisher is up after the upgrade, do not reboot until the CAR migration completes. You are not
allowed to switch to old version or perform a DRS backup in this phase. You can monitor the CAR migration
status by navigating to Cisco Unified Serviceability > Tools> CDR Analysis and Reporting.

Roll Back Cluster to a Pre-8.0 Release

Step 1

Step 2

Step 3

Step 4
Step 5

Before you roll back a cluster to a pre-8.0 release of Unified Communications Manager, you must prepare
the cluster for rollback using the Prepare Cluster for Rollback to pre-8.0 enterprise parameter.

To prepare the cluster for rollback, follow this procedure on each server in the cluster.

Procedure

From Unified Communications Manager, choose System > Enterprise Parameters Configuration.
The Enterprise Parameter s Configuration window displays.
Set the Prepare Cluster for Rollback to pre-8.0 enterprise parameter to True.

Note Enable this parameter only if you are preparing to rollback your cluster to a pre-8.0 release of
Unified Communications Manager. Phone services that use https (for example, extension mobility)
will not work while this parameter is enabled. However, users will be able to continue making and
receiving basic phone calls while this parameter is enabled.

Wait ten minutes for the Cisco IP Phones to automatically restart and register with Unified Communications
Manager.

Revert each server in the cluster to the previous release.

For more information about reverting a cluster to a previous version, see Administration Guide for Cisco
Unified Communications Manager .

Wait until the cluster finishes switching to the previous version.
If you are running one of the following releases in mixed mode, you must run the CTL client:
* Unified Communications Manager Release 7.1(2)

* All regular releases of 7.1(2)
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» All ES releases of 712 prior to 007.001(002.32016.001)

* Unified Communications Manager Release 7.1(3)
* All regular releases of 713 prior to 007.001(003.21900.003) = 7.1(3a)sula
» All ES releases of 713 prior to 007.001(003.21005.001)

Note For more information about running the CTL client, see the “Configuring the CTL Client”
chapter.

Step 6 If “Prepare Cluster for Rollback to pre 8.0” is set to True in Enterprise Parameters then the following change
must be made for Corporate Directories to work:

Under Device > Device Settings > Phone Services > Cor porate Directory you must change the Service
URL from Application:Cisco/CorporateDirectory to http://<ipaddr>:8080/ccmcip/xmldirectoryinput.jsp.

Step 7 If “Prepare Cluster for Rollback to pre 8.0” is set to True in Enterprise Parameters then the following change
must be made for Personal Directories to work:

Under Device > Device Settings > Phone Services > Personal Directory you must change the Service URL
from Application:Cisco/PersonalDirectory to 'http://<ipaddr>>:8080/ccmpd/pdCheckLogin.do?name=undefined.

Switch Back to Release 8.6 or Later After Revert

If you decide to switch back to the release 8.6 or later partition after you revert the cluster to Release 7.x,
follow this procedure.

Procedure

Step 1 Follow the procedure for switching the cluster back to the inactive partition. For more information, see the
Administration Guide for Cisco Unified Communications Manager .

Step 2 If you were running one of the following releases in mixed mode, you must run the CTL client:
Unified Communications Manager Release 7.1(2)
* All regular releases of 7.1(2)
* All ES releases of 712 prior to 007.001(002.32016.001)
* Unified Communications Manager Release 7.1(3)
* All regular releases of 713 prior to 007.001(003.21900.003) = 7.1(3a)sula
* All ES releases of 713 prior to 007.001(003.21005.001)

Note For more information about running the CTL client, see the “Configuring the CTL Client”
chapter.
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Step 3 From Unified Communications Manager Administration, choose System > Enter prise Parameters
Configuration.

The Enterprise Parameters Configuration window displays.

Set the Prepare Cluster for Rollback to pre-8.6 enterprise parameter to False.

Step 4 Wait ten minutes for the Cisco Unified IP Phones to automatically restart and register with Unified
Communications Manager.

Migrate IP Phones Between Clusters with Cisco Unified
Communications Manager and ITL Files

Unified Communications Manager 8.0(1) and later introduced the new Security By Default feature and the
use of Initial Trust List (ITL) files. With this new feature, you must be careful when moving phones between
different Unified CM clusters and ensure that you follow the proper steps for migration.

A

Caution  Failure to follow the proper steps may lead to a situation where thousands of phones must manually have their
ITL files deleted.

Cisco IP Phones that support the new ITL file must download this special file from their Unified CM TFTP
server. Once an ITL file is installed on a phone, all future configuration files and ITL file updates must be
signed by one of the following items:

» The TFTP server certificate that is currently installed on the phone or

» A TFTP certificate that can be validated TVS services on one of the clusters. You can find the certificates
of TVS services within the cluster listed in the ITL file.

With this new security functionality in mind, three problems can occur when moving a phone from one cluster
to another cluster:

1. The ITL file of the new cluster is not signed by the current ITL file signer, so the phone cannot accept
the new ITL file or configuration files.

2. The TVS servers listed in the existing ITL of the phone may not be reachable when the phones are moved
to the new cluster.

3. Evenifthe TVS servers are reachable for certificate verification, the old cluster servers may not have the
new server certificates.

If one or more of these three problems are encountered, one possible solution is to delete the ITL file manually
from all phones being moved between clusters. However, this is not a desirable solution since it requires
massive effort as the number of phones increases.

The most preferred option is to make use of the Cisco Unified CM Enterprise Parameter Prepare Cluster for
Rollback to pre-8.0. Once this parameter is set to True, the phones download a special ITL file that contains
empty TVS and TFTP certificate sections.
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When a phone has an empty ITL file, the phone accepts any unsigned configuration file (for migrations to
Unified CM pre-8.x clusters), and also accepts any new ITL file (for migrations to different Unified CM 8.x
clusters).

The empty ITL file can be verified on the phone by checking Settings> Security > Trust List > TL. Empty
entries appear where the old TVS and TFTP servers used to be.

The phones must have access to the old Unified CM servers only as long as it takes them to download the
new empty ITL files.

If you plan to keep the old cluster online, disable the Prepare Cluster for Rollback to pre-8.0 Enterprise
Parameter to restore Security By Default.

Bulk Certificate Export

Step 1
Step 2
Step 3
Step 4

Step 5

If both the old and new clusters are online at the same time, you can use the Bulk Certificate migration method.

Remember that the Cisco Unified IP Phones verify every downloaded file against either the ITL file, or against
a TVS server that exists in the ITL file. If the phone needs to move to a new cluster, the ITL file that the new
cluster presents must be trusted by the old cluster TVS certificate store.

\}

Note

the phones are being migrated.

The Bulk Certificate Export method only works if both clusters are online with network connectivity while

\)

Note

During bulk certificate import, you need to import an additional ITLRecovery certificate on both the visiting
cluster and the home cluster for Cisco Extension Mobility Cross Cluster (EMCC) to continue functioning. A
new option to import ITL Recovery certificate is added in Bulk Certificate Management for the Certificate

Type drop-down list.

To use the Bulk Certificate Export method complete the following procedure:

Procedure

From Cisco Unified Operating System Administration, choose Security > Bulk Certificate M anagement.
Export certificates from new destination cluster (TFTP only) to a central SFTP server.
Consolidate certificates (TFTP only) on the SFTP server using the Bulk Certificate interface.

On the origination cluster use the Bulk Certificate function to import the TFTP certificates from the central
SFTP server.

Use DHCP option 150, or some other method, to point the phones to the new destination cluster.
The phones download the new destination cluster ITL file and attempt to verify it against their existing ITL
file. The certificate is not in the existing ITL file so the phone requests the old TVS server to verify the

signature of the new ITL file. The phone sends a TVS query to the old origination cluster on TCP port 2445
to make this request.

If the certificate export/consolidate/import process works correctly then the TVS returns success, and the
phone replaces the ITL file in memory with the newly downloaded ITL file.
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The phones can now download and verify the signed configuration files from the new cluster.

Generate Self-Signed Certificate

Procedure

Step 1 From Cisco Unified OS Administration, choose Security > Certificate M anagement.
The Certificate List window appears.

Step 2 Enter search parameters to find a certificate and view its configuration details.
The system displays the records that match all the criteria in the Certificate List window.

Step 3 Click Gener ate Self-Signed Certificate to generate a new self-signed certificate.
The Generate New Self-Signed Certificate window appears.

Step 4 From the Certificate Purpose drop-down box, select a system security certificate, such as
CallManager-ECDSA.

Step 5 Configure the fields in the Generate New Self-Signed Certificate window. See the Related Topics section
for more information about the fields and their configuration options.

Step 6 Click Gener ate.

Related Topics
Self-Signed Certificate Fields, on page 65
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Self-Signed Certificate Fields

Table 11: Self-signed Certificate Fields

Field Description

Certificate Purpose Choose the required option from the drop-down list.

When you choose any of the following options, the Key Type field is
automatically set to RSA.

* tomcat

* ipsec

* ITLRecovery
* CallManager
* CAPF

* TVS

When you choose any of the following options, the Key Type field is
automatically set to EC (Elliptical Curve).

* tomcat-ECDSA
* CallManager-ECDSA

Distribution Choose a Unified Communications Manager server from the drop-down list.

Auto-populated Domains | Appears only if you have chosen any of the following options using the
Certificate Purpose drop-down list.

* tomcat

« tomcat-ECDSA

* CallManager

+ CallManager-ECDSA
* TVS

This field lists the host names that are protected by a single certificate. The
certificate common name is the same as the hostname. Both,

CallM anager-ECDSA and tomcat-ECDSAcertificate has a common name that
is different from the hostname.

The field displays the fully qualified domain name for CallM anager-ECDSA
certificate.

Key Type This field lists the type of keys used for encryption and decryption of the
public-private key pair.

Unified Communications Manager supports EC and RSA key types.
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Field Description

Key Length Choose any of the following values from the drop-down list:
+ 1024

* 2048
* 3072
* 4096

Depending on the key length, the self-signed certificate request, limits the hash
algorithm choices. With the limited hash algorithm choices, you can use a hash
algorithm strength that is greater than or equal to the key length strength.

« If the key length value is 256, the supported hash algorithms are SHA256,
SHA384, or SHAS12.

« If the key length value is 384, the supported hash algorithms are SHA384
or SHAS12.

Note Certificates with a key length value of 3072 or 4096 are chosen only
for RSA certificates. These options are not available for ECDSA
certificates.

Note Some phone models might fail to register if the RSA key length value
chosen for the CallManager Certificate Purposeis greater than 2048.

For more information, navigate to Unified CM Phone Feature List
Report on the Cisco Unified Reporting Tool (CURT), to check the
3072/4096 RSA key size support for the list of supported phone

models.
Hash Algorithm Choose a value that is greater than or equal to the key length from the drop-down
list:
Note * The values in the Hash Algorithm drop-down list changes based

on the value you have chosen in the Key Length field.

* If your system is running in FIPS mode, it is mandatory to choose
SHA256 as the hashing algorithm.

Generate Certificate Signing Request

If you generate a new certificate signing request for a specific certificate type, the application overwrites the
existing certificate signing request for that certificate type.

\}

Note Unified Communications Manager Release 11.0 onwards, when you choose the bulk operation units—TFTP
or all, the ECDSA certificates get included with the RSA certificates.

. Security Guide for Cisco Unified Communications Manager, Release 11.5(1)SU10



| Security Basics

Step 1
Step 2
Step 3
Step 4
Step 5

Step 6

Procedure

Certificate Signing Request Fields .

From Cisco Unified OS Administration, choose Security > Certificate M anagement.
The Certificate List window appears.

Click Generate CSR.

The Generate Certificate Signing Request window appears.

Enter search parameters to find a certificate and view its configuration details.
The system displays the records that match all the criteria in the Certificate List window.

From the Certificate Purpose drop-down box, select a system security certificate, such as

CallManager-ECDSA.

Configure the fields in the Gener ate Certificate Signing Request window. See the Related Topics section
for more information about the fields and their configuration options.

Click Gener ate.

Related Topics

Certificate Signing Request Fields, on page 67

Certificate Signing Request Fields

Table 12: Certificate Signing Request Fields

Field Description

Certificate Purpose From the drop-down box, select a value:
 CallManager
» CallManager-ECDSA

Distribution Select a Unified Communications Manager server.

When you select this field for multiserver for ECDSA, the syntax is:

Callmanager-ecdsa common name: <host-name>-EC-ms.<domain>

When you select this field for multiserver for RSA, the syntax is:

Callmanager common name: <host-name>-ms.<domain>

Shows the name of the Unified Communications Manager application
that you selected in the Distribution field by default.

Auto-populated Domains

This field appears in Subject Alternate Names (SANs) section. It lists
the host names that are to be protected by a single certificate.

Parent Domain

This field appears in Subject Alternate Names (SANs) section. It shows
the default domain name. You can modify the domain name, if required.

Key Type

This field identifies the type of key used for encryption and decryption
for the public-private key pair.

Unified Communications Manager supports EC and RSA key types.
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Field

Description

Key Length

From the Key L ength drop-down box, select one of the values.

Depending on the key length, the CSR request limits the hash algorithm
choices. By having the limited hash algorithm choices, you can use a
hash algorithm strength that is greater than or equal to the key length
strength. For example, for a key length of 256, the supported hash
algorithms are SHA256, SHA384, or SHAS512. Similarly, for the key
length of 384, the supported hash algorithms are SHA384 or SHAS512.

Note Certificates with a key length value of 3072 or 4096 can
only be selected for RSA certificates. These options are not
available for ECDSA certificates.

Note Some phone models may fail to register if the RSA key
length selected for the CallManager Cer tificate Purposeis
greater than 2048. From the Unified CM Phone Feature List
Report on the Cisco Unified Reporting Tool (CURT), you
can check the 3072/4096 RSA key size support feature for
the list of supported phone models.

Hash Algorithm

Select a value from the Hash Algorithm drop-down box to have
stronger hash algorithm as the elliptical curve key length. From the
Hash Algorithm drop-down box, select one of the values.

Note * The values for the Hash Algorithm field change based
on the value you select in the Key Length field.

* [f your system is running on FIPS mode, it is mandatory
that you select SHA256 as the hashing algorithm.

Interactions and Restrictions

* SIP devices that do not support TLS ECDHE_ECDSA_WITH_AES256_SHA384 and
TLS ECDHE_ECDSA_WITH_AES128_SHA?256 can still connect with
TLS ECDHE_RSA_WITH_AES 256 SHA384, TLS ECDHE_RSA_WITH_AES 128 SHA256,
or AES128 SHA. These options are dependent on the TLS cipher option that you choose. If you choose
ECDSA only option, then the device that does not support the ECDSA ciphers will not be able make a
TLS connection to the SIP interface. When you choose the ECDSA only option, the value of this parameter
are TLS ECDHE_ECDSA_WITH_AES128 SHA?256 and
TLS ECDHE_ECDSA_WITH_AES256_SHA384.

» CTI Manager Secure clients do not support TLS ECDHE_RSA_WITH_AES 128 SHA?256,
TLS ECDHE_RSA_WITH_AES 256 SHA384, TLS ECDHE_ECDSA_WITH_AES 128 SHA256,
and TLS ECDHE_ECDSA_WITH_AES 256 SHA384. However, they can connect with AES128 SHA.
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Perform Bulk Reset of ITL File

Make sure you perform this procedure only from the Unified Communications Manager publisher.

Step 1

Step 2
Step 3
Step 4
Step 5

The bulk reset of the ITL file is performed, when phones no longer trust the ITL file signer and also cannot
authenticate the ITL file provided by the TFTP service locally or using TVS.

To perform a bulk reset, use the CLI command utilsitl reset. This command generates a new ITL recovery
file and re-establishes the trust between phones and the TFTP service on CUCM.

Je

Tip  When you install Unified Communications Manager, use the CLI command file get tftp ITLRecovery.p12to
export the ITL Recovery pair and then perform a backup through DR. You will also be prompted to enter the
SFTP server (where the key is exported) and password.

Procedure

Perform any one of the following steps:

* Run utilsitl reset localkey.
* Run utilsitl reset remotekey.

Note For utilsitl reset localkey, the local key resides on the publisher. When issuing this command, the
ITL file is signed temporarily by the CallManager key while the ITL Recovery key is resetting.

Run show itl to verify that the reset was successful.

From Cisco Unified CM Administration, choose System > Enterprise Parameters.
Click Reset.

Restart the TFTP service and restart all devices.

The devices download the ITL file that is signed with the ITLRecovery Key and register correctly to Unified
Communications Manager again.

Reset CTL Localkey

Step 1

When devices on a Unified Communications Manager cluster are locked and lose their trusted status, perform
a reset of the Cisco Trust List (CTL) file with the CLI command utils ctl reset localkey. This command
generates a new CTL file.

Procedure

Run utilsctl reset localkey
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. View the Validity Period of ITLRecovery Certificate

Step 2
Step 3

Step 4

Step 5

Note For utilsctl reset localkey, the local key resides on the publisher. When issuing this command, the
CTL file is temporarily signed by the CallManager key.

Run show ctl to verify that the reset was successful.

From Cisco Unified CM Administration, choose System > Enterprise Parameters.
The Enterprise Parameter s Configuration page appears.

Click Reset.

The devices restart. They are ready to download the CTL file that is signed by the ITLRecovery key and
accept configuration files.

Run the utils ctl update CTLFile and restart the necessary services rolling back the changes in Step 1.

The devices restart. They are ready to download the CTL file that is signed by the CallManager key and accept
configuration files.

The devices download the CTL file that is signed using the required keys and register correctly to Unified
Communications Manager again.

View the Validity Period of ITLRecovery Certificate

Step 1
Step 2

Step 3

The ITLRecovery certificate has a long validity period with phones. You can navigate to the Certificate File
Data pane to view the validity period or any other ITLRecovery certificate details.

Procedure

From Cisco Unified OS Administration, choose Security > Certificate M anagement.

Enter the required search parameters to find the certificate and view its configuration details.
The list of certificates that match the criteria appears in the Certificate List page.

Click the I TLRecovery link to view the validity period.
The ITLRecovery certificate details appear in the Certificate File Data pane.

The validity period is 20 years from the current year.

Contact Search Authentication Task Flow

Complete the following tasks to set up Contact Search Authentication in Unified Communications Manager.
When this feature is configured, users must authenticate themselves before searching the directory for other
users.
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Procedure
Command or Action Purpose
Step 1 Confirm Phone Support for Contact Search Confirm that your phones support this feature.
Authentication, on page 71 Run the Unified CM Phone Feature List
report in Cisco Unified Reporting to get a list
of phone models that support the feature.
Step 2 Enable Contact Search Authentication, on page | Configure Unified Communications Manager
71 for Contact Search Authentication.
Step 3 Configure Secure Directory Server for Contact | Use this procedure to configure Unified
Search, on page 72 Communications Manager with the URL to
which phone users are directed when they
search the directory for other users.

Confirm Phone Support for Contact Search Authentication

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6

Confirm that the phones in your deployment support contact search authentication. Run a Phone Feature List
report to obtain a full list of phone models that support the feature.

Procedure

From Cisco Unified Reporting, click System Reports.

Select Unified CM Phone Feature.

Click the Unified CM Phone Featurereport.

Leave the Product field at the default value.

From the Feature drop-down, choose Authenticated Contact Search.
Click Submit.

Enable Contact Search Authentication

Step 1
Step 2

Step 3

Use this procedure on Unified Communications Manager to configure contact search authentication for phone
users.

Procedure

Log in to the Command Line Interface.

Run the utils contactsear chauthentication status command to confirm the contact search authentication
setting on this node.

If you need to configure contact search authentication:

* To enable authentication, run the utils contactsear chauthentication enable command.
« To disable authentication, run the utils contactsear chauthentication disable command.
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Step 4 Repeat this procedure on all Unified Communications Manager cluster nodes.

Note You must reset phones in order for the changes to take effect.

Configure Secure Directory Server for Contact Search

Use this procedure to configure Unified Communications Manager with the directory server URL to which
UDS sends user search requests. The default value is
https://<cucm-fgdn-or-ip>:port/cucm-uds/users.

)

Note The default UDS port is 8443. When contact search authentication becomes enabled, the default UDS port
switches to 9443. If you then disable contact search authentication, you must change the UDS port back to
8443 manually.

Procedure

Step 1 From Cisco Unified Communications Manager Administration, choose System > Enterprise Parameters.
Step 2 In the Secure Contact Search URL text box, enter the URL for secure UDS directory requests.

Note We recommend that for the URL, you choose a node that is not running the Cisco TFTP service.
The CiscoTFTP and UDS services may disrupt each other if either service gets restarted.

Step 3 Click Save.
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Cisco CTL Client Setup

This chapter provides information about Cisco CTL client setup.

* About Cisco CTL Setup, on page 73

+ Addition of Second SAST Role in the CTL File for Recovery, on page 75

* SIP OAuth Configuration Through CLI, on page 75

* Activate Cisco CTL Provider Service, on page 76

* Cisco CAPF Service Activation, on page 77

* Set up Secure Ports, on page 77

* Set Up Cisco CTL Client, on page 79

* SAST Roles of CTL File, on page 80

* Migrate Phones from One Cluster to Another Cluster, on page 81

* Migration from eToken-based CTL File to Tokenless CTL File, on page 82
» Update CTL File, on page 82

* Update Cisco Unified Communications Manager Security Mode, on page 83
* Cisco CTL File Details, on page 84

* Verify Cisco Unified Communications Manager Security Mode, on page 85
* Set Up Smart Card Service to Started or Automatic, on page 85

* Verify or Uninstall Cisco CTL Client, on page 86

About Cisco CTL Setup

Device, file, and signaling authentication rely on the creation of the Certificate Trust List (CTL) file, which
is created when you install and configure the Cisco Certificate Trust List (CTL).
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\)

Note * To enable mixed-mode or to update the CTL File, ensure that the Smart Licensing registration is completed
in Unified Communications Manager by using the Registration Token received from the Smart account
or Virtual account that has Allow export-controlled functionality enabled. For details on how to configure
Cisco Smart Software Licensing, see the “Smart Software Licensing” chapter of the System Configuration
Guide for Cisco Unified Communications Manager at http://www.cisco.com/c/en/us/support/
unified-communications/unified-communications-manager-callmanager/
products-installation-and-configuration-guides-list.html.

* An alarm named ClusterModeSecurityFailedExportControlNotAllow is sent when you are running CTL
Client but Unified Communications Manager is not enabled for export-controlled functionality.

The CTL file contains entries for the following servers or security tokens:

* System Administrator Security Token (SAST)

* CiscoCallManager and CiscoTFTP services that are running on the same server
* Certificate Authority Proxy Function (CAPF)

* TFTP server(s)

» ASA firewall

* [ITLRecovery

When a Call Manager certificate is self-signed, the CTL file contains a server certificate, public key, serial
number, signature, issuer name, subject name, server function, DNS name, and IP address for each server.

In the case of a Multi-SAN Call Manager certificate, the CTL file contains the Publisher's Call Manager
certificate.

The next time that the phone initializes, it downloads the CTL file from the TFTP server. If the CTL file
contains a TFTP server entry that has a self-signed certificate, the phone requests a signed configuration file
in.sgn format. If no TFTP server contains a certificate, the phone requests an unsigned file.

After the Cisco CTL Client adds a server certificate to the CTL file, you can update the CTL file by running
the following CLI commands:

utils ctl set-cluster mixed-mode

Updates the CTL file and sets the cluster to mixed mode.
utils ctl set-cluster non-secure-mode

Updates the CTL file and sets the cluster to non-secure mode.
utilsctl update CTLFile

Updates the CTL file on each node in the cluster.

When you configure a firewall in the CTL file, you can secure a Cisco ASA Firewall as part of a secure Unified
Communications Manage system. It displays the firewall certificate as a “CCM?” certificate.
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A\

Note * You must run the CLI commands on the publisher node.

» Be aware that regenerating the ITLRecovery certificate changes the signer of the file. Phones that do not
support Security by Default will not accept the new CTL file unless CTL files are manually deleted from
the phone. For information on deleting the CTL files on the phone, see the Cisco IP Phone Administration
Guide for your phone model.

Addition of Second SAST Role in the CTL File for Recovery

Earlier releases of Unified Communications Manager has tokenless approach where endpoints trusted only
one Cisco site administrator security token (SAST). This SAST is the CallManager certificate. In this approach,
the certificate trust list (CTL) file contained only one SAST record that was used to sign the CTL file. As only
one SAST was used, any update in the SAST signer caused the endpoints to get locked out. Following points
list the scenarios when endpoints or devices locked out due to update in SAST signer:

* The endpoints accepted the CTL file that is signed by using the CallManager certificate during registration.

* An administrator regenerated the CallManager certificate and updated the CTL file. This regeneration
implied that the updated CTL file was signed by updated CallManager certificate instead of the existing
CallManager certificate.

* The endpoints did not trust the updated CallManager certificate because the updated certificate was
unavailable in the endpoints trust list. So, the endpoints rejected the CTL file instead of downloading it.

* The endpoints tried to connect with the ccm service securely over Transport Layer Security (TLS),
ccmservice offered its updated CallManager certificate to the endpoints as part of TLS exchange. Because
the updated certificate was unavailable in the endpoints trust list, endpoints rejected the CTL file instead
of downloading it.

* The endpoints no longer talk to ccmservice and get locked out as a result.

For easier recovery from the endpoint lock out, the tokenless approach for endpoints is enhanced by addition
of second SAST in the CTL File for recovery. In this feature, the tokenless CTL file contains two SAST
tokens—the CallManager record and the ITLRecovery record.

The ITLRecovery certificate is chosen over other certificates because of the following reasons:

* Does not change because of secondary reasons, such as change in hostname.

* Already being used in the ITL file.

SIP OAuth Configuration Through CLI

Through the CLI, you can configure the Cluster SIP OAuth mode.

Security Guide for Cisco Unified Communications Manager, Release 11.5(1)SU10 .



Security Basics |
. Activate Cisco CTL Provider Service

\)

Note For more information on how to configure SIP OAuth mode on Cisco Unified Communication Manager, see
Feature Configuration Guide for Cisco Unified Communications Manager, Release 12.5(1).

Consider the following points:

» When Cluster SIP OAuth mode is enabled, Cisco Unified Communication Manager accepts SIP
registrations with an OAuth token from secure devices.

Once enabled, the following TLS ports are opened which are configurable through Cisco Unified
Communications Manager user interface.

» SIP OAuth Port
* SIP OAuth MRA Port

You can configure the ports from Cisco Unified CM Administration, choose System > Cisco Unified
CM > CallManager page.

* Restart the Cisco CallManager service in all the nodes for the parameter change to take effect.

The encryption option consists of the following CLI commands:

admin:utils sipOAuth-mode
Check the status of SIP OAuth mode in the cluster.
utils sipOAuth-mode enable
Enables the SIP OAuth mode in the cluster.
utils sipOAuth-mode disable
Disables the SIP OAuth mode in the cluster.
N

Note Run the CLI commands only on the publisher node.

Activate Cisco CTL Provider Service

After you configure the Cisco CTL Client, the Cisco CTL Provider service changes the security mode from
nonsecure to mixed mode and transports the server certificates to the CTL file. The service then transports
the CTL file to all Unified Communications Manager and CiscoTFTP servers.

If you activate this service and then upgrade Unified Communications Manager, Unified Communications
Manager automatically reactivates the service after the upgrade.

Je

Tip  You must activate the CiscoCTL Provider service on all servers in the cluster.

To activate the service, perform the following procedure:
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Procedure
Step 1 In Cisco Unified Serviceability, choose Tools> Service Activation.
Step 2 In the Servers drop-down list box, choose a server where you have activated the Cisco CallManager or Cisco

TFTP services.
Step 3 Click the CiscoCTL Provider service radio button.
Step 4 Click Save.

Tip Perform this procedure on all servers in the cluster.

Note You can enter a CTL port before you activate the CiscoCTL Provider service. If you want to change
the default port number, see topics related to setting up ports for a TLS connection.

Step 5 Verify that the service runs on the servers. In Cisco Unified Serviceability, choose Tools> Control Center
- Feature Servicesto verify the state of the service.

Cisco CAPF Service Activation
A

Warning  Activating the Cisco certificate authority proxy function service before you install and configure the Cisco
CTL Client ensures that you do not have to update the CTL file to use CAPF.

Set up Secure Ports

You may have to configure a different TLS port number if the default port is currently being used or if you
use a firewall and you cannot use the port within the firewall.

* The Cisco CTL Provider default port for the TLS connection equals 2444. The Cisco CTL Provider port
monitors requests from the Cisco CTL Client. This port processes Cisco CTL Client requests, such as
retrieving the CTL file, setting the cluster security mode, and saving the CTL file to the TFTP server.

N

Note Cluster security mode configures the security capability for your standalone server
or a cluster.

* The Ethernet Phone Port monitors registration requests from the phone that is running SCCP. In nonsecure
mode, the phone connects through port 2000. In mixed mode, the Unified Communications Manager
port for TLS connection equals the value for the Unified Communications Manager port number added
to (+) 443; therefore, the default TLS connection for Unified Communications Manager equals 2443.
Update this setting only if the port number is in use or if you use a firewall and you cannot use the port
within the firewall.
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Step 1

Step 2

Step 3
Step 4

Step 5

Step 6
Step 7

Step 8
Step 9

Step 10
Step 11

2

Tip

2
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* The SIP Secure Port allows Unified Communications Manager to listen for SIP messages from phones
that are running SIP. The default value equals 5061. If you change this port, you must restart the
CiscoCallManager service in Cisco Unified Serviceability and reset the phones that are running SIP.

After you update the port(s), you must restart the Cisco CTL Provider service in Cisco Unified Serviceability.

Tip  You must open the CTL ports to the data VLAN from where the CTL Client runs.

To change the default setting, perform the following procedure:

Procedure

Perform the following tasks, depending on the port that you want to change:

a) To change the Port Number parameter for the Cisco CTL Provider service, perform Step 2, on page 78
through Step 6, on page 78.

b) To change the Ethernet Phone Port or SIP Phone Secure Port settings, perform Step 7, on page 78 through
Step 11, on page 78.

To change the Cisco CTL Provider port, choose System > Service Parametersin Unified Communications
Manager Administration.

In the Server drop-down list, choose a server where the CiscoCTL Provider service runs.

In the Service drop-down list box, choose Cisco CTL Provider service.

Tip For information on the service parameter, click the question mark or the link name.

To change the value for the Port Number parameter, enter the new port number in the Parameter Value field.

Note Starting 12.X onwards, you cannot change the value for the Port Number parameter in the Parameter
Value field.
Click Save.

To change the Ethernet Phone Port or SIP Phone Secure Port settings, choose System > CiscoUnifiedCM in
Unified Communications Manager Administration.

Find a server where the CiscoCallManager service runs, as described in the Administration Guide for Cisco
Unified Communications Manager; after the results display, click the Name link for the server.

After the Unified Communications Manager Configuration window displays, enter the new port numbers in
the Ethernet Phone Port or SIP Phone Secure Port fields.

Reset the phones and restart the CiscoCallManager service in Cisco Unified Serviceability.
Click Save.
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Set Up Cisco CTL Client

|

Important  You can set up encryption by using the utils ctl CLI command set. For more information about this option,
see the Command Line Interface Guide for Cisco Unified Communications Solutions.

)

Note » The CLI command utils ctl set-cluster mixed-mode, sets the cluster in mixed-mode. To enable
mixed-mode, ensure that the Unified Communications Manager is registered with the Cisco Smart
Software Manager or Cisco Smart Software Manager satellite and the Registration Token received from
the Smart account or Virtual account has Allow export-controlled functionality enabled while registering
with this cluster.

The CLI command utilsctl update CTL File, updates the CTLFile. To update the CTLFile in mixed-mode,
ensure that the Unified Communications Manager is registered with the Cisco Smart Software Manager
or Cisco Smart Software Manager satellite and the Registration Token received from the Smart account
or Virtual account has Allow export-controlled functionality enabled while registering with this cluster.

When the Unified Communications Manager is not registered with the Registration Token that has Allow
export-controlled functionality enabled and you run the utils ctl set-cluster mixed-mode and utils ctl
update CTL File commands, the following error message is displayed:

Command cannot be executed because the Unified Communications Manager
cluster is not registered to a Smart/Virtual Account with Allow
export-controlled functionality. Please ensure Product Token received
from the Smart/Virtual Account has Allow export-controlled functionality
checked when registering the UCM Cluster

The Cisco CTL CLI performs the following tasks:

* Sets the Unified Communications Manager security mode for a cluster or standalone server.

\}

Note  You cannot set the Unified Communications Manager cluster security parameter to mixed mode through the
Enterprise Parameters Configuration window of Unified Communications Manager Administration. You can
set the cluster security mode through the Cisco CTL Client or the CLI command set utils ctl.

* Creates the Certificate Trust List (CTL), which is a file that contains certificate entries for security tokens,
Unified Communications Manager, ASA firewall, and CAPF server.

The CTL file indicates the servers that support TLS for the phone connection. The client automatically
detects the Unified Communications Manager, Cisco CAPF, and ASA firewall and adds certificate entries
for these servers.
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Note

The Cisco CTL Client also provides supercluster support: up to 16 call processing

servers, 1 publisher, 2 TETP servers, and up to 9 media resource servers.

Je

Tip  You can update the CTL file during a scheduled maintenance windc
you must restart the TFTP services and then the CallManager on all

that run these services in the cluster.

After you complete the Cisco CTL configuration, the CTL performs the following

tasks:

» Writes the CTL file to the Unified Communications Manager server(s).

» Writes CAPF capf.cer to all Unified Communications Manager subsequent
nodes (not first node) in the cluster.

» Writes CAPF certificate file in PEM format to all Unified Communications
Manager subsequent nodes (not first node) in the cluster.

* Writes the file to all configured TFTP servers.

* Writes the file to all configured ASA firewalls.

* Signs the CTL file with the private key of the security token that exists in
the USB port at the time you create the CTL file.

SAST Roles of CTL File
A

Note

*Signer, mentioned in the following table, is used to sign the CTL file.

Table 13: System Administrator Security Token (SAST) Roles of CTL File

Cisco Unified Communications
Manager Version

SAST Roles in Token-hased CTL
File

SAST Roles in Tokenless CTL File

12.0(1)

Token 1 (Signer*)
Token 2
ITLRecovery
CallManager

ITLRecovery (Signer)
CallManager
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Cisco Unified Communications SAST Roles in Token-based CTL | SAST Roles in Tokenless CTL File
Manager Version File
11.5(x) Token 1 (Signer) CallManager (Signer)
Token 2 ITLRecovery
ITLRecovery
CallManager
10.5(2) Token 1 (Signer) CallManager (Signer)
Token 2 ITLRecovery
10.5(1) Token 1 (Signer) CallManager (Signer)
(Not supported) Token 2
10.0(1) Token 1 (Signer) CallManager (Signer)
(Not supported) Token 2
9.1(2) Token 1 (Signer) Not applicable
Token 2

Migrate Phones from One Cluster to Another Cluster

Step 1
Step 2
Step 3

Step 4

Step 5

Step 6
Step 7
Step 8

Use the following procedure to migrate phones from one cluster to another. For example, from cluster 1 to
cluster 2.

Procedure

On cluster 2, from Cisco Unified OS Administration, choose Security > Certificate M anagement.
Click Find.

From the list of Certificates, click the ITLRecovery certificate and click either Download .PEM File or
Download .DER File to download the certificate in one of the file formats to your computer.
The details of certificate appear.

From the list of Certificates, click the CallManager certificate and click either Download .PEM File or
Download .DER File to download the certificate in one of the file formats to your computer.
The details of certificate appear.

On cluster 1, from Cisco Unified OS Administration, choose Security > Certificate M anagement.
The Certificate List window appears.

Click Upload Certificate Chain to upload the downloaded certificate.
From the Certificate Purpose drop-down list, choose Phone-SAST-trust.

For the Upload File field, click Choose File, browse to the ITLRecovery file that you downloaded in Step
3, and then click Upload File.

The uploaded ITLRecovery file appears for the Phone-SAST-Trust certificate on Certificate List window
of cluster 1. If the new ITL file has a ITLRecovery certificate for cluster 2, run the command show itl.
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Step 9 If the phones in cluster 1 have Locally Significant Certificates (LSC), then the CAPF certificate from cluster
1 has to be uploaded in the CAPF-trust store of cluster 2.
Step 10 (Optional) This step is applicable only if the cluster is in mixed mode. Run the utils ctl update CTLFile

command on the CLI to regenerate the CTL file on cluster 1.

Note * Run the show ct1 CLI command to ensure that the ITLRecovery certificate and CallManager
certificate of cluster 2 are included in the CTL file with the role as SAST.

* Ensure that the phones have received the new CTL and ITL files. The updated CTL file has
the ITLRecovery certificate of cluster 2.

The phones that you want to migrate from cluster 1 to cluster 2 will now accept the ITLRecovery certificate
of cluster 2.

Step 11 Migrate the phone from one cluster to another.

Migration from eToken-based CTL File to Tokenless CTL File

For the tokenless CTL file, administrators must ensure that the endpoints download the uploaded CTL file
generated using USB tokens on Unified Communications Manager Release 12.0(1) or later. After the download,
they can switch to tokenless CTL file. Then, they can run the util ctl update CLI command.

Update CTL File
A\

Note This procedure is not required if you manage cluster security through the CLI command set utils ctl.

You must update the CTL file if the following scenarios occur. If you:

* Add a new Unified Communications Manager server to the cluster

A

Note To add anode to a secure cluster, see Installing Unified Communications Manager,
which describes how to add a node and how to configure security for the new
node.

* Change the name or IP address of a Unified Communications Manager server

* Change the IP address or hostname for any configured TFTP servers

* Change the IP address or hostname for any configured ASA firewall

* Enable the Cisco Certificate Authority Function service in Cisco Unified Serviceability
* Add or remove a security token

* Add or remove a TFTP server

. Security Guide for Cisco Unified Communications Manager, Release 11.5(1)SU10



| Security Basics
Update Cisco Unified Communications Manager Security Mode .

* Add or remove a Unified Communications Manager server
* Add or remove an ASA firewall

» Manually regenerate CallManager, CAPF, or ITL Recovery certificate on any node on the Cisco Unified
Communications Manager cluster that contains a CTL file, you must re-run the CTL wizard. This step
is not required for the generation of other certificates.

* Update from a Unified Communications Manager version prior to 7.1.5 to a version 7.1.5 or later.

* Update from a Unified Communications Manager version prior to 10.5 to a version 10.5 or later, refer
to the migration section from Hardware eTokens to Tokenless Solution.

* Upload a third-party, CA-signed certificate to the platform.

Note When a domain name is added or changed on a Unified Communications Manager cluster in mixed mode,
you must update the CTL file for the phone configuration files to take effect.

Tip We strongly recommends that you update the file when minimal call-processing interruptions will occur.

A

Caution If Unified Communications Manager is integrated with Unity Connection 10.5 or later using secure SIP or
SCCP, then the secure calls may stop working with Unity Connection. You must reset the corresponding port
groups on Unity Connection to resolve this issue.

To reset the port group through the Unity Connection Administration interface, navigate to Telephony
Integrations> Port Group, select the port group that you want to reset, and click Reset on the Port Group
Basics page.

Update Cisco Unified Communications Manager Security Mode

You must use the Cisco CTL to configure the cluster security mode. You cannot change the Unified
Communications Manager security mode from the Enterprise Parameters Configuration window in Unified
Communications Manager Administration.

\)

Note Cluster security mode configures the security capability for a standalone server or a cluster.

To change the cluster security mode after the initial configuration of the Cisco CTL Client, you must update
the CTL file.

Procedure

Step 1 Run the CLI command utils ctl set-cluster mixed-mode to change the cluster security mode to secure.
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Step 2 Run the CLI command utils ctl set-cluster non-secure-mode to change the cluster security mode to
non-secure.

Cisco CTL File Details
A

Note  You can set up encryption by using the utils ctl CLI command set, which does not require security tokens.
For more information about this option, see the Command Line Interface Guide for Cisco Unified
Communications Solutions.

You can set the cluster security mode to nonsecure or mixed mode, as described in the following table. Only
mixed mode supports authentication, encrypted signaling, and encrypted media.

)

Note Cluster security mode configures the security capability for a standalone server or a cluster.

Table 14: CTL Configuration Settings

Setting Description

Unified Communications Manager Server

Security Mode

Set Unified Communications Manager Cluster to Mixed mode allows authenticated, encrypted, and
Mixed Mode nonsecure Cisco I[P Phones to register with Unified
Communications Manager. In this mode, Unified
Communications Manager ensures that authenticated
or encrypted devices use a secure port.

Set Unified Communications Manager Cluster to If you configure nonsecure mode, all devices register
Non-Secure Mode as unauthenticated, and Unified Communications
Manager supports image authentication only.

When you choose this mode, the Cisco CTL Client
removes the certificates for all entries that are listed
in the CTL file, but the CTL file still exists in the
directory that you specified. The phone requests
unsigned configuration files and registers as nonsecure
with Unified Communications Manager.

Tip To revert the phone to the default
nonsecure mode, you must delete the CTL
file from the phone and all Unified
Communications Manager servers.

CTL Entries

. Security Guide for Cisco Unified Communications Manager, Release 11.5(1)SU10



| Security Basics
Verify Cisco Unified Communications Manager Security Mode .

Setting Description

Tokens If you have not already done so, remove the token
that you initially inserted into the server or
workstation. When the application prompts you to do
so, insert the next token and click OK. When the
security token information for the additional token
displays, click Add. For all security tokens, repeat
these tasks.

Add TFTP Server Click this button to add an Alternate TFTP server to
the certificate trust list. For information on the
settings, click the Help button after the Alternate
TFTP Server tab settings display. After you enter the
settings, click Next.

Add Firewall Click this button to add an ASA firewall to the
certificate trust list. For information on the settings,
click the Help button after the Firewall tab settings
display. After you enter the settings, click Next.

Verify Cisco Unified Communications Manager Security Mode

To verify the cluster security mode, perform the following procedure:

)

Note Cluster security mode configures the security capability for a standalone server or a cluster.

Procedure

Step 1 In Unified Communications Manager Administration, choose System > Enter prise Parameter sConfiguration.

Step 2 Locate the Cluster Security M ode field. If the value in the field displays as 1, you correctly configured
Unified Communications Manager for mixed mode. (Click the field name for more information.)

Tip You cannot configure this value in Unified Communications Manager Administration. This value
displays after you configure the Cisco CTL Client.

Set Up Smart Card Service to Started or Automatic

If the Cisco CTL Client installation detects that the Smart Card service is disabled, you must set the Smart
Card service to automatic and started on the server or workstation where you are installing the Cisco CTL
Client plug-in.
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2

Tip  You cannot add the security tokens to the CTL file if the service is not set to started and automatic.

2

Tip  After you upgrade the operating system, apply service releases, upgrade Cisco Unified Communications
Manager, and so on, verify that the Smart Card service is started and automatic.

To set the service to started and automatic, perform the following procedure:

Procedure

Step 1 On the server or workstation where you installed the Cisco CTL Client, choose Start > Programs>
Administrative Tools> Services or Start > Control Panel > Administrative Tools> Services.

Step 2 From the Services window, right-click the Smart Card service and choose Properties.
Step 3 In the Properties window, verify that the General tab displays.

Step 4 From the Startup type drop-down list box, choose Automatic.

Step 5 Click Apply.

Step 6 In the Service Status area, click Start.

Step 7 Click OK.

Step 8 Reboot the server or workstation and verify that the service is running.

Verify or Uninstall Cisco CTL Client

Uninstalling the Cisco CTL Client does not delete the CTL file. Likewise, the cluster security mode and the
CTL file do not change when you uninstall the client. If you choose to do so, you can uninstall the Cisco CTL
using the CLI option.

To verify that the Cisco CTL Client installed, perform the following procedure:

Procedure
Step 1 Choose Start > Control Panel > Add Remove Programs.
Step 2 To verify that the client installed, locate Cisco CTL Client.
Step 3 To uninstall the client, click Remove.
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TLS Setup

» TLS Overview, on page 87

* TLS Prerequisites, on page 87

» TLS Configuration Task Flow, on page 88
 TLS Interactions and Restrictions, on page 92

TLS Overview

Transport Layer Security (TLS) provides secure and reliable signaling and data transfer between two systems
or devices, by using secure ports and certificate exchange. TLS secures and controls connections among
Unified Communications Manager-controlled systems, devices, and processes to prevent access to the voice
domain.

TLS Prerequisites

Before you configure the minimum TLS version, make sure that your network devices and applications both
support the TLS version. Also, make sure that they are enabled for TLS that you want to configure with
Unified Communications Manager and IM and Presence Services. If you have any of the following products
deployed, confirm that they meet the minimum TLS requirement. If they do not meet this requirement, upgrade
those products:

+ Skinny Client Control Protocol (SCCP) Conference Bridge
* Transcoder

» Hardware Media Termination Point (MTP)

* SIP Gateway

* Cisco Prime Collaboration Assurance

* Cisco Prime Collaboration Provisioning

* Cisco Prime Collaboration Deployment

* Cisco Unified Border Element (CUBE)

* Cisco Expressway
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* Cisco TelePresence Conductor
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You will not be able to upgrade conference bridges, Media Termination Point (MTP), Xcoder, Prime
Collaboration Assurance, and Prime Collaboration Provisioning.

\)

Note

If you are upgrading from an earlier release of Unified Communications Manager, make sure that all your
devices and applications support the higher version of TLS before you configure it. For example, Unified

Communications Manager and IM and Presence Services, Release 9.x supports TLS 1.0 only.

TLS Configuration Task Flow

Complete the following tasks to configure Unified Communications Manager for TLS connections.

Procedure

Command or Action

Purpose

Step 1

Set Minimum TLS Version, on page 9.

By default, Unified Communications Manager
supports a minimum TLS version of 1.0. If your
security needs require a higher version of TLS,
reconfigure the system to use TLS 1.1 or 1.2.

Step 2

(Optional) Set TLS Ciphers, on page 89.

Configure the TLS cipher options that Unified
Communications Manager supports.

Step 3

Configure TLS in a SIP Trunk Security Profile,
on page 89.

Assign TLS connections to a SIP Trunk. Trunks
that use this profile use TLS for signaling. You
can also use the secure trunk to add TLS
connections to devices, such as conference
bridges.

Step 4

Add Secure Profile to a SIP Trunk, on page 90.

Assign a TLS-enabled SIP trunk security profile
to a SIP trunk to allow the trunk to support TLS.
You can use the secure trunk to connect
resources, such as conference bridges.

Step 5

Configure TLS in a Phone Security Profile, on
page 90.

Assign TLS connections to a phone security
profile. Phones that use this profile use TLS for
signaling.

Step 6

Add Secure Phone Profile to a Phone, on page
91.

Assign the TLS-enabled profile that you created
to a phone.

Step 7

Add Secure Phone Profile to a Universal Device
Template, on page 92.

Assign a TLS-enabled phone security profile
to a universal device template. If you have the
LDAP directory synchronization configured
with this template, you can provision phones
with security through the LDAP sync.
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Set Minimum TLS Version

Step 1
Step 2
Step 3

Step 4

By default, Unified Communications Manager supports a minimum TLS version of 1.0. Use this procedure
to reset the minimum supported TLS version for Unified Communications Manager and the IM and Presence
Service to a higher version, such as 1.1 or 1.2.

Make sure that the devices and applications in your network support the TLS version that you want to configure.
For details, see TLS Prerequisites, on page 87.

Procedure

Log in to the Command Line Interface.
To confirm the existing TLS version, run the show tIs min-version CLI command.
Run the set tls min-version <minimum> CLI command where <minimum> represents the TLS version.

For example, run set tls min-version 1.2 to set the minimum TLS version to 1.2.

Perform Step 3 on all Unified Communications Managerand IM and Presence Service Service cluster nodes.

Set TLS Ciphers

Step 1
Step 2

Step 3

You can disable the weaker cipher, by choosing available strongest ciphers for the SIP interface. Use this
procedure to configure the ciphers that Unified Communications Manager supports for establishing TLS
connections.

Procedure

From Cisco Unified CM Administration, choose System > Enterprise Parameters.

In Security Parameters, configure a value for the TL S Cipher senterprise parameter. For help on the available
options, refer to the enterprise parameter online help.

Click Save.

Note All TLS Ciphers will be negotiated based on client cipher preference

Configure TLS in a SIP Trunk Security Profile

Step 1
Step 2

Use this procedure to assign TLS connections to a SIP Trunk Security Profile. Trunks that use this profile use
TLS for signaling.

Procedure

From Cisco Unified CM Administration, choose System > Security > SIP Trunk Security Profile.

Perform one of the following steps:
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Step 3
Step 4
Step 5
Step 6

Step 7

* Click Add New to create a new SIP trunk security profile.
» Click Find to search and select an existing profile.

In the Name field, enter a name for the profile.
Configure the Device Security M ode field value to Encrypted or Authenticated.
Configure both the Incoming Transport Type and Outgoing Transport Type field values to TLS.

Complete the remaining fields of the SIP Trunk Security Profile window. For help on the fields and their
configuration, see the online help.

Click Save.

Add Secure Profile to a SIP Trunk

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6

Step 7
Step 8

Step 9

Use this procedure to assign a TLS-enabled SIP trunk security profile to a SIP trunk. You can use this trunk
to create a secure connection to resources, such as conference bridges.

Procedure

From Cisco Unified CM Administration, choose Device> Trunk.
Click Find to search and select an existing trunk.

For the Device Name field, enter a device name for the trunk.
From the Device Pool drop-down list, choose a device pool.
From the SIP Profile drop-down list, choose a SIP Profile.

From the SIP Trunk Security Profile drop-down list, choose the TLS-enabled SIP Trunk Profile that you
created in the previous task.

In the Destination area, enter the destination IP address. You can enter up to 16 destination addresses. To
enter additional destinations, click the (+) button.

Complete the remaining fields in the Trunk Configuration window. For help with the fields and their
configuration, see the online help.

Click Save.

Note If you are connecting the trunk to a secure device, you must upload a certificate for the secure device
to Unified Communications Manager. For certificate details, see the Certificates section.

Configure TLS in a Phone Security Profile

Step 1

Use this procedure to assign TLS connections to a Phone Security Profile. Phones that use this profile use
TLS for signaling.

Procedure

From Cisco Unified CM Administration, choose System > Security > Phone Security Profile.
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Step 2 Perform one of the following steps:

» Click Add New to create a new profile.
* Click Find to search and select an existing profile.

Step 3 If you are creating a new profile, select a phone model and protocol, and click Next.

Note If you want to use a universal device template and LDAP sync to provision security through the
LDAP sync, select Universal Device Template as the Phone Security Profile Type.

Step 4 Enter a name for the profile.
Step 5 From the Device Security Mode drop-down list, select either Encrypted or Authenticated.
Step 6 (For SIP phones only) From the Transport Type, select TLS.

Step 7 Complete the remaining fields of the Phone Security Profile Configuration window. For help with the fields
and their configuration, see the online help.

Step 8 Click Save.

Add Secure Phone Profile to a Phone

Use this procedure to assign the TLS-enabled phone security profile to a phone.

\}

Note To assign a secure profile to a large number of phones at once, use the Bulk Administration Tool to reassign
the security profile for them.

Procedure
Step 1 From Cisco Unified CM Administration, choose Device > Phone.
Step 2 Perform one of the following steps:

* Click Add New to create a new phone.
* Click Find to search and select an existing phone.

Step 3 Select the phone type and protocol and click Next.
Step 4 From the Device Security Profile drop-down list, assign the secure profile that you created to the phone.
Step 5 Assign values for the following mandatory fields:

* MAC address

* Device Pool

» SIP Profile

* Owner User ID
* Phone Button Template

Step 6 Complete the remaining fields of the Phone Configuration window. For help with the fields and their
configuration, see the online help.
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Step 7

Click Save.

Add Secure Phone Profile to a Universal Device Template

Step 1

Step 2

Step 3
Step 4
Step 5

Step 6
Step 7
Step 8

Step 9

Use this procedure to assign a TLS-enabled phone security profile to a universal device template. If you have
LDAP directory sync configured, you can include this universal device template in the LDAP sync through
a feature group template and user profile. When the sync occurs, the secure profile is provisioned to the phones.

Procedure

From Cisco Unified CM Administration, choose User Management > User/Phone Add > Universal Device
Template.

Perform one of the following steps:

* Click Add New to create a new template.
* Click Find to search and select an existing template.

For the Name field, enter a name for the template.
From the Device Pool drop-down list, select a device pool.
From the Device Security Profile drop-down list, select the TLS-enabled security profile that you created.

Note The Phone Security Profile must have been created with Univer sal Device Template as the device
type.

Select a SIP Profile.
Select a Phone Button Template.

Complete the remaining fields of the Univer sal Device Template Configuration window. For help with the
fields and their configuration, see the online help.

Click Save.

Include the Universal Device template in an LDAP directory synchronization. For details on how to set up
an LDAP Directory sync, see the “Configure End Users” part of the System Configuration Guide for Cisco
Unified Communications Manager.

TLS Interactions and Restrictions

This chapter provides information about the TLS Interactions and Restrictions.
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TLS Interactions

Table 15: TLS Interactions

Feature Interaction

Common Criteria mode | You can enable Common Criteria mode along with configuration of minimum
TLS version. If you do so, the applications continue to comply with Common
Criteria requirements and disable TLS 1.0 secure connections at application level.
When the common criteria mode is enabled, you can configure the minimum
TLS version as either 1.1 or 1.2 for the applications. For details on Common
Criteria mode, see the Compliance to Common Criteria topic of the Command
Line Interface Reference Guide for Cisco Unified Communications Solutions.

TLS Restrictions

The following table highlights issues that you may run into when implementing Transport Layer Security
(TLS) version 1.2 on legacy phones, such as 79xx, 69xx, 89xx, 99xx, 39xx, and IP Communicator. To verify
whether your phone supports secure mode in this release, see the Phone Feature List Report in Cisco Unified
Reporting. The feature restrictions on legacy phones and the workaround to implement the feature is listed in
the following table:

\}

Note The workarounds are designed to get the impacted feature functioning in your system. However, they do not
guarantee TLS 1.2 compliance for that feature.

Table 16: Transport Layer Security Version 1.2 Restrictions

Feature Restriction

Legacy phones in Legacy phones in Encrypted Mode do not work. There is no workaround.
Encrypted Mode

Legacy phones in Legacy phones in Authenticated Mode do not work. There is no workaround.
Authenticated Mode

IP Phone services using | IP Phone services using secure URLs based on HTTPS do not work.
secure URLs based on

HTTPS Workaround to use IP Phone services: Use HTTP for all underlying service

options. For example, corporate directory and personal directory. However, HTTP
is not recommended as HTTP is not as secure if you need to enter sensitive data
for features, such as Extension Mobility. The drawbacks of using HTTP include:

* Provisioning challenges when configuring HTTP for legacy phones and
HTTPS for supported phones.

* No resiliency for IP Phone services.

* Performance of the server handling IP phone services can be affected.

Security Guide for Cisco Unified Communications Manager, Release 11.5(1)SU10 .



. TLS Restrictions

Security Basics |

Feature

Restriction

Extension Mobility Cross
Cluster (EMCC) on
legacy phones

EMCC is not supported with TLS 1.2 on legacy phones.
Workaround: Complete the following tasks to enable EMCC:
1. Enable EMCC over HTTP instead of HTTPS.

2. Turn on mixed-mode on all Unified Communications Manager clusters.

3. Use the same USB eTokens for all Unified Communications Manager clusters.

Locally Significant
Certificates (LSC) on

LSC is not supported with TLS 1.2 on legacy phones. As a result, 802.1x and
phone VPN authentication based on LSC are not available.

legacy phones Workaround for 802.1x: Authentication based on MIC or password with
EAP-MD)5 on older phones. However, those are not recommended.
Workaround for VPN: Use phone VPN authentication based on end-user username
and password.

Encrypted Trivial File Encrypted Trivial File Transfer Protocol (TFTP) configuration files are not

Transfer Protocol (TFTP)
configuration files

supported with TLS 1.2 on legacy phones even with Manufacturer Installed
Certificate (MIC).

There is no workaround.

CallManager certificate
renewal causes legacy
phones to lose trust

Legacy phones lose trust when CallManager certificate is renewed. For example,
a phone cannot get new configurations after renewing the certificate. This is
applicable only in Unified Communications Manager 11.5.1

Workaround: To prevent legacy phones from losing trust, complete the following
steps:

1. Before you enable the CallManager certificate, set the Cluster For Roll Back
to Pre 8.0 enterprise parameter to True. By default, this setting disables the
security.

2. Temporarily allow TLS 1.0 (multiple Unified Communications Manager
reboots).

Connections to
non-supported versions of
Cisco Unified
Communications Manager

TLS 1.2 connections to older versions of Unified Communications Manager that
do not support the higher TLS version do not work. For example, a TLS 1.2 SIP
trunk connection to Unified Communications Manager Release 9.x does not work
because that release does not support TLS 1.2.

You can use one of the following workarounds:

» Workaround to enable connections: Use nonsecure trunks, although this is
not a recommended option.

» Workaround to enable connections while using TLS 1.2: Upgrade the
non-supported version to a release that does support TLS 1.2.
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Feature

Restriction

Certificate Trust List
(CTL) Client

CTL client does not support TLS 1.2.
You can use one of the following workarounds:

 Temporarily allow TLS 1.0 when using the CTL client and then move the
Cluster to Common Criteria mode. Configure Minimum TLS to 1.1 or 1.2

* Migrate to the Tokenless CTL by using the CLI Command utils ctl
set-cluster mixed-mode in Common Criteria mode. Configure Minimum
TLSto 1.1 or 1.2

Address Book
Synchronizer

There is no workaround.

Cisco Unified Communications Manager Ports Affected by Transport Layer Security Version 1.2

The following table lists the Unified Communications Manager Ports Affected By TLS Version 1.2

Table 17: Cisco Unified Communications Manager Ports Affected by Transport Layer Security Version 1.2

Application | Protocol | Destination | Cisco Unified Communications Cisco Unified Communications
/ Listener | Manager Operating in Normal Manager Operating in Common
mode Criteria Mode
Minimum | Minimum | Minimum |Minimum |Minimum | Minimum
TLS TLS TLS TLS TLS TLS
version 1.0 | version 1.1 | version 1.2 | version 1.0 | version 1.1 | version 1.2
Tomcat HTTPS 443 TLS 1.0, |TLS1.1, |[TLS1.2 |TLS1.1 TLS 1.1, |TLS1.2
TLS 1.1, |TLSv1.2 TLS 1.2
TLS 1.2
SCCP - Signalling | 2443 TLS 1.0, |TLS1.1, |TLS1.2 |TLS1.1 |TLS1.1, |TLS1.2
SEC - SIG | Connection TLS 1.1, |TLS1.2 TLS 1.2
Control TLS 1.2
Part
(SCCP)
CTL-SERV | Proprietary | 2444 TLS 1.0, |TLS1.1, |TLS1.2 |TLSI1.1 |TLSI1.1, |TLS1.2
TLS 1.1, |TLS1.2 TLS 1.2
TLS 1.2
Computer | Quick 2749 TLS 1.0, |TLS1.1, |[TLS1.2 |TLS1.1 |TLS1.1, |TLS1.2
Telephony | Buffer TLS 1.1, |TLS 1.2 TLS 1.2
Integration | Encoding TLS 1.2
(CTD)  |(QBE)
CAPFSERV | Transmission | 3804 TLS 1.0, |TLS1.1, |TLS1.2 |TLS1.1 |TLS1.1, |TLS1.2
Control TLS 1.1, |TLS 1.2 TLS 1.2
Protocol TLS 1.2
(TCP)
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Application | Protocol | Destination | Cisco Unified Communications Cisco Unified Communications
/ Listener | Manager Operating in Normal Manager Operating in Common
mode Criteria Mode
Minimum |Minimum |Minimum |Minimum | Minimum | Minimum
TLS TLS TLS TLS TLS TLS
version 1.0 | version 1.1 | version 1.2 | version 1.0 | version 1.1 | version 1.2
Intercluster | Not 7501 TLS 1.0, |TLS1.1, |TLS1.2 |TLS1.1 |TLS1.1, |TLS1.2
Lookup |applicable TLS 1.1, |TLS 1.2 TLS 1.2
Service TLS 1.2
(ILS)
Adminstrative | Simple 8443 TLS 1.0, |TLS1.1, |TLS1.2 |TLSI1.1 |TLSI1.1, |TLS1.2
XML Object TLS 1.1, |TLS1.2 TLS 1.2
(AXL) Access TLS 1.2
Protocol
(SOAP)
High TCP 9443 TLS1.2 |TLS12 |TLS12 |TLS1.1 |TLS1.2 |TLS1.2
Available-
Proxy
(HA-Proxy)
SIP-SIG |Session  [5061 TLS 1.0, |TLS1.1, |TLS1.2 |TLSI1.1 |TLSI1.1, |TLS1.2
Initiation | (configurable | TLS 1.1, |TLS 1.2 TLS 1.2
Protocol | with TLS 1.2
(SIP) trunk)
HA Proxy | TCP 6971, TLS12 |TLS12 |TLS12 |TLS1.1 |TLS1.1, |TLS1.2
6972 TLS 1.2
Cisco HTTPS |8080, 8443: TLS | 8443: TLS | 8443: TLS [ TLS 1.1 | 8443: TLS | 8443: TLS
Tomcat 8443 1.0, TLS |I1.I,TLS |1.2 1.1, TLS |1.2
1.1, TLS |1.2 1.2
1.2
Trust Proprietary | 2445 TLS 1.0, |TLS1.1, |TLS1.2 |TLS1.1 |TLSI1.1, |TLS1.2
Verification TLS 1.1, |TLS1.2 TLS 1.2
Service TLS 1.2
(TVS)

Instant Messaging and Presence Ports Affected by Transport Layer Security Version 1.2

The following table lists the IM and Presence Service Ports Affected By Transport Layer Security Version

1.2
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Destination/Listener

Instant Messaging & Presence Operating
in Normal mode

Instant Messaging & Presence Operating
in Common Criteria mode

Minimum |Minimum Minimum Minimum Minimum Minimum
TLS TLS version |TLS version |TLS version |TLS version |TLS version
version1.0 | 1.1 1.2 1.0 11 1.2

443 TLS 1.0, |TLS 1.1, TLS 1.2 TLS 1.1 TLS 1.1, TLS 1.2
TLS 1.1, |[TLS1.2 TLS 1.2
TLS 1.2

5061 TLS 1.0, |TLS 1.1, TLS 1.2 TLS 1.1 TLS 1.1, TLS 1.2
TLS 1.1, |[TLS1.2 TLS 1.2
TLS 1.2

5062 TLS 1.0, |TLS 1.1, TLS 1.2 TLS 1.1 TLS 1.1, TLS 1.2
TLS 1.1, |[TLS1.2 TLS 1.2
TLS 1.2

7335 TLS 1.0, |TLS 1.1, TLS 1.2 TLS 1.1 TLS 1.1, TLS 1.2
TLS 1.1, |TLS1.2 TLS 1.2
TLS 1.2

8083 TLS 1.0, |TLS 1.1, TLS 1.2 TLS 1.1 TLS 1.1, TLS 1.2
TLS 1.1, |TLS1.2 TLS 1.2
TLS 1.2

8443 TLS 1.0, |TLS 1.1, TLS 1.2 TLS 1.1 TLS 1.1, TLS 1.2
TLS 1.1, |[TLS1.2 TLS 1.2
TLS 1.2
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CHAPTER 6

Certificate Setup

This chapter provides information about certificate setup.

* About Certificate Setup, on page 99

* Find Certificate, on page 99

* Upload Certificate or Certificate Chain, on page 100
* Certificate Settings, on page 100

About Certificate Setup

Use the Certificate Configuration window to view the certificates on your system. All fields on the Certificate
Configuration window are read-only, except Duration in Cache.

)

Note When a multi-SAN ca-signed certificate is uploaded it is only applied to nodes that are in the cluster at the
time the certificate is uploaded to the publisher. Anytime a node is rebuilt or a node is added to the cluster, it
is necessary to generate a new multi-SAN Certificate Signing Request (CSR), get it signed by the CA, and
upload it to the cluster.

Find Certificate

To find a certificate, perform the following procedure:

Procedure

Step 1 In Unified Communications Manager Administration, choose System > Security > Certificate.

The Find and List Certificates window displays. Records from an active (prior) query may also display in
the window.

Step 2 To find all records in the database, ensure the dialog box is empty; go to Step 3, on page 100.
To filter or search records

a) From the first drop-down list box, choose a search parameter.
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Step 3

Step 4

b) From the second drop-down list box, choose a search pattern.
c) Specify the appropriate search text, if applicable.

Note To add additional search criteria, click the + button. When you add criteria, the system searches
for a record that matches all criteria that you specify. To remove criteria, click the — button to
remove the last added criterion or click the Clear Filter button to remove all added search
criteria.

Click Find.

All matching records display. You can change the number of items that display on each page by choosing a
different value from the Rows per Page drop-down list box.

From the list of records that display, click the link for the record that you want to view.

Note To reverse the sort order, click the up or down arrow, if available, in the list header.

The window displays the item that you choose.

Upload Certificate or Certificate Chain

Step 1
Step 2
Step 3

Step 4
Step 5

Step 6

Select and upload a certificate or a cluster-wide certificate to distribute it to all the servers in the selected
cluster.

Procedure

From Cisco Unified OS Administration, choose Security > Certificate M anagement.
The Certificate List window appears.

Click Upload Certificate/Certificate chain.
The Upload Certificate/Certificate chain window appears.

From the Certificate Purpose drop-down box, select a system security certificate, such as
CallManager-ECDSA.

In the Description field, enter a name for the certificate.

In the Upload File field, click Choose File to browse for the certificate file that you want to distribute for all
the servers in the cluster.

Click Upload.

Certificate Settings

All fields on the Certificate Management window are read-only, except Duration in Cache.
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Table 19: VPN Profile Configuration Settings

Certificate Settings .

Field

Definition

Subject Name (read only)

Displays the subject name for the certificate.

Issuer Name (read only)

Displays the issuer name for the certificate.

Serial Number (read only)

Displays the serial number (MAC address).

IPv4 Address (read only)

Displays the IPv4 address.

IPv6 Address (read only)

Displays the IPv6 address.

Duration in Cache

Enter the time, in hours, that the certificate can persist
in the phone cache. A value of zero indicates that the
certificate does not get cached. Leave blank to accept
the system default value.

Maximum: 720 hours

Selected Roles

Displays the roles currently associated with the
certificate.

Selected Services

Displays the services currently associated with the
certificate.
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PART I I

Security for Cisco IP Phone and Cisco
Voice-Messaging Ports

* Phone Security, on page 105

* Phone Security Profile Setup, on page 111

* Secure and Nonsecure Indication Tone Setup, on page 127
* Encryption to Analog Endpoint Setup, on page 131

* Certificate Authority Proxy Function, on page 133

* Encrypted Phone Configuration File Setup, on page 147

* Digest Authentication for SIP Phones Setup, on page 159
* Phone Hardening, on page 163

* Secure Conference Resources Setup, on page 167

* Voice-Messaging Ports Security Setup, on page 179

* Call Secure Status Policy, on page 183

* Secure Call Monitoring and Recording Setup, on page 185






CHAPTER 7

Phone Security

This chapter provides information about phone security.

* Phone Security Overview, on page 105

* Trusted Devices, on page 106

* Phone Model Support, on page 107

* Preferred Vendor SIP Phone Security Set Up, on page 107

* View Phone Security Settings, on page 109

* Set Up Phone Security, on page 109

* Phone Security Interactions and Restrictions, on page 110

» Where to Find More Information About Phone Security, on page 110

Phone Security Overview

At installation, Unified Communications Manager boots up in nonsecure mode. When the phones boot up
after the Unified Communications Manager installation, all devices register as nonsecure with Unified
Communications Manager.

After you upgrade from Unified Communications Manager 4.0(1) or a later release, the phones boot up in the
device security mode that you enabled prior to the upgrade; all devices register by using the chosen security
mode.

The Unified Communications Manager installation creates a self-signed certificate on the Unified
Communications Manager and TFTP server. You may also choose to use a third-party, CA-signed certificate
for Unified Communications Manager instead of the self-signed certificate. After you configure authentication,
Unified Communications Manager uses the certificate to authenticate with supported Cisco Unified IP Phones.
After a certificate exists on the Unified Communications Manager and TFTP server, Unified Communications
Manager does not reissue the certificates during each Unified Communications Manager upgrade. You must
create a new CTL file with the new certificate entries.

Je

Tip  For information on unsupported or nonsecure scenarios, see topics related to interactions and restrictions.

Unified Communications Manager maintains the authentication and encryption status at the device level. If
all devices that are involved in the call register as secure, the call status registers as secure. If one device
registers as nonsecure, the call registers as nonsecure, even if the phone of the caller or recipient registers as
secure.
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Unified Communications Manager retains the authentication and encryption status of the device when a user
uses Cisco Extension Mobility. Unified Communications Manager also retains the authentication and encryption
status of the device when shared lines are configured.

Je

Tip

When you configure a shared line for an encrypted Cisco IP Phone, configure all devices that share the lines
for encryption; that is, ensure that you set the device security mode for all devices to encrypted by applying

a security profile that supports encryption.

Trusted Devices

Unified Communications Manager allows Security icons to be enabled by phone model on Cisco IP Phones.
The Security icon indicates whether the call is secure and the connected device is trusted.

A Trusted Device represents a Cisco device or a third-party device that has passed Cisco security criteria for
trusted connections. This includes, but is not limited to, signaling/media encryption, platform hardening, and
assurance. If a device is trusted, a Security icon displays and a secure tone plays on supported devices. Also,
the device may provide other features or indicators that are related to secure calls.

Unified Communications Manager determines whether a device is trusted when you add it to your system.
The security icon displays for information purposes only, and the administrator cannot configure it directly.

Unified Communications Manager also indicates whether a gateway is trusted by displaying an icon and a
message in Unified Communications Manager Administration.

This section describes the behavior of the security icon for trusted devices on both the Cisco IP Phones and
in Unified Communications Manager Administration.

Cisco Unified Communications Manager Administration

The following windows in Unified Communications Manager Administration indicate whether a device is
trusted:

Gateway Configuration

For each gateway type, the Gateway Configuration window (Device > Gateway) displays either Deviceis
trusted or Deviceisnot trusted, along with a corresponding icon.

The system determines whether the device is trusted, based on the device type. You cannot configure whether
the device is trusted.

Phone Configuration

For each phone device type, the Phone Configuration window (Device > Phone) displays either Deviceis
trusted or Deviceisnot trusted, along with a corresponding icon.

The system determines whether the device is trusted, based on the device type. You cannot configure whether
the device is trusted.
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Device Called Trust Determination Criteria

The type of device that a user calls affects the security icon that displays on the phone. The system considers
the following three criteria to determine whether the call is secure:

* Are all devices on the call trusted?
* Is the signaling secure (authenticated and encrypted)?

* Is the media secure?

Before a supported Cisco Unified IP Phone displays the Lock Security icon, be aware that all three of these
criteria must be met. For calls that involve a device that is not trusted, regardless of signaling and media
security, the overall status of the call will stay unsecure, and the phone will not display the Lock icon. For
example, if you include an untrusted device in a conference, the system considers its call leg, as well as the
conference itself, to be unsecure.

Phone Model Support

There are two categories of phone models which support security in Unified Communications Manager:
Secure Cisco phones and Secure Preferred Vendor phones. Secure Cisco phones are pre-installed with a
Manufacture-Installed Certificate (MIC) and support automatic generation and exchange of Locally-Significant
Certificates (LSC) using the Certificate Authority Proxy Function (CAPF). Secure Cisco phones are capable
of registering with Cisco Unified CM using the MIC without additional certificate management. For additional
security, you can create and install an LSC on the phone using CAPF. See topics related to phone security
setup and settings for more information.

Secure Preferred Vendor phones do not come pre-installed with a MIC, and do not support CAPF for generating
LSCs. In order for Secure Preferred Vendor phones to connect to Cisco Unified CM, a certificate must be
provided with the device, or generated by the device. The phone supplier must provide the details on how to
acquire or generate a certificate for the phone. Once you obtain the certificate, you must upload the certificate
to the Cisco Unified CM using the OS Administration Certificate Management interface. See topics related
to preferred vendor SIP phone security set up for more information.

For a list of security features that are supported on your phone, refer to the phone administration and user
documentation that supports this Unified Communications Manager release or the firmware documentation
that supports your firmware load.

You can also use Cisco Unified Reporting to list the phones that support a particular feature. For more
information about using Cisco Unified Reporting, see the Cisco Unified Reporting Administration Guide.

Preferred Vendor SIP Phone Security Set Up

Secure Preferred Vendor phones are phone types that are manufactured by third-party vendors but are installed
in the Cisco Unified database via a COP file. Unified Communications Manager provides security for a
preferred vendor SIP phone. In order to support security, you must enable Security Encryption or Security
Authentication for the preferred vendor SIP phone in the COP file. These phone types appear in the drop-down
list in the Add a New Phone window. While all preferred vendor phones support Digest Authorization, not
all preferred vendor phones support TLS security. Security capabilities is based on the phone model. If the
Phone Security Profile includes a “Device Security Mode” field, then it supports TLS security.
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If the preferred vendor phone supports TLS security, there are two modes that are possible: per-device certificate
and shared certificate. The phone supplier must specify which mode is applicable for the phone as well as
instructions on generating or acquiring a certificate for the phone.

Set Up Preferred Vendor SIP Phone Security Profile Per-Device Certificates

Step 1
Step 2
Step 3

Step 4
Step 5
Step 6
Step 7

To configure the preferred vendor SIP phone security profile with per-device certificates, perform the following
procedure:

Procedure

Upload the certificate for each phone using the OS Administration Certificate Management interface.
In the Cisco Unified Administration, choose System > Security > Phone Security Profile.

Configure a new Phone Security Profile for the device type of this phone and in the Device Security M ode
drop-down list, choose Encrypted or Authenticated.

To configure the new SIP phone in the CCMAdmin interface, choose Device > Phone> Add New.
Select Phone type.

Fill in the required fields.

In the Device Security Profile drop-down list, select the profile you just created.

Set Up Preferred Vendor SIP Phone Security Profile Shared Certificates

Step 1

Step 2
Step 3
Step 4

Step 5

To configure the preferred vendor SIP phone security profile with shared certificates, perform the following
procedure:

Procedure

Using instructions from the phone vendor, generate a certificate with a Subject Alternate Name (SAN) string.
The SAN must be of type DNS. Make a note of the SAN specified in this step. For example, X509v3 extensions:

* X509v3 Subject Alternative Name

* DNS:AscomGroup01.acme.com

Note The SAN must be of type DNS or security will not be enabled.

Upload the shared certificate using the OS Administration Certificate Management interface.

In the Cisco Unified Administration, choose System > Security > Phone Security Profile.

In the Name field, enter the name of the Subject Alt Name (SAN), which is the name on the certificate provided
by the preferred vendor, or if there is no SAN enter the Certificate Name.

Note The name of the security profile must match the SAN in the certificate exactly or security will not
be enabled.

In the Device Security M ode drop-down list, choose Encrypted or Authenticated.
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Step 6
Step 7
Step 8
Step 9
Step 10

View Phone Security Settings .

In the Transport type drop-down list, choose TL S.

To configure the new SIP phone in the CCMAdmin interface, choose Device > Phone> Add New.
Select Phone type.

Fill in the required fields

In the Device Security Profile drop-down list, select the profile you just created.

View Phone Security Settings

You can configure and view certain security-related settings on phones that support security; for example,
you can view whether a phone has a locally significant certificate or manufacture-installed certificate installed.
For additional information on the security menu and icons, refer to the Cisco IP Phone Administration Guide
and Cisco IP Phone User Guide that supports your phone model.

When Unified Communications Manager classifies a call as authenticated or encrypted, an icon is displayed
on the phone and indicates the call state. It also determines when Unified Communications Manager classifies
the call as authenticated or encrypted.

Set Up Phone Security

Step 1
Step 2

Step 3
Step 4
Step 5
Step 6

Step 7
Step 8

The following procedure describes the tasks to configure security for supported phones.

Procedure

If you have not already done so, configure the Cisco CTL Client and ensure that the Unified Communications
Manager security mode equals Mixed Mode.

If the phone does not contain a locally significant certificate (LSC) or manufacture-installed certificate (MIC),
install a LSC by using the Certificate Authority Proxy Function (CAPF).

Configure phone security profiles.

Apply a phone security profile to the phone.

After you configure digest credentials, choose the Digest User from the Phone Configuration window.

On Cisco Unified IP Phone 7962 or 7942 (SIP only), enter the digest authentication username and password

(digest credentials) that you configured in the End User Configuration window.

Note This document does not provide procedures on how to enter the digest authentication credentials
on the phone. For information on how to perform this task, see Administration Guide for Cisco
Unified Communications Manager that supports your phone model and this version of Unified
Communications Manager.

Encrypt the phone configuration file, if the phone supports this functionality.
To harden the phone, disable phone settings.
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Phone Security Interactions and Restrictions

This section provides the interaction and restriction on Phone Security.

Table 20: Phone Security Interactions and Restrictions

Feature Interaction and Restriction

Certificate Encryption Beginning from Unified Communications Manager Release 11.5(1) SU, all the
LSC certificates issued by CAPF service are signed with SHA-256 algorithm.
Therefore, Cisco Unified IP Phone 7900 Series, 8900 Series, and 9900 Series
supports SHA-256 signed LSC certificates and external SHA2 identity certificates
(Tomcat, CallManager, CAPF, TVS, and so on). For any other cryptographic
operation that require validation of signature, only SHA-1 is supported.

Note If you use phone models which are in End of Software Maintenance
or End of Life, we strongly recommend using the Unified
Communications Manager before 11.5(1)SU1 release.

Where to Find More Information About Phone Security

Related Cisco Documentation

« Administration Guide for Cisco Unified Communications Manager

« Troubleshooting Guide for Cisco Unified Communications Manager
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Phone Security Profile Setup

This chapter provides information about security profile setup.

* Phone Security Profile Overview, on page 111

* Phone Security Profile Setup Prerequisites, on page 111

* Find Phone Security Profile, on page 112

* Set Up Phone Security Profile, on page 113

* Phone Security Profile Settings, on page 113

* Apply Security Profiles to Phone , on page 123

* Synchronize Phone Security Profile with Phones, on page 124

* Delete Phone Security Profile, on page 124

* Find Phones with Phone Security Profiles, on page 125

* SIP Trunk Security Profile Interactions and Restrictions, on page 125

Phone Security Profile Overview

Unified Communications Manager Administration groups security-related settings for a phone type and
protocol into security profiles to allow you to assign a single security profile to multiple phones. Security-related
settings include device security mode, digest authentication, and some CAPF settings. You apply the configured
settings to a phone when you choose the security profile in the Phone Configuration window.

Installing Unified Communications Manager provides a set of predefined, nonsecure security profiles for
auto-registration. To enable security features for a phone, you must configure a new security profile for the
device type and protocol and apply it to the phone.

Only the security features that the selected device and protocol support display in the security profile settings
window.

Phone Security Profile Setup Prerequisites

Consider the following information before you configure the phone security profiles:

» When you configure phones, choose a security profile in the Phone Configur ation window. If the device
does not support security or a secure profile, apply a non-secure profile.

* You cannot delete or change the predefined non-secure profiles.
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* You cannot delete a security profile that is currently assigned to a device.

* If you change the settings in a security profile that is already assigned to a phone, the re-configured
settings apply to all phones that are assigned that particular profile.

* You can rename security files that are assigned to devices. The phones that are assigned with the earlier
profile name and settings assume the new profile name and settings.

* The CAPF settings, the authentication mode and the key size, are displayed in the Phone Configuration
window. You must configure CAPF settings for certificate operations that involve MICs or LSCs. You
can update these fields directly in the Phone Configuration window.

« If you update the CAPF settings in the security profile, the settings are also updated in the Phone
Configuration window.

* If you update the CAPF settings in the Phone Configuration window and a matching profile is found,
Unified Communications Manager applies the matching profile to the phone.

* If you update the CAPF settings in the Phone Configuration window, and no matching profiles are
found, Unified Communications Manager creates a new profile and applies that profile to the phone.

» If you have configured the device security mode earlier to an upgrade, Unified Communications Manager
creates a profile that is based on that model and protocol and applies the profile to the device.

* We recommend that you use MICs for LSC installation only. Cisco support LSCs to authenticate the
TLS connection with Unified Communications Manager. Since MIC root certificates can be compromised,
users who configure phones to use MICs for TLS authentication or for any other purpose do so at their
own risk. Cisco assumes no liability if MICs are compromised.

* We recommend that you upgrade Cisco IP Phones to use LSCs for TLS connections and remove the
MIC root certificates from the CallManager trust store to avoid compatibility issues.

Find Phone Security Profile

To find a phone security profile, perform the following procedure:

Procedure

Step 1 From Cisco Unified Communications Manager Administration, choose System > Security Profile> Phone
Security Profile.

Records from an active (prior) query may also display in the window.

Step 2 To find all records in the database, ensure the dialog box is empty; go to Step 3, on page 113.
To filter or search records

a) From the first drop-down list, choose a search parameter.
b) From the second drop-down list, choose a search pattern.
¢) Specify the appropriate search text, if applicable.

Note To add additional search criteria, click the + button. When you add criteria, the system searches
for a record that matches all criteria that you specify. To remove criteria, click the — button to
remove the last added criterion or click Clear Filter to remove all added search criteria.
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Step 3

Step 4

Set Up Phone Security Profile .

Click Find.

All matching records display. You can change the number of items that display on each page by choosing a
different value from the Rows per Page drop-down list.

From the list of records that display, click the link for the record that you want to view.

Note To reverse the sort order, click the up or down arrow, if available, in the list header.

The window displays the record that you choose.

Set Up Phone Security Profile

Step 1

Step 2

Step 3
Step 4

To setup a phone security profile, perform the following procedure:

Procedure

From Cisco Unified Communications Manager Administration, choose System > Security Profile > Phone
Security Profile.

Perform one of the following tasks:

a) To add a new profile, click Add New.

b) To copy an existing security profile, locate the appropriate profile, click Copy next to the security profile
that you want to copy, and continue.

¢) To update an existing profile, locate the appropriate security profile and continue.

When you click Add New, the configuration window displays with the default settings for each field.
When you click Copy, the configuration window displays the copied settings.

Enter appropriate settings for phones that are running SCCP or SIP.
Click Save.

Phone Security Profile Settings

The following table describes the settings for the security profile for the phone that is running SCCP.

Only settings that the selected phone type and protocol support display.
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Table 21: Security Profile for Phone That Is Running SCCP

Setting

Description

Name

Enter a name for the security profile.

When you save the new profile, the name displays in the Device Security Profile
drop-down list in the Phone Configuration window for the phone type and
protocol.

Tip Include the device model and protocol in the security profile name to
find the correct profile while searching for a profile or updating a
profile.

Description

Enter a description for the security profile. The description can include up to 50
characters in any language, but it cannot include double-quotes ("), percentage
sign (%), ampersand (&), back-slash (\), or angle brackets (<>).
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Setting Description

Device Security Mode
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Setting

Description

From the drop-down list, choose one of the following options:

» Non Secure—No security features except image, file, and device
authentication exist for the phone. A TCP connection opens to Unified
Communications Manager.

+ Authenticated—Unified Communications Manager provides integrity and
authentication for the phone. A TLS connection that uses NULL/SHA opens
for signaling.

* Encrypted—Unified Communications Manager provides integrity,
authentication, and signalling encryption for the trunk.

The following are the supported ciphers:
TLSCiphers

This parameter defines the ciphers that are supported by the Unified
Communications Manager for establishing SIP TLS and inbound CTI
Manager TLS connections.

Strongest- AES-256 SHA-384 only: RSA Preferred
* TLS ECDHE RSA with AES256 GCM SHA384

* TLS ECDHE RSA with AES256 GCM SHA384

Note It is recommended that the value of the parameter 'SRTP Ciphers'
be set to the value 'Strongest - AEAD AES-256 GCM cipher
only'. With this option chosen, the phones will not register on
authenticated mode.

Strongest- AES-256 SHA-384 only: ECDSA Preferred
* TLS ECDHE ECDSA with AES256 GCM SHA384
* TLS ECDHE RSA with AES256 GCM SHA384

Medium- AES-256 AES-128 only: RSA Preferred

Note It is recommended that the value of the parameter 'SRTP Ciphers'
be set to the value 'Strongest - AEAD AES-256 GCM cipher
only'. With this option chosen, the phones will not register on
authenticated mode.

®* TLS ECDHE RSA with AES256 GCM SHA384
®* TLS ECDHE ECDSA with AES256 GCM SHA384
®* TLS ECDHE RSA with AES128 GCM SHA256

* TLS_ECDHE ECDSA with AES128 GCM SHA256

Note It is recommended that the value of the parameter 'SRTP Ciphers'
be set to the value 'Medium - AEAD AES-256,AES-128 GCM
ciphers only'. With this option chosen, the phones will not register
on authenticated mode.

Medium- AES-256 AES-128 only: ECDSA Preferred
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Setting

Description

Note

Note

¢ TLS ECDHE ECDSA with AES256 GCM SHA384
®* TLS ECDHE RSA with AES256 GCM SHA384
TLS_ECDHE ECDSA with AES128 GCM SHA256

TLS ECDHE RSA with AES128 GCM SHA256

All Ciphers, RSA Preferred:

TLS ECDHE RSA with AES256 GCM SHA384
TLS_ECDHE ECDSA with AES256 GCM SHA384
TLS_ECDHE RSA with AES128 GCM SHA256
TLS ECDHE ECDSA with AES128 GCM SHA256
TLS RSA with AES 128 CBC SHAI

All Ciphers, ECDSA Preferred:

TLS ECDHE ECDSA with AES256 GCM SHA384
TLS ECDHE RSA with AES256 GCM SHA384
TLS ECDHE ECDSA with AES128 GCM SHA256
TLS ECDHE RSA with AES128 GCM SHA256

TLS RSA with AES 128 CBC SHAl

It is recommended that the value of the parameter 'SRTP Ciphers'
be set to the value 'Medium - AEAD AES-256,AES-128 GCM
ciphers only'. With this option chosen, the phones will not register
on authenticated mode.

If the trunks are configured with Device Security Profile option
selected as Authenticated, then Unified Communications Manager
starts a TLS connection that uses NULL SHA cipher (without
data encryption). These trunks will not register or make calls if
the destination devices do not support NULL SHA cipher. For
destination devices that do not support NULL SHA cipher, the
trunks should be configured with Device Security Profile option
selected as Encrypted. With this device security profile, the trunks
offer additional TLS ciphers that enables data encryption.

TFTP Encrypted Config

When this check box is checked, Unified Communications Manager encrypts a
phone downloads from the TFTP server.
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Setting

Description

Authentication Mode

This field allows you to choose the authentication method that the phone uses
during the CAPF certificate operation.

From the drop-down list box, choose one of the following options:

Note

By Authentication String—Installs or upgrades, deletes, or troubleshoots
a locally significant certificate only when the user enters the CAPF
authentication string on the phone.

By Null String—Installs or upgrades, deletes, or troubleshoots a locally
significant certificate without the user intervention.

This option provides no security. We recommend that you choose this option
only for closed, secure environments.

By Existing Certificate (Precedenceto L SC)—Installs or upgrades, deletes,
or troubleshoots a locally significant certificate if a manufacture-installed
certificate (MIC) or locally significant certificate (LSC) exists in the phone.
If an LSC exists in the phone, authentication occurs through the LSC,
regardless whether a MIC exists in the phone. If a MIC and an LSC exist in
the phone, authentication occurs through the LSC. If an LSC does not exist
in the phone, but a MIC exists, authentication occurs through the MIC.

Before you choose this option, verify that a certificate exists in the phone.
If you choose this option and no certificate exists in the phone, the operation
fails.

At any time, the phone uses only one certificate to authenticate to CAPF
although a MIC and an LSC can exist in the phone at the same time. If the
primary certificate, which takes precedence, becomes compromised for any
reason, or, if you want to authenticate through the other certificate, you must
update the authentication mode.

By Existing Certificate (Precedenceto M | C)—Installs or upgrades, deletes,
or troubleshoots a locally significant certificate if an LSC or MIC exists in
the phone. If a MIC exists in the phone, authentication occurs through the

MIC, regardless whether an LSC exists in the phone. If an LSC exists in the
phone, but a MIC does not exist, authentication occurs through the LSC.

Before you choose this option, verify that a certificate exists in the phone.
If you choose this option and no certificate exists in the phone, the operation
fails.

The CAPF settings that are configured in the Phone Security Profile
window interact with the CAPF parameters that are configured in the
Phone Configuration window.
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Setting Description
Key Order This field specifies the sequence of the key for CAPF. Select one of the following
values from the drop-down list:
* RSA Only
* EC Only

* EC Preferred, RSA Backup

Note When you add a phone, that is based on the value in Key Order, RSA
Key Size, and EC Key Size fields, the device security profile is
associated with the phone. If you select the EC Only value, with the
EC Key Sizevalue of 256 bits, then the device security profile appends
with EC-256 value.

RSA Key Size (Bits) From the drop-down list box, choose one of the values—512, 1024, 2048, 3072,
or 4096.

Note Some phone models may fail to register if the RSA key length that is
selected for the CallManager Certificate Purposeis greater than 2048.
From the Unified CM Phone Feature List Report on the Cisco Unified
Reporting Tool (CURT), you can check the 3072/4096 RSA key size
support feature for the list of supported phone models.

EC Key Size (Bits) From the drop-down list, choose one of the values—256, 384, or 521.

The following table describes the settings for the security profile for the phone that is running SIP.

Table 22: Security Profile for Phone That Is Running SIP

Setting Description

Name Enter a name for the security profile.

When you save the new profile, the name displays in the Device Security Profile
drop-down list in the Phone Configuration window for the phone type and

protocol.
Tip Include the device model and protocol in the security profile name to
help you find the correct profile when you are searching for or updating
a profile.
Description Enter a description for the security profile.
Nonce Validity Time Enter the number of minutes (in seconds) that the nonce value is valid. The default

value equals 600 (10 minutes). When the time expires, Unified Communications
Manager generates a new value.

Note A nonce value, a random number that supports digest authentication,
gets used to calculate the MDS5 hash of the digest authentication
password.
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Setting

Description

Device Security Mode

From the drop-down list, choose one of the following options:

» Non Secure—No security features except image, file, and device
authentication exist for the phone. A TCP connection opens to Unified
Communications Manager.

+ Authenticated—Unified Communications Manager provides integrity and
authentication for the phone. A TLS connection that uses NULL/SHA opens
for signaling.

* Encrypted—Unified Communications Manager provides integrity,
authentication, and encryption for the phone. A TLS connection that uses
AES128/SHA opens for signaling, and SRTP carries the media for all phone
calls on all SRTP-capable hops.

Note If the trunks are configured with Device Security Profile option
selected as Authenticated, then Unified Communications Manager
starts a TLS connection that uses NULL SHA cipher (without
data encryption). These trunks will not register or make calls if
the destination devices do not support NULL SHA cipher. For
destination devices that do not support NULL SHA cipher, the
trunks should be configured with Device Security Profile option
selected as Encrypted. With this device security profile, the trunks
offer additional TLS ciphers that enables data encryption.

Transport Type

When Device Security Mode is Non Secur e, choose one of the following options
from the drop-down list (some options may not display):

* TCP—Choose the Transmission Control Protocol to ensure that packets get
received in the same order as the order in which they are sent. This protocol
ensures that no packets get dropped, but the protocol does not provide any
security.

* UDP—Choose the User Datagram Protocol to ensure that packets are
received quickly. This protocol, which can drop packets, does not ensure
that packets are received in the order in which they are sent. This protocol
does not provide any security.

* TCP + UDP—Choose this option if you want to use a combination of TCP
and UDP. This option does not provide any security.

When Device Security Mode is Authenticated or Encrypted, TLS specifies the
Transport Type. TLS provides signaling integrity, device authentication, and
signaling encryption (encrypted mode only) for SIPphones.

If Device Security Mode cannot be configured in the profile, the transport type
specifies UDP.
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Setting

Description

Enable Digest
Authentication

If you check this check box, Unified Communications Manager challenges all
SIP requests from the phone.

Digest authentication does not provide a device authentication, integrity, or
confidentiality. Choose a security mode of authenticated or encrypted to use these
features.

TFTP Encrypted Config

When this check box is checked, Unified Communications Manager encrypts the
phone downloads from the TFTP server. This option exists for Cisco phones
only.

Tip We recommend that you enable this option and configure a symmetric
key to secure digest credentials and administrative passwords.

Enable OAuth
Authentication

This check box is available, when you choose Encrypted from the Device
Security Profile drop-down list.

When this check box is checked, Unified Communications Manager allows the
device that is associated with the phone security profile to register on the SIP
OAuth port. By default, this check box is unchecked.

You can enable the SIP OAuth when:
* Transport type is TLS.
* Device security mode is encrypted.
* Digest authentication is disabled.

* Encrypted configuration is disabled.

Note From Unified Communications Manager Release 12.5, Jabber devices
support SIP OAuth authentication.

Exclude Digest
Credentials in
Configuration File

When this check box is checked, Unified Communications Manager omits digest
credentials in the phone downloads from the TFTP server. This option exists for
Cisco IP Phones, 7942, and 7962 (SIP only).
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Setting

Description

Authentication Mode

This field allows you to choose the authentication method that the phone uses
during the CAPF certificate operation. This option exists for Cisco phones only.

From the drop-down list, choose one of the following options:

Note

By Authentication String—Installs or upgrades or troubleshoots a locally
significant certificate only when the user enters the CAPF authentication
string on the phone.

By Null String—Installs or upgrades or troubleshoots a locally significant
certificate without the user intervention.

This option provides no security; we recommend that you choose this option
only for closed, secure environments.

By Existing Certificate (Precedence to L SC)—Installs or upgrades or
troubleshoots a locally significant certificate if a manufacture-installed
certificate (MIC) or locally significant certificate (LSC) exists in the phone.
If an LSC exists in the phone, authentication occurs through the LSC,
regardless whether a MIC exists in the phone. If an LSC does not exist in
the phone, but a MIC does exist, authentication occurs through the MIC.

Before you choose this option, verify that a certificate exists in the phone.
If you choose this option and no certificate exists in the phone, the operation
fails.

At any time, the phone uses only one certificate to authenticate to CAPF
although a MIC and an LSC can exist in the phone at the same time. If the
primary certificate, which takes precedence, becomes compromised for any
reason, or, if you want to authenticate through the other certificate, you must
update the authentication mode.

By Existing Certificate (Precedence to M I C)—Installs or upgrades or
troubleshoots a locally significant certificate if an LSC or MIC exists in the
phone. If a MIC exists in the phone, authentication occurs through the MIC,
regardless whether an LSC exists in the phone. If an LSC exists in the phone,
but a MIC does not exist, authentication occurs through the LSC.

Before you choose this option, verify that a certificate exists in the phone.
If you choose this option and no certificate exists in the phone, the operation
fails.

The CAPF settings that are configured in the Phone Security Profile
window interact with the CAPF parameters that are configured in the
Phone Configuration window.
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Setting Description

Key Size For this setting that is used for CAPF, choose the key size for the certificate from
the drop-down list. The default setting equals 1024. The other option for key size
is 512.

If you choose a higher key size than the default setting, the phones take longer
to generate the entropy that is required to generate the keys. Key generation,
which is set at low priority, allows the phone to function while the action occurs.
Depending on the phone model, you may notice that key generation takes up to
30 or more minutes to complete.

Note The CAPF settings that are configured in the Phone Security Profile
window interact with the CAPF parameters that are configured in the
Phone Configuration window.

SIP Phone Port This setting applies to phones that are running SIP that uses UDP transport.

Enter the port number for Cisco Unified IP Phone (SIP only) that use UDP to
listen for SIP messages from Unified Communications Manager. The default
setting equals 5060.

Phones that use TCP or TLS ignore this setting.

Apply Security Profiles to Phone

Step 1
Step 2

Step 3
Step 4

Before you apply a security profile that uses certificates for authentication of the phone, make sure that the
particular phone contains a Locally Significant Certificate (LSC) or Manufacture-Installed Certificate (MIC).

To enable security features for a phone, you must configure a new security profile for the device type and
protocol and apply it to the phone. However, if the phone does not contain a certificate, perform the following
tasks:

« In the Phone Configuration window, apply a non-secure profile.
* In the Phone Configuration window, install a certificate by configuring the CAPF settings.

« In the Phone Configur ation window, apply a device security profile that is configured for authentication
or encryption.

To apply a phone security profile to a device, perform the following procedure:

Procedure

Go to the Protocol Specific I nformation section in the Phone Configuration window.

From the Device Security Profile drop-down list, choose the security profile that applies to the device.
The phone security profile that is configured only for the phone type and the protocol is displayed.

Click Save.
To apply the changes to the applicable phone, click Apply Config.
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. Synchronize Phone Security Profile with Phones

Note To delete security profiles, check the check boxes next to the appropriate security profile in the
Find and List window, and click Delete Selected.

Synchronize Phone Security Profile with Phones

Step 1
Step 2

Step 3
Step 4
Step 5
Step 6

Step 7

To synchronize phone security profile with phones, perform the following procedure:

Procedure

From Unified Communications Manager Administration, choose System > Security Profile> Phone Security
Profile.

Choose the search criteria to use and click Find.
The window displays a list of phone security profiles that match the search criteria.

Click the phone security profile to which you want to synchronize the applicable phones.
Make any additional configuration changes.
Click Save.

Click Apply Config.
The Apply Configuration Information dialog box appears.

Click OK.

Delete Phone Security Profile

Step 1

Step 2

Before you can delete a security profile from Unified Communications Manager, you must apply a different
profile to the devices or delete all devices that use the profile.

To find out which devices use the profile, perform Step 1:

Procedure

In the Security Profile Configuration window, choose Dependency Recor ds from the Related Links
drop-down list and click Go.

If the dependency records feature is not enabled for the system, go to System > Enterprise Parameters
Configuration and change the Enable Dependency Records setting to True. A message displays information
about high CPU consumption that relates to the dependency records feature. Save your change to activate
dependency records. For more information about dependency records, see System Configuration Guide for
Cisco Unified Communications Manager

This section describes how to delete a phone security profile from the Unified Communications Manager
database.

Find the security profile to delete.
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Step 3

Step 4

Step 5

Find Phones with Phone Security Profiles .

To delete multiple security profiles, check the check boxes next to the appropriate check box in the Find and
List window; then, click Delete Selected. You can delete all configurable records for this selection by clicking
Select All and then clicking Delete Selected.

To delete a single security profile, perform one of the following tasks:

a) Inthe Find and List window, check the check box next to the appropriate security profile; then, click
Delete Selected.

When prompted to confirm the delete operation, click OK to delete or Cancel to cancel the delete operation.

Find Phones with Phone Security Profiles

Step 1
Step 2

Step 3

Step 4

To find the phones that use a specific security profile, perform the following procedure:

Procedure

From Cisco Unified Communications Manager Administration, choose Device > Phone.
From the first drop-down list, choose the search parameter Security Profile.

a) From the drop-down list, choose a search pattern.
b) Specify the appropriate search text, if applicable.

Note To add additional search criteria, click +. When you add criteria, the system searches for a
record that matches all criteria that you specify. To remove criteria, click — to remove the last
added criterion or click Clear Filter to remove all added search criteria.

Click Find.

All matching records display. You can change the number of items that display on each page by choosing a
different value from the Rows per Page drop-down list.

From the list of records that display, click the link for the record that you want to view.

Note To reverse the sort order, click the up or down arrow, if available, in the list header.

The window displays the record that you choose.

SIP Trunk Security Profile Interactions and Restrictions

The following table contains feature interactions and restrictions for SIP Trunk Security Profiles.
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. SIP Trunk Security Profile Interactions and Restrictions

Table 23: SIP Trunk Security Profile Interactions and Restrictions

Feature Interactions and Restrictions
90-day Evaluation You cannot deploy a secure SIP trunk while running with a 90-day evaluation
License period. To deploy a secure SIP trunk, your system must have registered to a Smart

Software Manager account with the Allow export-controlled functionality
product registration token selected.

. Security Guide for Cisco Unified Communications Manager, Release 11.5(1)SU10




CHAPTER 9

Secure and Nonsecure Indication Tone Setup

This chapter provides information about secure and nonsecure indication tone setup. The system plays secure
and nonsecure indication tones on a protected phone to indicate whether a call is encrypted.

* Secure and Non-Secure Indication Tone Overview, on page 127
* Secure and Non-Secure Indication Tone Tips, on page 128
* Secure and Non-Secure Indication Tone Configuration Tasks , on page 129

Secure and Non-Secure Indication Tone Overview

The Secure Tone feature can configure a phone to play a secure indication tone when a call is encrypted. The
tone indicates that the call is protected and that confidential information may be exchanged. The 2-second
tone comprises three long beeps. If the call is protected, the tone begins to play on a protected phone as soon
as the called party answers.

When the call is not protected, the system plays a non-secure indication tone, which comprises six short beeps,
on a protected phone. For video calls, you might first hear secure indication tone for the audio portion of the
call and then non-secure indication tone for overall non-secure media.

The secure and non-secure indication tones are supported on the following types of calls:
* Intracluster to IP-to-IP calls
* Intercluster protected calls

* [P-to-Time-Division-Multiplexing (TDM) calls through a protected MGCP E1 PRI gateway

\}

Note Only callers on protected phones can hear secure and non-secure indication tones. Callers on phones that are
not protected never hear these tones. For video calls, the system plays secure and non-secure indication tones
on protected devices.

Protected Devices

Configuration designates a protected device in Unified Communications Manager. You can configure only
supported Cisco Unified IP Phones and MGCP E1 PRI gateways as protected devices in Unified
Communications Manager.
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Unified Communications Manager can also direct an MGCP 10S gateway to play secure and nonsecure
indication tones when the system determines the protected status of a call.

You can make the following types of calls that can use the secure and nonsecure indication tones:
* Intracluster IP-to-IP calls

* Intercluster calls that the system determines are protected

* [P-to-Time-Division-Multiplexing (TDM) calls through a protected MGCP E1 PRI gateway

Supported Devices

You can use Cisco Unified Reporting to determine which Cisco IP Phone models support secure and nonsecure
indication tones. From Cisco Unified Reporting, click Unified CM Phone Feature List. For the Feature
pull-down menu, choose Secure Tone. The system displays a list of products that support the feature.

For more information about using Cisco Unified Reporting, see the Cisco Unified Reporting Administration
Guide.

Secure and Non-Secure Indication Tone Tips

This section provides information that pertains to the impact of using the secure indication tone feature:
* Following are the facts about protected devices:

* You can configure phones that are running SCCP or SIP as protected devices.

* Protected devices that call non-protected devices that are encrypted play the secure tone, while
protected devices that call non-protected and non-encrypted devices play a non-secure tone.

* When a protected phone calls another protected phone, and the media is not encrypted, the call does
not drop. The system plays non-secure indication tone to the phones on the call.

* For video calls, the system plays secure and non-secure indication tones on protected devices.

N

Note For video calls, the user may first hear secure indication tone for the audio portion
of the call and then non-secure indication tone for overall non-secure media.

* A lock icon that displays on a Cisco IP Phone indicates that the media is encrypted, but does not necessarily
mean that the phone has been configured as a protected device. However, the lock icon must be present
for a protected call to occur.

* The following services and features are impacted:

» Multiline supplementary services (such as call transfer, conference, and call waiting) are supported
on protected phones. When the user invokes a supplementary service on a protected phone, the
system plays secure or non-secure indication tone to reflect the updated status of the call.

* Cisco Extension Mobility and Join Across Line services are disabled on protected phones.

* Shared-line configuration is not available on protected phones.
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» Hold/Resume and Call Forward All are supported for protected calls.

* Following are the facts about MGCP E1 PRI gateways:

* You must configure the MGCP gateway for SRTP encryption. Configure the gateway using the
following command: mgcppackage-capabilitysrtp-package.

* The MGCP gateway must specify an Advanced IP Services or Advanced Enterprise Services image.
For example, c3745-adventerprisek9-mz.124-6.T.bin).

* Protected status gets exchanged with the MGCP E1 PRI gateway by using proprietary FacilitylE
in the MGCP PRI Setup, Alert, and Connect messages.

* Unified Communications Managerkey plays the secure indication tone only to the Cisco Unified
IP Phone. A PBX in the network plays the tone to the gateway end of the call.

* [f the media between the Cisco Unified IP Phone and the MGCP E1 PRI gateway is not encrypted,
the call drops.

)

Note For more information about encryption for MGCP gateways, refer to Media and
Signaling Authentication and Encryption Feature for Cisco IOS MGCP Gateways
for the version of Cisco 10S software that you are using.

Secure and Non-Secure Indication Tone Configuration Tasks

Make sure that you configure the following items for the secure tone to play:

« In the Phone Configur ation window, which you can navigate to by choosing Device> Phonein Unified
Communications Manager Administration, configure the following items:

* From the Softkey Template drop-down list in the Device I nfor mation portion of the window,
choose Standard Protected Phone.

A

Note  You must use a new softkey template without supplementary service softkeys
for a protected phone.

* For the Join Across Lines option (also in the Device I nformation portion of the window), choose
Off.

* Check the Protected Device check box (also in the Device I nfor mation portion of the window).

* From the Device Security Profile drop-down list (in the Protocol Specific I nformation portion
of the window), choose a secure phone profile that is already configured in the Phone Security
Profile Configuration window (System > Security Profile> Phone Security Profile).

* Go to the Directory Number Configuration window that displays when you add a directory number
from the Phone Configuration window. In the M ultiple Call/Call Waiting Settings on Device
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DeviceNamearea of the Directory Number Configuration window, set the following options to a value
of 1:

¢ Maximum Number of Calls

* Busy Trigger

* In Unified Communications Manager Administration, choose System > Service Parameter s. In the first
Service Parameter Configuration window, choose your server and choose the Cisco CallManager
service. In the second Service Parameter Configuration window, locate the Clusterwide Parameters
(Feature - Secure Tone) area, and set the Play Secure Indication Tone option to True. (The default
value specifies False.)

* If you are configuring a protected MGCP E1 PRI gateway, choose Device > Gateway > Add New in
Unified Communications Manager Administration and choose a supported gateway. Choose MCGP as
the protocol. When the Gateway Configuration window displays, specify the following configuration
choices:

* Set Global 1 SDN Switch Typeto Euro.

* After you complete the rest of the MGCP Gateway configuration, click Save; then, click the endpoint
icon that appears to the right of subunit 0 in the window. The Enable Protected Facility | E check
box displays. Check this check box.

This configuration allows the system to pass protected status of the call between Cisco Unified IP
Phone endpoints and the protected PBX phones that connect to the MGCP gateway.
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Encryption to Analog Endpoint Setup

This chapter provides information about encryption to analog endpoint setup. This feature enables you to
create a secure SCCP connection for analog phones to a Cisco VG2xx Gateway. The gateway uses Transport
Layer Security (TLS) with Unified Communications Manager for SCCP signaling communication and uses
SRTP for voice communication. The existing Unified Communications Manager TLS functionality, including
certificate management, is used for secure SCCP communication.

* Analog Phone Security Profile, on page 131
* Certificate Management for Secure Analog Phones, on page 131

Analog Phone Security Profile

To establish an encrypted connection to analog phones, you must create a Phone Security Profile for analog
phones with the Device Security Mode parameter set to Authenticated or Encrypted. To create a Phone
Security Profile, navigate to System > Security Profile> Phone Security Profilein Unified Communications
Manager Administration.

When you configure an analog phone attached to a Cisco VG2xx gateway, choose the secure analog profile
you created for the Device Security Profile parameter. To configure the Device Security Profile parameter,
navigate to Device > Phone in Unified Communications Manager Administration and scroll down to the
Protocol Specific Information section for the phone you want to configure.

Certificate Management for Secure Analog Phones

For secure analog phones to function, you must import the same CA-signed certificate into Cisco Unified
Communications Manager that is being used by the Cisco VG2xx Gateway. For more information about
importing certificates, see Chapter 6, “Security,” in the Administration Guide for Cisco Unified Communications
Manager .
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Certificate Authority Proxy Function

This chapter provides information about the certificate authority proxy function.

* About Certificate Authority Proxy Function, on page 133

* Cisco IP Phone and CAPF Interaction, on page 134

* CAPF Interaction with IPv6 Addressing, on page 135

* CAPF System Interactions and Requirements, on page 137

» CAPF in Cisco Unified Serviceability Setup, on page 137

* Set Up CAPF, on page 137

* Activate Certificate Authority Proxy Function Service, on page 138
» Update CAPF Service Parameters, on page 139

* Generate and Import Third Party CA-Signed LSCs, on page 139

* Install, Upgrade, Troubleshoot, or Delete Certificates From Phone Using CAPF, on page 140
* CAPF Settings, on page 140

* Find Phones by LSC Status or Authentication String, on page 142

* Generate CAPF Report, on page 143

* Enter Phone Authentication String, on page 144

* Verify Phone Authentication String, on page 145

About Certificate Authority Proxy Function

Certificate Authority Proxy Function (CAPF), which automatically installs with Cisco Unified Communications
Manager, performs the following tasks, depending on your configuration:

+ Authenticate via an existing Manufacturing Installed Certificate (MIC), Locally Significant Certificate
(LSC), randomly generated authentication string, or optional less secure “null” authentication.

* Issues locally significant certificates to supported Cisco IP Phones.
» Upgrades existing locally significant certificates on the phones.

* Retrieves phone certificates for viewing and troubleshooting.
During installation, a certificate that is specific for CAPF gets generated. This CAPF certificate, which the

Cisco CTL Client copies to all Cisco Unified Communications Manager servers in the cluster, uses the.0
extension.
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Cisco IP Phone and CAPF Interaction

When the phone interacts with CAPF, the phone authenticates itself to CAPF by using an authentication string,
existing MIC or LSC certificate, or “null,” generates its public key and private key pair, and then forwards
its public key to the CAPF server in a signed message. The private key remains in the phone and never gets
exposed externally. CAPF signs the phone certificate and then sends the certificate back to the phone in a
signed message.

Beginning from Cisco Unified Communications Manager Release 11.5(1) SU1, all the LSC certificates issued
by CAPF service are signed with SHA-256 algorithm. Therefore, Cisco IP Phones 6900, 7800, 7900, 8800,
8900, and 9900 series models supports SHA-256 signed LSC certificates and external SHA?2 identity certificates
(Tomcat, CallManager, CAPF, TVS, and so on). For any other cryptographic operation that require validation
of signature, only SHA-1 is supported.

\)

Note We recommend to use the Cisco Unified Communications Manager prior to 11.5(1) SU1 release. If you use
phone the models, which are in End of Software Maintenance or End of Life.

The following information applies when a communication or power failure occurs.

+ [f a communication failure occurs while the certificate installation is taking place on the phone, the phone
will attempt to obtain the certificate three more times in 30-second intervals. You cannot configure these
values.

* If a power failure occurs while the phone attempts a session with CAPF, the phone will use the
authentication mode that is stored in flash; that is, if the phone cannot load the new configuration file
from the TFTP server after the phone reboots. After the certificate operation completes, the system clears
the value in flash.

2

Ti

p Be aware that the phone user can abort the certificate operation or view the operation status on the phone.

2

Ti

p Key generation, which is set at low priority, allows the phone to function while the action occurs. You may
notice that key generation takes up to 30 or more minutes to complete.

Although the phone functions during certification generation, additional TLS traffic may cause minimal
call-processing interruptions with the phone; for example, audio glitches may occur when the certificate is
written to flash at the end of the installation.

Consider the following information about how CAPF interacts with the Cisco Unified IP Phone 7960G and
7940G when the phone is reset by a user or by Cisco Unified Communications Manager.

)

Note In the following examples, if the LSC does not already exist in the phone and if By Existing Certificate is
chosen for the CAPF Authentication Mode, the CAPF certificate operation fails.
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Example—Nonsecure Device Security Mode

In this example, the phone resets after you configure the Device Security Mode to Nonsecure and the CAPF
Authentication Mode to By Null String or By Existing Certificate (Precedence...). After the phone resets, it
immediately registers with the primary Cisco Unified Communications Manager and receives the configuration
file. The phone then automatically initiates a session with CAPF to download the LSC. After the phone installs
the LSC, configure the Device Security Mode to Authenticated or Encrypted.

Example—Authenticated/Encrypted Device Security Mode

In this example, the phone resets after you configure the Device Security Mode to Authenticated or Encrypted
and the CAPF Authentication Mode to By Null String or By Existing Certificate (Precedence...). The phone
does not register with the primary Cisco Unified Communications Manager until the CAPF session ends and
the phone installs the LSC. After the session ends, the phone registers and immediately runs in authenticated
or encrypted mode.

You cannot configure By Authentication String in this example because the phone does not automatically
contact the CAPF server; the registration fails if the phone does not have a valid LSC.

CAPF Interaction with IPv6 Addressing

CAPF can issue and upgrade certificates to a phone that uses an IPv4, an IPv6, or both types of addresses. To
issue or upgrade certificates for phones that are running SCCP that use an IPv6 address, you must set the
Enable IPv6 service parameter to True in Unified Communications Manager Administration.

When the phone connects to CAPF to get a certificate, CAPF uses the configuration from the Enable IPv6
enterprise parameter to determine whether to issue or upgrade the certificate to the phone. If the enterprise
parameter is set to False, CAPF ignores/rejects connections from phones that use [Pv6 addresses, and the
phone does not receive the certificate.

The following table describes how a phone that has an IPv4, IPv6, or both types of addresses connects to
CAPF.

Table 24: How IPv6 or IPv4 Phone Connects to CAPF

IP Mode of Phone IP Addresses on Phone | CAPF IP Address How Phone Connects to
CAPF
Two stack IPv4 and IPv6 available |IPv4, IPv6 Phone uses an IPv6

address to connect to
CAPF; if the phone
cannot connect via an
IPv6 address, it attempts
to connect by using an
IPv4 address.

Two stack 1Pv4 IPv4, IPv6 Phone uses an IPv4
address to connect to
CAPF.
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IP Mode of Phone IP Addresses on Phone | CAPF IP Address How Phone Connects to
CAPF

Two stack IPv6 IPv4, IPv6 Phone uses an IPv6
address to connect to
CAPF. If the attempt fails,
the phone uses an IPv4
address to connect to
CAPF.

Two stack IPv4 IPv4 Phone uses an IPv4
address to connect to
CAPF.

Two stack IPv4 and IPv6 available |IPv6 Phone uses and IPv6
address to connect to
CAPF.

Two stack IPv4 and IPv6 available |IPv4 Phone uses an IPv4
address to connect to
CAPF.

Two stack 1Pv4 IPv6 Phone cannot connect to
CAPF.

Two stack IPv6 IPv4 Phone cannot connect to
CAPF.

Two stack IPv6 IPv6 Phone uses an IPv6
address to connect to
CAPF.

IPv4 stack 1Pv4 IPv4, IPv6 Phone uses an IPv4
address to connect to
CAPF.

IPv6 stack IPv6 IPv4, IPv6 Phone uses an IPv6
address to connect to
CAPF.

IPv4 stack 1Pv4 1Pv4 Phone uses an IPv4
address to connect to
CAPF.

IPv4 stack IPv4 IPv6 Phone cannot connect to
CAPF.

IPv6 stack IPv6 IPv6 Phone uses an IPv6
address to connect to
CAPF.

IPv6 stack IPv6 1Pv4 Phone cannot connect to
CAPF.
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CAPF System Interactions and Requirements

The following requirements exist for CAPF:

* Before you use CAPF, ensure that you performed all necessary tasks to install and configure the CiscoCTL
Client. To use CAPF, you must activate the Cisco Certificate Authority Proxy Function service on the
first node.

* During a certificate upgrade or install operation, if By Authentication String is the CAPF authentication
method for the phone, you must enter the same authentication string on the phone after the operation, or
the operation will fail. If TFTP Encrypted Configuration enterprise parameter is enabled and you fail to
enter the authentication string, the phone may fail and may not recover until the matching authentication
string is entered on the phone.

Cisco strongly recommends that you use CAPF during a scheduled maintenance window because
generating many certificates at the same time may cause call-processing interruptions.

Ensure that the first node is functional and running during the entire certificate operation.

Ensure that the phone is functional during the entire certificate operation.

If a secure phone gets moved to another cluster, the Cisco Unified Communications Manager will not
trust the LSC certificate that the phone sends because it was issued by another CAPF, whose certificate
is not in the CTL file. To enable the secure phone to register, delete the existing CTL file. You can then
use the Install/Upgrade option to install a new LSC certificate with the new CAPF and reset the phone
for the new CTL file (or use the MIC). Use the Delete option in the CAPF section on the Phone
Configuration window to delete the existing LSC before you move the phones.

Tip  CiscolP Telephony Backup and Restore System (BARS) backs up the CAPF data and reports because Cisco

Unified Communications Manager stores the information in the Cisco Unified Communications Manager
database.

CAPF in Cisco Unified Serviceability Setup

You perform the following tasks in Cisco Unified Serviceability:
* Activate the Cisco Certificate Authority Proxy Function service.

* Configure trace settings for CAPF.

Refer to the Cisco Unified Serviceability Administration Guides for more information.

Set Up CAPF

Perform the following tasks to install, upgrade, or troubleshoot locally significant certificates.
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. Activate Certificate Authority Proxy Function Service

Step 1

Step 2

Step 3

Step 4
Step 5

Step 6

Activate

Step 1
Step 2

Step 3
Step 4

Procedure

Determine whether a locally significant certificate exists in the phone.

Determine whether you need to copy CAPF data to the Unified Communications Manager publisher database
server. For more information, see the Cisco IP Phone Administration Guide for your phone model.

Tip If you used the CAPF utility with Unified Communications Manager 4.0 and verified that the CAPF
data exists in the Unified Communications Manager database, you can delete the CAPF utility that
you used with Unified Communications Manager 4.0.

Verify that the Cisco Certificate Authority Proxy Function service is running.

Tip This service must run during all CAPF operations. It must also run for the CiscoCTL Client to
include the CAPF certificate in the CTL file.

Verify that you performed all necessary tasks to install and configure the CiscoCTL Client. Ensure that the
CAPF certificate exists in the CiscoCTL file.

If necessary, update CAPF service parameters.

To install, upgrade, or troubleshoot locally significant certificates in the phone, use Unified Communications
Manager Administration.

If it is required for certificate operations, enter the authentication string on the phone.

Certificate Authority Proxy Function Service

Cisco Unified Communications Manager does not automatically activate the Certificate Authority Proxy
Function service in Cisco Unified Serviceability.

If you did not activate this service before you installed and configured the Cisco CTL Client, you must update
the CTL file. Activate this service only on the first node.

To activate the service, perform the following procedure:

Procedure

In Cisco Unified Serviceability, choose Tools> Service Activation.

From the Serversdrop-down list box, choose the server on which you want to activate the Certificate Authority
Proxy Function service.

Check the Certificate Authority Proxy Function check box.
Click Save.
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Update CAPF Service Parameters

The CAPF Service Parameter window provides information on the number of years that the certificate is valid,
the maximum number of times that the system retries to generate the key, and so on.

For the CAPF service parameters to show Active status in Cisco Unified Communications Manager
Administration, you must activate the Certificate Authority Proxy Function service.

To update the CAPF service parameters, perform the following procedure:

Procedure
Step 1 In Cisco Unified Communications Manager Administration, choose System > Service Parameters.
Step 2 From the Server drop-down list box, choose the server.

Tip You must choose the first node in the cluster.
Step 3 From the Service drop-down list box, choose the CiscoCertificate Authority Proxy Function service.

Step 4 Update the CAPF service parameters, as described in help that displays for the parameter.

Note To display help for the CAPF service parameters, click the question mark or the parameter name
links.

Step 5 For the changes to take effect, restart the Cisco Certificate Authority Proxy Function service.

Generate and Import Third Party CA-Signed LSCs

CAPF LSCs are locally signed. However, you may require phones to use third party CA signed LSCs.

)

Note Perform Steps 1 and 2 once and repeat the remaining steps until you configure all require phone LSC operations.

Procedure
Step 1 Import the third party CA certificate into the Unified Communications Manager trust store.
Step 2 Follow these steps to configure the service parameter Certificate Issuer to Endpoint:

a) In Cisco Unified CM Administration, select System > Service Parameter.

b) Select your Unified Communications Manager server frop the drop-down list box.

¢) Under the service drop-down list box, select Cisco Certificate Authority Proxy Function.
d) For the service parameter Certificate Issuer to Endpoint, select Offline CA.

Step 3 Check CSR generation progress. After the phones reregister, use the CLI command utils capf csr countto
check whether the CSRs are generated.
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Step 4

Step 5

Step 6

Dump the CSRs to the desired location (local directory or remote directory through FTP or TFTP) by using
the CLI command utils capf csr dump.
The CLI tars and zip the CSRs into a single file (. tgz) before uploading.

When all the signed certificates are provided by the CA, you need to tar and zip all the certificates into a single
file using the Linux command tar cvzf <filename.tgz> *.der.

Use the CLI command utilscapf cert import to import the certificates into Unified Communications Manager.
Note The imported certificate must be in DER format, and they must be tarred in a flat file structure.

The CLI command untars the file, and parses and verifies each certificate. If the certificates are valid, they
are sent to the phones, and the corresponding CSR is deleted.

What to do next

To remove all the CSRs and certificates that were previously built and imported, you can use the command
utils capf csr delete.

Install, Upgrade, Troubleshoot, or Delete Certificates From
Phone Using CAPF

Step 1
Step 2

Step 3
Step 4
Step 5

Perform the following procedure to use the Certificate Authority Proxy Function:

Procedure

Find the phone, as described in the Administration Guide for Cisco Unified Communications Manager .

After the search results display, locate the phone where you want to install, upgrade, delete, or troubleshoot
the certificate and click the Device Name (Line) link for that phone.

Enter the configuration settings, as described in Table 25: CAPF Configuration Settings, on page 141.
Click Save.
Click Reset.

CAPF Settings

The following table describes the CAPF settings in the Phone Configuration window in Cisco Unified
Communications Manager Administration.
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Table 25: CAPF Configuration Settings

cAPF Settings ]

Setting

Description

Certificate Operation

From the drop-down list box, choose one of the
following options:

» No Pending Oper ation—Displays when no
certificate operation is occurring. (default setting)

* Install/Upgrade—Installs a new or upgrades an
existing locally significant certificate in the
phone.

 Delete—Deletes the locally significant certificate
that exists in the phone.

* Troubleshoot—Retrieves the locally significant
certificate (LSC) or the manufacture-installed
certificate (MIC), so you can view the certificate
credentials in the CAPF trace file. If both
certificate types exist in the phone, Cisco Unified
Communications Manager creates two trace files,
one for each certificate type.

Tip By choosing the Troubleshoot option,
you can verify that an LSC or MIC
exists in the phone. The Delete and
Troubleshoot options do not display
if a certificate does not exist in the
phone.

Authentication String

If you chose the By Authentication String option, this
field applies. Manually enter a string or generate a
string by clicking the Generate String button. Ensure
that the string contains 4 to 10 digits.

To install, upgrade, or troubleshoot a locally
significant certificate, the phone user or administrator
must enter the authentication string on the phone.

Generate String

If you want CAPF to automatically generate an
authentication string, click this button. The 4- to
10-digit authentication string displays in the
Authentication String field.

Security Guide for Cisco Unified Communications Manager, Release 11.5(1)SU10 .



. Find Phones by LSC Status or Authentication String

Security for Cisco IP Phone and Cisco Voice-Messaging Ports |

Setting

Description

Key Order

This field specifies the sequence of the key for CAPF.
Select one of the following values from the drop-down
list:

* RSA Only
« EC Only
* EC Preferred, RSA Backup

Note When you add a phone based on the value
in Key Order, RSA Key Size, and EC
Key Sizefields, the device security profile
is associated with the phone. If you select
the EC Only value with the EC Key Size
value of 256 bits then the device security
profile appends with EC-256 value.

RSA Key Size (Bits)

From the drop-down list box, choose one of the these
values—512, 1024, or 2048.

EC Key Size (Bits)

From the drop-down list box, choose one of the these
values—256, 384, or 521.

Operation Completes by

This field, which supports all certificate operation
options, specifies the date and time by which you must
complete the operation.

The values that display apply for the first node.

Operation Status

This field displays the progress of the certificate
operation; for example, <operation type> pending,
failed, or successful, where operating type equals the
Install/Upgrade, Delete, or Troubleshoot certificate
operation options. You cannot change the information
that displays in this field.

Find Phones by LSC Status or Authentication String

To find phones on the basis of certificate operation status or the authentication string, perform the following

procedure:

Procedure

Step 1 In Cisco Unified Communications Manager Administration, choose Device > Phone.

The Find and List window displays. Records from an active (prior) query may also display in the window.

Step 2 From the first drop-down list box, choose one of the following options:
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Step 3
Step 4

Step 5

Step 6

Generate CAPF Report .

a) LSC Status— Choosing this option returns a list of phones that use CAPF to install, upgrade, delete, or
troubleshoot locally significant certificates.

b) LSC Expires- Choosing this option returns a list of phones based on the specified Isc expiration search
criteria.

¢) LSC Issued by - Choosing this option returns a list of phones based on the specified Isc issued by search
criteria.

d) LSC Issuer Expiresby - Choosing this option returns a list of phones based on the specified Isc issuer
expires by search criteria.

e) Authentication String—Choosing this option returns a list of phones with an authentication string that
is specified in the Authentication String field.

From the second drop-down list box, choose a search pattern.

Specify the appropriate search text, if applicable.

Note To add additional search criteria, click the + button. When you add criteria, the system searches for
a record that matches all criteria that you specify. To remove criteria, click the — button to remove
the last added criterion or click the Clear Filter button to remove all added search criteria.

Click Find.

All matching records display. You can change the number of items that display on each page by choosing a
different value from the Rows per Page drop-down list box.

From the list of records that display, click the link for the record that you want to view.

Note To reverse the sort order, click the up or down arrow, if available, in the list header.

The window displays the item that you choose.

Generate CAPF Report

Step 1

Step 2

If you want to do so, you can generate a CAPF report to view the status of the certificate operation, the
authentication string, security profile, authentication mode, and so on. The report includes information such
as device name, device description, security profile, authentication string, authentication mode, LSC status,
and so on.

To generate a CAPF report, perform the following procedure:

Procedure

In Cisco Unified Communications Manager Administration, choose Device > Phone.

The Find/List window displays. Records from an active (prior) query may also display in the window.

To find all records in the database, ensure the dialog box is empty; go to Step 3, on page 144.
To filter or search records

a) From the first drop-down list box, choose a search parameter.
b) From the second drop-down list box, choose a search pattern.
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Step 3

Step 4
Step 5
Step 6

¢) Specify the appropriate search text, if applicable.

Note To add additional search criteria, click the + button. When you add criteria, the system searches
for a record that matches all criteria that you specify. To remove criteria, click the — button to
remove the last added criterion or click the Clear Filter button to remove all added search
criteria.

Click Find.

All matching records display. You can change the number of items that display on each page by choosing a
different value from the Rows per Page drop-down list box.

In the Related Links drop-down list box, choose CAPF Report in File; then, click Go.

Save the file to a location that you will remember.

Use Microsoft Excel to open the.csv file.

Enter Phone Authentication String

Step 1
Step 2
Step 3
Step 4
Step 5

If you chose the By Authentication String mode and generated an authentication string, you must enter the
authentication string on the phone to install the locally significant certificate.

Je

Tip  The authentication string applies for one-time use only. Obtain the authentication string that displays in the
Phone Configuration window or in the CAPF report.

Before you begin
Before you enter the authentication string on the phone, verify that the following conditions are met:

» The CAPF certificate exists in the CTL file.

* You activated the Cisco Certificate Authority Proxy Function service.

* The first node functions and runs. Ensure that the server runs for each certificate installation.
* The device has registered.

* A signed image exists on the phone; refer to the Cisco IP Phone Administration Guide.

Procedure

Press the Applications button on the phone.

If the configuration is locked, press **# (asterisk, asterisk, pound sign) to unlock it.

Scroll down the Settings menu. Highlight “Security Configuration” and press the Select softkey.

Scroll down the Security Configuration menu. Highlight “LSC” and press the Update softkey.

When prompted for the authentication string, enter the string that the system provides and press the Submit
softkey.

The phone installs, updates, deletes, or fetches the certificate, depending on the current CAPF configuration.
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You can monitor the progress of the certificate operation by viewing the messages that display on the phone.
After you press Submit, the message “Pending” displays under the LSC option. The phone generates the
public and private key pair and displays the information on the phone. When the phone successfully completes
the process, the phone displays a successful message. If the phone displays a failure message, you entered the
wrong authentication string or did not enable the phone for upgrade.

You can stop the process by choosing the Stop option at any time.

Verify Phone Authentication String

You can verify that the certificate is installed on the phone by pressing the Applicationsbutton and selecting
the Model Information menu.
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Encrypted Phone Configuration File Setup

This chapter provides information about encrypted phone configuration files setup. After you configure
security-related settings, the phone configuration file contains sensitive information, such as digest passwords
and phone administrator passwords. To ensure privacy of the configuration file, you must configure the
configuration files for encryption.

* TFTP Encrypted Configuration Files Overview, on page 147

* Phone Models That Support Encryption, on page 149

* TFTP Encrypted Configuration Files Tips, on page 150

* Encryption for Phone Configuration File Task Flow, on page 151

* Disable TFTP Encrypted Configuration Files, on page 156

* Exclude Digest Credentials From Phone Configuration File Download, on page 157

TFTP Encrypted Configuration Files Overview

TFTP configuration protects your data during device registration by encrypting the configuration file that the
phone downloads from the TFTP server during the registration process. This file contains confidential
information such as usernames, passwords, IP addresses, port details, phone SSH credentials, and so on. If
this feature is not configured, the configuration file is sent in cleartext. Deploying this feature ensures that an
attacker cannot intercept this information during the registration process. This information is unencrypted and
sent in cleartext. Hence, we recommend that you encrypt the TFTP configuration file in order to protect your
data.

A

Warning  If you have enabled the digest authentication option for SIP phones and disabled the TFTP encrypted
configuration option, the digest credentials are sent in the cleartext.

After TFTP configuration, the TFTP server:

* Deletes all the cleartext configuration files on disk

* Generates encrypted versions of the configuration files

If the phone supports encrypted phone configuration files and you have performed the tasks for phone
configuration file encryption, the phone requests an encrypted version of the configuration file.

Some phones don't support encrypted phone configuration files. The phone model and protocol determine the
method that the system uses to encrypt the configuration file. Supported methods rely on Unified
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Communications Manager functionality and a firmware load that supports encrypted configuration files. If
you downgrade the phone firmware load to a version that doesn't support encrypted configuration files, the
TFTP server offers an unencrypted configuration file that provides minimal configuration settings, and the
phone may not perform as expected.

Encryption Key Distribution

To ensure that you maintain the privacy of the key information, we recommend that you perform the tasks
that are associated with encrypted phone configuration files in a secure environment.

Unified Communications Manager supports the following methods:
* Manual key distribution
» Symmetric key encryption with a phone public key
The setup information provided for manual key distribution and symmetric key encryption with a phone public

key assume that you have configured mixed mode and enabled the TFTP Encrypted Config option in Cisco
Unified CM Administration.

Manual Key Distribution

With manual key distribution, a 128- or 256-bit symmetric key, which is stored in the Unified Communications
Manager database, encrypts the phone configuration file after the phone resets. To determine the key size for
your phone model.

To encrypt the configuration file, the administrator can either manually enter the key into or prompt Unified
Communications Manager to generate the key in the Phone Configuration window. After the key exists in
the database, the administrator or user must enter the key into the phone by accessing the user interface on
the phone; the phone stores the key in flash as soon as you press the Accept softkey. After the key is entered,
the phone requests an encrypted configuration file after it is reset. After the required tasks occur, the symmetric
key uses RC4 or AES 128 encryption algorithms to encrypt the configuration file. To determine which phones
use the RC4 or AES 128 encryption algorithms, see Phone Models That Support Encryption, on page 149.

When the phone contains the symmetric key, the phone always requests the encrypted configuration file.Unified
Communications Manager downloads the encrypted configuration file to the phone, which the TFTP server
signs. Not all phone types validate the signer of the configuration file.

The phone decrypts the file contents by using the symmetric key that is stored in flash. If decryption fails, the
configuration file does not get applied to the phone.

Je

Tip

If the TFTP Encrypted Config setting gets disabled, administrators must remove the symmetric key from the
phone GUI, so the phone requests an unencrypted configuration file the next time that it is reset.

Symmetric Key Encryption with Phone Public Key

If the phone contains a manufacturing-installed certificate (MIC) or a locally significant certificate (LSC),
the phone contains a public and private key pair, which are used for PKI encryption.

If you are using this method for the first time, the phone compares the MDS5 hash of the phone certificate in
the configuration file to the MD5 hash of the LSC or MIC. If the phone does not identify a problem, the phone
requests an encrypted configuration file from the TFTP server after the phone resets. If the phone identifies
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a problem, for example, the hash does not match, the phone does not contain a certificate, or the MDS5 value
is blank, the phone attempts to initiate a session with CAPF unless the CAPF authentication mode equals By
Authentication String (in which case, you must manually enter the string). The Certificate Authority Proxy
Function (CAPF) authenticates Cisco IP Phones to Unified Communications Manager and issues phone
certificates (LSCs). CAPF extracts the phone public key from the LSC or MIC, generates a MD5 hash, and
stores the values for the public key and certificate hash in the Unified Communications Manager database.
After the public key gets stored in the database, the phone resets and requests a new configuration file.

After the public key exists in the database and the phone resets, the symmetric key encryption process begins
after the database notifies TFTP that the public key exists for the phone. The TFTP server generates a 128-bit
symmetric key, which encrypts the configuration file with the Advanced Encryption Standard (AES)128
encryption algorithm. Then, the phone public key encrypts the symmetric key, which it includes in the signed
envelope header of the configuration file. The phone validates the file signing, and, if the signature is valid,
the phone uses the private key from the LSC or MIC to decrypt the encrypted symmetric key. The symmetric

key then decrypts the file contents.

Every time that you update the configuration file, the TFTP server automatically generates a new key to
encrypt the file.

Je

Tip

For phones that support this encryption method, the phone uses the encryption configuration flag in the
configuration file to determine whether to request an encrypted or unencrypted file. If the TFTP Encrypted
Conlfig setting is disabled, and Cisco IP Phones that support this encryption method request an encrypted file
(.enc.sgn file), Unified Communications Manager sends a 'file not found error' to the phone. The phone then
requests an unencrypted, signed file (.sgn file).

If the TFTP Encrypted Config setting is enabled but the phone requests an unencrypted configuration file for
some reason, the TFTP server offers an unencrypted file that contains minimal configuration settings. After
the phone receives the minimum configuration, the phone can detect error conditions, such as key mismatch,
and may start a session with CAPF to synchronize the phone public key with the Unified Communications
Manager database. If the error condition is resolved, the phone requests an encrypted configuration file the
next time that it resets.

Phone Models That Support Encryption

You can encrypt the phone configuration file for the following Cisco Unified IP Phones:

Phone Model and Protocol Encryption Method

Cisco Unified IP Phone 7800 or 6921 Manual key distribution—Encryption algorithm:

RC4Key size: 256 bits
File signing support: No

Cisco Unified IP Phone 7942 or 7962 (SIP only) Manual key distribution—Encryption algorithm:

Advanced Encryption Standard (AES)128Key size:
128 bits

File signing support: These phones that are running
SIP receive signed, encrypted configuration files but
ignore the signing information.
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Phone Model and Protocol Encryption Method

Cisco Unified IP Phone 6901, 6911, 6921, 6941, 6945, | Symmetric key encryption with phone public key (PKI
and 6961 encryption)—Encryption algorithm: AES128Key size:

Cisco Unified IP Phone 7970G, 7971G, 7975G; Cisco | 125 115

Unified IP Phone 7961G, 7962G, or 7965G;Cisco | File signing support: Yes

Unifed P Phone 7911G; Cisco Unifed 1P Phone |10 Cisco Unified P Phones 6901 and 6911
’ do not request for the ITL file as they do

7906G not support security by default. Therefore,
Cisco Unified IP Phone 7971G-GE, 7961G-GE, the Unified Communications Manager
7941G-GE cluster should be set to secure (Mixed)

mode for the Cisco Unified IP Phones 6901
and 6911 to get the Cisco CTL file
containing Cisco Certificate Authority
Proxy Function (CAPF) details for the
Cisco Unified IP Phone 8941 and 8945 encrypted configuration file to work on the

Cisco Unified IP Phone 8961, 9951, and 9971 Cisco Unified IP Phones (6901 and 6911).
Cisco IP Phone 7811, 7821, 7841, 7861
Cisco IP Conference Phone 7832

Cisco IP Phone 8811, 8841, 8845, 8851, 8851NR,
8861, 8865, 8865NR

Cisco Unified Conference Phone 8831

Cisco Unified IP Phone 7931G, 7921G, (SCCP only)
Cisco Unified Wireless IP Phone 7925G, 7925G-EX,
7926G

Cisco Conference Phone 8832
Cisco Wireless IP Phone 8821

TFTP Encrypted Configuration Files Tips

We recommend that you enable the TFTP Encrypted Configuration file to secure confidential data in phone
downloads. For phones that don't have PKI capabilities, you must also configure a symmetric key in Unified
Communications Manager Administration and in the phone. If the symmetric key is missing from either the
phone or Unified Communications Manager or if a mismatch occurs when the TFTP Encrypted Configuration
file is set, the phone can't register.

Consider the following information when you configure encrypted configuration files in Unified
Communications Manager:

* Only phones that support encrypted configuration files display the TFTP Encrypted Config check box
in the Phone Security Profile Configuration page. You can't configure encrypted configuration files
for Cisco Unified IP Phones 7800, 7942, and 7962 (SCCP only) because these phones don't receive
confidential data in the configuration file download.

* By default, the TFTP Encrypted Config check box is unchecked. If you apply this default setting, the
non secure profile to the phone, the digest credentials, and secured passwords are sent in the cleartext.

* For Cisco Unified IP Phones that use Public Key Encryption, Unified Communications Manager does
not require you to set the Device Security Mode to Authenticated or Encrypted to enable encrypted
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configuration files. Unified Communications Manager uses the CAPF process for downloading its Public
key during registration.

* You may choose to download the unencrypted configuration files to the phones if you know that your
environment is secure or to avoid manually configuring symmetric keys for phones that are not
PKI-enabled. However, we don't recommend that you use this method.

* For Cisco Unified IP Phones 7800, 7942, and 7962 (SIP only), Unified Communications Manager
provides a method of sending digest credentials to the phone that is easier, but less secure, than using an
encrypted configuration file. This method, which uses the Exclude Digest Credential in Configuration
File setting, is useful for initializing digest credentials because it doesn't require you to first configure a
symmetric key and enter it on the phone. With this method, you send the digest credentials to the phone
in an unencrypted configuration file. After the credentials are in the phone, we recommend that you
disable the TFTP Encrypted Config option and then enable the Exclude Digest Credential in
Configuration File on the Phone Security Profile Configuration page. This will exclude digest
credentials from future downloads.

* After digest credentials exist in these phones and an incoming file doesn't contain digest credentials, the
existing credentials remain in place. The digest credentials remain intact until the phone is factory reset
or new credentials (including blanks) are received. If you change digest credentials for a phone or end
user, temporarily disable the Exclude Digest Credential in Configuration File on the corresponding
Phone Security Profile I nformation page to download the new digest credentials to the phone.

Encryption for Phone Configuration File Task Flow

To set up encryption for TFTP configuration files, make sure that the cluster security is in mixed mode, verify
phones in your cluster that support manual key encryption and public key encryption, verify the phones that
support SHA-1 and SHA-512 and complete the tasks below.

\}

Note If you enable SHA-512 clusterwide, and your phones don't support it, those phones do not work.

Procedure

Command or Action Purpose

Step 1 Enable TFTP Encryption, on page 152 Enable the TFTP Configuration File option for
your phones. You can enable this option in the
Phone Security Profile.

Step 2 Configure SHA-512 Signing Algorithm, on | When TFTP file encryption is enabled, SHA-1
page 152 is configured by default as the signing
algorithm. Use this procedure to update the
system to use the stronger SHA-512 algorithm.

Step 3 Verify LSC or MIC Certificate Installation, on | For phones that use public keys, verify the
page 155 certificate installation.

Step 4 Update CTL File, on page 155 After you complete your TFTP config file
updates, regenerate the CTL file.
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Command or Action Purpose
Step 5 Restart Services, on page 156 Restart the Cisco CallManager and Cisco TFTP
services.
Step 6 Reset Phones, on page 156 After you complete your encrypted TFTP config
file updates, reset your phones.

Enable TFTP Encryption

You can enable this TFTP within the phone security profile for a given phone model. Perform this procedure
to enable TFTP encryption for files downloaded from the TFTP server.

Procedure

Step 1 From Cisco Unified CM Administration, choose System > Security > Phone Security Profile.
Step 2 Click Find and choose a phone security profile.
Step 3 Check the TFTP Encrypted Config check box.
Step 4 Click Save.
Step 5 Repeat these steps for any other phone security profiles that are used in the cluster.
Note To disable encryption for the phone configuration files, you must uncheck the TFTP Encrypted

Config check box in the phone security profile in Cisco Unified Communications Manager
Administration and then save your change.

Configure SHA-512 Signing Algorithm

SHA-1 is the default algorithm for TFTP file signing. You can use the below optional procedure to upgrade
the system to use the stronger SHA-512 algorithm for TFTP configuration files such as digital signatures.

)

Note Make sure that your phones support SHA-512. If not, the phones don't work after you update your system.

Procedure

Step 1 From Cisco Unified CM Administration, choose System > Enterprise Parameters.
Step 2 Go to the Security Parameter s pane.

Step 3 From the TFTP File Signature Algorithm drop-down list, choose SHA-512.

Step 4 Click Save.

Restart the affected services listed in the pop-up window to complete the procedure.
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Set Up Manual Key Distribution

For phones that use manual keys, you must set up manual key distribution.

Before you begin
The following procedure assumes that:

* Your phone exists in the Unified Communications Manager database.
* A compatible firmware load exists on the TFTP server.

* You have enabled the TFTP Encrypted Config parameter in Unified Communications Manager
Administration.

* Your phone supports manual key distribution.

Procedure
Step 1 From Cisco Unified CM Administration, choose Device > Phone.
Step 2 Click Find.
Step 3 After the Phone Configuration window displays, configure the manual key distribution settings.

Note After you have configured the settings, you should not change the key.

Step 4 Click Save.
Step 5 Enter the symmetric key on the phone and then reset the phone.

For information on how to perform these tasks, refer to the phone administration guide that supports your
phone model.

Manual Key Distribution Settings

The following table describes the manual distribution configuration settings in the Phone Configuration
window.
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Table 26: Manual Key Distribution Configuration Settings

Setting Description

Symmetric Key Enter a string of hexadecimal characters that you want
to use for the symmetric key. Valid characters include
numerals, 0-9, and uppercase/lowercase characters,
A-F (or a-f).

Make sure that you enter the correct bits for the key
size; otherwise, Cisco Unified Communications
Manager rejects the value. Cisco Unified
Communications Manager supports the following key
sizes:

* Cisco Unified IP Phones 7800 and (SIP
only)—256 bits

* Cisco Unified IP Phones 7942 and 7962 (SIP
only)—128 bits

After the key is configured, you should not change it.

Generate String If you want Cisco Unified Communications Manager
Administration to generate a hexadecimal string for
you, click the Generate String button.

After the key is configured, you should not change it.

Revert to Database Value If you want to restore the value that exists in the
database, click this button.

Enter Phone Symmetric Key

Step 1
Step 2

Step 3
Step 4
Step 5

Step 6

If you used the previous procedure to configure a manual key for your phone in Unified Communications
Manager, use this procedure to enter the key on the phone.

Procedure

Press the Settings button on the phone.
If the configuration is locked, scroll down the Settings menu, highlight Unlock Phone and press the Select
softkey. Enter the phone password and press the Accept softkey.

The phone accepts the password.

Scroll down the Settings menu, highlight Security Configuration, and press the Select softkey.

In the Security Configur ation menu, highlight the Set Cfg Encrypt Key option and press the Select softkey.
When prompted for the encryption key, enter the key (in hex). If you need to clear the key, enter 32 zero
digits.

After you have finished entering the key, press the Accept softkey.

The phone accepts the encryption key.
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Step 7 Reset the phone.

After the phone resets, the phone requests encrypted configuration files.

Verify LSC or MIC Certificate Installation

For phones that use public keys, verify the certificate installation.

)

Note This procedure applies to Cisco Unified IP Phones that uses PKI encryption. To determine, if your phone
supports PKI encryption, see Phone Models Supporting Encrypted Configuration File section.

The following procedure assumes that the phone exists in Unified Communications Manager database and
you have enabled the TFTP Encrypted Config parameter in Unified Communications Manager.

Procedure

Step 1 Verify that a Manufacture-Installed Certificate (MIC) or a Locally Significant Certificate (LSC) exists in the
phone.

Step 2 From Cisco Unified CM Administration, choose Device > Phone.
The lists of phones appear.

Step 3 Click the Device Name.
The Phone Configuration page appears.

Tip Choose the Troubleshoot option in the CAPF settings section from the Phone Configur ation page,
to verify whether an LSC or MIC exists in the phone in Unified Communications Manager. The
Delete and Troubleshoot options don't appear when a certificate doesn't exist in the phone.

Tip You can also verify that an LSC or MIC exists in the phone by checking the security configuration
on the phone. For more information, see the administration guides for Cisco Unified IP Phones that
support this version of Unified Communications Manager.

Step 4 If a certificate doesn't exist, install an LSC by using the CAPF functionality on the Phone Configuration
window. For information on how to install an LSC, see topics related to the Certificate Authority Proxy
Function.

Step 5 Click Save after you configure the CAPF settings.

Step 6 Click Reset.
The phone requests an encrypted configuration file from the TFTP server after the phone resets.

Update CTL File

Update the CTL file, when you have done any modifications to Unified Communications Manager. Since you
have enabled the TFTP file encryption, you have to regenerate the CTL file.
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Procedure

Step 1 Log in to the Command Line Interface.
Step 2 On the publisher node, run the utils ctl update CTLfile command.

Restart Services

After you have completed your encrypted TFTP configuration file updates, make sure that you restart your
Cisco TFTP and Cisco CallManager services for the changes to take effect.

Procedure
Step 1 From Cisco Unified Serviceability, choose Tools > Control Center — Feature Services.
Step 2 Choose the following two services.

* Cisco CallManager
* Cisco TFTP

Step 3 Click Restart..

Reset Phones

Make sure that you reset your phones after you complete all your encrypted TFTP configuration file updates.

Procedure

Step 1 From Cisco Unified CM Administration, choose Device > Phones.
Step 2 Click Find.

Step 3 Click Select All.

Step 4 Click Reset Selected.

Disable TFTP Encrypted Configuration Files
A

Warning  If digest authentication is True for the phone that is running SIP when the TFTP encrypted configuration
setting is False, digest credentials may get sent in the clear.

After you update the setting, the encryption keys for the phone remain in the Unified Communications
Managerdatabase.
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Cisco Unified IP Phones 7911G, 7931G (SCCP only), 7941G, 7941G-GE, 7942G, 7945G, 7961G, 7961G-GE,
7962G, 7965G, 7971G, 7971G-GE, and 7975G request an encrypted file (.enc.sgn file) when the encrypted
configuration setting gets updated to False, the phone requests an unencrypted, signed file (.sgn file).

If Cisco Unified IP Phones are running on SCCP and SIP, request an encrypted file when the encryption
configuration setting gets updated to False. Remove the symmetric key from the phone GUI so that the phone
requests an unencrypted configuration file the next time that it is reset.

» Cisco Unified IP Phones running on SCCP: 6901, 6911, 6921, 6941, 6945, 6961, 7906G, 7911G, 7921G,
7925G, 7925G-EX, 7926G, 7931G, 7941G, 7941G-GE, 7942G, 7945G, 7961G, 7961G-GE, 7962G,
7965G, 7971G, 7971G-GE, 7975G, 8941, 8945.

* Cisco Unified IP Phones running on SIP: 6901, 6911, 6921, 6941, 6945, 6961, 7906G, 7911G, 7941G,
7941G-GE, 7942G, 7961G, 7961G-GE,7962G, 7965G, 7970G, 7971G, 7971G-GE, 7975G, 8941, 8945,
8961, 9971, 7811, 78321, 7841, 7861, 7832, 8811, 8841, 8845, 8851, 8851NR, 8861, 8865, 8865NE,
8821, 8831, 8832, 8832NR.

Procedure

Command or Action

Purpose

Step 1

To disable encryption for the phone
configuration files, Uncheck TFTP Encrypted
Config check box in the phone security profile
associated to the phone.

Step 2

For Cisco Unified IP Phones 7942 and 7962
(SIP only), Enter a 32-byte 0 as the key value
for the symmetric key at the phone screen to
disable encryption.

Step 3

For Cisco Unified IP Phones (SIP only), delete
the symmetric key at the phone screen to disable
encryption.

For information on how to perform these tasks,
see the phone administration guide that supports
your phone model.

Exclude Digest Credentials From Phone Configuration File

Download

To exclude digest credentials from the configuration file that is sent to phones after the initial configuration,
check the Exclude Digest Credentials in Configuration File check box for the security profile that is applied
to the phone. Only Cisco Unified IP Phones 7800, 7942, and 7962 (SIP only) support this option.

You may need to uncheck this check box to update the configuration file for changes to digest credentials.
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Digest Authentication for SIP Phones Setup

This chapter provides information about digest authentication for SIP phones setup. For additional information
on how digest authentication works for phones that are running SIP, see Digest Authentication, on page 21.

When you enable digest authentication for a phone, Unified Communications Manager challenges all requests
except keepalive messages for phones that are running SIP. Unified Communications Manager uses the digest
credentials for the end user, as configured in the End User Configuration window, to validate the credentials
that the phone offers.

If the phone supports extension mobility, Unified Communications Manager uses the digest credentials for
the extension mobility end user, as configured in the End User Configuration window, when the extension
mobility user logs in.

For information about configuring digest authentication for non-Cisco phones that are running SIP, refer to
Appendix C in the Administration Guide for Cisco Unified Communications Manager.

* Enable Digest Authentication in Phone Security Profile, on page 159
* Configure SIP Station Realm, on page 160

* Assign Digest Credentials to Phone User, on page 160

* End User Digest Credential Settings, on page 160

» Assign Digest Authentication to the Phone, on page 161

Enable Digest Authentication in Phone Security Profile

Step 1
Step 2
Step 3
Step 4

Use this procedure to enable digest authentication for a phone through the Phone Security Profile.

Procedure
From Cisco Unified CM Administration, choose System > Security > Phone Security Profile.
Click Find and choose the phone security profile that is associated to the phone.

Check the Enable Digest Authentication check box.
Click Save.
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Configure SIP Station Realm

Assign the string that Cisco Unified Communications Manager uses in the Realm field when challenging a
SIP phone in the response to a 401 Unauthorized message. This applies when the phone is configured for
digest authentication.

\)

Note The default string for this service parameter is ccmsipline.

Procedure
Step 1 From Unified Communications Manager, choose System > Service Parameters.
Step 2 From the Server drop-down list, choose a node where you activated the CiscoCallManager service.

Step 3 From the Servicedrop-down list, choose the CiscoCallManager service. Verify that the word “Active” displays
next to the service name.

Step 4 Update the SIP Realm Station parameter, as described in the help. To display help for the parameters, click
the question mark or the parameter name link.

Step 5 Click Save.

Assign Digest Credentials to Phone User

Use this procedure to assign digest credentials to the end user who owns the phone. Phones use the credentials
to authenticate.

Procedure
Step 1 From Cisco Unified Communications Manager Administration, choose User Management > End User.
Step 2 Click Find and choose the end user who owns the phone.

Step 3 Enter the credentials in the following fields:

* Digest Credentials

* Confirm Digest Credentials

Step 4 Click Save.

End User Digest Credential Settings

To view the digest credentials details, perform the following procedure:
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From Cisco Unified Communications Manager Administration, choose User Management > End User and
click the User ID and the End User Configuration window appears. The digest credentials are available in
the User Information pane of the End User Configuration window.

Table 27: Digest Credentials

Setting Description

Digest Credentials Enter a string of alphanumeric characters.

Confirm Digest To confirm that you entered the digest credentials correctly, enter the credentials
Credentials in this field.

Assign Digest Authentication to the Phone

Step 1
Step 2
Step 3
Step 4

Step 5
Step 6

Use this procedure to associate the digest user and digest authentication-enabled security profile to the phone.

Procedure

From Cisco Unified Communications Manager Administration, choose Device > Phone.
Click Find and choose the phone for which you want to assign digest authentication.
From the Digest User drop-down list, assign the end user for whom you assigned digest credentials.

Make sure that the phone security profile for which you enabled digest authentication is assigned through the
Device Security Profile drop-down list.

Click Save.
Click Reset.

After you associate the end user with the phone, save the configuration and reset the phone.

Security Guide for Cisco Unified Communications Manager, Release 11.5(1)SU10 .



Security for Cisco IP Phone and Cisco Voice-Messaging Ports |
. Assign Digest Authentication to the Phone

. Security Guide for Cisco Unified Communications Manager, Release 11.5(1)SU10



CHAPTER 1 4

Phone Hardening

This chapter provides information about phone hardening. To tighten security on the phone, you can perform
phone hardening tasks in the Phone Configuration window in Unified Communications Manager
Administration.

* Gratuitous ARP Disable, on page 163

* Web Access Disable, on page 163

* PC Voice VLAN Access Disable, on page 164

* Setting Access Disable, on page 164

* PC Port Disable, on page 164

* Set Up Phone Hardening, on page 164

* Where to Find More Information About Phone Hardening, on page 165

Gratuitous ARP Disable

By default, Cisco Unified IP Phones accept Gratuitous ARP packets. Gratuitous ARP packets, which devices
use, announce the presence of the device on the network. However, attackers can use these packets to spoof
a valid network device; for example, an attacker could send out a packet that claims to be the default router.
If you choose to do so, you can disable Gratuitous ARP in the Phone Configuration window.

\}

Note Disabling this functionality does not prevent the phone from identifying its default router.

Web Access Disable

Disabling the web server functionality for the phone blocks access to the phone internal web pages, which
provide statistics and configuration information. Features, such as CiscoQuality Report Tool, do not function
properly without access to the phone web pages. Disabling the web server also affects any serviceability
application, such as CiscoWorks, that relies on web access.

To determine whether the web services are disabled, the phone parses a parameter in the configuration file
that indicates whether the services are disabled or enabled. If the web services are disabled, the phone does
not open the HTTP port 80 for monitoring purposes and blocks access to the phone internal web pages.
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PC Voice VLAN Access Disable

By default, Cisco IP Phones forward all packets that are received on the switch port (the one that faces the
upstream switch) to the PC port. If you choose to disable the PC Voice VLAN Access setting in the Phone
Configuration window, packets that are received from the PC port that use voice VLAN functionality will
drop. Various Cisco IP Phones use this functionality differently.

* Cisco Unified IP Phones 7942 and 7962 drop any packets that are tagged with the voice VLAN, in or
out of the PC port.

* Cisco Unified IP Phone 7970G drops any packet that contains an 802.1Q tag on any VLAN, in or out of
the PC port.

Setting Access Disable

By default, pressing the Applications button on a Cisco IP Phone provides access to a variety of information,
including phone configuration information. Disabling the Setting Access parameter in the Phone Configuration
window prohibits access to all options that normally display when you press the Applications button on the

phone; for example, the Contrast, Ring Type, Network Configuration, Model Information, and Status settings.

The preceding settings do not display on the phone if you disable the setting in Unified Communications
Manager Administration. If you disable this setting, the phone user cannot save the settings that are associated
with the Volume button; for example, the user cannot save the volume.

Disabling this setting automatically saves the current Contrast, Ring Type, Network Configuration, Model
Information, Status, and Volume settings that exist on the phone. To change these phone settings, you must
enable the Setting Access setting in Unified Communications Manager Administration.

PC Port Disable

By default, Unified Communications Manager enables the PC port on all Cisco IP Phones that have a PC port.
If you choose to do so, you can disable the PC Port setting in the Phone Configuration window. Disabling the
PC port proves useful for lobby or conference room phones.

Y

Note The PC port is available on some phones and allows the user to connect their computer to the phone. This
connection method means that the user only needs one LAN port.

Set Up Phone Hardening

Phone Hardening consists of optional settings that you can apply to your phones in order to harden the
connection. You can apply settings using one of three configuration windows:

* Phone Configuration - use Phone Configuration window to apply the settings to an individual phone
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Step 1
Step 2
Step 3
Step 4

Step 5

Step 6
Step 7

Where to Find More Information About Phone Hardening .

» Common Phone Profile - use the Common Phone Profile window to apply the settings to all of the
phones that use this profile

* Enterprise Phone - use the Enter prise Phone window to apply the settings to all of your phones enterprise
wide

\}

Note If conflicting settings appear in each of these windows, following is the priority order the phone uses to

determine the correct setting: 1) Phone Configuration, 2) Common Phone Profile, 3)Enterprise Phone

To setup phone hardening, perform the following procedure:

Procedure

From Cisco Unified Communications Manager Administration, choose Device > Phone.
Specify the criteria to find the phone and click Find to display a list of all phones.

Click the device name.

Locate the following product-specific parameters:

a) PC Port

b) Settings Access

¢) Gratuitous ARP

d) PC Voice VLAN Access

e) Web Access

Tip To review information on these settings, click the help icon that appears next to the parameters
in the Phone Configuration window.

Choose Disabled from the drop-down list for each parameter that you want to disable. To disable the
speakerphone or speakerphone and headset, check the corresponding check boxes.

Click Save.
Click Reset.

Where to Find More Information About Phone Hardening
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Secure Conference Resources Setup

This chapter provides information about secure conference resources setup.

* Secure Conference, on page 167

* Conference Bridge Requirements, on page 168

* Secure Conference Icons, on page 169

* Secure Conference Status, on page 169

* Cisco Unified IP Phone Secure Conference and Icon Support, on page 172
* Secure Conference CTI Support, on page 172

* Secure Conference Over Trunks and Gateways, on page 172
* CDR Data, on page 173

* Interactions and Restrictions, on page 173

* Securing Conference Resources Tips, on page 174

* Set Up Secure Conference Bridge, on page 176

* Set Up Secure Conference Bridge in Cisco Unified Communications Manager Administration, on page
177

* Set Up Minimum Security Level for Meet-Me Conferences, on page 177
* Set Up Packet Capturing for Secure Conference Bridge, on page 178

Secure Conference

The Secure Conferencing feature provides authentication and encryption to secure a conference. A conference
gets considered secure when all participating devices have encrypted signaling and media. The secure conference
feature supports SRTP encryption over a secure TLS or IPSec connection.

The system provides a security icon for the overall security status of the conference, which is determined by
the lowest security level of the participating devices. For example, a secure conference that includes two
encrypted connections and one authenticated connection has a conference security status of authenticated.

To configure secure ad hoc and meet-me conferences, you configure a secure conference bridge.

« If a user initiates a conference call from a phone that is authenticated or encrypted, Unified
Communications Manager allocates the secure conference bridge

* If a user initiates a call from a phone that is nonsecure, Unified Communications Manager allocates a
nonsecure conference bridge.
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. Conference Bridge Requirements

When you configure conference bridge resources as nonsecure, the conference remains nonsecure, regardless
of the security configuration for the phone.

\)

Note

Unified Communications Manager allocates a conference bridge from the Media Resource Group List (MRGL)
for the phone that is initiating the conference. If a secure conference bridge is not available, Unified

Communications Manager assigns a nonsecure conference bridge, and the conference is nonsecure. Likewise,
if a nonsecure conference bridge is not available, Unified Communications Manager assigns a secure conference

bridge, and the conference is nonsecure. If no conference bridge is available, the call will fail.

For meet-me conference calls, the phone that initiates the conference must also meet the minimum security
requirement that is configured for the meet-me number. If no secure conference bridge is available or if the
initiator security level does not meet the minimum, Unified Communications Manager rejects the conference
attempt.

To secure conferences with barge, configure phones to use encrypted mode. After the Barge key is pressed
and if the device is authenticated or encrypted, Unified Communications Manager establishes a secure
connection between the barging party and the built-in bridge at the target device. The system provides a
conference security status for all connected parties in the barge call.

)

Note Nonsecure or authenticated Cisco Unified IP Phones that are running release 8.3 or later can now barge
encrypted calls.

Conference Bridge Requirements

A conference bridge can register as a secure media resource when you add a hardware conference bridge to
your network and configure a secure conference bridge in Unified Communications Manager Administration.

)

Note Due to the performance impact to Unified Communications Manager processing, Cisco does not support
secure conferencing on software conference bridge.

A Digital Signal Processor (DSP) farm, which provides conferencing on a H.323 or MGCP gateway, acts as
the network resource for IP telephony conferencing. The conference bridge registers to Unified Communications
Manager as a secure SCCP client.

* The conference bridge root certificate must exist in CallManager trust store, and the Cisco CallManager
certificate must exist in the conference bridge trust store.

* The secure conference bridge security setting must match the security setting in Unified Communications
Manager to register.

For more information about conferencing routers, refer to the IOS router documentation that is provided with
your router.

Unified Communications Manager assigns conference resources to calls on a dynamic basis. The available
conference resource and the enabled codec provide the maximum number of concurrent, secure conferences
allowed per router. Because transmit and receive streams are individually keyed for each participating endpoint
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Secure Conference Icons .

(so no rekeying is necessary when a participant leaves the conference), the total secure conference capacity
for a DSP module equals one-half the nonsecure capacity that you can configure.

See Feature Configuration Guide for Cisco Unified Communications Manager for more information.

Secure Conference Icons

Cisco IP Phones display a conference security icon for the security level of the entire conference. These icons
match the status icons for a secure two-party call, as described in the user documentation for your phone.

The audio and video portions of the call provide the basis for the conference security level. The call gets
considered secure only if both the audio and video portions are secure.

For ad hoc and meet-me secure conferences, the security icon for the conference displays next to the conference
softkey in the phone window for conference participants. The icon that displays depends on the security level
of the conference bridge and all participants:

* A lock icon displays if the conference bridge is secure and all participants in the conference are encrypted.

* A shield icon displays if the conference bridge is secure and all participants in the conference are
authenticated. Some phone models do not display the shield icon.

» When the conference bridge or any participant in the conference is nonsecure, the call state icon (active,
hold, and so on) displays, or, on some older phone models, no icon displays.

)

Note

The “Override BFCP Application Encryption Status When Designating Call Security Status” service parameter
displays the lock icon when parameter value is True and audio is secure. This condition ignores the security

statuses of all other media channels. The default parameter value is False.

When an encrypted phone connects to a secure conference bridge, the media streaming between the device
and the conference bridge gets encrypted; however, the icon for the conference can be encrypted, authenticated,
or nonsecure depending on the security levels of the other participants. A nonsecure status indicates that one
of the parties is not secure or cannot be verified.

When a user presses Barge, the icon that displays next to the Barge softkey provides the security level for the
barge conference. If the barging device and the barged device support encryption, the system encrypts the
media between the two devices, but the barge conference status can be nonsecure, authenticated, or encrypted,
depending on the security levels of the connected parties.

Secure Conference Status

Conference status can change as participants enter and leave the conference. An encrypted conference can
revert to a security level of authenticated or nonsecure if an authenticated or nonsecure participant connects
to the call. Likewise, the status can upgrade if an authenticated or nonsecure participant drops off the call. A
nonsecure participant that connects to a conference call renders the conference nonsecure.

Conference status can also change when participants chain conferences together, when the security status for
a chained conference changes, when a held conference call is resumed on another device, when a conference
call gets barged, or when a transferred conference call completes to another device.
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\)

Note The Advanced Ad Hoc Conference Enabled service parameter determines whether ad hoc conferences can
be linked together by using features such as conference, join, direct transfer, and transfer.

Unified Communications Manager provides these options to maintain a secure conference:

*» Ad hoc conference lists
* Meet-Me conference with minimum security level

Ad Hoc Conference Lists

A conference list displays on participating phones when the ConfList softkey is pressed during a conference
call. The conference list provides the conference status as well as the security status for each participant to
identify participants that are not encrypted.

Conference list displays these security icons: nonsecure, authenticated, encrypted, held. The conference
initiator can use the conference list to eject participants with a low security status.

)

Note The Advanced Ad Hoc Conference Enabled service parameter determines whether conference participants
other than the conference initiator can eject conference participants.

As participants join the conference, they get added to the top of the conference list. To remove nonsecure
participants from a secure conference with the ConfList and RmLstC softkeys, refer to the user documentation
for your phone.

The following sections describe secure ad hoc conference interactions with other features.

Secure Ad Hoc Conference and Conference Chaining

When an ad hoc conference is chained to another ad hoc conference, the chained conference displays in the
list as member “Conference” with its own security status. Unified Communications Manager includes the
security level for the chained conference to determine the overall conference security status.

Secure Ad Hoc Conference and cBarge

When a user presses the cBarge softkey to join an active conference, Unified Communications Manager
creates an ad hoc conference and allocates a conference bridge according to the security level and MRGL of
the barged device. The cbarge member names display in the conference list.

Secure Ad Hoc Conference and Barge

If a participant in a secure ad hoc conference gets barged, the barge call security status shows in the conference
list next to the barge target. The security icon for the barge target may show authenticated when, in fact, the
media is encrypted between the barge target and the conference bridge, because the barge caller has an
authenticated connection.

If the barge target is secure but in an unsecured ad hoc conference, if the ad hoc conference status later changes
to secure, the barge caller icon will update as well.
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Secure Ad Hoc Conference and Join

Authenticated or encrypted phone users can use the Join softkey at a Cisco Unified IP Phone (only phones
that are running SCCP) to create or join a secure ad hoc conference. If a user presses Join to add a participant
with an unknown security status to an existing conference, Unified Communications Manager downgrades
the conference status to unknown. A participant who adds a new member with Join becomes the conference
initiator and can eject the new member or any other participant from the conference list (if the Advanced Ad
Hoc Conference Enabled setting is True).

Secure Ad Hoc Conference and Hold/Resume

When a conference initiator puts the conference call on hold to add a participant, the conference status remains
unknown (nonsecure) until the added participant answers the call. After the new participant answers, conference
status updates in the conference list.

If a caller on a shared line resumes a held conference call at another phone, the conference list updates when
the caller presses Resume.

Meet-Me Conference with Minimum Security Level

As administrator, you can specify a minimum security level for a conference when you configure a meet-me
pattern or number as nonsecure, authenticated, or encrypted. Participants must meet the minimum security
requirement, or the system blocks the participant and drops the call. This action applies to meet-me conference
call transfers, resumed meet-me conference calls on shared lines, and chained Meet-Me conferences.

The phone that initiates the meet-me conference must meet the minimum security level, or the system rejects
the attempt. When the minimum security level specifies authenticated or encrypted and a secure conference
bridge is not available, the call fails.

If you specify nonsecure as the minimum level for the conference bridge, the conference bridge accepts all
calls, and the conference status is nonsecure.

The following sections describe secure meet-me conference interactions with other features.

Meet-Me Conference and Ad Hoc Conference

To add a meet-me conference to an ad hoc conference or add an ad hoc conference to a meet-me conference,
the ad hoc conference must meet the minimum security level for the meet-me conference, or the call is dropped.
The conference icon can change when the conference gets added.

Meet-Me Conference and Barge

Unless a barge caller meets the minimum security requirement when the caller barges a meet-me conference
participant, the security level of the barged device downgrades, and both the barge caller and the barged call
get dropped.

Meet-Me Conference and Hold/Resume

A phone on a shared line cannot resume a meet-me conference unless the phone meets the minimum security
level. If a phone does not meet the minimum security level, all phones on the shared line get blocked when
the user presses Resume.
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Cisco Unified IP Phone Secure Conference and Icon Support

These Cisco Unified IP Phones support secure conference and secure conference icons:

* Cisco Unified IP Phones 7942 and 7962 (SCCP only, authenticated secure conference only)

* Cisco Unified IP Phones 6901, 6911, 6921, 6941, 6945, 6961, 7906G, 7911G, 7921G, , 7931G, 7942,
7941G, 7941G-GE, 7942G, 7945G, 7961G, 7961G-GE, 7962G, 7965G, 7970G, 7971G, 7971G-GE,
7975G, 8941, and 8945. (SCCP only)

« Cisco Unified IP Phones 6901, 6911, 6921, 6941, 6945, 6961, 7906G, 7911G, 7941G, 7941G-GE, 7942G,
7961G, 7961G-GE,7962G, 7965G, 7970G, 7971G, 7971G-GE, 7975G, 8941, 8945, 8961, 9971, and
9971.

Cisco IP Phones 7811, 7821, 7841, 7861, Cisco IP Conference Phone7832, Cisco IP Phones 8811, 8841,
8845, 8851, 8851NR, 8861, 8865, 8865NR, Cisco Wireless IP Phone 8821, Cisco Unified IP Conference
Phone 8831, Cisco IP Conference Phone 8832.

A

Warning  To obtain the full benefit of secure conference features, Cisco recommends upgrading Cisco Unified IP Phones
to release 8.3 or later, which supports the encryption features in this release. Encrypted phones that run earlier
releases do not fully support these new features. These phones can only participate in secure conference as
authenticated or nonsecure participants.

Cisco Unified IP Phones that are running release 8.3 with an previous release of Cisco Unified Communications
Manager will display their connection security status, not the conference security status, during a conference
call, and do not support secure conference features like conference list.

See topics related to Unified Communications Manager secure conference restrictions for more restrictions
that apply to Cisco Unified IP Phones.

For additional information about secure conference calls and security icons, refer to the Cisco IP Phone
Administration Guide and Cisco IP Phone User Guide for your phone.

Secure Conference CTI Support

Unified Communications Manager supports secure conference over licensed CTI devices. Refer to the Unified
Communications Manager JTAPI Developers Guide and Unified Communications Manager TAPI Developers
Guide for this release for more information.

Secure Conference Over Trunks and Gateways

Unified Communications Manager supports secure conference over intracluster trunks (ICTs), H.323
trunks/gateways, and MGCP gateways; however, encrypted phones that are running release 8.2 or earlier will
revert to RTP for ICT and H.323 calls, and the media does not get encrypted.

If a conference involves a SIP trunk, the secure conference status is nonsecure. In addition, SIP trunk signaling
does not support secure conference notifications to off-cluster participants.
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CDR Data

CDR data provides the security status of each call leg from the phone endpoint to the conference bridge as
well as the security status of the conference itself. The two values use two different fields inside the CDR
database.

CDR data provides termination cause code 58 (Bearer capability not presently available) when a meet-me
conference rejects a join attempt that does not meet the minimum security level requirement. See the CDR
Analysis and Reporting Administration Guide for more information.

Interactions and Restrictions

This section contains information on the following topics:
* Cisco Unified Communications Manager Interactions with Secure Conference, on page 173

* Cisco Unified Communications Manager Restrictions with Secure Conference, on page 174

Cisco Unified Communications Manager Interactions with Secure Conference

This section describes Unified Communications Manager interactions with the secure conference feature.

» To keep a conference secure, if a participant in a secure ad hoc conference puts a call on hold or parks
the call, the system does not play MOH, even if the Suppress MOH to Conference Bridge service parameter
is set to False. The secure conference status does not change.

* In intercluster environments, if an off-cluster conference participant presses hold in a secure ad hoc
conference, the media stream to the device stops, MOH plays, and the media status changes to unknown.
If the off-cluster participant resumes a held call with MOH, the conference status may upgrade.

* A secure MeetMe call across an intercluster trunk (ICT) will clear if the remote user invokes a phone
feature such a hold/resume, which changes the media status to unknown.

 Annunciator tones or announcements for Unified Communications Manager Multilevel Precedence and
Preemption that play on a participant phone during a secure ad hoc conference change the conference
status to nonsecure.

* If a caller barges a secure SCCP phone call, the system uses an internal tone-playing mechanism at the
target device, and the conference status remains secure.

» If a caller barges a secure SIP phone call, the system provides tone-on-hold, and the conference status
remains nonsecure during the tone.

« If a conference is secure and RSVP is enabled, the conference remains secure.

* For conference calls that involve the PSTN, the security conference icon shows the security status for
only the IP domain portion of the call.

* The Maximum Call Duration Timer service parameter also controls the maximum conference duration.

* Conference bridge supports packet capture. During a packet capture session, the phone displays a nonsecure
status for the conference, even if the media stream is encrypted.
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* The media security policy that is configured for your system may alter secure conference behavior; for
example, an endpoint will use media security according to the system media security policy, even when
participating in a conference call with endpoints that do no support media security.

Cisco Unified Communications Manager Restrictions with Secure Conference

This section describes Unified Communications Manager restrictions with secure conferencing feature.

* Encrypted Cisco IP Phones that are running release 8.2 or earlier can only participate in a secure conference
as authenticated or nonsecure participants.

* Cisco Unified IP Phones that are running release 8.3 with an previous release of Unified Communications
Manager will display their connection security status, not the conference security status, during a
conference call and do not support secure conference features like conference list.

* Cisco Unified IP Phones 7800 and 7911G do not support conference list.

* Due to bandwidth requirements, Cisco Unified IP Phones 7942 and 7962 do not support barge from an
encrypted device on an active encrypted call. The barge attempt will fail.

* Cisco Unified IP Phone 7931G does not support conference chaining.

* Phones that are calling over SIP trunks get treated as nonsecure phones, regardless of their device security
status.

» If a secure phone attempts to join a secure meet-me conference over a SIP trunk, the call gets dropped.
Because SIP trunks do not support providing the “device not authorized” message to a phone that is
running SIP, the phone does not update with this message. In addition, 7962 phones that are running SIP
do not support the “device not authorized” message.

* In intercluster environments, the conference list does not display for off-cluster participants; however,
the security status for the connection displays next to the Conference softkey as long as the connection
between the clusters supports it. For example, for H.323 ICT connections, the authentication icon does
not display (the system treats the authenticated connection as nonsecure), but the encryption icon displays
for an encrypted connection.

Off-cluster participants can create their own conference that connects to another cluster across the cluster
boundary. The system treats the connected conferences as a basic, two-party call.

Securing Conference Resources Tips

Consider the following information before you configure secure conference bridge resources:

» Use localization if you want the phone to display custom text for secure conference messages. Refer to
the Unified Communications Manager Locale Installer documentation for more information.

* The conference or built-in bridge must support encryption to secure conference calls.
* To enable secure conference bridge registration, set the cluster security mode to mixed mode.

* Ensure the phone that initiates a conference is authenticated or encrypted to procure a secure conference
bridge.
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To maintain conference integrity on shared lines, do not configure devices that share a line with different
security modes; for example, do not configure an encrypted phone to share a line with an authenticated
or nonsecure phone.

Do not use SIP trunks as ICTs when you want to share conference security status between clusters.

If you set the cluster security mode to mixed mode, the security mode that is configured for the DSP
farm (nonsecure or encrypted) must match the conference bridge security mode in Unified Communications
Manager Administration, or the conference bridge cannot register. The conference bridge registers as
encrypted when both security modes specify encrypted; the conference bridge registers as nonsecure
when both security modes specify nonsecure.

If you set the cluster security mode to mixed mode, if the security profile you applied to the conference
bridge is encrypted, but the conference bridge security level is nonsecure, Unified Communications
Manager rejects conference bridge registration.

If you set the cluster security mode to nonsecure mode, configure the security mode at the DSP farm as
nonsecure, so the conference bridge can register. The conference bridge registers as nonsecure even if
the setting in Unified Communications Manager Administration specifies encrypted.

During registration, the conference bridge must pass authentication. To pass authentication, the DSP
farm system must contain one or more the Unified Communications Manager CallManager.pem
certificates, and Unified Communications Manager must contain certificates for the DSP farm system
and the DSP connection in the CallManager-trust store. The common Name specified in the X.509 Subject
attribute must begin with the conference bridge name defined in Cisco Unified Communications Manager
and on the DSP farm system using the associate profile <profile-identifier > register <device-name>?
command. The Subject Alternate Name attribute is not supported. For example, if the certificate Subject
Common Name is ?CN=example.cisco.com? then the Conference Bridge Name in Unified
Communications Manager must be ?example? and the DSP farm system command must be ?associate
profile <profile-identifier> register example. If you have multiple secure conference bridges on the
same DSP farm system, each requires a separate certificate.

Je

Tip Make sure that the Conference Bridge Name is unique and that it can not be
configured in any other place under the "Device" table. This applies to the Route
list, SIP trunks, IP phones, and so on.

If conference bridge certificates expire or change for any reason, use the certificate management feature
in Cisco Unified Communications Operating System Administration to update the certificates in the
trusted store. The TLS authentication fails when certificates do not match, and conference bridge does
not work because it cannot register to Unified Communications Manager.

The secure conference bridge registers to Unified Communications Manager through TLS connection
at port 2443; a nonsecure conference bridge registers to Unified Communications Manager through TCP
connection at port 2000.

Changing the device security mode for the conference bridge requires a reset of Unified Communications
Manager devices and a restart of the Cisco CallManager service.
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Set Up Secure Conference Bridge

Step 1
Step 2

Step 3

Step 4

Step 5

Step 6

The following procedure provides the tasks used to add secure conferencing to your network.

Procedure

Verify that you installed and configured the CiscoCTL Client for Mixed Mode.

Verify that you configured the DSP farm security settings for Unified Communications Manager connection,
including adding the Unified Communications Manager certificate to the trust store. Set the DSP farm security
level to encrypted.

Refer to the documentation for your conference bridge.

Tip The DSP farm establishes the TLS port connection to Unified Communications Manager on port
2443.

Verify the DSP farm certificate is in the CallManager trust store.

To add the certificate, use the certificate management function in the Cisco Unified Communications Operating
System to copy the DSP certificate to the trusted store in Unified Communications Manager.

When you have finished copying the certificate, restart the CiscoCallManager service on the server.

For more information, see the Administration Guide for Cisco Unified Communications Manager and the
Cisco Unified Serviceability Administration Guide.

Tip Be sure to copy the certificate to each server in the cluster and restart the CiscoCallManager service
on each server in the cluster.

In Unified Communications Manager Administration, configure Cisco IOS Enhanced Conference Bridge as
the conference bridge type and select Encrypted Conference Bridge for device security mode.

Tip When you upgrade to this release, Unified Communications Manager automatically assigns a
nonsecure conference bridge security profile to Cisco IOS Enhanced Conference Bridge
configurations.

Configure a minimum security level for Meet-Me Conferences.

Tip When you upgrade to this release, Unified Communications Manager automatically assigns a
minimum security level of nonsecure to all Meet Me patterns.

Configure packet capturing for the secure conference bridge.
See the Troubleshooting Guide for Unified Communications Manager for more information.

Tip Set packet capture mode to batch mode and capture tier to SRTP.
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Set Up Secure Conference Bridge in Cisco Unified
Communications Manager Administration

Step 1
Step 2

Step 3

Step 4

Step 5
Step 6
Step 7

To configure a secure conference bridge in Unified Communications Manager Administration, perform the
following procedure. After you configure encryption for the conference bridge, you must reset Unified
Communications Manager devices and restart the CiscoCallManager service.

Ensure that you installed certificates in Unified Communications Manager and in the DSP farm to secure the
connection between the devices.

Before you begin

Before You Begin

Procedure

Choose M edia Resour ces > Conference Bridge.

In the Find and List Conference Bridges window, verify that a Cisco IOS Enhanced Conference Bridge is
installed and go to Set Up Secure Conference Bridge, on page 176.

If the device does not exist in the database, click Add New; go to Set Up Secure Conference Bridge in Cisco
Unified Communications Manager Administration, on page 177.

In the Conference Bridge Configuration window, select Cisco | OS Enhanced Conference Bridge in the
Conference Bridge Type drop-down list box. Configure the Conference Bridge Name, Description, Device
Pool, Common Device Configuration, and Location settings as described in the Administration Guide for
Cisco Unified Communications Manager .

In the Device Security Mode field, select Encrypted Conference Bridge.

Click Save.

Click Reset.

What to do next

To perform additional conference bridge configuration tasks, you can jump to the Meet-Me/Number Pattern
Configuration window or the Service Parameter Configuration window by selecting the option from the
Related Links drop-down list box and clicking Go.

Set Up Minimum Security Level for Meet-Me Conferences

Step 1

To configure a minimum security level for Meet-Me conferences, perform the following procedure.

Procedure

Choose Call Routing > M eet-M e Number /Pattern.
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Step 2

Step 3

Step 4

Step 5
Step 6

In the Find and List Conference Bridges window, verify that the Meet-Me number/pattern is configured and
go to Set Up Secure Conference Bridge, on page 176.

If the Meet-Me number/pattern is not configured, click Add New; go to Set Up Minimum Security Level for
Meet-Me Conferences, on page 177.

In the M eet-MeNumber Configuration window, enter a Meet-Me number or range in the Directory Number
or Pattern field. Configure the Description and Partition settings as described in the Feature Configuration
Guide for Cisco Unified Communications Manager.

In the Minimum Security Level field, select Non Secure, Authenticated, or Encrypted.
Click Save.

What to do next

If you have not yet installed a secure conference bridge, install and configure a secure conference bridge.

Set Up Packet Capturing for Secure Conference Bridge

To configure packet capturing for a secure conference bridge, enable packet capturing in the Service Parameter
Configuration window; then, set the packet capture mode to batch mode and capture tier to SRTP for the
phone, gateway, or trunk in the device configuration window. Refer to the Troubleshooting Guide for Cisco
Unified Communications Manager for more information.

During a packet capture session, the phone displays a nonsecure status for the conference, even if the media
stream is encrypted.
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Voice-Messaging Ports Security Setup

This chapter provides information about voice-messaging ports security setup.

* Voice-Messaging Security, on page 179

* Voice-Messaging Security Setup Tips, on page 179

* Set Up Secure Voice-Messaging Port, on page 180

* Apply Security Profile to Single Voice-Messaging Port, on page 181
* Apply Security Profile Using Voice Mail Port Wizard, on page 182

Voice-Messaging Security

To configure security for Unified Communications Manager voice-messaging ports and Cisco Unity devices
that are running SCCP or Cisco Unity Connection devices that are running SCCP, you choose a secure device
security mode for the port. If you choose an authenticated voicemail port, a TLS connection opens, which
authenticates the devices by using a mutual certificate exchange (each device accepts the certificate of the
other device). If you choose an encrypted voicemail port, the system first authenticates the devices and then
sends encrypted voice streams between the devices.

Cisco Unity Connection connects to Unified Communications Manager through the TLS port. When the
device security mode is nonsecure, Cisco Unity Connection connects to Unified Communications Manager
through the SCCP port.

\}

Note In this chapter, the use of the term “server” refers to a Unified Communications Manager server. The use of
the phrase “voicemail server” refers to a Cisco Unity server or to a Cisco Unity Connection server.

Voice-Messaging Security Setup Tips
Consider the following information before you configure security:

* For Cisco Unity, you must perform security tasks by using the Cisco Unity Telephony Integration Manager
(UTIM); for Cisco Unity Connection, you must perform security tasks by using Cisco Unity Connection
Administration. For information on how to perform these tasks, refer to the applicable Unified
Communications Manager integration guide for Cisco Unity or for Cisco Unity Connection.
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* In addition to the procedures that are described in this chapter, you must use the certificate management
feature in Unified Communications Manager to save the Cisco Unity certificate to the trusted store.

For more information, see the “To Add Voice Messaging Ports in Cisco Unity Connection Administration”
procedure in the Cisco Unified Communications Manager SCCP Integration Guide for Cisco Unity
Connection at the following URL:

http://www.cisco.com/en/US/docs/voice_ip _comm/connection/10x/integration/guide/cucm_sccp/guide/
cucintcucmskinny230.html

After you copy the certificate, you must restart the CiscoCallManager service on each Unified
Communications Manager server in the cluster.

» If Cisco Unity certificates expire or change for any reason, use the certificate management feature in the
Administration Guide for Cisco Unified Communications Manager to update the certificates in the trusted
store. The TLS authentication fails when certificates do not match, and voice messaging does not work
because it cannot register to Unified Communications Manager.

* When configuring voice-mail server ports, you must select a device security mode.

* The setting that you specify in the Cisco Unity Telephony Integration Manager (UTIM) or in Cisco Unity
Connection Administration must match the voice-messaging port device security mode that is configured
in Unified Communications Manager Administration. In Cisco Unity Connection Administration, you
apply the device security mode to the voice-messaging port in the Voice Mail Port Configuration window
(or in the Voice Mail Port Wizard).

2

Tip If the device security mode settings do not match, the voicemail server ports fail to register with Unified
Communications Manager, and the voicemail server cannot accept calls on those ports.

*» Changing the security profile for the port requires a reset of Unified Communications Manager devices
and a restart of the voicemail server software. If you apply a security profile in Unified Communications
Manager Administration that uses a different device security mode than the previous profile, you must
change the setting on the voicemail server.

* You cannot change the Device Security Mode for existing voice-mail servers through the VoiceMail
Port Wizard. If you add ports to an existing voicemail server, the device security mode that is currently
configured for the profile automatically applies to the new ports.

Set Up Secure Voice-Messaging Port

The following procedure provides the tasks used to configure security for voice-messaging ports.

Procedure

Step 1 Verify that you installed and configured the CiscoCTL Client for Mixed Mode.
Step 2 Verify that you configured the phones for authentication or encryption.
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Step 3

Step 4

Step 5

Step 6

Apply Security Profile to Single Voice-Messaging Port .

Use the certificate management feature in Cisco Unified Communications Operating System Administration
to copy the Cisco Unity certificate to the trusted store on the Unified Communications Manager server; then
restart the CiscoCallManager service.

For more information, see the Administration Guide for Cisco Unified Communications Manager and Cisco
Unified Serviceability Administration Guide.

Tip Activate the Cisco CTL Provider service on each Unified Communications Manager server in the
cluster; then restart the CiscoCallManager service on all servers.

In Unified Communications Manager Administration, configure the device security mode for the
voice-messaging ports.

Perform security-related configuration tasks for Cisco Unity or Cisco Unity Connection voice-messaging
ports; for example, configure Cisco Unity to point to the Cisco TFTP server.

For more information, see Unified Communications Manager Integration Guide for Cisco Unity or for Cisco
Unity Connection

Reset the devices in Unified Communications Manager Administration and restart the Cisco Unity software.

For more information, see the Unified Communications ManagerIntegration Guide for Cisco Unity or for
Cisco Unity Connection.

Apply Security Profile to Single Voice-Messaging Port

Step 1

Step 2

Step 3
Step 4

To apply a security profile to a single voice-messaging port, perform the following procedure.

This procedure assumes that you added the device to the database and installed a certificate in the phone, if
a certificate does not already exist. After you apply a security profile for the first time or if you change the
security profile, you must reset the device.

Before you begin

Before you apply a security profile, review topics related to voice-messaging security and secure
voice-messaging port setup.

Procedure

Find the voice-messaging port, as described in the Administration Guide for Cisco Unified Communications
Manager.

After the configuration window for the port displays, locate the Device Security M ode setting. From the
drop-down list box, choose the security mode that you want to apply to the port. The database predefines
these options. The default value specifies Not Selected.

Click Save.
Click Reset.
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Apply Security Profile Using Voice Mail Port Wizard

Use this procedure to apply the Device Security Mode setting in the Voice Mail Port Wizard for a new
voice-mail server.

To change the security setting for an existing voice-mail server, see topics related to applying the security
profile to a single voice-messaging port.
Before you begin

Before you apply a security profile, review topics related to voice-messaging security and secure
voice-messaging port setup.

Procedure
Step 1 Unified Communications Manager Administration, choose Voice M ail > Cisco Voice Mail Port Wizard.
Step 2 Enter the name of the voice-mail server; click Next.

Step 3 Choose the number of ports that you want to add; click Next.

Step 4 In the Cisco Voice Mail Device I nfor mation window, choose a Device Security M ode from the drop-down
list box. The database predefines these options. The default value specifies Not Selected.
Step 5 Configure the other device settings, as described in the Administration Guide for Cisco Unified Communications

Manager. Click Next.

Step 6 Continue the configuration process, as described in the Administration Guide for Cisco Unified Communications
Manager. When the Summary window displays, click Finish.
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Call Secure Status Policy

* About Call Secure Status Policy, on page 183
* Setup Call Secure Status Policy, on page 184

About Call Secure Status Policy

Call Secure Status Policy controls display of secure status icon on phones. The following are the policy options:
* All media except BFCP and iX application streams must be encrypted

This is the default value. The security status of the call is not dependent on the encryption status of BFCP
and iX application streams.

+ All media except iX application streams must be encrypted

The security status of the call is not dependent on the encryption status iX application streams.
* All media except BFCP application streams must be encrypted

The security status of the call is not dependent on the encryption status BFCP.
* All media in a session must be encrypted

The security status of the call is dependent on the encryption status of all the media streams of an
established phone session.

* Only Audio must be encrypted

The security status of the call is dependent on the encryption of the audio stream.

A\

Note Changes to the policy impacts display of the secure icon and playing of secure tone on the phone.
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Setup Call Secure Status Policy

Procedure

Step 1 Find the Call Secure Status Policy service parameter, as described in the "Configure Service Parameters"
section of the System Configuration Guide for Cisco Unified Communications Manager .

Step 2 From the Secure Call | con Display Policy drop-down list, choose a policy option.

A warning message with the impact on video calls and secure tone is displayed.

Step 3 Click Save.

The window refreshes, and Unified Communications Manager updates the service parameter with your changes.
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Secure Call Monitoring and Recording Setup

This chapter provides information about secure call monitoring and recording setup.

* About Secure Call Monitoring and Recording Setup, on page 185
* Set Up Secure Call Monitoring and Recording, on page 186

About Secure Call Monitoring and Recording Setup

Secure calls can be monitored and recorded, as described in this section:

* A supervisor can establish a secured monitoring session for a secured or a non-secured call.

* The call security of the original call is never impacted or downgraded as a result of a call monitoring
request.

* The monitoring call is allowed to proceed only when it can be established and maintained at the same
security level as the device capability of the agent.

* The original call between the agent and customer must have different crypto keys than that of monitoring
call. In a monitoring session, the system encrypts the mixed voices of the agent and customer with the
new key first before sending to the supervisor.

\}

Note Unified Communications Manager supports call recording for authenticated calls while using a nonsecure
recorder. For calls with a secure call recorder, recording is allowed only if the recorder supports SRTP fallback,
so that the media stream to the recorder falls back to RTP.

To record calls that use authenticated phones:

+ Set the Authenticated Phone Recor ding, a Cisco CallManager service parameter, to Allow Recor ding.
In this case, the call is authenticated, but the connection to the recording server is unauthenticated and
unencrypted.

* Ensure that the Cluster SIPOAuth Mode field a Cisco CallManager enterprise parameter, is set to
Enabled.
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Set Up Secure Call Monitoring and Recording

Use this procedure to configure Secure Call Monitoring and Recording.

Procedure
Step 1 Provision secure capability on agent and supervisor phones.
Step 2 Create a secure SIP trunk with the following configuration:

» Set the Device Security M ode to Encrypted.

* Check the Transmit Security Status check box.
* Check the SRTP Allowed check box.

* Configure the TLS SIP trunk to the recorder.

Step 3 Configure monitoring and recording, in the same way you would for non-secure monitoring and recording.
a) Configure a built-in bridge for the agent phone.
b) Configure the Recording Option (Automatic Call Recording Enabled and Application I nvoked Call
Recording Enabled.) using the Directory Number page on the agent phone.
¢) Create a route pattern for the recorder.
d) Add a call recording profile to the Directory Number.
e) Provision monitoring and recording tones as needed.

For more information and detailed procedures, see the “Monitoring and Recording” chapter in the Feature
Configuration Guide for Cisco Unified Communications Manager.
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VPN Client

* VPN Client Overview, on page 189
* VPN Client Configuration Task Flow, on page 189

VPN Client Overview

The Cisco VPN Client for Cisco Unified IP Phone creates a secure VPN connection for employees who
telecommute. All settings of the Cisco VPN Client are configured through Cisco Unified Communications
Manager Administration. After the phone is configured within the Enterprise, the users can plug it into their
broadband router for instant connectivity.

\)

Note The VPN menu and its options are not available in the U.S. export unrestricted version of Unified
Communications Manager.

VPN Client Configuration Task Flow

Pre-provision the phone and establish the initial connection inside the corporate network to retrieve the phone
configuration. You can make subsequent connections using VPN, as the configuration is already retrieved on

the phone.
Procedure
Command or Action Purpose
Step 1 Complete Cisco IOS Prerequisites, on page | Complete Cisco IOS prerequisites. Perform
190 this action if you want to configure Cisco I0S
VPN.
Step 2 Configure Cisco IOS SSL VPN to Support IP | Configure Cisco IOS for VPN client on an IP
Phones , on page 191 Phone. Perform this action if you want to
configure Cisco IOS VPN.
Step 3 Complete ASA Prerequisites for AnyConnect, | Complete ASA prerequisites for AnyConnect.
on page 192 Perform this action if you want to configure
ASA VPN.
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Command or Action

Purpose

Step 4

Configure ASA for VPN Client on IP Phone,
on page 193

Configure ASA for VPN client on an IP Phone.
Perform this action if you want to configure
ASA VPN.

Step 5

Configure the VPN concentrators for each
VPN Gateway.

To avoid long delays when the user upgrades
the firmware or configuration information on
a remote phone, set up the VPN concentrator
close in the network to the TFTP or Unified
Communications Manager server. If this is not
feasible in your network, you can set up an
alternate TFTP or load server that is next to
the VPN concentrator.

Step 6

Upload VPN Concentrator Certificates, on
page 195

Upload the VPN concentrator certificates.

Step 7

Configure VPN Gateway, on page 196

Configure the VPN gateways.

Step 8

Configure VPN Group, on page 197

After you create a VPN group, you can add
one of the VPN gateways that you just
configured to it.

Step 9

Perform one of the following:

* Configure VPN Profile, on page 198
* Configure VPN Feature Parameters, on
page 199

You must configure a VPN profile only if you
have multiple VPN groups. The VPN Profile

fields take precedence over the VPN Feature

Configuration fields.

Step 10

Add VPN Details to Common Phone Profile,
on page 201

Add the VPN Group and VPN Profile to a
Common Phone Profile.

Step 11

Upgrade the firmware for Cisco Unified IP
Phone to a version that supports VPN.

To run the Cisco VPN client, a supported Cisco
Unified IP Phone must be running firmware
release 9.0(2) or higher. For more information
about upgrading the firmware, see Cisco
Unified IP Phone Administration Guide for
Unified Communications Manager for
yourCisco Unified IP Phone model.

Step 12

Using a supported Cisco Unified IP Phone,
establish the VPN connection.

Connect your Cisco Unified IP Phone to a
VPN.

Complete Cisco 10S Prerequisites

Use this procedure to complete Cisco IOS Prerequisites.

Procedure

Step 1

Install Cisco 10S Software version 15.1(2)T or later.

Feature Set/License: Universal (Data & Security & UC) for IOS ISR-G2 and ISR-G3
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Step 2

Configure Cisco 10S SSL VPN to Support IP Phones .

Feature Set/License: Advanced Security for IOS ISR

Activate the SSL VPN License.

Configure Cisco 10S SSL VPN to Support IP Phones

Use this procedure to complete Cisco IOS SSL VPN to Support IP Phones.

Step 1

Step 2
Step 3

Procedure

Configure Cisco 10S locally.

a)

b)

Configure the Network Interface.

Example:

router (config) # interface GigabitEthernet0/0

router (config-if) # description "outside interface"
router (config-if)# ip address 10.1.1.1 255.255.255.0
router (config-if)# duplex auto

router (config-if) # speed auto

router (config-if) # no shutdown

router#show ip interface brief (shows interfaces summary)

Configure static and default routes by using this command:
router(config)# ip route <dest_ip> < mask> < gateway_ip>

Example:

router (config)# ip route 10.10.10.0 255.255.255.0 192.168.1.1

Generate and register the CAPF certificate to authenticate the IP phones with an LSC.

Import the CAPF certificate from Unified Communications Manager.

a)

b)
<)

d)

From the Cisco Unified OS Administration, choose Security > Certificate M anagement.

Note This location changes based on the Unified Communications Manager version.

Find the Cisco Manufacturing CA and CAPF certificates. Download the.pem file and save as.txt file.
Create trustpoint on the Cisco IOS software.
hostname (config) # crypto pki trustpoint trustpoint name

hostname (config-ca-trustpoint)# enrollment terminal
hostname (config) # crypto pki authenticate trustpoint

When prompted for the base 64-encoded CA certificate, copy and paste the text in the downloaded .pem
file along with the BEGIN and END lines. Repeat the procedure for the other certificates.

Generate the following Cisco 10S self-signed certificates and register them with Unified Communications
Manager, or replace with a certificate that you import from a CA.

* Generate a self-signed certificate.

Router> enable

Router# configure terminal

Router (config)# crypto key generate rsa general-keys label <name>
<exportable -optional>Router (config)# crypto pki trustpoint <name>
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Step 4

Step 5

Router (ca-trustpoint) # enrollment selfsigned

Router (ca-trustpoint) # rsakeypair <name> 2048 2048

Router (ca-trustpoint) #authorization username subjectname commonname
Router (ca-trustpoint) # crypto pki enroll <name>

Router (ca-trustpoint)# end

Generate a self-signed certificate with Host-id check enabled on the VPN profile in Unified
Communications Manager.

Example:

Router> enable

Router# configure terminal

Router (config)# crypto key generate rsa general-keys label <name>
<exportable -optional>Router (config)# crypto pki trustpoint <name>
Router (ca-trustpoint) # enrollment selfsigned

Router (config-ca-trustpoint) # f£gdn <full domain

name>Router (config-ca-trustpoint)# subject-name CN=<full domain
name>, CN=<IP>Router (ca-trustpoint) #authorization username
subjectname commonname

Router (ca-trustpoint)# crypto pki enroll <name>

Router (ca-trustpoint) # end

Register the generated certificate with Unified Communications Manager.
Example:
Router (config) # crypto pki export <name> pem terminal

Copy the text from the terminal and save it as a.pem file and upload it to the Unified Communications
Manager using the Cisco Unified OS Administration.

Install AnyConnect on Cisco IOS.
Download the Anyconnect package from cisco.com and install to flash.

Example:

router (config) #webvpn install svc
flash:/webvpn/anyconnect-win-2.3.2016-k9.pkg

Configure the VPN feature.

Note To use the phone with both certificate and password authentication, create a user with the phone
MAC address. Username matching is case sensitive. For example:

username CP-7975G-SEP001AE2BC16CB password klkLGQIoxyCO4ti9 encrypted

Complete ASA Prerequisites for AnyConnect

Step 1
Step 2

Use this procedure to complete ASA Prerequisites for AnyConnect.

Procedure

Install ASA software (version 8.0.4 or later) and a compatible ASDM.
Install a compatible AnyConnect package.
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Step 3 Activate License.

a) Check features of the current license using the following command:

show activation-key detail

b) If necessary, obtain a new license with additional SSL. VPN sessions and enable the Linksys phone.

Step 4 Make sure that you configure a tunnel-group with a non-default URL as follows:

tunnel-group phonevpn type remote-access
tunnel-group phonevpn general-attribute
address-pool vpnpool
tunnel-group phonevpn webvpn-attributes
group-url https://172.18.254.172/phonevpn enable

Consider the following when configuring non-default URL:

* If the IP address of the ASA has a public DNS entry, you can replace it with a Fully Qualified Domain
Name (FQDN).

* You can only use a single URL (FQDN or IP address) on the VPN gateway in Unified Communications
Manager.

» It is preferred to have the certificate CN or subject alternate name match the FQDN or IP address in the
group-url.

* [f the ASA certificate CN or SAN does not match with the FQDN or IP address, uncheck the host ID
check box in the Unified Communications Manager.

Configure ASA for VPN Client on IP Phone

Use this procedure to configure ASA for VPN Client on IP Phone.

\}

Note Replacing ASA certificates results in non-availability of Unified Communications Manager.

Procedure

Step 1 Local configuration

a) Configure network interface.
Example:

ciscoasa(config)# interface Ethernet0/0
ciscoasa(config-if) # nameif outside

ciscoasa(config-if)# ip address 10.89.79.135 255.255.255.0
ciscoasa(config-if)# duplex auto

ciscoasa(config-if)# speed auto

ciscoasa(config-if) # no shutdown

ciscoasa#show interface ip brief (shows interfaces summary)

b) Configure static routes and default routes.
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ciscoasa(config)# route <interface name> <ip_address> <netmask> <gateway ip>

Example:

ciscoasa (config) # route outside 0.0.0.0 0.0.0.0 10.89.79.129
c¢) Configure the DNS.

Example:

ciscoasa(config)# dns domain-lookup inside
ciscoasa(config) # dns server-group Defaul tDNS
ciscoasa (config-dns-server-group) # name-server 10.1.1.5 192.168.1.67 209.165.201.6

Step 2 Generate and register the necessary certificates for Unified Communications Manager and ASA.
Import the following certificates from the Unified Communications Manager.

* CallManager - Authenticating the Cisco UCM during TLS handshake (Only required for mixed-mode
clusters).

* Cisco_Manufacturing_ CA - Authenticating IP phones with a Manufacturer Installed Certificate (MIC).
* CAPF - Authenticating IP phones with an LSC.

To import these Unified Communications Manager certificates, do the following:

a) From the Cisco Unified OS Administration, choose Security > Certificate M anagement.

b) Locate the certificates Cisco Manufacturing CA and CAPF. Download the . pem file and save asa . txt
file.

c) Create trustpoint on the ASA.

Example:

ciscoasa(config)# crypto ca trustpoint trustpoint name
ciscoasa (ca-trustpoint)# enrollment terminal
ciscoasa(config) # crypto ca authenticate trustpoint name

When prompted for base 64 encoded CA Certificate, copy-paste the text in the downloaded . pem file
along with the BEGIN and END lines. Repeat the procedure for the other certificates.

d) Generate the following ASA self-signed certificates and register them with Unified Communications
Manager, or replace with a certificate that you import from a CA.

* Generate a self-signed certificate.

Example:

ciscoasa> enable

ciscoasa# configure terminal

ciscoasa(config)# crypto key generate rsa general-keys label <name>
ciscoasa(config) # crypto ca trustpoint <name>

ciscoasa (ca-trustpoint)# enrollment self

ciscoasa(ca-trustpoint) # keypair <name>

ciscoasa(config) # crypto ca enroll <name>

ciscoasa(config) # end

Generate a self-signed certificate with Host-id check enabled on the VPN profile in Unified
Communications Manager.

Example:
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Upload VPN Concentrator Certificates .

ciscoasa> enable

ciscoasa# configure terminal

ciscoasa(config) # crypto key generate rsa general-keys label <name>
ciscoasa(config) # crypto ca trustpoint <name>

ciscoasa(ca-trustpoint)# enrollment self

ciscoasa (ca-trustpoint)# fgdn <full domain name>

ciscoasa (config-ca-trustpoint) # subject-name CN=<full domain name>,CN=<IP>
ciscoasa(config)# crypto ca enroll <name>

ciscoasa (config) # end

Register the generated certificate with Unified Communications Manager.

Example:

ciscoasa(config)# crypto ca export <name> identity-certificate

Copy the text from the terminal and save it as a.pem file and upload it to Unified Communications
Manager.

Step 3 Configure the VPN feature. You can use the Sample ASA configuration summary below to guide you with
the configuration.

Note

To use the phone with both certificate and password authentication, create a user with the phone
MAC address. Username matching is case sensitive. For example:

ciscoasa(config) # username CP-7975G-SEP001AE2BC16CB password klkLGQIoxyCO4ti9
encrypted

ciscoasa(config)# username CP-7975G-SEP001AE2BC16CB attributes

ciscoasa (config-username) # vpn-group-policy GroupPhoneWebvpn

ciscoasa (config-username) #service-type remote-access

ASA Certificate Configuration

For more information on ASA certificate configuration, see Configure AnyConnect VPN Phone with
Certificate Authentication on an ASA

Upload VPN Concentrator Certificates

Generate a certificate on the ASA when you set it up to support the VPN feature. Download the generated
certificate to your PC or workstation and then upload it to Unified Communications Manager using the
procedure in this section. Unified Communications Manager saves the certificate in the Phone-VPN-trust list.

The ASA sends this certificate during the SSL handshake, and the Cisco Unified IP Phone compares it against
the values stored in the Phone-VPN-trust list.

If a Locally Significant Certificate (LSC) is installed on the Cisco Unified IP Phone, it will send its LSC by

default.

To use device level certificate authentication, install the root MIC or CAPF certificate in the ASA, so that the
Cisco Unified IP Phone are trusted.

To upload certificates to Unified Communications Manager, use the Cisco Unified OS Administration.
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. Configure VPN Gateway

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6

Procedure

From Cisco Unified OS Administration, choose Security > Certificate M anagement.
Click Upload Certificate.

From the Certificate Purpose drop-down list, choose Phone-VPN-trust.

Click Browse to choose the file that you want to upload.

Click Upload File.

Choose another file to upload or click Close.

For more information, see Certificate Management chapter.

Configure VPN Gateway

Step 1
Step 2

Step 3

Step 4

Ensure that you have configured VPN concentrators for each VPN gateway. After configuring the VPN
concentrators, upload the VPN concentrator certificates. For more information, see Upload VPN Concentrator
Certificates, on page 195.

Use this procedure to configure the VPN Gateway.

Procedure

From Cisco Unified CM Administration, choose Advanced Features> VPN > VPN Gateway.

Perform one of the following tasks:

a) Click Add New to configure new profile.

b) Click the Copy next to the VPN gateway that you want to copy.

¢) Locate the appropriate VPN gateway and modify the settings to update an existing profile.

Configure the fields in the VPN Gateway Configuration window. For more information, see VPN Gateway
Fields for VPN Client, on page 196.

Click Save.

VPN Gateway Fields for VPN Client

The table describes the VPN Gateway fields for VPN Client.

Table 28: VPN Gateway Fields for VPN Client

Field Description

VPN Gateway Name Enter the name of the VPN gateway.

VPN Gateway Enter a description of the VPN gateway.
Description
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Field Description
VPN Gateway URL Enter the URL for the main VPN concentrator in the gateway.
Note You must configure the VPN concentrator with a group URL and use

this URL as the gateway URL.

For configuration information, refer to the documentation for the VPN
concentrator, such as the following:

* SSL VPN Client (SVC) on ASA with ASDM Configuration Example

VPN Certificates in this | Use the up and down arrow keys to assign certificates to the gateway. If you do
Gateway not assign a certificate for the gateway, the VPN client fails to connect to that
concentrator.

Note You can assign up to 10 certificates to a VPN gateway, and you must
assign at least one certificate to each gateway. Only certificates that
are associated with the Phone-VPN-trust role appear in the available
VPN certificates list.

Configure VPN Group

Use this procedure to configure VPN Group.

Procedure

Step 1 From Cisco Unified CM Administration, choose Advanced Features> VPN > VPN Group.
Step 2 Perform one of the following tasks:

a) Click Add New to configure new profile.

b) Click Copy next to the VPN group that you want to copy an existing VPN group.

¢) Locate the appropriate VPN group and modify the settings to update an existing profile.

Step 3 Configure the fields in the VPN Group Configur ation window. For more information, see VPN Gateway
Fields for VPN Client, on page 196 for the field description details.

Step 4 Click Save.

VPN Group Fields for VPN Client

The table describes the VPN Group Fields for VPN Client.

Table 29: VPN Group Fields for VPN Client

Field Definition

VPN Group Name Enter the name of the VPN group.

VPN Group Description | Enter a description of the VPN group.
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Field Definition
All Available VPN Scroll to see all available VPN gateways.
Gateways

in this VPN Group

Selected VPN Gateways | Use the up and down arrow buttons to move available VPN gateways into and

out of this VPN group.

If the VPN client encounters critical error and cannot connect to a particular VPN
gateway, it will attempt to move to the next VPN gateway in the list.

Note You can add up to a maximum of three VPN gateways to a VPN group.
Also, the total number of certificates in the VPN group cannot exceed
10.

Configure VPN Profile

Use this procedure to configure the VPN Profile.

Step 1
Step 2

Step 3

Step 4

Procedure

From Cisco Unified CM Administration, choose Advanced Features> VPN > VPN Profile.

Perform one of the following tasks:

a) Click Add New to configure new profle.
b) Click Copy next to the VPN profile that you want to copy an existing profile.
¢) To update an existing profile, specify the appropriate filters in the Find VPN Profile Where, click Find,

and modify the settings.

Configure the fields in the VPN Profile Configuration window. For more information, see VPN Profile
Fields for VPN Client, on page 198 for the field description details.

Click Save.

VPN Profile Fields for VPN Client

The table describes the VPN profile field details.

Table 30: VPN Profile Field Details

Field Definition
Name Enter a name for the VPN profile.
Description Enter a description for the VPN profile.
Enable Auto Network When you check this check box, the VPN client can only run when it detects that
Detect it is out of the corporate network.
Default: Disabled.
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Field Definition

MTU Enter the size, in bytes, for the Maximum Transmission Unit (MTU).
Default: 1290 bytes.

Fail to Connect This field specifies the amount of time to wait for login or connect operations to
complete while the system creates the VPN tunnel.

Default: 30 seconds

Enable Host ID Check | When you check this check box, the gateway certificate subjectAltName or CN
must match the URL to which the VPN client is connected.

Default: Enabled

Client Authentication From the drop-down list, choose the client authentication method:
Meth
cthod * User and password
* Password only

* Certificate (LSC or MIC)

Enable Password When you check this check box, a user password gets saved in the phone until
Persistence either a failed log in attempt occurs, a user manually clears the password, or the
phone resets or loses power.

Configure VPN Feature Parameters

Procedure

Step 1 From Cisco Unified CM Administration, choose Advanced Features>VPN > VPN Feature Configuration.

Step 2 Configure the fields in the VPN Feature Configuration window. For more information, see VPN Feature
Parameters, on page 199.

Step 3 Click Save.
Perform the following tasks:

 Upgrade the firmware for Cisco Unified IP Phones to a version that supports VPN. For more information
about upgrading the firmware, see Cisco Unified IP Phone Administration Guide for your Cisco Unified
IP Phone model.

+ Using a supported Cisco Unified IP Phone, establish the VPN connection.

VPN Feature Parameters

The table describes the VPN feature parameters.
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Table 31: VPN Feature Parameters
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Field Default
Enable Auto Network When True, the VPN client can only run when it detects that it is out of the
Detect corporate network.
Default: False
MTU This field specifies the maximum transmission unit:
Default: 1290 bytes
Minimum: 256 bytes
Maximum: 1406 bytes
Keep Alive This field specifies the rate at which the system sends the keep alive message.

Note If it is non zero and less than the value specified in Unified

Communications Manager, the keep alive setting in the VPN
concentrator overwrites this setting.

Default: 60 seconds

Minimum: 0

Maximum: 120 seconds

Fail to Connect

This field specifies the amount of time to wait for login or connect operations to
complete while the system creates the VPN tunnel.

Default: 30 seconds
Minimum: 0

Maximum: 600 seconds

Client Authentication
Method

From the drop-down list, choose the client authentication method:

* User and password
* Password only

* Certificate (LSC or MIC)

Default: User And Password

Enable Password

When True, a user password gets saved in the phone, if Reset button or “#*#**”

Persistence is used for reset. The password does not get saved and the phone prompts for
credentials if the phone loses power or you initiate a factory reset.
Default: False

Enable Host ID Check | When True, the gateway certificate subjectAltName or CN must match the URL

to which the VPN client is connected.

Default: True
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Add VPN Details to Common Phone Profile

Use this procedure to add VPN details to common phone profile.

Procedure

Step 1 From Cisco Unified CM Administration, choose Device > Device Settings> Common Phone Profile.
Step 2 Click Find and choose common phone profile to which you want to add the VPN details.

Step 3 In the VPN Information section, choose the appropriate VPN Group and VPN Profile.

Step 4 Click Save and then Apply Config.

Step 5 Click OK in apply configuration window.
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PART IV

Cisco CTI, JTAPI, and TAPI Application Security

* Authentication and Encryption Setup for CTI, JTAPI, and TAPI, on page 205
* Certificate Revocation/Expiry Status Verification, on page 217






CHAPTER 20

Authentication and Encryption Setup for CTI,
JTAPI, and TAPI

This chapter provides a brief overview of how to secure the CTI, JTAPI, and TAPI applications. It also
describes the tasks that you must perform in Unified Communications Manager Administration to configure
authentication and encryption for CTI/TAPI/JTAPI applications.

This document does not describe how to install the CiscoJTAPI or TSP plug-ins that are available in Unified
Communications Manager Administration, nor does it describe how to configure the security parameters
during the installation. Likewise, this document does not describe how to configure restrictions for
CTlI-controlled devices or lines.

* Authentication for CTI, JTAPI, and TAPI Applications, on page 205

* Encryption for CTI, JTAPI, and TAPI Applications, on page 206

* CAPF Functions for CTI, JTAPI, and TAPI Applications, on page 207

* Securing CTI, JTAPI, and TAPI, on page 213

» Add Application and End Users to Security-Related Access Control Groups, on page 214
* Set Up JTAPI/TAPI Security-Related Service Parameters, on page 215

* View Certificate Operation Status for Application or End User, on page 215

Authentication for CTI, JTAPI, and TAPI Applications

Unified Communications Manager allows you to secure the signaling connections and media streams between
CTIManager and CTI/JTAPI/TAPI applications.

\}

Note We assume that you configured security settings during the CiscoJTAPI/TSP plug-in installation. We also
assume that the Cluster Security Mode equals Mixed Mode, as configured in the Cisco CTL Client or through
the CLI command set utilsctl. If these settings are not configured when you perform the tasks that are described
in this chapter, CTIManager and the application connect via a nonsecure port, Port2748.

CTIManager and the application verify the identity of the other party through a mutually authenticated TLS
handshake (certificate exchange). When a TLS connection occurs, CTIManager and the application exchange
QBE messages via the TLS port, Port 2749.
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To authenticate with the application, CTIManager uses the Unified Communications Manager certificate —
either the self-signed certificate that installs automatically on the Unified Communications Manager server
during installation or a third-party, CA-signed certificate that you uploaded to the platform.

After you generate the CTL file through the CLI command set utilsctl or the Cisco CTL Client, this certificate
is added automatically to the CTL file. Before the application attempts to connect to CTIManager, the
application downloads the CTL file from the TFTP server.

The first time that the JTAPI/TSP client downloads the CTL file from the TFTP server, the JTAPI/TSP client
trusts the CTL file. We recommend that the download occur in a secure environment because the JTAPI/TSP
client does not validate the CTL file. The JTAPI/TSP client verifies subsequent downloads of the CTL file;
for example, after you update the CTL file, the JTAPI/TSP client uses the security tokens in the CTL file to
authenticate the digital signature of the new CTL file it downloads. Contents of the file include the Unified
Communications Manager certificates and CAPF server certificate.

If the CTL file appears compromised, the JTAPI/TSP client does not replace the downloaded CTL file; the
client logs an error and attempts to establish a TLS connection by using an older certificate in the existing
CTL file. The connection may not succeed if the CTL file has changed or is compromised. If the CTL file
download fails and more than one TFTP server exists, you can configure another TFTP server to download
the file. The JTAPI/TAPI client does not connect to any port under the following circumstances:

* The client cannot download the CTL file for some reason; for example, no CTL file exists.
* The client does not have an existing CTL file.

* You configured the application user as a secure CTI user.

To authenticate with CTIManager, the application uses a certificate that the Certificate Authority Proxy
Function (CAPF) issues. To use TLS for every connection between the application and CTIManager, each
instance that runs on the application PC must have a unique certificate. One certificate does not cover all
instances. To ensure that the certificate installs on the node whereCisco Unified Communications Manager
Assistant service is running, you configure a unique Instance ID for each Application User CAPF Profile
Configuration or End User CAPF Profile Configuration in Cisco Unified Communications Manager
Administration, as described in CAPF Settings.

Je

Tip  If you uninstall the application from one PC and install it on another PC, you must install a new certificate
for each instance on the new PC.

You must also add the application users or the end users to the Standard CTI Secure Connection user group
in Unified Communications Manager to enable TLS for the application. After you add the user to this group
and install the certificate, the application ensures that the user connects via the TLS port.

Encryption for CTI, JTAPI, and TAPI Applications
je)

Tip  Authentication serves as the minimum requirement for encryption; that is, you cannot use encryption if you
have not configured authentication.

Unified Communications Manager, Cisco QRT, and Cisco Web Dialer do not support encryption. CTI clients
that connect to the CTIManager service may support encryption if the client sends voice packets.
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To secure the media streams between the application and CTIManager, add the application users or the end
users to the Standard CTI Allow Reception of SRTP Key Material user group in Unified Communications
Manager. If these users also exist in the Standard CTI Secure Connection user group and if the cluster security
mode equals Mixed Mode, CTIManager establishes a TLS connection with the application and provides the
key materials to the application in a media event

\)

Note Cluster security mode configures the security capability for your standalone server or cluster.

Although applications do not record or store the SRTP key materials, the application uses the key materials
to encrypt its RTP stream and decrypt the SRTP stream from CTIManager.

If the application connects to the nonsecure port, Port 2748, for any reason, CTIManager does not send the
keying material. If CTI/JTAPI/TAPI cannot monitor or control a device or directory number because you
configured restrictions, CTIManager does not send the keying material.

Je

Tip  For an application to receive SRTP session keys, the application or end user must exist in three groups:
Standard CTI Enabled, Standard CTI Secure Connection, and Standard CTI Allow Reception of SRTP Key
Material.

Although Unified Communications Manager can facilitate secure calls to and from CTIports and route points,
you must configure the application to support secure calls because the application handles the media parameters.

CTlports/route points register through dynamic or static registration. If the port/route point uses dynamic
registration, the media parameters get specified for each call; for static registration, media parameters get
specified during registration and cannot change per call. When CTIports/route points register to CTIManager
through a TLS connection, the device registers securely, and the media gets encrypted via SRTP if the
application uses a valid encryption algorithm in the device registration request and if the other party is secure.

When the CTI application begins to monitor a call that is already established, the application does not receive
any RTP events. For the established call, the CTI application provides a DeviceSnapshot event, which defines
whether the media for the call is secure or nonsecure; this event provides no keying material.

CAPF Functions for CTI, JTAPI, and TAPI Applications

Certificate Authority Proxy Function (CAPF), which automatically installs with Unified Communications
Manager, performs the following tasks for CTI/TAPI/TAPI applications, depending on your configuration:

* Authenticates to the JTAPI/TSP client via an authentication string.
* Issues Locally Significant Certificates (LSC) to CTI/JTAPI/TAPI applicationusers or end users.
 Upgrades existing Locally Significant Certificates.

* Retrieves certificates for viewing and troubleshooting.

When the JTAPI/TSP client interacts with CAPF, the client authenticates to CAPF by using an authentication
string; the client then generates its public key and private key pair and forwards its public key to the CAPF
server in a signed message. The private key remains in the client and never gets exposed externally. CAPF
signs the certificate and then sends the certificate back to the client in a signed message.

Security Guide for Cisco Unified Communications Manager, Release 11.5(1)SU10 .



Cisco CTI, JTAPI, and TAPI Application Security |
. CAPF System Interactions and Requirements for CTl, JTAPI, and TAPI Applications

You issue certificates to application users or end users by configuring the settings in the Application User
CAPF Profile Configuration window or End User CAPF Profile Configuration window, respectively. The
following information describes the differences between the CAPF profiles that Unified Communications
Manager supports:

» Application User CAPF Profile—This profile allows you to issue locally significant certificates to
secure application users so that a TLS connection opens between the CTIManager service and the
application.

One Application User CAPF Profile corresponds to a single instance of the service or application on a
server. If you activate multiple web services or applications on the same server, you must configure
multiple Application User CAPF Profiles, one for each service on the server.

If you activate a service or application on two servers in the cluster, you must configure two Application
User CAPF Profiles, one for each server.

» End User CAPF Profile—This profile allows you to issue locally significant certificates to CTI clients
so that the CTI client communicates with the CTIManager service via a TLS connection.

2

Tip  The JTAPI client stores the LSC in Java Key Store format in the path that you configure in the JTAPI
Preferences window. The TSP client stores the LSC in an encrypted format in the default directory or in the
path that you configure.

The following information applies when a communication or power failure occurs.

* If a communication failure occurs while the certificate installation is taking place, the JTAPI client
attempts to obtain the certificate three more times in 30-second intervals. You cannot configure this
value.

For the TSP client, you can configure the retry attempts and the retry timer. Configure these values by

specifying the number of times that the TSP client tries to obtain the certificate in an allotted time. For
both values, the default equals 0. You can configure up to 3 retry attempts by specifying 1 (for one retry),
2, or 3. You can configure no more than 30 seconds for each retry attempt.

* If a power failure occurs while the JTAPI/TSP client attempts a session with CAPF, the client attempts
to download the certificate after power gets restored.

CAPF System Interactions and Requirements for CTI, JTAPI, and TAPI
Applications

The following requirements exist for CAPF:

* Before you configure the Application User and End User CAPF Profiles, verify that the Cluster Security
Mode in the Enterprise Parameters Configuration window is 1 (mixed mode).

* To use CAPF, you must activate the Cisco Certificate Authority Proxy Function service on the publisher
node.

* Generating many certificates at the same time may cause call-processing interruptions and we recommend
that you use CAPF during a scheduled maintenance window.

* Ensure that the publisher node is functional and running during the entire certificate operation.
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Certificate Authority Proxy Function Service Activation .

* Ensure that the CTI/ JTAPI/TAPI application is functional during the entire certificate operation.

Certificate Authority Proxy Function Service Activation

Unified Communications Managerdoes not automatically activate the Certificate Authority Proxy Function
service in Cisco Unified Serviceability.

To use the CAPF functionality, you must activate this service on the first node.

If you did not activate this service before you installed and configured the Cisco CTL Client, you must update
the CTL file.

After you activate the Cisco Certificate Authority Proxy Function service, CAPF automatically generates a
key pair and certificate that is specific to CAPF. The CAPF certificate, which the Cisco CTL Client copies
to your standalone server or all server(s) in the cluster, uses the .0 extension. The CAPF certificate is then
displayed on the Cisco Unified Communications Operating System GUI as a verification that the CAPF
certificate exists.

Set Up Application User or End User CAPF Profile

Step 1

Step 2

Step 3
Step 4
Step 5

Use CAPF Settings as a reference when you install/upgrade/troubleshoot locally significant certificates for
JTAPI/TAPI/CTI applications.

Je

Tip We recommend that you configure Application User CAPF Profiles before you configure End User CAPF

Profiles.

Procedure

From Cisco Unified Communications Manager Administration, choose one of the following options:
a) User Management > User Settings> Application User CAPF Profile
b) User Management > User Settings> End User CAPF Profile.

Perform one of the following tasks:
a) To edit an existing profile, click Find and select the existing profile.
b) To create a new profile, click Add New.

¢) To copy settings from an existing profile to a new profile, click Find and select the existing profile with
the settings that you want. Click Copy and name the new profile that will contain those settings. Then
edit the new profile as needed.

Enter the appropriate settings as described in CAPF Settings.
Click Save.

Repeat this procedure to create additional CAPF Profiles. Create as many profiles as your users need.
If you configured the CCM QRT SecureSysUser, | PM A SecureSysUser, or WDSecureSysUser in the
Application User CAPF Profile Configuration window, you must configure Service Parameters.
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CAPF Settings
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The following table describes the CAPF settings in the Application User CAPF Profile Configuration and
End User CAPF Profile Configuration windows.

Table 32: Application and End User CAPF Profile Configuration Settings

Setting

Description

Application User

From the drop-down list, choose the application user for the CAPF
operation.This setting shows configured application users.

This setting does not display in the End User CAPF Profile window.

End User ID

From the drop-down list, choose the end user for the CAPF operation. This
setting shows configured end users.

This setting does not display in the Application User CAPF Profile window.

Instance ID

Enter 1-128 alphanumeric characters (a-zA-Z0-9). The Instance ID identifies the
user for the certificate operation.

You can configure multiple connections (instances) of an application.To secure
the connection between the application and CTIManager, ensure that each instance
that runs on the application PC (for end users) or server (for application users)
has a unique certificate.

This field relates to the CAPF Profile Instance ID for Secure Connection to
CTIManager service parameter that supports web services and applications.

Certificate Operation

From the drop-down list, choose one of the following options:

+ No Pending Oper ation—Displays when no certificate operation is occurring.
(Default Setting)

* Install/Upgrade—Installs a new or upgrades an existing Locally Significant
Certificate for the application.

Authentication Mode

The authentication mode for the Install/Upgrade certificate operation specifies
By Authentication String, which means CAPF installs/upgrades or troubleshoots
alocally significant certificate only when the user/administrator enters the CAPF
authentication string in the JTAPI/TSP Preferences window.

Authentication String

Manually enter a unique string or generate a string by clicking the Gener ate
String button.

Ensure that the string contains 4 to 10 digits.

To install or upgrade a Locally Significant Certificate, you must enter the
authentication string in the JTAPI/T SP preferences GUI on the applicationPC.
This string supports one-time use only; after you use the string for the instance,
you cannot use it again.

Generate String

If you want CAPF to automatically generate an authentication string, click the
Generate String button. The 4- to10-digit authentication string displays in the
Authentication String field.
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Setting

Description

Key Order

This field specifies the sequence of the key for CAPF. Select one of the following
values from the drop-down list:

* RSA Only
« EC Only
* EC Preferred, RSA Backup

Note When you add a phone based on the value in Key Order, RSA Key
Size, and EC Key Sizefields, the device security profile is associated
with the phone. If you select the EC Only value with the EC Key Size
value of 256 bits then the device security profile appends with EC-256
value.

RSA Key Size (Bits)

From the drop-down list, choose one of the these values—512, 1024, 2048, 3072,
or 4096.

EC Key Size (Bits)

From the drop-down list, choose one of the these values—256, 384, or 521.

Operation Completes by

This field, which supports all certificate operations, specifies the date and time
by which you must complete the operation.

The values displayed apply for the first node.

Use this setting with the CAPF Oper ation Expiresin (days) enterprise parameter,
which specifies the default number of days in which the certificate operation
must be completed. You can update this parameter any time.

Certificate Operation
Status

This field displays the progress of the certificate operation, such as pending,
failed, or successful.

You cannot change the information that displays in this field.

Update CAPF Service Parameters

The Service Parameter window contains optional settings for the Cisco Certificate Authority Proxy Function.
You can configure settings such as the Certificate Issuer, Online CA connection settings, Certificate Validity
duration, and key size for the CAPF certificate.

For the CAPF service parameters to display as Active in Cisco Unified Communications Manager
Administration, Activate the Certificate Authority Proxy Function service in Cisco Unified Serviceability.

Je

Tip If you updated the CAPF service parameters when you used CAPF for the phones, you do not need to update

the service parameters again.

To update the CAPF service parameters, perform the following procedure:
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. Delete Application User CAPF or End User CAPF Profile

Step 1
Step 2
Step 3
Step 4

Step 5

Procedure

From Cisco Unified Communications Manager Administration, choose System > Service Parameters.
From the Server drop-down list, choose the server.

Tip You must choose the publisher node in the cluster.

From the Service drop-down list, choose the CiscoCertificate Authority Proxy Function service. Verify
that the word “Active” displays next to the service name.

Update the CAPF service parameter s, as described in the Online help. To display help for the CAPF service
parameters, click the question mark or the parameter name link.

For the changes to take effect, restart the Cisco Certificate Authority Proxy Function service in Cisco
Unified Serviceability.

Note For more information on how to configure the Certificate Authority Proxy Function, See Certificate
Authority Proxy Function chapter.

Delete Application User CAPF or End User CAPF Profile

Step 1
Step 2

Step 3

Before you can delete an Application User CAPF Profile or End User CAPF Profile from Cisco Unified
Communications Manager Administration, you must apply a different profile to the devices or delete all
devices that use the profile. To find out which devices use the profile, choose Dependency Recor ds from the
Related Links drop-down list in the Security Profile Configuration window and click Go.

If the dependency records feature is not enabled for the system, the dependency records summary window
displays a message that shows the action that you can take to enable the dependency records; the message
also displays information about high CPU consumption that is related to the dependency records feature. For
more information about dependency records, refer to the System Configuration Guide for Cisco Unified
Communications Manager.

This section describes how to delete an Application User CAPF Profile or End User CAPF Profile from the
Unified Communications Manager database.

Procedure

Find the Application User CAPF Profile or End User CAPF Profile.
Perform one of the following tasks:

a) To delete multiple profiles, check the check boxes next to the appropriate check box in the Find and List
window; then, click Delete Selected. You can delete all configurable records for this selection by clicking
Select All and then clicking Delete Selected.

b) To delete a single profile, check the check box next to the appropriate profile In the Find and List window;
then, click Delete Selected.

When prompted to confirm the delete operation, click OK to delete or Cancel to cancel the delete operation.
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Securing CTI, JTAPI, and TAPI

Step 1

Step 2

Step 3

The following procedure provides the tasks that you perform to secure the CTI/JTAPI/TAPI application.

Procedure

Verify that the CTI application and any JTAPI/TSP plug-ins are installed and running.
Tip Assign the application user to the Standard CTI Enabled group.
See the following documentation for more information:

« Cisco JTAPI Installation Guide for Unified Communications Manager

» Cisco TAPI Installation Guide for Unified Communications Manager

Verify that the following Unified Communications Manager security features are installed (if not installed,
install and configure these features):

* Verify if the CTL Client is installed and run the CTL file to create it.
* Verify if the CTL provider service is installed and that the service is activated.

* Verify if the CAPF service is installed and that the service is activated. If necessary, update CAPF service
parameters.

Tip The CAPF service must run for the Cisco CTL Client to include the CAPF certificate in the
CTL file. If you updated these parameters when you used CAPF for the phones, you do not
need to update the parameters again.

» Verify if the cluster security mode is set to Mixed Mode. (Cluster security mode configures the security
capability for your standalone server or cluster.)

Tip The CTI/JTAPI/TAPI application cannot access the CTL file if the cluster security mode does
not equal Mixed Mode.

Assign your end users and application users to access control groups that contain the permissions they need.
Assign your users to all of the following groups so that they can use TL S and SRTP over CTI connections:

« Standard CTI Enabled
« Standard CTI Secure Connection

* Standard CTI Allow Reception of SRTP Key Material

Tip A CTI application can be assigned to either an application user or an end user, but not both.

The user must already exist in the Standard CT| Enabled and Standard CTI Secure Connection user
group. The application or end user cannot receive SRTP session keys if it does not exist in these three groups.
For more information, see topics related to User access control group configurations.

Note Cisco Unified Communications Manager Assistant, Cisco QRT, and Cisco Web Dialer do not
support encryption. CTI clients that connect to the CTIManager service may support encryption if
the client sends voice packets.
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. Add Application and End Users to Security-Related Access Control Groups

Step 4

Step 5

Configure CAPF Profiles for your end users and application users. For more information, see Certificate
Authority Proxy Function chapter.

Enable the corresponding security-related parameters in the CTI/JTAPI/TAPI application.

Add Application and End Users to Security-Related Access
Control Groups

Step 1
Step 2
Step 3

Step 4
Step 5

The Standard CTI Secure Connection user group and the Standard CTI Allow Reception of SRTP Key Material
user group display in Unified Communications Manager by default. You cannot delete these groups.

To secure the user connection to CTIManager, you must add the application user or end users to the Standard
CTI Secure Connection user group. You can assign a CTI application to either an application user or an end
user, but not both.

If you want the application and CTIManager to secure the media streams, you must add the application user
or end users to the Standard CTI Allow Reception of SRTP Key Material user group.

Before the application and end user can use SRTP, the user must exist in the Standard CTI Enabled and
Standard CTI Secure Connection user groups, which serve as a baseline configuration for TLS. SRTP
connections require TLS. After the user exists in these groups, you can add the user to the Standard CTI Allow
Reception of SRTP Key Material user group. For an application to receive SRTP session keys, the application
or end user must exist in three groups: Standard CT| Enabled, Standard CTI Secure Connection, and
Standard CTI Allow Reception of SRTP Key Material.

You do not need to add the application users, CCMQRTSecureSysUser, IPMASecureSysUser, and the
WDSecureSysUser, to the Standard CTI Allow Reception of SRTP Key Material user group because Cisco
Unified Communications Manager Assistant, CiscoQRT, and Cisco Web Dialer do not support encryption.

Je

Tip  For information on deleting an application or end user from a user group, refer to the Administration Guide

for Cisco Unified Communications Manager. For information about security-related settings in the Role
Configuration window, refer to the Administration Guide for Cisco Unified Communications Manager.

Procedure

From Cisco Unified Communications Manager Administration, choose User M anagement > User Groups.
To display all user groups, click Find.
Depending on what you want to accomplish, perform one of the following tasks:

a) Verify that the application or end users exist in the Standard CTI Enabled group.

b) To add an application user or end users to the Standard CT| Secure Connection user group, click the
Standard CTI Secure Connection link.

¢) To add an application user or end users to the Standard CT| Allow Reception of SRTP Key Material
user group, click the Standard CTI Allow Reception of SRTP Key Material link.

To add an application user to the group, perform steps 5 through 7.
Click Add Application Usersto Group.
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Step 6

Step 7

Step 8
Step 9
Step 10

Step 11

Set Up JTAPI/TAPI Security-Related Service Parameters .

To find an application user, specify the search criteria; then, click Find.

Clicking Find without specifying search criteria displays all available options.

Check the check boxes for the application users that you want to add to the group; then, click Add Selected.
The users are displayed in the User Group window.

To add end users to the group, perform steps 9 through 11.

Click Add Usersto Group.

To find an end user, specify the search criteria; then, click Find.
Clicking Find without specifying search criteria displays all available options.

Check the check boxes for the end users that you want to add to the group; then, click Add Selected.

The users are displayed in the User Group window.

Set Up JTAPI/TAPI Security-Related Service Parameters

Step 1
Step 2
Step 3
Step 4

Step 5

Step 6
Step 7

After you configure the Application User CAPF Profile or End User CAPF Profile, you must configure the
following service parameters for Cisco |P Manager Assistant service:

* CTIManager Connection Security Flag

* CAPF Profile Instance ID for Secure Connection to CTIManager

To access the service parameters, perform the following procedure:

Procedure

From Cisco Unified Communications Manager Administration, choose System > Service Parameters.
From the Server drop-down list, choose the server where the Cisco | P M anager Assistant service is activated.
From the Service drop-down list, choose the Cisco | P Manager Assistant service.

After the parameters display, locate the CTIManager Connection Security Flagand CAPF Profilel nstance
ID for Secure Connection to CTIManager parameters.

Update the parameters, as described in the help that displays when you click the question mark or parameter
name link.

Click Save.

Repeat the procedure on each server where the service is activated.

View Certificate Operation Status for Application or End User

You can view the certificate operation status in a specific Application User or End User CAPF Profile
configuration window (not the Find/List window) or in the JTAPI/T SP Preferences GUI window.
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CHAPTER 21

Certificate Revocation/Expiry Status Verification

This chapter provides a brief overview of how to check the status of the certificates generated for sessions in
Unified Communications Manager Administration. The certificate service periodically checks for long lived
sessions between Unified Communications Manager and other services. Long lived sessions have duration
of six hours or more. The check is performed for the following long lived sessions:

* CTI Connections with JTAPI /TAPI applications.
* LDAP Connection between Unified Communications Manager and SunOne servers.

* IPSec Connections

It also describes how to configure the enterprise parameter for verifying certificate revocation and expiry.

The enterprise parameter Certificate Revocation and Expiry allows you to control the certificate validation
checks. The revocation and expiry check parameter is enabled on the Enterprise Parameter page of Unified
Communications Manager. The certificate expiry for the long lived sessions is not verified, when the enterprise
parameter value is disabled.

The certificate revocation service is active for LDAP and IPSec connections, when the Enable Revocation
is selected on the Operating System Administration of Unified Communications Manager and revocation and
expiry check parameter is set to enabled. The periodicity of the check for IPSec connections are based on the
Check Every value. The revocation check for the certificate is not performed, if the Enable Revocation
check box is unchecked.

)

Note

The GeneralizedTime values for X.509 Public Key Infrastructure Certificate and Certificate Revocation List
(CRL) profile must be expressed in Greenwich Mean Time (GMT) and must include seconds (i.e., times are
YYYYMMDDHHMMSSZ), even when the number is zero. GeneralizedTime values must not include the
fractional seconds. If the peer entity offers a certificate which violates this rule or a certificate is loaded in the
trust stores from the peer entities, then it could possibly fail the certificate verification process.

* Certificate Revocation/Expiry Status Verification, on page 218
* Certificate Monitoring Task Flow, on page 218
* Support for Delegated Trust Model in OCSP Response, on page 220
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. Certificate Revocation/Expiry Status Verification

Certificate Revocation/Expiry Status Verification

This chapter provides a brief overview of how to check the status of the certificates generated for sessions in
Unified Communications Manager Administration. The certificate service periodically checks for long lived
sessions between Unified Communications Manager and other services. Long lived sessions have duration
of six hours or more. The check is performed for the following long lived sessions:

* CTI Connections with JTAPI /TAPI applications.
* LDAP Connection between Unified Communications Manager and SunOne servers.

* [PSec Connections

It also describes how to configure the enterprise parameter for verifying certificate revocation and expiry.

The enterprise parameter Certificate Revocation and Expiry allows you to control the certificate validation
checks. The revocation and expiry check parameter is enabled on the Enterprise Parameter page of Unified
Communications Manager. The certificate expiry for the long lived sessions is not verified, when the enterprise
parameter value is disabled.

The certificate revocation service is active for LDAP and IPSec connections, when the Enable Revocation
is selected on the Operating System Administration of Unified Communications Manager and revocation and
expiry check parameter is set to enabled. The periodicity of the check for IPSec connections are based on the
Check Every value. The revocation check for the certificate is not performed, if the Enable Revocation
check box is unchecked.

\}

Note

The GeneralizedTime values for X.509 Public Key Infrastructure Certificate and Certificate Revocation List
(CRL) profile must be expressed in Greenwich Mean Time (GMT) and must include seconds (i.e., times are
YYYYMMDDHHMM SSZ), even when the number is zero. GeneralizedTime values must not include the
fractional seconds. If the peer entity offers a certificate which violates this rule or a certificate is loaded in the
trust stores from the peer entities, then it could possibly fail the certificate verification process.

Certificate Monitoring Task Flow

Complete these tasks to configure the system to monitor certificate status and expiration automatically.

» Email you when certificates are approaching expiration.

* Revoke expired certificates.

Procedure
Command or Action Purpose
Step 1 Configure Certificate Monitor Notifications, on | Configure automatic certificate monitoring. The
page 219 system periodically checks certificate statuses
and emails you when a certificate is approaching
expiration.
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Configure Certificate Monitor Notifications .

Command or Action Purpose

Step 2 Configure Certificate Revocation via OCSP, on | Configure the OCSP so that the system revokes
page 219 expired certificates automatically.

Configure Certificate Monitor Notifications

Step 1

Step 2
Step 3

Step 4
Step 5

Step 6
Step 7

Step 8

Configure automated certificate monitoring for Unified Communications Manager or the IM and Presence
Service. The system periodically checks the status of certificates and emails you when a certificate is
approaching expiration.

)

Note The Cisco Certificate Expiry Monitor network service must be running. This service is enabled by default,

but you can confirm the service is running in Cisco Unified Serviceability by choosing Tools> Control
Center - Network Services and verifying that the Cisco Certificate Expiry Monitor Service status is
Running.

Procedure

Log in to Cisco Unified OS Administration (for Unified Communications Manager certificate monitoring) or
Cisco Unified IM and Presence Administration (for IM and Presence Service certificate monitoring).

Choose Security > Certificate Monitor.

In the Notification Start Time field, enter a numeric value. This value represents the number of days before
certificate expiration where the system starts to notify you of the upcoming expiration.

In the Notification Fregquency fields, enter the frequency of notifications.

Optional. Check the Enable E-mail notification check box to have the system send email alerts of upcoming
certificate expirations..

Check the Enable L SC Monitoring check box to include LSC certificates in the certificate status checks.

In the E-mail I Ds field, enter the email addresses where you want the system to send notifications. You can
enter multiple email addresses separated by a semicolon.

Click Save.

What to do next

Configure the Online Certificate Status Protocol (OCSP) so that the system revokes expired certificates
automatically. For details, seeConfigure Certificate Revocation via OCSP, on page 219

Configure Certificate Revocation via 0CSP

Enable the Online Certificate Status Protocol (OCSP) to check certificate status regularly and to revoke expired
certificates automatically.
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. Support for Delegated Trust Model in OCSP Response

Step 1

Step 2
Step 3

Step 4
Step 5
Step 6
Step 7

Before you begin

Make sure that your system has the certificates that are required for OCSP checks. You can use Root or
Intermediate CA certificates that are configured with the OCSP response attribute or you can use a designated
OCSP signing certificate that has been uploaded to the tomcat-trust.

Procedure

Log in to Cisco Unified OS Administration (for Unified Communications Manager certificate revocation) or
Cisco Unified IM and Presence Administration (for IM and Presence Service certificate revocation).

Choose Security > Certificate Revocation.
Check the Enable OCSP check box, and perform one of the following tasks:

* If you want to specify an OCSP responder for OCSP checks, select the Use configured OCSP URI
button and enter the URI of the responder in the OCSP Configured URI field.

» If the certificate is configured with an OCSP responder URI, select the Use OCSP URI from Certificate
button.

Check the Enable Revocation Check check box.
Complete the Check Every field with the interval period for revocation checks.
Click Save.

Optional. If you have CTI, IPsec or LDAP links, you must also complete these steps in addition to the above
steps to enable OCSP revocation support for those long-lived connections:

a) From Cisco Unified CM Administration, choose System > Enterprise Parameters.

b) Under Certificate Revocation and Expiry, set the Certificate Validity Check parameter to True.

¢) Configure a value for the Validity Check Frequency parameter.

Note The interval value of the Enable Revocation Check parameter in the Certificate Revocation
window takes precedence over the value of the Validity Check Frequency enterprise parameter.

d) Click Save.

Support for Delegated Trust Model in OCSP Response

Online Certificate Status Protocol (OCSP) allows a device to obtain real-time information about the status of
a given certificate. Examples of certificate status are Good, Revoked, and Unknown.

Unified Communications Manager uses OCSP to validate third-party certificates that are uploaded into the
Unified Communications Manager trust store. Unified Communications Manager requires an OCSP Responder
URL to connect to the OCSP responder server over HTTP. It sends an HTTP request to the responder to
validate a certificate.

Unified Communications Manager currently supports the Trusted Responder Model of OCSP, where the
OCSP response is signed by a self-signed certificate of the OCSP server. This self-signed certificate is uploaded
to the trust store before initiating an OCSP request. This certificate is used to verify the signature on the OCSP
response.

Unified Communications Manager 11.0 and later support the Delegated Trust Model (DTM) of the OCSP
responder, where the OCSP responses are no longer approved by the self-signed certificate but are issued by
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a Certificate Authority (Root CA or Subordinate CA). The CA certificate validates the OCSP responder
certificates. The CA certificate that issued the OCSP responder certificate in Unified Communications Manager
trust store is required, instead of OCSP response signing certificate. When you receive an OCSP response,
the CA's certificate is used to validate the signature in the response.

\)

Note In case of a DTM execution failure, the OCSP response is verified using the self-signed certificate.
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PART V

Security for SRST References, Trunks, and
Gateways

* Secure Survivable Remote Site Telephony (SRST) Reference, on page 225

* Encryption Setup for Gateways and Trunks, on page 231

« SIP Trunk Security Profile Setup, on page 237

* Digest Authentication Setup for SIP Trunks, on page 247

* Cisco Unified Mobility Advantage Server Security Profile Setup, on page 253
* FIPS 140-2 Mode Setup, on page 259

* Cisco V.150 Minimum Essential Requirements (MER), on page 271






CHAPTER 22

Secure Survivable Remote Site Telephony (SRST)
Reference

This chapter provides information about SRST references.

* Securing SRST, on page 225

* Securing SRST Tips, on page 226

* Set Up Secure SRST, on page 227

* Set Up Secure SRST References, on page 227

* SRST Reference Security Settings, on page 228

* Delete Security From SRST Reference, on page 230

* SRST Certificate Deletion From Gateway, on page 230

Securing SRST

A SRST-enabled gateway provides limited call-processing tasks if the Unified Communications Manager
cannot complete the call.

Secure SRST-enabled gateways contain a self-signed certificate. After you perform SRST configuration tasks
in Unified Communications Manager Administration, Unified Communications Manager uses a TLS connection
to authenticate with the Certificate Provider service in the SRST-enabled gateway. Unified Communications
Manager then retrieves the certificate from the SRST-enabled gateway and adds the certificate to the Unified
Communications Manager database.

After you reset the dependent devices in Unified Communications Manager Administration, the TFTP server
adds the SRST-enabled gateway certificate to the phone cnf.xml file and sends the file to the phone. A secure
phone then uses a TLS connection to interact with the SRST-enabled gateway.

Je

Tip  The phone configuration file only contains a certificate from a single issuer. Consequently, the system does
not support HSRP.
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Securing SRST Tips

Ensure that the following criteria are met to secure the connection between the secure phone and the
SRST-enabled gateway:

» The SRST reference contains a self-signed certificate.

* You configured Mixed Mode through the Cisco CTL Client.

* You configured the phone for authentication or encryption.

* You configured the SRST reference in Unified Communications Manager Administration.

* You reset the SRST-enabled gateway and the dependent phones after the SRST configuration.

\)

Note Unified Communications Manager provides the PEM format files that contain phone certificate information
to the SRST-enabled gateway.

Note For LSC authentication, download the CAPF root certificate (CAPF.der). This root certificate allows the
secure SRST to verify the phone LSC during the TLS handshake.

When the cluster security mode equals nonsecure, the device security mode remains nonsecure in the
phone configuration file, even though Unified Communications Manager Administration may indicate
that the device security mode is authenticated or encrypted. Under these circumstances, the phone attempts
nonsecure connections with the SRST-enabled gateway and Unified Communications Manager.

N

Note Cluster security mode configures the security capability for your standalone server
or a cluster.

When the cluster security mode equals nonsecure, the system ignores the security-related configuration;
for example, the device security mode, the Is SRST Secure? check box, and so on. The configuration
does not get deleted in from the database, but security is not provided.

The phone attempts a secure connection to the SRST-enabled gateway only when the cluster security
mode equals Mixed Mode, the device security mode in the phone configuration file is set to authenticated
or encrypted, the Is SRST Secure? check box is checked in the SRST Configuration window, and a
valid SRST-enabled gateway certificate exists in the phone configuration file.

If you configured secure SRST references in a previous Unified Communications Manager release, the
configuration automatically migrates during the upgrade.

If phones in encrypted or authenticated mode fail over to SRST, and, during the connection with SRST,
the cluster security mode switches from Mixed Mode to Nonsecure Mode, these phones will not fall back
to Unified Communications Manager automatically. You must power down the SRST router to force
these phones to reregister to Unified Communications Manager. After phones fall back to Unified
Communications Manager, you can power up SRST, and failover and fallback will be automatic again.
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Set Up Secure SRST .

Set Up Secure SRST

Step 1

Step 2
Step 3

Step 4
Step 5

Step 6

The following procedure provides the tasks to perform the SRST configuration process for security.

Procedure

Verify that you performed all necessary tasks on the SRST-enabled gateway, so the device supports Unified
Communications Manager and security.

For more information, see the CiscolOS SRST Version System Administrator Guide that supports this version
of Unified Communications Manager.

Verify that you performed all necessary tasks to install and configure the CiscoCTL Client.
Verify that a certificate exists in the phone.

For more information, refer to the Cisco Unified IP Phone documentation for your phone model.

Verify that you configured the phones for authentication or encryption.

Configure the SRST reference for security, which includes enabling the SRST reference in the Device Pool
Configuration window.

Reset the SRST-enabled gateway and phones.

Set Up Secure SRST References

Consider the following information before you add, update, or delete the SRST reference in Cisco Unified
Communications Manager AdministrationUnified Communications Manager Administration:

» Adding a Secure SRST Reference—The first time that you configure the SRST reference for security,
you must configure all settings that are described in Table 33: Configuration Settings for Secure SRST
References, on page 229.

* Updating a Secure SRST Reference—Performing SRST updates in Unified Communications Manager
Administration does not automatically update the SRST-enabled gateway certificate. To update the
certificate, you must click the Update Certificate button; after you click the button, the contents of the
certificate display, and you must accept or reject the certificate. If you accept the certificate, Unified
Communications Manager replaces the SRST-enabled gateway certificate in the trust folder on the Unified
Communications Manager server or on each Unified Communications Manager server in the cluster.

* Deleting a Secure SRST Reference—Deleting a secure SRST reference removes the SRST-enabled
gateway certificate from the Unified Communications Manager database and the cnf.xml file in the
phone.

For information on how to delete SRST references, refer to the Administration Guide for Cisco Unified
Communications Manager .

To configure a secure SRST reference, perform the following procedure:
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. SRST Reference Security Settings

Step 1

Step 2

Step 3

Step 4

Step 5
Step 6

Step 7
Step 8
Step 9

Procedure

In Unified Communications Manager Administration, choose System > SRST.

The Find and List window displays.

Perform one of the following tasks:

a) To add a new SRST reference, click Add New in the Find window. (You can also display a profile and
then click Add New.) The configuration window displays with the default settings for each field.

b) To copy an existing SRST reference, locate the appropriate SRST reference as described in the
Administration Guide for Cisco Unified Communications Manager, and click the Copy icon for that
record in the Copy column. (You can also display a profile and then click Copy.) The configuration
window displays with the configured settings.

¢) To update an existing SRST reference, locate the appropriate SRST reference as described in the
Administration Guide for Cisco Unified Communications Manager.

The configuration window displays with the current settings.
Enter the security-related settings as described in Table 33: Configuration Settings for Secure SRST References,
on page 229.

For descriptions of additional SRST reference configuration settings, refer to the Administration Guide for
Cisco Unified Communications Manager.

The Find and List window displays.

After you check the Is SRST Secure? check box, a dialog box displays a message that you must download
the SRST certificate by clicking the Update Certificate button. Click OK.

Click Save.
To update the SRST-enabled gateway certificate in the database, click the Update Certificate button.

Tip This button displays only after you check the Is SRST Secure? check box and click Save.

The fingerprint for the certificate displays. To accept the certificate, click Save.
Click Close.
In the SRST Reference Configuration window, click Reset.

What to do next

Verify that you enabled the SRST reference in the Device Pool Configuration window.

SRST Reference Security Settings

The following table describes the available settings for secure SRST references in Unified Communications
Manager Administration.
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Table 33: Configuration Settings for Secure SRST References

SRST Reference Security Settings .

Setting

Description

Is SRST Secure?

After you verify that the SRST-enabled gateway
contains a self-signed certificate, check this check
box.

After you configure the SRST and reset the gateway
and dependent phones, the CiscoCTL Provider service
authenticates to the Certificate Provider service on
the SRST-enabled gateway. The CiscoCTL Client
retrieves the certificate from the SRST-enabled
gateway and stores the certificate in the Unified
Communications Manager database.

Tip To remove the SRST certificate from the
database and phone, uncheck this check
box, click Save, and reset the dependent
phones.

SRST Certificate Provider Port

This port monitors requests for the Certificate Provider
service on the SRST-enabled gateway. Unified
Communications Manager uses this port to retrieve
the certificate from the SRST-enabled gateway. The
CiscoSRST Certificate Provider default port equals
2445.

After you configure this port on the SRST-enabled
gateway, enter the port number in this field.

Tip You may need to configure a different port
number if the port is currently used or if
you use a firewall and you cannot use the
port within the firewall. The port number
must exist in the range of 1024 and 49151;
otherwise, the following message displays:
Port Numbers can only contain digits.

Update Certificate

Tip This button displays only after you check
the Is SRST Secure? check box and click
Save.

After you click this button, the CiscoCTL Client
replaces the existing SRST-enabled gateway certificate
that is stored in the Unified Communications Manager
database, if a certificate exists in the database. After
you reset the dependent phones, the TFTP server sends
the cnf.xml file (with the new SRST-enabled gateway
certificate) to the phones.
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Delete Security From SRST Reference

To make the SRST reference nonsecure after you configure security, uncheck the Is SRTS Secure? check box
in the SRST Configuration window. A message states that you must turn off the credential service on the
gateway.

SRST Certificate Deletion From Gateway

If the SRST certificate no longer exists in the SRST-enabled gateway, you must remove the SRST certificate
from the Unified Communications Manager database and the phone.

To perform this task, uncheck the | S SRST Secure? check box and click Update in the SRST Configuration
window; then, click Reset Devices.
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Encryption Setup for Gateways and Trunks

This chapter provides information about encryption setup for gateways and trunks.

* Cisco IOS MGCP Gateway Encryption, on page 231

» H.323 Gateway and H.323/H.225/H.245 Trunk Encryption, on page 232

* SIP Trunk Encryption, on page 233

* Set Up Secure Gateways and Trunks, on page 234

* [Psec Setup Within Network Infrastructures, on page 235

* [Psec Setup Between Unified Communications Manager and Gateway or Trunks, on page 235
* Allow SRTP Using Unified Communications Manager Administration, on page 236

* Where to Find More Information About Gateway and Trunk Encryption, on page 236

Cisco 10S MGCP Gateway Encryption

Unified Communications Manager supports gateways that use the MGCP SRTP package, which the gateway
uses to encrypt and decrypt packets over a secure RTP connection. The information that gets exchanged during
call setup determines whether the gateway uses SRTP for a call. If the devices support SRTP, the system uses
a SRTP connection. If at least one device does not support SRTP, the system uses a RTP connection.
SRTP-to-RTP fallback (and vice versa) may occur for transfers from a secure device to a non-secure device,
conferencing, transcoding, music on hold, and so on.

When the system sets up an encrypted SRTP call between two devices, Unified Communications Manager
generates a master encryption key and salt for secure calls and sends them to the gateway for the SRTP stream
only. Unified Communications Manager does not send the key and salt for SRTCP streams, which the gateway
also supports. These keys get sent to the gateway over the MGCP signaling path, which you should secure
by using IPSec. Although Unified Communications Manager does not recognize whether an IPSec connection
exists, the system sends the session keys to the gateway in the cleartext if [PSec is not configured. Confirm
that the [PSec connection exists, so the session keys get sent through a secure connection.

Je

Tip

If the MGCP gateway, which is configured for SRTP, is involved in a call with an authenticated device, for
example, an authenticated phone that is running SCCP, a shield icon displays on the phone because Unified
Communications Manager classifies the call as authenticated. Unified Communications Manager classifies a
call as encrypted if the SRTP capabilities for the devices are successfully negotiated for the call. If the MGCP
gateway is connected to a phone that can display security icons, the phone displays the lock icon when the
call is encrypted.
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. H.323 Gateway and H.323/H.225/H.245 Trunk Encryption

The following are the facts about MGCP E1 PRI gateways:

* You must configure the MGCP gateway for SRTP encryption. Configure the gateway using the following
command: mgcppackage-capabilitysrtp-package

» The MGCP gateway must specify an Advanced IP Services or Advanced Enterprise Services image.
For example, c3745-adventer prisek9-mz.124-6.T.bin

* Protected status gets exchanged with the MGCP E1 PRI gateway by using proprietary FacilityIE in the
MGCP PRI Setup, Alert, and Connect messages.

* Unified Communications Manager plays the secure indication tone only to the Cisco Unified IP Phone.
A PBX in the network plays the tone to the gateway end of the call.

* If the media between the Cisco Unified IP Phone and the MGCP E1 PRI gateway is not encrypted, the
call drops.

N

Note For more information about encryption for MGCP gateways, see Media and
Signaling Authentication and Encryption Feature for Cisco IOS MGCP Gateways
for the version of Cisco 10S software that you are using.

H.323 Gateway and H.323/H.225/H.245 Trunk Encryption

H.323 gateways and gatekeeper or non-gatekeeper controlled H.225/H.323/H.245 trunks that support security
can authenticate to Unified Communications Manager if you configure an IPSec association in the Cisco
Unified Communications Operating System. For information on creating an IPSec association between Unified
Communications Manager and these devices, refer to the Administration Guide for Cisco Unified
Communications Manager .

The H.323, H.225, and H.245 devices generate the encryption keys. These keys get sent to Unified
Communications Manager through the signaling path, which you secure through IPSec. Although Unified
Communications Manager does not recognize whether an IPSec connection exists, the session keys get sent
in the clear if [PSec is not configured. Confirm that the [PSec connection exists, so the session keys get sent
through a secure connection.

In addition to configuring an IPSec association, you must check the SRTP Allowed check box in the device
configuration window in Unified Communications Manager Administration; for example, the H.323 Gateway,
the H.225 Trunk (Gatekeeper Controlled), the Inter-Cluster Trunk (Gatekeeper Controlled), and the Inter-Cluster
Trunk (Non-Gatekeeper Controlled) configuration windows. If you do not check this check box, Unified
Communications Manager uses RTP to communicate with the device. If you check the check box, Unified
Communications Manager allows secure and nonsecure calls to occur, depending on whether SRTP is
configured for the device.

A

Caution

If you check the SRTP Allowed check box in Unified Communications Manager Administration, Cisco
strongly recommends that you configure I[PSec, so security-related information does not get sent in the clear.

Unified Communications Manager does not confirm that you configured the IPSec connection correctly. If
you do not configure the connection correctly, security-related information may get sent in the clear.
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SIP Trunk Encryption .

If the system can establish a secure media or signaling path and if the devices support SRTP, the system uses
a SRTP connection. If the system cannot establish a secure media or signaling path or if at least one device
does not support SRTP, the system uses a RTP connection. SRTP-to-RTP fallback (and vice versa) may occur
for transfers from a secure device to a non-secure device, conferencing, transcoding, music on hold, and so
on.

Je

Tip

If the call uses pass-through capable M TP, if the audio capabilities for the device match after region filtering,
and if the MTP Required check box is not checked for any device, Unified Communications Manager classifies
the call as secure. If the MTP Required check box is checked, Unified Communications Manager disables
audio pass-through for the call and classifies the call as nonsecure. If no MTP is involved in the call, Unified
Communications Manager may classify the call as encrypted, depending on the SRTP capabilities of the
devices.

For SRTP-configured devices, Unified Communications Manager classifies a call as encrypted if the SRTP
Allowed check box is checked for the device and if the SRTP capabilities for the devices are successfully
negotiated for the call. If the preceding criteria are not met, Unified Communications Manager classifies the
call as nonsecure. If the device is connected to a phone that can display security icons, the phone displays the
lock icon when the call is encrypted.

Unified Communications Manager classifies outbound faststart calls over a trunk or gateway as nonsecure.
If you check the SRTP Allowed check box in Unified Communications Manager Administration, Unified
Communications Manager disables the Enable Outbound FastStart check box.

Unified Communications Manager allows some types of gateways and trunks to transparently pass through
the shared secret (Diffie-Hellman key) and other H.235 data between two H.235 endpoints, so the two endpoints
can establish a secure media channel.

To enable the passing through of H.235 data, check the H.235 pass through allowed check box in the
configuration settings of the following trunks and gateways:

* H.225 Trunk
* ICT Gatekeeper Control
* ICT non-Gatekeeper Control

* H.323 Gateway

For information about configuring trunks and gateways, see the Administration Guide for Cisco Unified
Communications Manager .

SIP Trunk Encryption

SIP trunks can support secure calls both for signaling as well as media; TLS provides signaling encryption
and SRTP provides media encryption.

To configure signaling encryption for the trunk, choose the following options when you configure the SIP
trunk security profile (in the System > Security Profile> SIP Trunk Security Profile window):

* From the Device Security M ode drop-down list, choose “Encrypted.”

* From the Incoming Transport Type drop-down list, choose “TLS.”
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. Set Up Secure Gateways and Trunks

* From the Outgoing Transport Type drop-down list, choose “TLS.”
After you configure the SIP trunk security profile, apply it to the trunk (in the Device > Trunk > SIP Trunk
configuration window).

To configure media encryption for the trunk, check the SRTP Allowed check box (also in the DeviceTrunkSI P
Trunk configuration window).

A

Caution  If you check this check box, we recommend that you use an encrypted TLS profile, so that keys and other

security-related information do not get exposed during call negotiations. If you use a non- secure profile,
SRTP will still work but the keys will be exposed in signaling and traces. In that case, you must ensure the
security of the network between Unified Communications Manager and the destination side of the trunk.

Set Up Secure Gateways and Trunks

Step 1
Step 2
Step 3

Step 4

Step 5

Step 6

Use this procedure in conjunction with the document, Media and Signaling Authentication and Encryption
Feature for Cisco IOS MGCP Gateways, which provides information on how to configure your CiscolOS
MGCP gateways for security.

Procedure

Verify that you have run the utils ctl command to set the cluster in mixed mode.
Verify that you configured the phones for encryption.
Configure IPSec.

Tip You may configure IPSec in the network infrastructure, or you may configure IPSec between Unified
Communications Manager and the gateway or trunk. If you implement one method to set up IPSec,
you do not need to implement the other method.

For H.323 10S gateways and intercluster trunks, check the SRTP Allowed check box in Unified
Communications Manager.

The SRTP Allowed check box displays in the Trunk Configuration or Gateway Configuration window.
For information on how to display these windows, refer to the trunk and gateway chapters in the Administration
Guide for Cisco Unified Communications Manager.

For SIP trunks, configure the SIP trunk security profile and apply it to the trunk(s), if you have not already
done so. Also, be sure to check the SRTP Allowed check box in the Device> Trunk > SIP Trunk
Configuration window.

Caution If you check the SRTP Allowed check box, we recommend that you use an encrypted TLS profile,
so that keys and other security-related information does not get exposed during call negotiations.
If you use a non-secure profile, SRTP will still work but the keys will be exposed in signaling and
traces. In that case, you must ensure the security of the network between Unified Communications
Manager and the destination side of the trunk.

Perform security-related configuration tasks on the gateway.
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For more information, see Media and Signaling Authentication and Encryption Feature for Cisco IOS MGCP
Gateways.

IPsec Setup Within Network Infrastructures

This section does not describe how to configure IPsec. Instead, it provides considerations and recommendations
for configuring IPsec in your network infrastructure. If you plan to configure IPsec in the network infrastructure
and not between Unified Communications Manager and the device, review the following information before
you configure IPsec:

* Cisco recommends that you provision IPsec in the infrastructure rather than in the Unified Communications
Manager itself.

* Before you configure IPsec, consider existing IPsec or VPN connections, platform CPU impact, bandwidth
implications, jitter or latency, and other performance metrics.

* Review the Voice and Video Enabled IPsec Virtual Private Networks Solution Reference Network Design
Guide.

* Review the CiscolOS Security Configuration Guide, Release 12.2 (or later).
* Terminate the remote end of the [Psec connection in the secure CiscolOS MGCP gateway.

* Terminate the host end in a network device within the trusted sphere of the network where the telephony
servers exist; for example, behind a firewall, access control list (ACL), or other layer three device.

* The equipment that you use to terminate the host-end IPsec connections depends on the number of
gateways and the anticipated call volume to those gateways; for example, you could use Cisco VPN 3000
Series Concentrators, Catalyst 6500 IPsec VPN Services Module, or Cisco Integrated Services Routers.

* Perform the steps in the order that is specified in the topics related to setting up secure gateways and
trunks.

A

Caution  Failing to configure the IPsec connections and verify that the connections are active and may compromise
privacy of the media streams.

IPsec Setup Between Unified Communications Manager and
Gateway or Trunks

For information on configuring IPSec between Unified Communications Manager and the gateways or trunks
that are described in this chapter, refer to the Administration Guide for Cisco Unified Communications Manager
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. Allow SRTP Using Unified Communications Manager Administration

Allow SRTP Using Unified Communications Manager
Administration

The SRTP Allowed check box displays in the following configuration windows in Unified Communications
Manager:

* H.323 Gateway Configuration window

* H.225 Trunk (Gatekeeper Controlled) Configuration window

* Inter-Cluster Trunk (Gatekeeper Controlled) Configuration window

* Inter-Cluster Trunk (Non-Gatekeeper Controlled) Configuration window

* SIP Trunk Configuration window

To configure the SRTP Allowed check box for H.323 gateways and gatekeeper or non-gatekeeper controlled
H.323/H.245/H.225 trunks or SIP trunks, perform the following procedure:

Procedure

Step 1 Find the gateway or trunk, as described in the Unified Communications Manager.
Step 2 After you open the configuration window for the gateway/trunk, check the SRTP Allowed check box.

Caution If'you check the SRTP Allowed check box for a SIP trunk, we recommend that you use an encrypted
TLS profile, so keys and other security-related information are not exposed during call negotiations.
If you use a non-secure profile, SRTP will still work but the keys will be exposed in signaling and
traces. In that case, you must ensure the security of the network between Unified Communications
Manager and the destination side of the trunk.

Step 3 Click Save.
Step 4 To reset the device, click Reset.
Step 5 Verify that you configured IPSec correctly for H323. (For SIP, make sure you configured TLS correctly.)

Where to Find More Information About Gateway and Trunk
Encryption

+ Authentication, Integrity, and Authorization, on page 20

* Encryption, on page 24
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SIP Trunk Security Profile Setup

This chapter provides information about SIP trunk security profile setup.

* About SIP Trunk Security Profile Setup, on page 237

* SIP Trunk Security Profile Setup Tips, on page 237

* Find SIP Trunk Security Profile, on page 238

* Set Up SIP Trunk Security Profile, on page 238

* SIP Trunk Security Profile Settings, on page 239

* Apply SIP Trunk Security Profile, on page 244

* Synchronize SIP Trunk Security Profile with SIP Trunks, on page 245

* Delete SIP Trunk Security Profile, on page 245

* Where to Find More Information About SIP Trunk Security Profiles, on page 246

About SIP Trunk Security Profile Setup

Unified Communications Manager Administration groups security-related settings for the SIP trunk to allow
you to assign a single security profile to multiple SIP trunks. Security-related settings include device security
mode, digest authentication, and incoming/outgoing transport type settings. You apply the configured settings
to the SIP trunk when you choose the security profile in the Trunk Configuration window.

Installing Unified Communications Manager provides a predefined, nonsecure SIP trunk security profile for
autoregistration. To enable security features for a SIP trunk, configure a new security profile and apply it to
the SIP trunk. If the trunk does not support security, choose a nonsecure profile.

Only security features that the SIP trunk supports display in the security profile settings window.

SIP Trunk Security Profile Setup Tips

Consider the following information when you configure SIP trunk security profiles in Unified Communications
Manager Administration:

» When you are configuring a SIP trunk, you must select a security profile in the Trunk Configuration
window. If the device does not support security, apply a nonsecure profile.

* You cannot delete a security profile that is currently assigned to a device.

« If you change the settings in a security profile that is already assigned to a SIP trunk, the reconfigured
settings apply to all SIP trunks that are assigned that profile.

Security Guide for Cisco Unified Communications Manager, Release 11.5(1)SU10 .



Security for SRST References, Trunks, and Gateways |

. Find SIP Trunk Security Profile

* You can rename security files that are assigned to devices. The SIP trunks that are assigned the old profile
name and settings assume the new profile name and settings.

* If you configured the device security mode prior to a Unified Communications Manager 5.0 or later
upgrade, Unified Communications Manager creates a profile for the SIP trunk and applies the profile to
the device.

Find SIP Trunk Security Profile

Step 1

Step 2

Step 3

Step 4

To find a SIP trunk security profile, perform the following procedure:

Procedure

Choose System > Security Profile> SIP Trunk Security Profile.

The Find and List window displays. Records from an active (prior) query may also display in the window.

To find all records in the database, ensure the dialog box is empty; go to Step 3, on page 238.
To filter or search records

a) From the drop-down list box, choose a search parameter.
b) Then from the drop-down list box, choose a search pattern.
¢) Specify the appropriate search text, if applicable.

Note To add additional search criteria, click the + button. When you add criteria, the system searches
for a record that matches all criteria that you specify. To remove criteria, click the — button to
remove the last added criterion or click the Clear Filter button to remove all added search
criteria.

Click Find.

All matching records display. You can change the number of items that display on each page by choosing a
different value from the Rows per Page drop-down list box.

From the list of records that display, click the link for the record that you want to view.

Note To reverse the sort order, click the up or down arrow, if available, in the list header.

The window displays the item that you choose.

Set Up SIP Trunk Security Profile

To add, update, or copy a SIP trunk security profile, perform the following procedure:
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Step 1

Step 2

Step 3
Step 4

SIP Trunk Security Profile Settings .

Procedure

From Cisco Unified Communications Manager Administration, choose System > Security Profile> SIP
Trunk Security Profile.

Perform one of the following tasks:
a) To add a new profile, click Add New in the Find window.

(You can also display a profile and then click Add New.)

The configuration window displays the default settings for each field.

b) To copy an existing security profile, locate the appropriate profile and click the Copy icon for that record
in the Copy column.

(You can also display a profile and then click Copy.)

The configuration window displays the configured settings.

¢) To update an existing profile, locate and display the appropriate security profile as described in Find SIP
Trunk Security Profile, on page 238.

The configuration window displays the current settings.

Enter the appropriate settings as described in SIP Trunk Security Profile Settings.

Click Save.

After you create the security profile, apply it to the trunk. If you configured digest authentication for SIP
trunks, you must configure the digest credentials in the SIP Realm window for the trunk and Application
User window for applications that are connected through the SIP trunk, if you have not already done so. If
you enabled application-level authorization for applications that are connected through the SIP trunk, you
must configure the methods that are allowed for the application in the Application User window, if you have
not already done so.

SIP Trunk Security Profile Settings

The following table describes the settings for the SIP Trunk Security Profile.

Table 34: SIP Trunk Security Profile Configuration Settings

Setting Description

Name Enter a name for the security profile. When you save the new profile, the name
displays in the SIP Trunk Security Profile drop-down list in the Trunk
Configuration window.

Description Enter a description for the security profile. The description can include up to 50
characters in any language, but it cannot include double-quotes ("), percentage
sign (%), ampersand (&), back-slash (\), or angle brackets (<>).
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Setting Description

Device Security Mode From the drop-down list, choose one of the following options:

» Non Secure—No security features except image authentication apply. A
TCP or UDP connection opens to Unified Communications Manager.

+ Authenticated—Unified Communications Manager provides integrity and
authentication for the trunk. A TLS connection that uses NULL/SHA opens.

* Encrypted— Unified Communications Manager provides integrity,
authentication, and signaling encryption for the trunk. A TLS connection
that uses AES128/SHA opens for signaling.

Note If the trunks are configured with Device Security Profile option selected
as Authenticated, then Unified Communications Manager starts a
TLS connection that uses NULL SHA cipher (without data
encryption).

These trunks will not register or make calls if the destination devices
do not support NULL_SHA cipher.

For destination devices that do not support NULL_SHA cipher, the
trunks should be configured with Device Security Profile option
selected as Encrypted. With this device security profile, the trunks
offer additional TLS ciphers that enables data encryption.

Incoming Transport Type | When Device Security Mode is Non Secure TCP+UDP specifies the transport
type.

When Device Security Mode is Authenticated or Encrypted, TLS specifies the
transport type.

Note The Transport Layer Security (TLS) protocol secures the connection
between Unified Communications Manager and the trunk.

Outgoing Transport Type | From the drop-down list, choose the outgoing transport mode.
When Device Security Mode is Non Secure, choose TCP or UDP.

When Device Security Mode is Authenticated or Encrypted, TLS specifies the
transport type.

Note TLS ensures signaling integrity, device authentication, and signaling
encryption for SIP trunks.

Tip You must use UDP as the outgoing transport type when connecting
SIP trunks between Unified Communications Manager systems and
IOS gateways that do not support TCP connection reuse.
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SIP Trunk Security Profile Settings .

Setting

Description

Enable Digest
Authentication

Check this check box to enable digest authentication. If you check this check
box, Unified Communications Manager challenges all SIP requests from the
trunk.

Digest authentication does not provide device authentication, integrity or
confidentiality. Choose a security mode of Authenticated or Encrypted to use
these features.

Tip Use digest authentication to authenticate SIP trunk users on trunks
that are using TCP or UDP transport.

Nonce Validity Time

Enter the number of minutes (in seconds) that the nonce value is valid. The default
value equals 600 (10 minutes). When the time expires, Unified Communications
Manager generates a new value.

Note A nonce value, a random number that supports digest authentication,
gets used to calculate the MDS5 hash of the digest authentication
password.

Secure Certificate Subject
or Subject Alternate Name

This field applies if you configured TLS for the incoming and outgoing transport
type.

For device authentication, enter the name of the Secure Certificate Subject or
Subject Alternate Name certificate for the SIP trunk device. If you have a Unified
Communications Manager cluster or if you use SRV lookup for the TLS peer, a
single trunk may resolve to multiple hosts, which results in multiple Secure
Certificate Subject or Subject Alternate Name for the trunks. If multiple Secure
Certificate Subject or Subject Alternate Name exists, enter one of the following
characters to separate the names: space, comma, semicolon, or a colon.

You can enter up to 4096 characters in this field.

Tip The subject name corresponds to the source connection TLS certificate.
Ensure subject names are unique for each subject name and port. You
cannot assign the same subject name and incoming port combination
to different SIP trunks. Example: SIP TLS trunkl on port 5061 has
Secure Certificate Subject or Subject Alternate Name my cml,
my_cm?2. SIP TLS trunk2 on port 5071 has Secure Certificate Subject
or Subject Alternate Name my_cm?2, my_cm3. SIP TLS trunk3 on
port 5061 can have Secure Certificate Subject or Subject Alternate
Name my_ccm4 but cannot have Secure Certificate Subject or Subject
Alternate Name my_cml.
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Setting

Description

Incoming Port

Choose the incoming port. Enter a value that is a unique port number from
0-65535. The default port value for incoming TCP and UDP SIP messages
specifies 5060. The default SIP secured port for incoming TLS messages specifies
5061. The value that you enter applies to all SIP trunks that use the profile.

Tip All SIP trunks that use TLS can share the same incoming port; all SIP
trunks that use TCP + UDP can share the same incoming port. You
cannot mix SIP TLS transport trunks with SIP non-TLS transport trunk
types on the same port.

Tip If the incoming packet rate on a SIP trunk UDP port from a single IP
address exceeds the configured SIP Trunk UDP Port Throttle Threshold
during normal traffic, reconfigure the threshold. When a SIP trunk
and SIP station share the same incoming UDP port, Unified
Communications Manager throttles packets based on the higher of the
two service parameter values. You must restart the Cisco CallManager
service for changes to this parameter to take effect.

Enable Application Level
Authorization

Application-level authorization applies to applications that are connected through
the SIP trunk.

If you check this check box, you must also check the Enable Digest
Authentication check box and configure digest authentication for the trunk.
Unified Communications Manager authenticates a SIP application user before
checking the allowed application methods.

When application level authorization is enabled, trunk-level authorization occurs
first, and application-level authorization then occurs, which means that Unified
Communications Manager checks the methods that are authorized for the trunk
(in this security profile) before the methods that are authorized for the SIP
application user in the Application User Configuration window.

Tip Consider using application-level authorization if you do not trust the
identity of the application or if the application is not trusted on a
particular trunk; that is, application requests may come from a different
trunk than you expect.

Accept Presence
Subscription

If you want Unified Communications Manager to accept presence subscription
requests that come via the SIP trunk, check this check box.

If you checked the Enable Application Level Authorization check box, go to
the Application User Configuration window and check the Accept Presence
Subscription check box for any application users that are authorized for this
feature.

When application-level authorization is enabled, if you check the Accept Presence
Subscription check box for the application user but not for the trunk, a 403 error
message gets sent to the SIP user agent that is connected to the trunk.
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SIP Trunk Security Profile Settings .

Setting

Description

Accept Out-of-Dialog
Refer

If you want Unified Communications Manager to accept incoming non-INVITE,
Out-of-Dialog REFER requests that come via the SIP trunk, check this check
box.

If you checked the Enable Application Level Authorization check box, go to the
Application User Configuration window and check the Accept Out-of-Dialog
Refer check box for any application users that are authorized for this method.

Accept Unsolicited
Notification

If you want Unified Communications Manager to accept incoming non-INVITE,
unsolicited notification messages that come via the SIP trunk, check this check
box.

If you checked the Enable Application Level Authorization check box, go to
the Application User Configuration window and check the Accept Unsolicited
Notification check box for any application users that are authorized for this
method.

Accept Replaces Header

If you want Unified Communications Manager to accept new SIP dialogs, which
have replaced existing SIP dialogs, check this check box.

If you checked the Enable Application Level Authorization check box, go to
the Application User Configuration window and check the Accept Header
Replacement check box for any application users that are authorized for this
method.

Transmit Security Status

If you want Unified Communications Manager to transmit the security icon status
of a call from the associated SIP trunk to the SIP peer, check this check box.

Default: This box is not checked.

SIP V.150 Outbound SDP
Offer Filtering

From the drop-down list, select one of the following filter options:

* Use Default Filter—The SIP trunk uses the default filter that is indicated
in the SIP V.150 Outbound SDP Offer Filtering service parameter. To locate
the service parameter, go to System > Service Parameter s> Clusterwide
Parameter s (Device-SIP) in Cisco Unified Communications Manager
Administration.

* No Filtering—The SIP trunk performs no filtering of V.150 SDP lines in
outbound offers.

* Remove MER V.150—The SIP trunk removes V.150 MER SDP lines in
outbound offers. Select this option to reduce ambiguity when the trunk is
connected to a pre-MER V.150 Unified Communications Manager.

* RemovePre-M ER V.150—The SIP trunk removes any non-MER compliant
V.150 lines in outbound offers. Select this option to reduce ambiguity when
your cluster is contained in a network of MER-compliant devices that are
incapable of processing offers with pre-MER lines.
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Setting Description
SIP V.150 Outbound SDP | From the drop-down list, select one of the following filter options:
Offer Filtering

*» Use Default Filter—The SIP trunk uses the default filter that is indicated
in the SIP V.150 Outbound SDP Offer Filtering service parameter. To locate
the service parameter, go to System > Service Parameters> Clusterwide
Parameter s (Device-SIP) in Cisco Unified Communications Manager
Administration.

* No Filtering—The SIP trunk performs no filtering of V.150 SDP lines in
outbound offers.

* Remove MER V.150—The SIP trunk removes V.150 MER SDP lines in
outbound offers. Select this option to reduce ambiguity when the trunk is
connected to a pre-MER V.150 Unified Communications Manager.

* Remove Pre-M ER V.150—The SIP trunk removes any non-MER compliant
V.150 lines in outbound offers. Select this option to reduce ambiguity when
your cluster is contained in a network of MER compliant devices that are
incapable of processing offers with pre-MER lines.

Note You have to configure IOS on SIP for V.150 to make a secure call
connection. For more information to configure IOS on Unified
Communications Manager, see http://www.cisco.com/c/en/us/td/docs/
i0s/12_4t/12_4t4/mer cg 15 1 4M.html.

Apply SIP Trunk Security Profile

You apply a SIP trunk security profile to the trunk in the Trunk Configuration window. To apply a security
profile to a device, perform the following procedure:

Step 1
Step 2
Step 3
Step 4
Step 5

Procedure

Find the trunk, as described in the Administration Guide for Cisco Unified Communications Manager.
After the Trunk Configuration window displays, locate the SIP Trunk Security Profile setting.
From the security profile drop-down list, choose the security profile that applies to the device.

Click Save.

To reset the trunk, click Apply Config.

If you applied a profile enabling digest authentication for SIP trunks, you must configure the digest credentials
in the SIP Realm window for the trunk. If you applied a profile enabling application-level authorization, you
must configure the digest credentials and allowed authorization methods in the Application User window,
if you have not already done so.
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Synchronize SIP Trunk Security Profile with SIP Trunks .

Synchronize SIP Trunk Security Profile with SIP Trunks

Step 1
Step 2
Step 3

Step 4
Step 5
Step 6
Step 7

Step 8

To synchronize SIP trunks with a SIP Trunk Security Profile that has undergone configuration changes,
perform the following procedure, which will apply any outstanding configuration settings in the least-intrusive
manner possible. (For example, you may not need to perform a reset/restart on some affected devices.)

Procedure

Choose System > Security Profile> SIP Trunk Security Profile.
Choose the search criteria to use.
Click Find.

The window displays a list of SIP trunk security profiles that match the search criteria.
Click the SIP trunk security profile to which you want to synchronize applicable SIP trunks.
Make any additional configuration changes.

Click Save.
Click Apply Config.

The Apply Configuration Information dialog appears.

Click OK.

Delete SIP Trunk Security Profile

Step 1
Step 2

This section describes how to delete a SIP trunk security profile from the Unified Communications Manager
database.

Before you begin

Before you can delete a security profile from Unified Communications Manager Administration, you must
apply a different profile to the devices or delete all devices that use the profile. To find out which devices use
the profile, choose Dependency Recor ds from the Related Links drop-down list box in the SIP Trunk
Security Profile Configuration window and click Go.

If the dependency records feature is not enabled for the system, the dependency records summary window
displays a message that shows the action that you can take to enable the dependency records; the message
also displays information about high CPU consumption that is related to the dependency records feature. For
more information about dependency records, refer to the System Configuration Guide for Cisco Unified
Communications Manager .

Procedure

Find the SIP trunk security profile to delete.

Perform one of the following tasks:
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a) To delete multiple security profiles, perform one of these tasks in the Find and List window:
* Check the check boxes next to the security profiles that you want to delete; then, click Delete Selected.

* You can delete all configurable records for this selection by clicking Select All and then clicking
Delete Selected.

b) To delete a single security profile, perform one of these tasks in the Find and List window:

* Check the check box next to the security profile that you want to delete; then, click Delete Selected.

* Click the Namelink for the security profile. After the specific Security Profile Configuration window
displays, click Delete Selected.

Step 3 When prompted to confirm the delete operation, click OK to delete or Cancel to cancel the delete operation.

Where to Find More Information About SIP Trunk Security
Profiles

* Authorization, on page 23
* Interactions, on page 9

* Digest Authentication, on page 21
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Digest Authentication Setup for SIP Trunks

This chapter provides information about digest authentication setup for SIP trunks. When you configure digest
authentication for SIP trunks, Unified Communications Manager challenges the identity of the SIP user agent
when it receives a SIP request on the SIP trunk. The SIP user agent, in turn, can challenge the identity of
Unified Communications Manager when Unified Communications Managersends a SIP request to the trunk.
For additional information on how digest authentication works for SIP trunks, see Digest Authentication, on
page 21.

* Set Up SIP Trunk Digest Authentication, on page 247

* Set Up Digest Authentication Enterprise Parameters, on page 248
* Set Up Digest Credentials, on page 248

* Application User Digest Credential Settings, on page 248

* Find SIP Realm, on page 249

* Configure SIP Realm, on page 249

* SIP Realm Settings, on page 250

* Delete SIP Realm, on page 250

Set Up SIP Trunk Digest Authentication

Step 1

Step 2
Step 3

Step 4

The following procedure describes the tasks to configure digest authentication for SIP trunks.

Procedure

Configure the SIP trunk security profiles; make sure that you check the Enable Digest Authentication check
box.

Apply a SIP trunk security profile to the trunk.
Configure the enterprise parameter, Cluster ID, if not configured.

This parameter supports Unified Communications Manager challenges to the identity of the SIP user agent
that is sending a SIP request on the SIP trunk.

If Unified Communications Manager challenges the identity of SIP user agents that are sending SIP requests
on the SIP trunk, configure the digest credentials for the application user in the Application User Configuration
window.
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Step 5
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If Unified Communications Manager responds to challenges from a trunk peer, configure the SIP realm.

Set Up Digest Authentication Enterprise Parameters

To configure the enterprise parameter, Cluster ID, for digest authentication, choose System > Enterprise
Parameter sin Unified Communications Manager Administration. Locate the Cluster ID parameter and update
the value, as described in the Help for the parameter. This parameter supports Unified Communications
Manager challenges to the identity of the SIP user agent that is sending a SIP request on the SIP trunk.

Je

Tip  To access the Help for the parameter, click the question mark that displays in the Enterprise Parameters
Configuration window or click the parameter link.

Set Up Digest Credentials

Step 1

Step 2
Step 3

Step 4

If Unified Communications Manager challenges the identity of a SIP user agent, you must configure the digest
credentials for the application user in the Application User Configuration window in Unified Communications
Manager Administration. Unified Communications Manager uses these credentials to verify the identity of
SIP user agents that are sending requests through the SIP trunk.

To configure the digest credentials for an application user, perform the following procedure:

Procedure

Find the application user, as described in the Administration Guide for Cisco Unified Communications Manager

Click the application user link.

After the specific Application User Configuration window displays, enter the appropriate settings, as
described in Table 36: SIP Realm Security Profile, on page 250.

Click Save.

Application User Digest Credential Settings

The following table describes the settings for the digest credential settings in the Application User
Configuration window in Unified Communications Manager Administration.

Table 35: Digest Authentication Credentials

Setting Description

Digest Credentials Enter a string of alphanumeric characters.
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Setting Description

Confirm Digest Credentials To confirm that you entered the digest credentials
correctly, enter the credentials in this field.

Find SIP Realm

Step 1

Step 2

Step 3

Step 4

To find a SIP Realm, perform the following procedure:

Procedure

In Unified Communications Manager Administration, choose User Management > SIP Realm.

The Find and List window displays. Records from an active (prior) query may also display in the window.

To find all records in the database, ensure the dialog box is empty; go to Step 3, on page 249.
To filter or search records

a) From the first drop-down list box, choose a search parameter.
b) From the second drop-down list box, choose a search pattern.
c) Specify the appropriate search text, if applicable.

Note To add additional search criteria, click the + button. When you add criteria, the system searches
for a record that matches all criteria that you specify. To remove criteria, click the — button to
remove the last added criterion or click the Clear Filter button to remove all added search
criteria.

Click Find.

All matching records display. You can change the number of items that display on each page by choosing a
different value from the Rows per Page drop-down list box.

From the list of records that display, click the link for the record that you want to view.

Note To reverse the sort order, click the up or down arrow, if available, in the list header.

The window displays the item that you choose.

What to do next

If you have not already done so, configure the Cluster ID enterprise parameter.

Configure SIP Realm

If Unified Communications Manager responds to challenges from one or more trunk peers, you must configure
SIP Realm for each SIP trunk user agent that can challenge Unified Communications Manager.
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Step 2
Step 3
Step 4
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To add or update a SIP Realm, perform the following procedure:

Procedure

In Unified Communications Manager Administration, choose User Management > SIP Realm.
Enter the appropriate settings as described in Table 36: SIP Realm Security Profile, on page 250.

Click Save.

Perform the procedure for all realms that you must add or update.

What to do next

To ensure that digest authentication is successful, verify that the same settings that you configured in Unified
Communications Manager are configured on the SIP user agent.

SIP Realm Settings

The SIP Realm provides the trunk-side credentials when Unified Communications Manager gets challenged

by a trunk peer.

The following table describes the settings for the SIP Realm.

Table 36: SIP Realm Security Profile

Setting

Description

Realm

Enter the domain name for the realm that connects to
the SIP trunk; for example, SIPProxyl xyz.com. You
can use alphanumeric characters, period, dash,
underscore, and space.

User

Enter the user name for the SIP user agent in this
realm; for example, enter the Unified Communications
Manager server name. The SIP trunk uses this user
name to challenge this Unified Communications
Manager.

Digest Credentials

Enter the password that Unified Communications
Manager uses to respond to a challenge for this realm
and user.

Confirm Digest Credentials

Re-enter the password for verification.

Delete SIP Realm

This section describes how to delete a SIP Realm from the Unified Communications Manager database.
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Procedure

Step 1 Find the SIP Realm to delete.
Step 2 Perform one of the following tasks:
a) To delete multiple SIP Realms, perform one of these tasks in the Find and List window:

* Check the check boxes next to the realms that you want to delete; then, click Delete Selected.
You can delete all configurable records for this selection by clicking Select All and then clicking
Delete Selected.
b) To delete a single SIP Realm, perform one of these tasks in the Find and List window:
* Check the check box next to the realm that you want to delete; then, click Delete Selected.

Click the Name link for the realm. After the specific SIP Realm Configuration window displays,
click Delete Selected.

Step 3 When prompted to confirm the delete operation, click OK to delete or Cancel to cancel the delete operation.
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Cisco Unified Mobility Advantage Server Security
Profile Setup

This chapter provides information about Cisco Unified Mobility Advantage server security profile setup.

» About Cisco Unified Mobility Advantage Server Security Profile Setup, on page 253

* Find Cisco Unified Mobility Advantage Server Security Profile, on page 254

* Set Up Cisco Unified Mobility Advantage Server Security Profile, on page 254

* Cisco Unified Mobility Advantage Server Security Profile Settings, on page 255

* Cisco Unified Mobility Advantage Server Security Profile Client Application, on page 256
* Delete Cisco Unified Mobility Advantage Server Security Profile, on page 256

* Where to Find More Information About Cisco Unified Mobility Advantage Server Security Profile, on
page 257

About Cisco Unified Mobility Advantage Server Security Profile

Setup

Unified Communications Manager Administration groups security-related settings to allow you to assign a
single security profile to multiple Mobile Communicator clients. Security-related settings include device
security mode, incoming transport type, and X.509 subject name. Configuring a Cisco Unified Mobility
Advantage server security profile in Unified Communications Manager Administration automatically applies
this profile to all configured Mobile Communicator clients on that Unified Communications Manager.

Only the security features that the Cisco Unified Mobility Advantage server supports display in the security
profile settings window.

\}

Note  You cannot configure Cisco Unified Mobility Advantage servers in Unified Communications Manager

Assistant Administration. For information on setting up a security profile for a Cisco Unified Mobility

Advantage server, refer to your Cisco Unified Mobility Advantage documentation. Make sure that the Cisco
Unified Mobility Advantage Security Profile you configure on Unified Communications Manager matches
the security profile on the Cisco Unified Mobility Advantage servers. For information on configuring a Cisco

Unity Cisco Unified Mobility Advantage server security profile, see the Cisco Unified Communications
Manager Security Guide.
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. Find Cisco Unified Mobility Advantage Server Security Profile

Find Cisco Unified Mobility Advantage Server Security Profile

Step 1

Step 2

Step 3

Step 4

To find a Cisco Unified Mobility Advantage server security profile, perform the following procedure:

Procedure

In Unified Communications Manager Administration, choose System > Security Profile> CUMA Server
Security Profile.

The Find and List CUMA Server Security Profile window displays. Records from an active (prior) query may
also display in the window.

To find all records in the database, ensure the dialog box is empty; go to Step 3, on page 254.
To filter or search records

a) From the first drop-down list box, choose a search parameter.
b) From the second drop-down list box, choose a search pattern.
¢) Specify the appropriate search text, if applicable.

Note To add additional search criteria, click the + button. When you add criteria, the system searches
for a record that matches all criteria that you specify. To remove criteria, click the — button to
remove the last added criterion or click the Clear Filter button to remove all added search
criteria.

Click Find.

All matching records display. You can change the number of items that display on each page by choosing a
different value from the Rows per Page drop-down list box.

From the list of records that display, click the link for the record that you want to view.

Note To reverse the sort order, click the up or down arrow, if available, in the list header.

The window displays the item that you choose.

SetUp Cisco Unified Mobility Advantage Server Security Profile

Step 1

Step 2

To add, update, or copy a security profile, perform the following procedure:

Procedure

In Unified Communications Manager Administration, choose System > Secur ity Profile> CUMA Server
Security Profile.

Perform one of the following tasks:
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a) To add a new profile, click Add New in the Find window and continue with Cisco Unified Mobility
Advantage Server Security Profile Setup, on page 253.

b) To copy an existing security profile, locate the appropriate profile and click the Copy button next to the
security profile that you want to copy, and continue with Cisco Unified Mobility Advantage Server Security
Profile Setup, on page 253.

¢) To update an existing profile, locate the appropriate security profile and continue with Cisco Unified
Mobility Advantage Server Security Profile Setup, on page 253.

When you click Add New, the configuration window displays with the default settings for each field.
When you click Copy, the configuration window displays with the copied settings.

Step 3 Enter the appropriate settings as described in Table 37: Security Profile Settings, on page 255
Step 4 Click Save.

Cisco Unified Mobility Advantage Server Security Profile
Settings

The following table describes the settings for the Cisco Unified Mobility Advantage Server security profiles.

Table 37: Security Profile Settings

Setting Description
Name Enter a name for the security profile.
Tip Include the device model in the security profile name to help you find

the correct profile when you are searching for or updating a profile.

Description Enter a description for the security profile. The description can include up to 50
characters in any language, but it cannot include double-quotes ("), percentage
sign (%), ampersand (&), back-slash (\), or angle brackets (<>).

Device Security Mode From the drop-down list box, choose one of the following options:

» Non Secure—No security features except image authentication exist for
the Cisco Unified Mobility Advantage server. A TCP connection opens to
Unified Communications Manager.

+ Authenticated—Unified Communications Manager provides integrity and
authentication for the Cisco Unified Mobility Advantage server. A TLS
connection that uses NULL/SHA opens for signaling.

» Encrypted—Unified Communications Manager provides integrity,
authentication, and encryption for the Cisco Unified Mobility Advantage
server. A TLS connection that uses AES128/SHA opens for signaling, and
SRTP carries the media for all mobile calls.

Security Guide for Cisco Unified Communications Manager, Release 11.5(1)SU10 .



Security for SRST References, Trunks, and Gateways |

. Cisco Unified Mobility Advantage Server Security Profile Client Application

Setting

Description

Transport Type

When Device Security Mode is Non Secure, choose the following option from
the drop-down list box:

* TCP—Choose the Transmission Control Protocol to ensure that packets get
received in the same order as the order in which they are sent. This protocol
ensures that no packets get dropped, but the protocol does not provide any
security.

When Device Security Mode is Authenticated or Encrypted, TLS specifies the
Transport Type. TLS provides signaling integrity, device authentication, and
signaling encryption (encrypted mode only).

Secure Certificate Subject
or Subject Alternate Name

(Required for Authenticated or Encrypted Device Security Mode setting.) This
field applies if you configured TLS as the transport type.

Secure Certificate Subject or Subject Alternate Name is an ITU
Telecommunication Standardization Sector standard for Public Key Infrastructure
in cryptography. The subject name corresponds to the source connection TLS
certificate.

If multiple Secure Certificate Subject or Subject Alternate Name exists, enter
one of the following characters to separate the names: space, comma, semicolon,
or a colon.

You can enter up to 4096 characters in this field.

Cisco Unified Mobility Advantage Server Security Profile Client

Application

No “Device Security Profile” field exists on the device configuration window for a Mobile Communicator
client, which means that you do not have to manually apply the Cisco Unified Mobility Advantage Server

Security profile to a client.

Configuring a Cisco Unified Mobility Advantage server security profile in Unified Communications Manager
Administration automatically applies this profile to all configured Mobile Communicator clients on that
Unified Communications Manager.

Delete CiscoUnified Mobility Advantage Server Security Profile

This section describes how to delete a Cisco Unified Mobility Advantage server security profile from the
Unified Communications Manager database.

Procedure

Step 1 Find the security profile to delete.

Step 2 To delete a security profile, perform the following task:
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a) Inthe Find and List window, check the check box next to the appropriate security profile; then, click
Delete Selected.

Step 3 When prompted to confirm the delete operation, click OK to delete or Cancel to cancel the delete operation.

Where to Find More Information About Cisco Unified Mobility
Advantage Server Security Profile
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FIPS 140-2 Mode Setup

This chapter provides information about FIPS 140-2 mode setup.

 FIPS 140-2 Setup, on page 259
* FIPS Mode Restrictions, on page 268

FIPS 140-2 Setup
A

Caution  FIPS mode is only supported on releases that have been through FIPS compliance. Be warned that FIPS mode
should be disabled before you upgrade to a non-FIPS compliance version of Unified Communications Manager.

For information about which releases are FIPS compliant and to view their certifications, see the FIPS 140
document at https://www.cisco.com/c/en/us/solutions/industries/government/global-government-certifications/
fips-140.html.

FIPS, or Federal Information Processing Standard, is a U.S. and Canadian government certification standard.
It defines requirements that cryptographic modules must follow.

Certain versions of Unified Communications Manager are FIPS 140-2 compliant, in accordance with the U.S.
National Institute of Standards (NIST). They can operate in FIPS mode, level 1 compliance.

Unified Communications Manager

* Reboots
* Runs certification self-tests at startup
* Performs the cryptographic modules integrity check

» Regenerates the keying materials

when you enable FIPS 140-2 mode. At this point, Unified Communications Manager operates in FIPS 140-2
mode.

FIPS requirements include the following:

* Performance of startup self-tests

* Restriction to a list of approved cryptographic functions
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FIPS mode uses the following FIPS 140-2 level 1 validated cryptographic modules:
* CiscoSSL 1.0.2n.6.2.194 with FIPS Module CiscoSSL FOM 6 2 0

* CiscoJ 5.2.1

* RSA CryptoJ 6 2 3
* OpenSSH 7.5.9

* Libreswan

* NSS

You can perform the following FIPS-related tasks:
* Enable FIPS 140-2 mode

* Disable FIPS 140-2 mode
 Check the status of FIPS 140-2 mode

\}

Note * By default, your system is in non-FIPS mode, you must enable it.

* Ensure that the security password length is minimum 14 characters before you upgrade to FIPS, Common
Criteria, or Enhanced Security mode on the cluster. Update the password even if the prior version was
FIPS enabled.

If you generate a Self-Signed Certificate or Certificate Signing Request (CSR) on FIPS mode, certificates
must be encrypted using the SHA256 hashing algorithm and can't select SHA1.

IPsec Requirements

With this release, the Libreswan library support replaces Openswan library support for IPsec. This support
has no changes to the existing functionality.

For the certificate-based authentication to function with the Libreswan library, the certificates of both the
source and destination must be CA-signed certificates. In addition, same certificate authority (CA) must sign
these certificates. The migration to the Libreswan library has the following limitations:

* [Psec stops working if you're using certificate-based authentication and self-signed certificates for setting
up [Psec.

* [Psec stops working if you're using certificate-based authentication and CA-signed certificates with
different CAs signing source and destination for setting up IPsec.

Enable FIPS 140-2 Mode

Consider the following before you enable FIPS 140-2 mode on Unified Communications Manager:

» When you switch from non-FIPS to FIPS mode, the MDS5 and DES protocols aren't functional.
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A

Enable FIPS 140-2 Mode ]

* In single server clusters, because certificates are regenerated, you need to run the CTL Client or apply
the Prepare Cluster for Rollback to pre-8.0 enterprise parameter before you enable FIPS mode. If you
do not perform either of these steps, you must manually delete the ITL file after you enable FIPS mode.

* In a cluster, all nodes should be either in FIPS or Non FIPS mode. Each node being in different modes
is not allowed. For example, Node A in FIPS mode and Node B in Non-FIPS mode is not allowed.

* After you enable FIPS mode on a server, please wait until the server reboots and the phones re-register
successfully before enabling FIPS on the next server.

Step 1

Step 2

Caution Before you enable FIPS mode, we strongly recommend that you perform a system backup. If FIPS checks
fail at start-up, the system halts and requires a recovery CD to be restored.
Make sure that all cluster nodes are set to FIPS mode or Non-FIPS mode during deployment. You cannot
deploy mixed nodes in a cluster. A cluster must be either a FIP or a non-FIPS node.
Procedure

Start a CLI session.

For more information, see “Start CLI Session” in the Command Line Interface Reference Guide for Cisco
Unifed Communications Solutions.

In

the CLI, enter utilsfips enable

If you enter a password less than 14 characters, the following prompt appear:

The cluster security password must be at least 14 characters long before
security modes such as FIPS, Common Criteria and Enhanced Security modes can be
enabled. Update the cluster security password using the 'set password user

security' CLI command on all nodes and retry this command.
khkhkhkkhkhkkhkhkkhhkhkhk kA kb hhhhkhhhhhhhkhhkhkhkhhkhhhhhhhhhhhhkhkhkhkhhhhhkhhkhhkhkhkhkkhkhhhhhkhkhkhkhhkkhkhrkhkhrkhkhhkhkhdkx

Executed command unsuccessfully

If you enter a password more than 14 characters, the following prompts appear:

Security Warning: The operation will regenerate certificates for

7)

CallManager
Tomcat

ITLRecovery

Any third party CA signed certificates that have been uploaded for the above
components will need to be re-uploaded. If the system is operating in mixed
mode, then the CTL client needs to be run again to update the CTL file.

If there are other servers in the cluster, please wait and do not change

the FIPS Settings on any other node until the FIPS operation on this node

is complete and the system is back up and running.

If the enterprise parameter 'TFTP File Signature Algorithm' is configured
with the value 'SHA-1' which is not FIPS compliant in the current version of the
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[l Disable FIPS 140-2 Mode

Step 3

Unified Communications Manager, though the signing operation

will continue to succeed, it is recommended the parameter value be changed to
SHA-512 in order to be fully FIPS. Configuring SHA-512 as the signing algorithm
may regiure all the phones that are provisioned in the cluster to be capable of
verifying SHA-512 signed configuration file, otherwise the phone registration
may fail. Please refer to the Cisco Unified Communications Manager Security Guide

for more details.
khkhkhkhkhkhkhhkhkhkhkhhkhhhkhh kb hkhhkhkhhkh bk h bk hhkhkhkh kb hkhkhkhkr kb hkhkdhkhhkhhkhhkdhhkhkhk ok hkhkhkhkhkhkrkhkhkkxkx

This will change the system to FIPS mode and will reboot.

KA AR AR A A A A A R A R A A A A A A A R A A A A A A AR AR A AR A AR AR AR A A A A AR AR A AR A AR AR A AR AR A A A A A A AR A Ak kKK

WARNING: Once you continue do not press Ctrl+C. Canceling this operation after
it
starts will leave the system in an inconsistent state; rebooting the system and

running "utils fips status" will be required to recover.
AR AR AR A AR A R A A A A A A A AR A R A A A AR A AR A A A AR A AR A AR A A AR A AR AR AR AR AR AR A A A KRR KA A KR AR AR AR AR AR AR AR AR KR KK

Do you want to continue (yes/no)?

Enter Yes.

The following message appears:

Generating certificates...Setting FIPS mode in operating system.
FIPS mode enabled successfully.

R I b i S b I R b S I b S R S S b e S R I I S IE S b S b I S I b b b b b Sh S b I b b S 2b 4

It is highly recommended that after your system restarts

that a system backup is performed.
AR AR A A AR AR A A AR A A A AR AR A A R A AR A AR AR AR A AR A AR AR AR AR AR AR AKX Rk Kk

The system will reboot in a few minutes.

Unified Communications Manager reboots automatically.

Note * Certificates and SSH key are regenerated automatically, in accordance with FIPS requirements.

* If you have a single server cluster and applied the Prepare Cluster for Rollback to pre 8.0
enterprise parameter before you enabled FIPS 140-2 mode, you must disable this enterprise
parameter after making sure that all the phones registered successfully to the server.

* To enable FIPS in a cluster, first enable the Publisher and make sure all the configured services
are properly initialized which will take some time to come up. Then enable fips in all other
nodes one after the other within the cluster.

Note In FIPS mode, Unified Communications Manager uses Libreswan (FIPS validated) in place of
Racoon (non-FIPS validated). If the security policies in Racoon contain functions that aren't FIPS
approved, CLI command asks you to redefine security policies with FIPS approved functions and
abort. For more information, see topics related to I[Psec Management in the Administration Guide
for Cisco Unified Communications Manager.

Disable FIPS 140-2 Mode

Consider the following information before you disable FIPS 140-2 mode on Unified Communications Manager:

* In single or multiple server clusters, we recommend you to run the CTL Client. If the CTL Client is not
run on a single server cluster, you must manually delete the ITL File after disabling FIPS mode.
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Step 1

Step 2

Check FIPS 140-2 Mode Status [}

* In multiple server clusters, each server must be disabled separately, because FIPS mode is not disabled
cluster-wide but rather on a per-server basis.

To disable FIPS 140-2 mode, perform the following procedure:

Procedure

Start a CLI Session.

For more information, see the Starting a CLI Session section in the Command Line Interface Reference Guide
for Cisco Unified Communications Solutions.

In the CLI, enter utilsfips disable
Unified Communications Manager reboots and is restored to non-FIPS mode.

Note Certificates and SSH key are regenerated automatically.

Check FIPS 140-2 Mode Status

Step 1

Step 2

To confirm if the FIPS 140-2 mode is enabled, check the mode status from the CLI.
To check the status of FIPS 140-2 mode, perform the following procedure:

Procedure

Start a CLI Session.

For more information, see the Starting a CLI Session section in the Command Line Interface Reference Guide
for Cisco Unified Communications Solutions.

In the CLI, enter utilsfips status

The following message appears to confirm that FIPS 140-2 mode is enabled.

admin:utils fips status
The system is operating in FIPS mode. Self test status:

= 8 T A R W ocooomomooooooooooooos
Executing FIPS selftests

runlevel is N 3

Start time: Thu Apr 28 15:59:24 PDT 2011
NSS self tests passed.

Kernel Crypto tests passed.

Operating System OpenSSL self tests passed.
Libreswan self tests passed.

OpenSSL self tests passed.

CryptoJ self tests passed...
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FIPS 140-2 Mode Server Reboot

FIPS startup self-tests in each of the FIPS 140-2 modules are triggered after rebooting when Unified
Communications Manager server reboots in FIPS 140-2 mode.

A

Caution If any of these self-tests fail, the Unified Communications Manager server halts.

)

Note Unified Communications Manager server is automatically rebooted when FIPS is enabled or disabled with
the corresponding CLI command. You can also initiate a reboot.

A

Caution  If the startup self-test failed because of a transient error, restarting the Unified Communications Manager
server fixes the issue. However, if the startup self-test error persists, it indicates a critical problem in the FIPS
module and the only option is to use a recovery CD.

Enhanced Security Mode

Enhanced Security Mode runs on a FIPS-enabled system. Both Unified Communications Manager and the
IM and Presence Service can be enabled to operate in Enhanced Security Mode, which enables the system
with the following security and risk management controls:

» Stricter credential policy is implemented for user passwords and password changes.
* Contact search authentication feature becomes enabled by default.

» If the protocol for remote audit logging is set to TCP or UDP, the default protocol is changed to TCP. If
the protocol for remote audit logging is set to TLS, the default protocol remains TLS. In Common Criteria
Mode, strict hostname verification is implemented. Hence, it is required to configure the server with a
fully qualified domain name (FQDN) which matches the certificate.

Credential Policy Updates

When Enhanced Security Mode is enabled, a stricter credential policy takes effect for new user passwords
and password changes. After Enhanced Security Mode is enabled, administrators can use the set password
*** geries of CLI commands to modify any of these requirements:

* Password Length should be between 14 to 127 characters.

» Password should have at least 1 lowercase, | uppercase, 1 digit and 1 special character.
* Any of the previous 24 passwords cannot be reused.

* Minimum age of the password is 1 day and Maximum age of the password is 60 days.

» Any newly generated password's character sequence will need to differ by at least 4 characters from the
old password's character sequence.
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Configure Enhanced Security Mode
Enable FIPS before you enable Enhanced Security Mode.

Use this procedure on all Unified Communications Manager or IM and Presence Service cluster nodes to
configure Enhanced Security Mode.

)

Note You must ensure that services in the IM and Presence Service publishers are in the 'STARTED' state ("Cisco
IM and Presence Data Monitor" service and SyncAgent), when you are changing the password on the Unified
Communications Manager publisher after enabling the Enhanced Security Mode.

Procedure

Step 1 Log in to the Command Line Interface.
Step 2 Run utilsEnhancedSecurityM ode status command to confirm whether Enhanced Security Mode is enabled.

Step 3 Run one of the following commands on a Unified Communications Manager cluster node:

* To enable Enhanced Security Mode, run utils EnhancedSecurityM ode enable command.
* To disable Enhanced Security Mode, run utils EnhancedSecurityM ode disable command.

Step 4 After enabling Enhanced Security Mode, change the password in the Cisco Unified CM Administration user
interface with a new password containing 14 characters.

Perform the following after enabling Enhanced Security Mode on Unified Communications Manager publisher:

a. Enable Enhanced Security Mode on Unified Communications Manager subscribers.
b. Enable Enhanced Security Mode on IM and Presence Service publisher.

C. Enable Enhanced Security Mode on IM and Presence Service subscribers.

Note Do not run either utils EnhancedSecurityM ode enable or utils EnhancedSecurityM ode disable
CLI commands on all nodes simultaneously.

Common Criteria Mode

Common Criteria mode allows both Unified Communications Manager and IM and Presence Service Service
to comply with Common Criteria guidelines. Common Criteria mode can be configured with the following
set of CLI commands on each cluster node:

*utils fips_common_criteria enable
*utils fips common criteria disable

*utils fips common criteria status
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Common Criteria Configuration Task Flow

* FIPS mode must be running to enable Common Criteria mode. If FIPS isn't already enabled, you'll be
prompted to enable it when you try to enable Common Criteria mode. Enabling FIPS does require
certificate regeneration. For more information, see Enable FIPS 140-2 Mode, on page 260.

* In Common Criteria mode, Certificate Exchange operation is mandatory between clusters/nodes before
configuring IPSec policies for Certificate based IPSec Policy.

* X.509 v3 certificates are required in Common Criteria mode. X.509 v3 certificates enable secure
connections when using TLS 1.2 as a communication protocol for the following:

* Remote audit logging

» Establishing connection between the FileBeat client and the logstash server.

To configure Unified Communications Manager and IM and Presence Service for Common Criteria mode,
perform the following:

Procedure
Command or Action Purpose
Step 1 Enable TLS, on page 266 TLS is a prerequisite for configuring Common
Criteria mode.
Step 2 Configure Common Criteria Mode, on page 267 | Configure Common Criteria mode on all
Unified Communications Manager and IM and
Presence Service cluster nodes.

Enable TLS

TLS 1.2 version or TLS version 1.1 is a requirement for Common Criteria mode. Secure connections using
TLS version 1.0 are not permitted after enabling Common Criteria mode.

* During establishment of a TLS connection, the extendedkeyUsage extension of the peer certificate is
checked for proper values.

* The peer certificate should have serverauth as extendedkeyUsage extension if the peer is a server.

* The peer certificate should have clientAuth as extendedKeyUsage extension if the peer is a client.

If the extendedkeyUsage extension does not exist in the peer certificate or is not set properly, the connection
is closed.

To support TLS version 1.2, perform the following:

Procedure

Step 1 Install Soap Ul version 5.2.1.
Step 2 If you are running on the Microsoft Windows platform:
a) Navigateto C: \Program Files\SmartBear\SoapUI-5.2.1\bin.

. Security Guide for Cisco Unified Communications Manager, Release 11.5(1)SU10



| Security for SRST References, Trunks, and Gateways
Configure Common Criteria Mode .

b) Editthe SoapUI-5.2.1.vmoptions filetoadd -Dsocapui.https.protocols=TLSv1.2, TLSv1, SSLv3
and save the file.

Step 3 If you are running on Linux, edit the bin/soaup. sh file to add gava opTs="sJava oPTs
-Dsoapui.https.protocols=SSLv3, TLSv1.2" and save the file.
Step 4 If you are running OSX:

a) Navigateto /Applications/SoapUI-{VERSION}.app/Contents.

b) Editthe vmoptions. txt filetoadd -pDsoapui.https.protocols=TLSv1.2,TLSv1, SSLv3 and save the
file.

Step 5 Restart the SoapUI tool and proceed with AXL testing

Configure Common Criteria Mode

Use this procedure to configure Common Criteria mode for Unified Communications Manager and IM and
Presence Service Service.

Procedure
Step 1 Log in to the Command Line Interface prompt.
Step 2 Run utils fips common criteria status command to verify whether the system is operating in Common

Criteria mode.

Step 3 Run one of the following commands on a cluster node:
* To enable the Common Criteria mode, run utils fips common criteria enable.
* To disable the Common Criteria mode, run utils fips_ common criteria disable.

When Common Criteria mode is disabled, a prompt is displayed to set the minimum TLS version.

Note Do not run these commands on all nodes simultaneously.

Step 4 To enable Common Criteria Mode across a single cluster, repeat this procedure on all Unified Communications
Manager and IM and Presence Service cluster nodes.

Note * CTL client does not connect to Unified Communications Manager node when server is in the
Common Criteria mode, as CTL client does not support TLS 1.1 and TLS 1.2 protocols.

* Only phone models that support TLS 1.1 or TLS 1.2 such as DX series and 88 XX series phones
are supported in Common Criteria mode. Phone models that support only TLSv1.0 such as
7975 and 9971 are not supported in the Common Criteria mode.

* Temporarly allow TLS 1.0 when using the CTL Client and then move the Cluster to Common
Criteria mode. Configure Minimum TLS to 1.1 or 1.2.

* Migrate to Tokenless CTL by using the CLI Command utils ctl set-cluster mixed-mode in
Common Criteria mode. Configure Minimum TLS to 1.1 or 1.2.

Step 5 To enable the Common Criteria mode in a multi cluster setup where ICSA is already configured between the
nodes, enable Common Criteria mode in each of the nodes in the following order:
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a. Unified Communications Manager - Cluster 1 (Publisher)

b. IM and Presence Service - Cluster 1 (Publisher)

C. IM and Presence Service - Cluster 1 (Subscriber or subscribers)

d. Unified Communications Manager - Cluster 2 (Publisher)

e. IM and Presence Service - Cluster 2 (Publisher)

f. IM and Presence Service - Cluster 2 (Subscriber or subscribers)

Step 6 In case of a cert sync failure, see.

FIPS Mode Restrictions

Feature

Restrictions

SNMP v3

FIPS mode does not support SNMP v3 with MD5 or DES. If you have SNMP
v3 configured while FIPS mode is enabled, you must configure SHA as the
Authentication Protocol and AES128 as the Privacy Protocol.

Certificate Remote
Enrolment

FIPS mode does not support Certificate Remote Enrolment.

SFTP Server

By Default, the JSCH library was using ssh-rsa for SFTP connection but the FIPS
mode doesn’t support ssh-rsa. Due to a recent update of CentOS, the JSCH library
supports both ssh-rsa (SHA1withRSA) or rsa-sha2-256 (SHA256withRSA)
depending on the FIPS value after modifications. That is,

Note * FIPS mode only supports rsa-sha2-256.
* Non-FIPS mode supports both ssh-rsa and r sa-sha2-256.

The rsa-sha2-256 (SHA256WithRSA) support is available only from OpenSSH
6.8 version onwards. In FIPS mode, only the SFTP servers running with OpenSSH
6.8 version onwards supports the rsa-sha2-256 (SHA256WithRSA)
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Feature Restrictions

IPSec Policy In Common Criteria (CC) mode, Certificate Exchange operation is recommended
first between clusters/nodes before configuring IPSec policies for Certificate
based IPSec Policy.

Certificate based IPSec Policy will not work when moving from Non-FIPS to
FIPS / Common Criteria mode or vice-versa.

Perform the following when you should move from Non-FIPS mode to FIPS /
CC Mode or vice-versa. If you have a certificate based IPSec policy and its in
enabled state then:

1. Disable the IPSec policy before moving to FIPS/CC mode or vice versa.

2. Re-certify the certificate and exchange the new certificate after moving to
FIPS/CC mode or vice versa.

3. Enable IPSec policy.
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CHAPTER 28

Cisco V.150 Minimum Essential Requirements
(MER)

* V.150 Overview, on page 271
* Prerequisites for Cisco V.150.1 MER, on page 271
* Configure V.150 Task Flow, on page 272

V.150 Overview

The V.150 Minimum Essential Requirements feature allows you to make secure calls in a modem over IP
network. The feature uses a dial-up modem for large installed bases of modems and telephony devices operating
on a traditional public switched telephone network (PSTN). The V.150.1 recommendation specifically defines
how to relay data from modems and telephony devices on a PSTN into and out of an IP network through a
modem. The V.150.1 is an ITU-T recommendation for using a modem over IP networks that support dial-up
modem calls.

The Cisco V.150.1 Minimum Essential Requirements feature complies with the requirements of the National
Security Agency (NSA) SCIP-216 Minimum Essential Requirements (MER) for V.150.1 recommendation.
The SCIP-216 recommendation has simplified the existing V.150.1 requirements.

Cisco V.150.1 MER feature supports the following interfaces:
* Media Gateway Control Protocol(MGCP) T1(PRI and CAS) and E1(PRI) trunks

* Session Initiation Protocol (SIP) trunks
+ Skinny Client Control Protocol (SCCP) for analog gateway endpoints

* Secure Communication Interoperability Protocol-End Instruments (SCIP-EI)

Prerequisites for Cisco V.150.1 MER

Your system should already be set up with basic call control functionality. For instructions on how to set up
the call control system, refer to theSystem Configuration Guide for Cisco Unified Communications Manager.

For Unified Communications Manager, you must have one of the following releases installed:

* The minimum version is Release 10.5(2) SU3
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* For 11.0, the minimum version will be 11.0(1) SU2 available in Spring 2016

* All releases from 11.5(1) on support this feature

* You must have Cisco 10S Release 15.6(2)T or later.

V.150 is not supported with Media Termination Point (MTP). We recommend that you remove MTP from
devices, trunks, and gateways that are handling V.150 calls.

Configure V.150 Task Flow

Complete these tasks to add V.150 support in Unified Communications Manager.

Procedure

Command or Action

Purpose

Step 1

To Configure Media Resource Group Task
Flow, on page 273, perform the following
subtasks:

* Configure Media Resource Group for
Non-V.150 Endpoints, on page 274

* Configure a Media Resource Group List
for Non-V.150 Endpoints, on page 274

* Configure Media Resource Group for
V.150 Endpoints, on page 274

* Configure a Media Resource Group List
for V.150 Endpoints, on page 275

Add Media Resource Group and Media
Resource Group List for V.150 and non V.150
devices.

Step 2

Configure the Gateway for Cisco V.150 (MER),
on page 275

Add V.150 functionality to a gateway.

Step 3

Configure V.150 MGCP Gateway Port
Interface, on page 276

If you want to use V.150 support across an
MGCP gateway, add V.150 support to the port
interface.

Step 4

Configure V.150 SCCP Gateway Port Interface,
on page 276

If you want to use V.150 support across an
SCCP gateway, add V.150 support to the port
interface.

Step 5

Configure V.150 Support for Phone, on page
277

Add V.150 support to the phones that will be
placing V.150 calls.

Step 6

To Configure SIP Trunk Task Flow, on page
278, perform one or any of the following
subtasks:

* Configure SIP Profile for V.150, on page
278

* Set the Clusterwide V.150 Filter, on page
278

Add V.150 support to the SIP trunk that will be
used for V.150 calls.
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Command or Action Purpose

* Add V.150 Filter to SIP Trunk Security
Profile, on page 279

* Configure SIP Trunk for V.150, on page
280

Step 7 To use the V.150 MER feature, you also need | For more information on 10S gateway

to configure IOS on your gateway to support | configuration settings, see

the feature. http://www.cisco.com/c/en/us/td/docs/ios/12
41/12 4t4/mer cg 15 1 4M.html.

Configure Media Resource Group Task Flow

Your system should already be set up with basic call control functionality. For instructions on how to set up
the call control system, see System Configuration Guide for Cisco Unified Communications Manager.

For Unified Communications Manager, you must have one of the following releases installed:

* The minimum version is Release 10.5(2) SU3

* For 11.0, the minimum version will be 11.0(1) SU2

* All releases from 11.5(1) on support this feature

* You must have Cisco 10S Release 15.6(2)T or later.
V.150 is not supported with Media Termination Point (MTP). We recommend that you remove MTP from
devices, trunks, and gateways that are handling V.150 calls.

Complete these tasks to configure two sets of media resource groups: a media resource group with MTP
resources for non-V.150 calls, and a media resource group without MTP resources for V.150 calls.

Procedure
Command or Action Purpose

Step 1 Configure Media Resource Group for You can configure the Media Resource Group
Non-V.150 Endpoints, on page 274 with MTP for non-V.150 endpoints.

Step 2 Configure a Media Resource Group List for | Configure a Media Resource Group list that
Non-V.150 Endpoints, on page 274 includes your MTP Media Resources for
non-V.150 endpoints.

Step 3 Configure Media Resource Group for V.150 | Configure Media Resource Group without MTP

Endpoints, on page 274 resources for secure V.150 calls.
Step 4 Configure a Media Resource Group List for | Configure a Media Resource Group list without
V.150 Endpoints, on page 275 MTP after adding the required resources in the
Media Resource Group for secure V.150
endpoints.
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. Configure Media Resource Group for Non-V.150 Endpoints

Configure Media Resource Group for Non-V.150 Endpoints

Step 1

Step 2
Step 3
Step 4

Step 5

Use this procedure to add a new media resource group that includes MTP resources for non-V.150 endpoints.

Procedure

From Cisco Unified Communications Manager Administration, choose M edia Resour ces> M edia Resour ce
Group.

Click Add New.
In the Name field, enter the media resource group name as Do not use with V.150 devices.

From the Available M edia Resour ces field, choose only MTP devices and click the down-arrow key.
The selected devices appear in the Selected M edia Resour ces field.

Click Save.

Configure a Media Resource Group List for Non-V.150 Endpoints

Step 1

Step 2
Step 3
Step 4

Step 5

Configure Media Resource Group for Non-V.150 Endpoints, on page 274

Use this procedure to add new media resource group list with MTP resources for non-V.150 end points.

Procedure

From Cisco Unified Communications Manager Administration, choose M edia Resour ces> M edia Resour ce
Group List.

Click Add New.
In the Name field, enter a name for the media resource group list as Non- V.150.

From the Available M edia Resour ces field, choose the V.150 MER resource group named Do not use with
V.150 Devices and click the down-arrow key.
The selected devices appear in the Selected M edia Resour ces field.

Click Save.

Configure Media Resource Group for V.150 Endpoints

Step 1

Step 2
Step 3
Step 4

Use this procedure to add new media resource group without MTP resources for V.150 devices.

Procedure

From Cisco Unified Communications Manager Administration, choose M edia Resour ces> M edia Resour ce
Group.

Click Add New.
In the Name field, enter the media resource group name as For use with V.150 devices.

From the Available M edia Resour ces field, choose multiple devices except the MTP resources and click the
down-arrow key.

. Security Guide for Cisco Unified Communications Manager, Release 11.5(1)SU10



| Security for SRST References, Trunks, and Gateways

Step 5

Configure a Media Resource Group List for V.150 Endpoints .

The selected devices appear in the Selected M edia Resour ces field.
Click Save.

Configure a Media Resource Group List for V.150 Endpoints

Step 1

Step 2
Step 3
Step 4

Step 5

Configure Media Resource Group for V.150 Endpoints, on page 274

Use this procedure to add a media resource group list without MTP resources for V.150 devices.

Procedure

From Cisco Unified Communications Manager Administration, choose M edia Resour ces> M edia Resour ce
Group List.

Click Add New.
In the Name field, enter a name for the media resource group list as V.150.

From the Available M edia Resour cesfield, choose the V.150 MER resource group named For V.150 Devices
and click the down-arrow key.
The selected media resource groups appear in the Selected M edia Resour ces field.

Click Save.

Configure the Gateway for Cisco V.150 (MER)

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6

Step 7
Step 8

Use this procedure to configure the gateway for Cisco V.150 (MER).

Procedure

From Cisco Unified Communications Manager Administration, choose Device > Gateway.
Click Add New.

Choose the gateway from the Gateway Type drop-down list.

Click Next.

From the Protocol drop-down list, choose a protocol.

Depending on which Protocol you chose for the gateway, perform:

» For MGCP, in the Domain Name field, enter the domain name that is configured on the gateway.
* For SCCP, in the MAC Address (Last 10 Characters) field, enter the gateway MAC address.

From the Unified Communications Manager Group drop-down list, choose Default.
In the Configured Slots, VICs and Endpoints area, perform the following steps:

a) From each Module drop-down list, select the slot that corresponds to the Network Interface Module
hardware that is installed on the gateway.

b) From each Subunit drop-down list, select the VIC that is installed on the gateway.

¢) Click Save.

Security Guide for Cisco Unified Communications Manager, Release 11.5(1)SU10 .



Security for SRST References, Trunks, and Gateways |

. Configure V.150 MGCP Gateway Port Interface

Step 9

Step 10

The port icons appear. Each port icon corresponds to an available port interface on the gateway. You
can configure any port interface by clicking the corresponding port icon.

Complete the remaining fields in the Gateway Configur ation window. See the online help for more information
about the fields and their configuration options.

Click Save.

Configure V.150 MGCP Gateway Port Interface

Step 1
Step 2
Step 3

Step 4

Step 5
Step 6
Step 7

Step 8
Step 9

Use this procedure to configure V.150 MGCP gateway port interface.

Procedure

From Cisco Unified Communications Manager Administration, choose Device > Gateway.
Enter the appropriate search criteria to modify the settings for an existing gateway and click Find.

In the Configured Slots, VICs, and Endpoints area, locate the module and subunit on which you want to
configure a port for V.150 MER and click the corresponding port icon.

From the Device Protocol drop-down list, choose Digital Access T1 or Digital Access PRI and click Next.

Note The Device Protocol drop-down list is displayed only if T1 port is selected in the Configured Slots,
VICs, and Endpoints area.

The Gateway Configuration window now displays the port interface configuration.

Select the M edia Resource Group List named V.150.

Check the V150 (subset) check box.

Configure the remaining fields, if applicable. See the online help for more information about the fields and
their configuration options.

Click Save.

(Optional) If you want to configure additional port interfaces for the gateway, from the Related Links
drop-down list, choose Back to M GCP Configuration and click Go. You can select a different port interface.

Configure V.150 SCCP Gateway Port Interface

Step 1
Step 2
Step 3

Step 4

Use this procedure to configure V.150 SCCP gateway port interface.

Procedure

From Cisco Unified Communications Manager Administration, choose Device > Gateway.
Enter the appropriate search criteria to modify the settings for an existing SCCP gateway and click Find.

In the Configured Slots, VICs, and Endpoints area, locate the module and subunit on which you want to
configure a port for V.150 MER and click the corresponding port icon.

Select the M edia Resource Group List named “V.150”.
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Step 5
Step 6

Step 7

Configure V.150 Support for Phone .

In the Product Specific Configuration Layout area, if the L atent Capability Registration Setting drop-down
list appears, select Modem Relay or Modem Relay and Passthrough.

Configure the remaining fields, if applicable. See the online help for more information about the fields and
their configuration options.

Click Save.

Configure V.150 Support for Phone

Step 1
Step 2

Step 3
Step 4

Step 5
Step 6

Step 7
Step 8

Step 9
Step 10
Step 11

Use this procedure to add V.150 support for a phone. The following phone types support V.150:
* Cisco 7962—Third party SCCP end point registered as Cisco 7962
* Cisco 7961G-GE—Third party SCCP end point registered as Cisco 7961G-GE
* Third Party AS-SIP Endpoints

Procedure

Required: Create an End User with the User ID same as the intended phone number.
Required: Configure the Digest Credentials field in the End User Configuration window for Third Party
AS-SIP SIP endpoints.

For more information on how to configure a new End User, see the “Provision End Users Manually” chapter
in the System Configuration Guide for Cisco Unified Communications Manager

From Cisco Unified Communications Manager Administration, choose Device > Phone.
Perform either of the following steps:

* To configure V.150 on an existing phone, click Find and select the phone.
* To configure a new phone for V.150, click Add New.

From the Phone Type drop-down list, select one of the phone types that supports V.150, and click Next.

For third party SCCP endpoints registered as Cisco 7962, select SCCP from the Device Protocol drop-down
list, and click Next.

From the M edia Resource Group List drop-down menu, select V.150.
For third party AS-SIP SIP endpoints only, Configure the following fields:

* From the Digest User drop-down select the end user for this phone. The end user will be used for digest
authentication.

* Leave the Media Termination Point Required check box unchecked.

* Check the Early Offer support for voice and video calls check box.

Click Save.
Click Apply Config.
Click OK.
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. Configure SIP Trunk Task Flow

Configure SIP Trunk Task Flow

Use this procedure to configure SIP Trunk task flow.

Procedure

Command or Action Purpose

Step 1 Configure SIP Profile for V.150, on page 278 | Configure a SIP Profile with SIP Best Effort
Early Offer support for the SIP trunk.

Step 2 Set the Clusterwide V.150 Filter, on page 278 | Optional. Configure a clusterwide default
setting for SIP V.150 SDP Offer Filtering.

Step 3 Add V.150 Filter to SIP Trunk Security Profile, | Configure a V.150 Filter within a SIP Trunk
on page 279 Security Profile that you can assign to specific
SIP trunks.

Step 4 Configure SIP Trunk for V.150, on page 280 | Configure V.150 support for the SIP trunks that
will handle V.150 calls.

Configure SIP Profile for V.150

Step 1

Step 2

Step 3
Step 4
Step 5

Step 6

Step 7

Use this procedure to configure a SIP Profile with SIP Best Effort Early Offer support for the SIP trunk.

Procedure

In Cisco Unified Communications Manager Administration, choose Device> Device Settings> S|P Profile

Perform either of the following steps:

* To create a new profile, click Add New.
* To select an existing profile, click Find and select a SIP profile.

In the Name field, enter the SIP name for V.150.
In the Description field, enter the description for V.150.

From the Early Offer Support for Voice and video class drop-down list, choose Select Best Effort (no
MTP inserted).

Enter any other configuration settings that you want. See the online help for more information about the fields
and their configuration options.

Click Save.

Set the Clusterwide V.150 Filter

Use this procedure to configure a clusterwide default setting for SIP V.150 SDP Offer filtering.
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\)

Note If you configure a SIP V.150 SDP Offer Filtering value within a SIP Trunk Security Profile that is different
than the clusterwide service parameter setting, the security profile setting overrides the cluster-wide service
parameter setting for the trunks that use that security profile.

Procedure
Step 1 From Cisco Unified Communications Manager Administration, choose System > Service Parameters.
Step 2 From the Server drop-down list, choose an active server.

Step 3 From the Service drop-down list, choose Cisco CallManager .

Step 4 In the Clusterwide Parameters ( Device- SIP) section, configure a value for the SIP V.150 SDP Offer
Filtering service parameter.

Step 5 Choose SIP V.150 SDP Offer Filtering from the drop-down list.
Step 6 Specify the desired filtering action.
Step 7 Click Save.

Add V.150 Filter to SIP Trunk Security Profile

Use this procedure to assign a V.150 Filter within a SIP Trunk Security Profile.

\}

Note Ifyou configure a SIP V.150 SDP Offer Filtering value within a SIP Trunk Security Profile that is different
than the clusterwide service parameter, the security profile setting overrides the cluster-wide service parameter
setting for the trunks that use that security profile.

Procedure

Step 1 From Cisco Unified Communications Manager Administration, choose System > Security > SIP Trunk
Security Profile.

Step 2 Perform one of the following tasks:

* Enter search criteria and Click Find to choose an existing profile from the list to modify the settings for
an existing SIP Trunk Security Profile.

* Click Add New to add a new SIP Trunk Security Profile.

Step 3 Configure a value for the SIP V.150 Outbound SDP Offer Filtering drop-down list.

Note The default setting is to use the value of the SI P V.150 Outbound SDP Offer Filtering cluster-wide
service parameter.

Step 4 Configure any remaining fields in the SIP Trunk Security Profile Configuration window. See the online
help for more information about the fields and their configuration options.
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. Configure SIP Trunk for V.150

Step 5

Click Save.

Configure SIP Trunk for V.150

Step 1
Step 2

Step 3

Step 4
Step 5
Step 6
Step 7

Step 8
Step 9

Step 10
Step 11

Step 12

Use this procedure to configure settings for a SIP trunk.

Procedure

From Cisco Unified Communications Manager Administration, choose Device > Trunk.
Perform either of the following steps:

* To create a new profile, click Add New.
» Click Find and select a SIP trunk, to select an existing trunk.

For new trunks, do the following:

* From the Trunk Type drop-down list, choose SIP Trunk.

* From the Protocol Type drop-down list, choose SIP.

* From the Trunk Service Type drop-down list, choose None(Default).
* Click Next.

Enter the SIP trunk name in the Name field.

Enter the SIP trunk description in the Description field.

From the M edia Resour ce Group List drop-down list, choose the Media resource group list named “V.150”.
Configure the destination address for the SIP trunk:

a) In the Destination Address text box, enter an IPv4 address, fully qualified domain name, or DNS SRV
record for the server or endpoint that you want to connect to the trunk.

b) Ifthe destination is a DNS SRV record, check the Destination Addressisan SRV check box.

¢) To add additional destinations, click (+) button. You can add up to 16 destinations for a SIP trunk.

From the SIP Trunk Security Profile drop-down list, assign the SIP trunk security profile that you configured
for this trunk.

From the SIP Profile drop-down list, assign the SIP profile that you set up with the Best Effort Early Offer
setting.

Leave the Media Termination Point Required check box unchecked.

Configure any additional fields in the Trunk Configuration window. See the online help for more information
about the fields and their configuration options.

Click Save.
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